Color

User Manual
Contents

Preface  
9 Welcome to Color  
9 About Color  
10 About the Color Documentation  
10 Additional Resources

Chapter 1  
13 Color Correction Basics  
13 The Fundamental Color Correction Tasks  
16 When Does Color Correction Happen?  
23 Image Encoding Standards  
28 Basic Color and Imaging Concepts

Chapter 2  
35 Color Correction Workflows  
35 An Overview of the Color Workflow  
37 Limitations in Color  
39 Video Finishing Workflows Using Final Cut Pro  
47 Importing Projects from Other Video Editing Applications  
50 Digital Cinema Workflows Using Apple ProRes 4444  
56 Finishing Projects Using RED Media  
65 Digital Intermediate Workflows Using DPX/Cineon Media  
73 Using EDLs, Timecode, and Frame Numbers to Conform Projects

Chapter 3  
77 Using the Color Interface  
78 Setting Up a Control Surface  
78 Using Onscreen Controls  
82 Using Organizational Browsers and Bins  
88 Using Color with One or Two Monitors

Chapter 4  
91 Importing and Managing Projects and Media  
92 Creating and Opening Projects  
92 Saving Projects  
95 Saving and Opening Archives  
95 Moving Projects from Final Cut Pro to Color  
101 Importing EDLs  
102 EDL Import Settings
Relinking Media
Importing Media Directly into the Timeline
Compatible Media Formats
Moving Projects from Color to Final Cut Pro
Exporting EDLs
Reconforming Projects
Converting Cineon and DPX Image Sequences to QuickTime
Importing Color Corrections
Exporting JPEG Images

Chapter 5
Configuring the Setup Room
The File Browser
Using the Shots Browser
The Grades Bin
The Project Settings Tab
The Messages Tab
The User Preferences Tab

Chapter 6
Monitoring Your Project
The Scopes Window and Preview Display
Monitoring Broadcast Video Output
Using Display LUTs
Monitoring the Still Store

Chapter 7
Timeline Playback, Navigation, and Editing
Basic Timeline Elements
Customizing the Timeline Interface
Working with Tracks
Selecting the Current Shot
Timeline Playback
Zooming In and Out of the Timeline
Timeline Navigation
Selecting Shots in the Timeline
Working with Grades in the Timeline
The Settings 1 Tab
The Settings 2 Tab
Editing Controls and Procedures

Chapter 8
Analyzing Signals Using the Video Scopes
What Scopes Are Available?
Video Scope Options
Analyzing Images Using the Video Scopes
Welcome to Color

Welcome to the world of professional video and film grading and manipulation using Color.

This preface covers the following:

• About Color (p. 9)
• About the Color Documentation (p. 10)
• Additional Resources (p. 10)

About Color

Color has been designed from the ground up as a feature-rich color correction environment that complements a wide variety of post-production workflows, whether your project is standard definition, high definition, or a 2K digital intermediate. If you've edited a program using Final Cut Pro, it's easy to send your program to Color for grading and then send it back to Final Cut Pro for final output. However, it's also easy to reconform projects that originate as EDLs from other editing environments.

Color has the tools that professional colorists demand, including:

• Primary color correction using three-way color balance and contrast controls with individual shadow, midtone, and highlight controls
• Curve controls for detailed color and luma channel adjustments
• Up to eight secondary color correction operations per shot with HSL qualifiers, vignettes, user shapes, and separate adjustments for the inside and outside of each secondary
• Color FX node-based effects for creating custom color effects
• Pan & Scan effects
• Motion tracking that can be used to animate vignettes, user shapes, and other effects
• Broadcast legal settings to guarantee adherence to quality control standards
• Support for color correction–specific control surfaces
• And much, much more
All of these tools are divided among eight individual “rooms” of the Color interface, logically arranged in an order that matches the workflow of most colorists. You use Color to correct, balance, and create stylized “looks” for each shot in your program as the last step in the post-production workflow, giving your programs a final polish previously available only to high-end facilities.

About the Color Documentation
The Color User Manual provides comprehensive information about the application and is written for users of all levels of experience.

• Editors and post-production professionals from other disciplines who are new to the color correction process will find information on how to get started, with detailed explanations of how all controls work, and why they function the way they do.
• Colorists coming to Color from other grading environments can skip ahead to find detailed information about the application’s inner workings and exhaustive parameter-by-parameter explanations for every room of the Color interface.

Additional Resources
The following websites provide general information, updates, and support information about Color, as well as the latest news, resources, and training materials.

Color Website
For more information about Color, go to:
• http://www.apple.com/finalcutstudio/color

Apple Service and Support Websites
The Apple Service and Support website provides software updates and answers to the most frequently asked questions for all Apple products, including Color. You’ll also have access to product specifications, reference documentation, and Apple product technical articles:
• http://www.apple.com/support

For support information that’s specific to Color, go to:
• http://www.apple.com/support/color

To provide comments and feedback about Color, go to:
• http://www.apple.com/feedback/color.html

A discussion forum is also available to share information about Color. To participate, go to:
• http://discussions.apple.com
For more information on the Apple Pro Training Program, go to:

To better learn how Color works, it’s important to understand the overall color correction process and how images work their way through post-production in standard definition (SD), high definition (HD), and film workflows.

If you’re new to color correction, the first part of this chapter provides a background in color correction workflows to help you better understand why Color works the way it does. The second part goes on to explain color and imaging concepts that are important to the operation of the Color interface.

This chapter covers the following:

• The Fundamental Color Correction Tasks (p. 13)
• When Does Color Correction Happen? (p. 16)
• Image Encoding Standards (p. 23)
• Basic Color and Imaging Concepts (p. 28)

The Fundamental Color Correction Tasks

In any post-production workflow, color correction is generally one of the last steps taken to finish an edited program. Color has been created to give you precise control over the look of every shot in your project by providing flexible tools and an efficient workspace in which to manipulate the contrast, color, and geometry of each shot in your program.

When color correcting a given program, you’ll be called upon to perform many, if not all, of the tasks described in this section. Color gives you an extensive feature set with which to accomplish all this and more. While the deciding factor in determining how far you go in any color correction session is usually the amount of time you have in which to work, the dedicated color correction interface in Color allows you to work quickly and efficiently.

Every program requires you to take some combination of the following steps.
Stage 1: Correcting Errors in Color Balance and Exposure
Frequently, images that are acquired digitally (whether shot on analog or digital video, or transferred from film) don’t have optimal exposure or color balance to begin with. For example, many camcorders and digital cinema cameras deliberately record blacks that aren’t quite at 0 percent in order to avoid the inadvertent crushing of data unnecessarily.

Furthermore, accidents can happen in any shoot. For example, the crew may not have had the correctly balanced film stock for the conditions in which they were shooting, or someone may have forgotten to white balance the video camera before shooting an interview in an office lit with fluorescent lights, resulting in footage with a greenish tinge. Color makes it easy to fix these kinds of mistakes.

Stage 2: Making Sure That Key Elements in Your Program Look the Way They Should
Every scene of your program has key elements that are the main focus of the viewer. In a narrative or documentary video, the focus is probably on the individuals within each shot. In a commercial, the key element is undoubtedly the product (for example, the label of a bottle or the color of a car). Regardless of what these key elements are, chances are you or your audience will have certain expectations of what they should look like, and it’s your job to make the colors in the program match what was originally shot.

When working with shots of people, one of the guiding principles of color correction is to make sure that their skin tones in the program look the same as (or better than) in real life. Regardless of ethnicity or complexion, the hues of human skin tones, when measured objectively on a Vectorscope, fall along a fairly narrow range (although the saturation and brightness vary). Color gives you the tools to make whatever adjustments are necessary to ensure that the skin tones of people in your final edited piece look the way they should.

Stage 3: Balancing All the Shots in a Scene to Match
Most edited programs incorporate footage from a variety of sources, shot in multiple locations over the course of many days, weeks, or months of production. Even with the most skilled lighting and camera crews, differences in color and exposure are bound to occur, sometimes within shots meant to be combined into a single scene.

When edited together, these changes in color and lighting can cause individual shots to stand out, making the editing appear uneven. With careful color correction, all the different shots that make up a scene can be balanced to match one another so that they all look as if they’re happening at the same time and in the same place, with the same lighting. This is commonly referred to as scene-to-scene color correction.

Stage 4: Creating Contrast
Color correction can also be used to create contrast between two scenes for a more jarring effect. Imagine cutting from a lush, green jungle scene to a harsh desert landscape with many more reds and yellows. Using color correction, you can subtly accentuate these differences.
Stage 5: Achieving a “Look”
The process of color correction is not simply one of making all the video in your piece match some objective model of exposure. Color, like sound, is a property that, when subtly mixed, can result in an additional level of dramatic control over your program.

With color correction, you can control whether your video has rich, saturated colors or a more muted look. You can make your shots look warmer by pushing their tones into the reds, or make them look cooler by bringing them into the blues. You can pull details out of the shadows, or crush them, increasing the picture’s contrast for a starker look. Such subtle modifications alter the audience’s perception of the scene being played, changing a program’s mood. Once you pick a look for your piece, or even for an individual scene, you can use color correction to make sure that all the shots in the appropriate scenes match the same look, so that they cut together smoothly.

Stage 6: Adhering to Guidelines for Broadcast Legality
If a program is destined for television broadcast, you are usually provided with a set of quality control (QC) guidelines that specify the “legal” limits for minimum black levels, maximum white levels, and minimum and maximum chroma saturation and composite RGB limits. Adherence to these guidelines is important to ensure that the program is accepted for broadcast, as “illegal” values may cause problems when the program is encoded for transmission. QC standards vary, so it’s important to check what these guidelines are in advance. Color has built-in broadcast safe settings (sometimes referred to as a legalizer) that automatically prevent video levels from exceeding the specified limits. For more information, see The Project Settings Tab.

Stage 7: Adjusting Specific Elements Separately
It’s sometimes necessary to selectively target a narrow range of colors to alter or replace only those color values. A common example of this might be to turn a red car blue or to mute the excessive colors of an article of clothing. These sorts of tasks are accomplished with what’s referred to as secondary color correction, and Color provides you with numerous tools with which to achieve such effects. For more information, see The Secondaries Room.

Stage 8: Making Digital Lighting Adjustments
Sometimes lighting setups that looked right during the shoot don’t work as well in post-production. Changes in the director’s vision, alterations to the tone of the scene as edited, or suggestions on the part of the director of photography (DoP) during post may necessitate alterations to the lighting within a scene beyond simple adjustments to the image’s overall contrast. Color provides powerful controls for user-definable masking which, in combination with secondary color correction controls, allow you to isolate multiple regions within an image and fine-tune the lighting. This is sometimes referred to as digital relighting. For more information, see The Secondaries Room and Controls in the Shapes Tab.
Stage 9: Creating Special Effects
Sometimes a scene requires more extreme effects, such as manipulating colors and exposure intensively to achieve a day-for-night look, creating an altered state for a flashback or hallucination sequence, or just creating something bizarre for a music video. In the Color FX room, Color provides you with an extensible node-based tool set for creating such in-depth composites efficiently, in conjunction with the other primary and secondary tools at your disposal. For more information, see The Color FX Room.

When Does Color Correction Happen?
A program’s color fidelity shouldn’t be neglected until the color correction stage of the post-production process. Ideally, every project is begun with a philosophy of color management that’s applied during the shoot, is maintained throughout the various transfer and editing passes that occur during post-production, and concludes with the final color correction pass conducted in Color. This section elaborates on how film and video images have traditionally made their way through the post-production process. For detailed information, see:

• Color Management Starts During the Shoot
• Initial Color Correction When Transferring Film
• Traditional Means of Final Color Correction
• Advantages of Grading with Color

Color Management Starts During the Shoot
Whether a program is shot using film, video, or high-resolution digital imaging of another means, it’s important to remember that the process of determining a program’s overall look begins when each scene is lit and shot during production. To obtain the maximum amount of control and flexibility over shots in post-production, you ideally should start out with footage that has been exposed with the end goals in mind right from the beginning. Color correction in post-production is no substitute for good lighting.

Optimistically, the process of color correction can be seen as extending and enhancing the vision of the producer, director, and director of photography (DoP) as it was originally conceived. Often, the DoP gets personally involved during the color correction process to ensure that the look he or she was trying to achieve is perfected.

At other times, the director or producer may change his or her mind regarding how the finished piece should look. In these cases, color correction might be used to alter the overall look of the piece (for example, making footage that was shot to look cool look warmer, instead). While Color provides an exceptional degree of control over your footage, it’s still important to start out with clean, properly exposed footage.
Furthermore, choices made during preproduction and the shoot, including the film or video format and camera settings used, can have a profound effect on the amount of flexibility that’s available during the eventual color correction process.

**Initial Color Correction When Transferring Film**

When a project has been shot on film, the camera negatives must first be transferred to the videotape or digital video format of choice prior to editing and digital post using a telecine or datacine machine. A telecine is a machine for transferring film to videotape, while a datacine is set up for transferring film directly to a digital format, usually a DPX (Digital Picture eXchange) or Cineon image sequence.

![Diagram of film transfer process]

Usually, the colorist running the film transfer session performs some level of color correction to ensure that the editor has the most appropriate picture to work with. The goals of color correction at this stage usually depend on both the length of the project and the post-production workflow that’s been decided upon.

- **Short projects**, commercials, spots, and very short videos may get a detailed color correction pass right away. The colorist will first calibrate the telecine’s own color corrector to balance the whites, blacks, and color perfectly. Then the colorist, in consultation with the DoP, director, or producer, will work shot by shot to determine the look of each shot according to the needs of the project. As a result, the editor will be working with footage that has already been corrected.

- **Long-form projects** such as feature-length films and longer television programs probably won’t get a detailed color correction pass right away. Instead, the footage that is run through the telecine will be balanced to have reasonably ideal exposure and color for purposes of having a good image for editing, and left at that. Detailed color correction is then done at another stage.

- **Projects of any length** that are going through post-production as a digital intermediate are transferred with a color correction pass designed to retain the maximum amount of image data. Since a second (and final) digital color correction pass is intended to be performed at the end of the post-production process, it’s critical that the image data is high quality, preserving as much highlight and shadow detail as possible. Interestingly, since the goal is to preserve the image data and not to create the final look of the program, the highest-quality image for grading may not be the most visually appealing image.
However the color correction is handled during the initial telecine or datacine transfer, once complete, the footage goes through the typical post-production processes of offline and online editorial.

**Color Correcting Video Versus Film**

Color has been designed to fit into both video and film digital intermediate workflows. Since all footage must first be transferred to a QuickTime or image sequence format to be imported into Color, film and video images are corrected using the same tools and methods.

Three main attributes affect the quality of media used in a program, all of which are determined when the footage is originally captured or transferred prior to Color import:

- The type and level of compression applied to the media
- The bit depth at which it’s encoded
- The chroma subsampling ratio used

For color correction, spatial and temporal compression should be minimized, since compression artifacts can compromise the quality of your adjustments. Also, media at higher bit depths is generally preferable (see Bit Depth Explained).

Most importantly of all, high chroma subsampling ratios, such as 4:4:4 or 4:2:2, are preferred to maximize the quality and flexibility of your corrections. There’s nothing stopping you from working with 4:1:1 or 4:2:0 subsampled footage, but you may find that extreme contrast adjustments and smooth secondary selections are a bit more difficult to accomplish with highly compressed color spaces.

For more information, see Chroma Subsampling Explained.

**Traditional Means of Final Color Correction**

Once editing is complete and the picture is locked, it’s time for color correction (referred to as color *grading* in the film world) to begin. Traditionally, this process has been accomplished either via a *color timing* session for film or via a *tape-to-tape* color correction session for video.

**Color Timing for Film**

Programs being finished and color corrected on film traditionally undergo a negative conform process prior to color timing. When editorial is complete, the original camera negative is conformed to match the workprint or video cut of the edited program using a *cut list* or *pull list*. (If the program was edited using Final Cut Pro, this can be derived using Cinema Tools.) These lists list each shot used in the edited program and show how each shot fits together. This is a time-consuming and detail-oriented process, since mistakes made while cutting the negative are extremely expensive to correct.
Once the camera negative has been conformed and the different shots physically glued together onto alternating A and B rolls, the negative can be color-timed by being run through an optical printer designed for this process. These machines shine filtered light through the original negatives to expose an intermediate positive print, in the process creating a single reel of film that is the color-corrected print.

The process of controlling the color of individual shots and doing scene-to-scene color correction is accomplished with three controls to individually adjust the amount of red, green, and blue light that exposes the film, using a series of optical filters and shutters. Each of the red, green, and blue dials is adjusted in discrete increments called printer points (with each point being a fraction of an f-stop, the scale used to measure film exposure). Typically there’s a total range of 50 points, where point 25 is the original neutral state for that color channel. Increasing or decreasing all three color channels together darkens or brightens the image, while making disproportionate adjustments to the three channels changes the color balance of the image relative to the adjustment.

The machine settings used for each shot can be stored (at one time using paper tape technology) and recalled at any time, to ease subsequent retiming and adjustments, with the printing process being automated once the manual timing is complete. Once the intermediate print has been exposed, it can be developed and the final results projected.

While this system of color correction may seem cumbersome compared to today’s digital tools for image manipulation, it’s an extremely effective means of primary color correction for those who’ve mastered it.

**Note:** Color includes printer points controls for colorists who are familiar with this method of color correction. For more information, see The Advanced Tab.

**Tape-to-Tape Color Correction**

For projects shot on videotape (and for those shot on film that will not receive a second telecine pass), the color correction process fits into the traditional video offline/online workflow. Once the edit has been locked, the final master tape is assembled, either by being reconformed on the system originally used to do the offline or by taking the EDL (Edit Decision List) and original source tapes to an online suite compatible with the source tape formats. For more information about EDLs, see Importing Projects from Other Video Editing Applications.
If the online assembly is happening in a high-end online suite, then color correction can be performed either during the assembly of the master tape or after assembly by running the master tape through a color correction session.

Note: If the final master tape is color corrected, the colorist must carefully dissolve and wipe color correction operations to match video dissolves and wipes happening in the program.

Either way, the video signal is run through dedicated video color correction hardware and software, and the colorist uses the tape’s master timecode to set up and preserve color correction settings for every shot of every scene.

The evolution of the online video color correction suite introduced many more tools to the process, including separate corrections for discrete tonal zones, secondary color correction of specific subjects via keying and shapes controls, and many other creative options.

**Color Correcting via a Second Telecine Pass**

Programs shot on film that are destined for video mastering, such as for an episodic broadcast series, may end up back in the telecine suite for their final color correction pass. Once editing is complete and the picture is locked, a *cut list* or *pull list* (similar to that used for a negative conform) is created that matches the EDL of the edited program.

Using the cut list, the post-production supervisor pulls only the film negative that was actually used in the edit. Since this is usually a minority of the footage that was originally shot, the colorist now has more time (depending on the show’s budget, of course) to perform a more detailed color correction pass on the selected footage that will be assembled into the final video program during this final telecine pass.

Although this process might seem redundant, performing color correction directly from the film negative has several distinct advantages. Since film has greater latitude from black to white than video has, a colorist working straight off the telecine potentially has a wider range of color and exposure from which to draw than when working only with video.
In addition, the color correction equipment available to the telecine colorist has evolved to match (and is sometimes identical to) the tools available to online video colorists, with the added advantage that the colorist can work directly on the uncompressed images provided by the telecine.

After the conclusion of the second color correction pass, the color-corrected selects are reassembled to match the original edit, and the project is mastered to tape.

Incidentally, even if you don’t intend to color correct your program in the telecine suite, you might consider retransferring specific shots to make changes that are easier or of higher quality to make directly from the original camera negative. For example, after identifying shots you want to retransfer in your Final Cut Pro sequence, you can use Cinema Tools to create a selects list just for shots you want to optically enlarge, speeding the transfer process.

**Other Advantages to Telecine Transfers**

In addition to color correction, a colorist working with a telecine has many other options available, depending on what kinds of issues may have come up during the edit.

- Using a telecine to pull the image straight off the film negative, the colorist can reposition the image to include parts of the film image that fall outside of the action safe area of video.

- With the telecine, the image can also be enlarged optically, potentially up to 50 percent without visible distortion.

- The ability to reframe shots in the telecine allows the director or producer to make significant changes to a scene, turning a medium shot into a close-up for dramatic effect, or moving the entire frame up to crop out a microphone that’s inadvertently dropped into the shot.
Advantages of Grading with Color

When Does Color Correction Happen? discusses how color correction is accomplished in other post-production environments. This section describes how Color fits into a typical film or video post-production process.

Color provides many of the same high-end color correction tools on your desktop that were previously available only in high-end tape-to-tape and telecine color correction suites. In addition, Color provides additional tools in the Color FX room that are more commonly found in dedicated compositing applications, which give you even more detailed control over the images in your program. (For more information, see The Color FX Room.)

Color has been designed as a color correction environment for both film and video. It's resolution-independent, supporting everything from standard definition video up to 2K and 4K film scans. It also supports multiple media formats and is compatible with image data using a variety of image sequence formats and QuickTime codecs.

Color also has been designed to be incorporated into a digital intermediate workflow. Digital intermediate refers to a high-quality digital version of your program that can be edited, color corrected, and otherwise digitally manipulated using computer hardware and software, instead of tape machines or optical printers.

Editors, effects artists, and colorists who finish video programs in a tapeless fashion have effectively been working with digital intermediates for years, but the term usually describes the process of scanning film frames digitally, for the purposes of doing all edit conforming, effects, and color correction digitally. It is then the digital image data which is printed directly to film or compiled as a file for digital projection.

Finishing film or video programs digitally frees colorists from the limitations of film and tape transport mechanisms, speeding their work by letting them navigate through a project as quickly as they can in a nonlinear editing application. Furthermore, working with the digital image data provides a margin of safety, by eliminating the risk of scratching the negative or damaging the source tapes.

When Does Color Correction in Color Happen?

Color correction using Color usually happens at or near the conclusion of the online edit or project conform, often at the same time the final audio mix is being performed. Waiting until the picture is locked is always a good idea, but it's not essential, as Color provides tools for synchronizing projects that are still being edited via XML files or EDLs.

Color has been designed to work hand in hand with editing applications like Final Cut Pro; Final Cut Pro takes care of input, editing, and output, and Color allows you to focus on color correction and related effects.
About Importing Projects and Media into Color
To work on a program in Color, you must be provided with two sets of files:

• Final Cut Pro sequence data can be sent to Color directly using the Send To Color command. Otherwise, the edited project file (or files, if the program is in multiple reels) should be provided in a format that can be imported into Color. Compatible formats include Final Cut Pro XML files, and compatible EDL files from nearly any editing environment.

• High-quality digital versions of the original source media, in a compatible QuickTime or image sequence format.

Project and media format flexibility means that Color can be incorporated into a wide variety of post-production workflows. For an overview of different color correction workflows using Color, see Color Correction Workflows.

About Exporting Projects from Color
Color doesn’t handle video capture or output to tape on its own. Once you finish color correcting your project in Color, you render every shot in the project to disk as an alternate set of color-corrected media files, and you then send your Color project back to Final Cut Pro, or hand it off to another facility for tape layoff or film out. For more information, see The Render Queue.

What Footage Does Color Work With?
Color can work with film using scanned DPX or Cineon image sequences, or with video clips using QuickTime files, at a variety of resolutions and compression ratios. This means you have the option of importing and outputting nearly any professional format, from highly compressed standard definition QuickTime DV-25 shots up through uncompressed 2K or 4K DPX image sequences—whatever your clients provide.

Image Encoding Standards
The sections listed below provide important information about the image encoding standards supported by Color. The image data you’ll be color correcting is typically encoded either using an RGB or Y′C_bC_r (sometimes referred to as YUV) format. Color is extremely flexible and capable of working with image data of either type. For detailed information, see:

• The RGB Additive Color Model Explained
• The Y′C_bC_r Color Model Explained
• Chroma Subsampling Explained
• Bit Depth Explained
The RGB Additive Color Model Explained

In the RGB color model, three color channels are used to store red, green, and blue values in varying amounts to represent each available color that can be reproduced. Adjusting the relative balance of values in these color channels adjusts the color being represented. When all three values are equal, the result is a neutral tone, from black through gray to white.

More typically, you’ll see these ratios expressed as digital percentages in the Color Parade scope or Histogram. For example, if all three color channels are 0%, the pixel is black. If all three color channels are 50%, the pixel is a neutral gray. If all three color channels are 100% (the maximum value), the pixel is white.

Animation (an older, 8-bit codec) and Apple ProRes 4444 (a newer 10-bit codec) are the two most commonly used RGB QuickTime codecs. In digital intermediate workflows, RGB-encoded images are typically stored as uncompressed DPX or Cineon image sequences.

The \(Y'\)\(C_B\)\(C_R\) Color Model Explained

Video is typically recorded using the \(Y'\)\(C_B\)\(C_R\) color model. \(Y'\)\(C_B\)\(C_R\) color coding also employs three channels, or components. A shot’s image is divided into one luma component (luma is image luminance modified by gamma for broadcast) and two color difference components which encode the chroma (chrominance). Together, these three components make up the picture that you see when you play back your video.

- The \(Y'\) component represents the black-and-white portion of an image’s tonal range. Because the eye has different sensitivities to the red, green, and blue portions of the spectrum, the image “lightness” that the \(Y'\) component reproduces is derived from a weighted ratio of the (gamma-corrected) R, G, and B color channels. (Incidentally, the \(Y'\) component is mostly green.) Viewed on its own, the \(Y'\) component is the monochrome image.

- The two color difference components, \(C_B\) and \(C_R\), are used to encode the color information in such a way as to fit three color channels of image data into two. A bit of math is used to take advantage of the fact that the \(Y'\) component also stores green information for the image. The actual math used to derive each color component is \(C_B = B' - Y'\), while \(C_R = R' - Y'\).

Note: This scheme was originally created so that older black-and-white televisions would be compatible with the newer color television transmissions.

Chroma Subsampling Explained

In \(Y'\)\(C_B\)\(C_R\) encoded video, the color channels are typically sampled at a lower ratio than the luma channel. Because the human eye is more sensitive to differences in brightness than in color, this has been used as a way of reducing the video bandwidth (or data rate) requirements without perceptible loss to the image.
The sampling ratio between the $Y'$, $C_b$, and $C_r$ channels is notated as a three-value ratio. There are four common chroma subsampling ratios:

- **4:4:4**: 4:4:4 chroma subsampled media encodes completely uncompressed color, the highest quality possible, as the color difference channels are sampled at the same rate as the luma channel. 4:4:4 subsampled image data is typically obtained via telecine or datacine to an image sequence or video format capable of containing it, and is generally employed for digital intermediate and film workflows. RGB encoded images such as DPX and Cineon image sequences and TIFF files are always 4:4:4.

  The Apple ProRes 4444 codec lets you capture, transcoding, and master media at this high quality. (The fourth 4 refers to the ability of Apple ProRes 4444 to preserve an uncompressed alpha channel in addition to the three color channels; however, Color doesn't support alpha channels.)

  Be aware that simply rendering at 4:4:4 doesn’t guarantee a high-quality result. If media is not acquired at 4:4:4, then rendering at 4:4:4 will preserve the high quality of corrections you make to the video, but it won’t add color information that wasn’t there to begin with.

  As of this writing, few digital acquisition formats are capable of recording 4:4:4 video, but those that do include HDCAM SR, as well as certain digital cinema cameras, including the RED, Thompson Viper FilmStream, and Genesis digital camera systems.

- **4:2:2**: 4:2:2 is a chroma subsampling ratio typical for many high-quality standard and high-definition video acquisition and mastering formats, including Beta SP (an analog format), Digital Betacam, Beta SX, IMX, DVCPRO 50, DVCPRO HD, HDCAM, and D-5 HD.

  Although storing half the color information of 4:4:4, 4:2:2 is standard for video mastering and broadcast. As their names imply, Apple Uncompressed 8-bit 4:2:2, Apple Uncompressed 10-bit 4:2:2, Apple ProRes 422, and Apple ProRes 422 (HQ) all use 4:2:2 chroma subsampling.

- **4:1:1 and 4:2:0**: 4:1:1 is typical for consumer and prosumer video formats including DVCPRO 25 (NTSC and PAL), DV, and DVCam (NTSC).

  4:2:0 is another consumer-oriented subsampling rate, used by DV (PAL), DVCAM (PAL), and MPEG-2, as well as the high-definition HDV and XDCAM HD formats.

  Due to their low cost, producers of all types have flocked to these formats for acquisition, despite the resulting limitations during post-production (discussed below). Regardless, whatever the acquisition format, it is inadvisable to master using either 4:1:1 or 4:2:0 video formats.

It’s important to be aware of the advantages of higher chroma subsampling ratios in the color correction process. Whenever you’re in a position to specify the transfer format with which a project will be finished, make sure you ask for the highest-quality format your system can handle. (For more information about high-quality finishing codecs, see A Tape-Based Workflow.)
As you can probably guess, more color information is better when doing color correction. For example, when you make large contrast adjustments to 4:1:1 or 4:2:0 subsampled video, video noise in the image can become exaggerated; this happens most often with underexposed footage. You'll find that you can make the same or greater adjustments to 4:2:2 subsampled video, and the resulting image will have much less grain and noise. Greater contrast with less noise provides for a richer image overall. 4:4:4 allows the most latitude, or flexibility, for making contrast adjustments with a minimum of artifacts and noise.

Furthermore, it’s common to use chroma keying operations to isolate specific areas of the picture for correction. This is done using the HSB qualifiers in the Secondaries room. (For more information, see Choosing a Region to Correct Using the HSL Qualifiers.) These keying operations will have smoother and less noisy edges when you’re working with 4:2:2 or 4:4:4 subsampled video. The chroma compression used by 4:1:1 and 4:2:0 subsampled video results in macroblocks around the edges of the resulting matte when you isolate the chroma, which can cause a “choppy” or “blocky” result in the correction you’re trying to create.

Despite these limitations, it is very possible to color correct highly compressed video. By paying attention to image noise as you stretch the contrast of poorly exposed footage, you can focus your corrections on the areas of the picture where noise is minimized. When doing secondary color correction to make targeted corrections to specific parts of the image, you may find it a bit more time consuming to pull smooth secondary keys. However, with care and patience, you can still achieve beautiful results.

**Film Versus Video and Chroma Subsampling**

With a bit of care you can color correct nearly any compressed video or image sequence format with excellent results, and Color gives you the flexibility to use highly compressed source formats including DV, HDV, and DVCPRO HD.

Standard and high definition video, on the other hand, is usually recorded with lower chroma subsampling ratios (4:2:2 is typical even with higher-quality video formats, and 4:1:1 and 4:2:0 are common with prosumer formats) and higher compression ratios, depending entirely upon the recording and video capture formats used. Since the selected video format determines compression quality at the time of the shoot, there's nothing you can do about the lost image data, other than to make the best of what you have.

In general, film footage is usually transferred with the maximum amount of image data possible, especially when transferred as a completely uncompressed image sequence (4:4:4) as part of a carefully managed digital intermediate workflow. This is one reason for the higher quality of the average film workflow.
Bit Depth Explained

Another factor that affects the quality of video images, and can have an effect on the quality of your image adjustments, is the bit depth of the source media you’re working with. With both RGB and Y’C_bC_r encoded media, the higher the bit depth, the more image data is available, and the smoother both the image and your corrections will be. The differences between images at different bit depths is most readily apparent in gradients such as skies, where lower bit depths show banding, and higher bit depths do not.

The bit depth of your source media depends largely on how that media was originally acquired. Most of the media you’ll receive falls into one of the following bit depths, all of which Color supports:

• **8-bit**: Most standard and high definition consumer and professional digital video formats capture 8-bit image data, including DV and DVCPRO-25, DVCPRO 50, HDV, DVCPRO HD, HDCAM, and so on.

• **10-bit**: Many video capture interfaces allow the uncompressed capture of analog and digital video at 10-bit resolution.

• **10-bit log**: By storing data logarithmically, rather than linearly, a wider contrast ratio (such as that of film) can be represented by a 10-bit data space. 10-bit log files are often recorded from datacine scans using the Cineon and DPX image sequence formats.

• **12-bit**: Some cameras, such as the RED ONE, capture digital images at 12-bit, providing for even smoother transitions in gradients.

• **16-bit**: It has been said that it takes 16 bits of linear data to match the contrast ratio that can be stored in a 10-bit log file. Since linear data is easier for computers to process, this is another data space that’s available in some image formats.

• **Floating Point**: The highest level of image-processing quality available. Refers to the use of floating-point math to store and calculate fractional data. This means that values higher than 1 can be used to store data that would otherwise be rounded down using the integer-based 8-bit, 10-bit, 12-bit, and 16-bit depths. Floating Point is a processor-intensive bit depth to work with.

Higher bit depths accommodate more image data by using a greater range of numbers to represent the tonal range that’s available. This is apparent when looking at the numeric ranges used by the two bit depths most commonly associated with video.

• **8-bit** images use a full range of 0–255 to store each color channel. (Y’C_bC_r video uses a narrower range of 16–235 to accommodate super-black and super-white.) 255 isn’t a lot of values, and the result can be subtly visible “stairstepping” in areas of the picture with narrow gradients (such as skies).
• 10-bit images, on the other hand, use a full range of 0 to 1023 to store each color channel. (Again, Y’C_B C_R video uses a narrower range of 64–940 to accommodate super-black and super-white.) The additional numeric range allows for smoother gradients and virtually eliminates bit depth–related artifacts.

Fortunately, while you can’t always control the bit depth of your source media, you can control the bit depth at which you work in Color independently. This means that even if the source media is at a lower bit depth, you can work at a higher bit depth to make sure that the quality of your corrections is as high as possible. In particular, many effects and secondary corrections look significantly better when Color is set to render at higher bit depths. For more information, see Playback, Processing, and Output Settings.

Basic Color and Imaging Concepts
Color correction involves controlling both an image’s contrast and its color (exercising separate control over its hue and saturation). This section explains these important imaging concepts so that you can better understand how the Color tools let you alter the image. For detailed information, see:

• Contrast Explained
• Luma Explained
• Gamma Explained
• Chroma Explained
• Primary and Secondary Color Relationships Explained
• The HSL Color Space Model Explained

Contrast Explained
Contrast adjustments are among the most fundamental, and generally the first, adjustments made. Contrast is a way of describing an image’s tonality. If you eliminate all color from an image, reducing it to a series of grayscale tones, the contrast of the picture is seen by the distribution of dark, medium, and light tones in the image.

Controlling contrast involves adjustments to three aspects of an image’s tonality:
• The black point is the darkest pixel in the image.
• The white point is the brightest pixel in the image.
• The *midtones* are the distribution of all tonal values in between the black and white points.

An image’s *contrast ratio* is the difference between the darkest and brightest tonal values within that image. Typically, a higher contrast ratio, where the difference between the two is greater, is preferable to a lower one. Unless you’re specifically going for a low-contrast look, higher contrast ratios generally provide a clearer, crisper image. The following two images, with their accompanying Histograms which show a graph of the distribution of shadows, midtones, and highlights from left to right, illustrate this.

In addition, maximizing the contrast ratio of an image aids further color correction operations by more evenly distributing that image’s color throughout the three tonal zones that are adjusted with the three color balance controls in the Primary In, Secondaries, and Primary Out rooms. This makes it easier to perform individual corrections to the shadows, midtones, and highlights.
For more information about adjusting image contrast, see Contrast Adjustment Explained.

**Luma Explained**

*Luma* (which technically speaking is gamma-corrected *luminance*) describes the exposure (lightness) of a video shot, from absolute black, through the distribution of gray tones, all the way up to the brightest white. Luma can be separated from the color of an image. In fact, if you desaturate an image completely, the grayscale image that remains is the luma.

Luma is measured by Color as a digital percentage from 0 to 100, where 0 represents absolute black and 100 represents absolute white. Color also supports super-white levels (levels from 101 to 109 percent) if they exist in your shot. While super-white video levels are not considered to be safe for broadcast, many cameras record video at these levels anyway.

![Luma Scale](image.png)

**Note:** Unadjusted super-white levels will be clamped by the Broadcast Safe settings (if they’re turned on with their default settings), so that pixels in the image with luma above 100 percent will be set to 100 percent.

**What Is Setup?**

People often confuse the black level of digital video with *setup*. Setup refers to the minimum black level assigned to specific analog video signals and is *only* an issue with analog video output to the Beta SP tape format. If you are outputting to an analog tape format using a third-party analog video interface, you should check the documentation that came with that video interface to determine how to configure the video interface for the North American standard for setup (7.5 IRE) or the Japanese standard (0 IRE). Most vendors of analog video interfaces include a software control panel that allows you to select which black level to use. Most vendors label this as “7.5 Setup” versus “0 Setup,” or in some cases “NTSC” versus “NTSC-J.”

Video sent digitally via SDI *has no setup*. The \( Y' \text{CgCr} \) minimum black level for all digital video signals is 0 percent, 0 IRE, or 0 millivolts, depending on how you’re monitoring the signal.
Gamma Explained

Gamma refers to two different concepts. In a video signal, gamma refers to the nonlinear representation of luminance in a picture displayed on a broadcast or computer monitor. Since the eye has a nonlinear response to light (mentioned in The Y’C_bC_r Color Model Explained), applying a gamma adjustment while recording an image maximizes the perceptible recorded detail in video signals with limited bandwidth. Upon playback, a television or monitor applies an inverted gamma function to return the image to its “original” state.

You want to avoid unplanned gamma adjustments when sending media from Final Cut Pro to Color. It’s important to keep track of any possible gamma adjustments that occur when exporting or importing clips in Final Cut Pro during the editing process, so that these adjustments are accounted for and avoided during the Final Cut Pro–to–Color roundtrip. For more information on gamma handling in Final Cut Pro, see the Final Cut Pro 7 User Manual.

Gamma is also used to describe a nonlinear adjustment made to the distribution of midtones in an image. For example, a gamma adjustment leaves the black point and the white point of an image alone, but either brightens or darkens the midtones according to the type of adjustment being made. For more information on gamma and midtones adjustments, see The Primary In Room.

Chroma Explained

Chroma (also referred to as chrominance) describes the color channels in your shots, ranging from the absence of color to the maximum levels of color that can be represented. Specific chroma values can be described using two properties, hue and saturation.

Hue

Hue describes the actual color itself, whether it’s red or green or yellow. Hue is measured as an angle on a color wheel.
Saturation

Saturation describes the intensity of that color, whether it’s a bright red or a pale red. An image that is completely desaturated has no color at all and is a grayscale image. Saturation is also measured on a color wheel, but as the distance from the center of the wheel to the edge.

As you look at the color wheel, notice that it is a mix of the red, green, and blue primary colors that make up video. In between these are the yellow, cyan, and magenta secondary colors, which are equal mixes of the primary colors.

Primary and Secondary Color Relationships Explained

Understanding color wheel interactions will help you to see how the Color controls actually affect colors in an image.

Primary Colors
In any additive color model, the primary colors are red, green, and blue. These are the three purest colors that can be represented, by setting a single color channel to 100 percent and the other two color channels to 0 percent.

Secondary Colors
Adding any two primary colors produces a secondary color. In other words, you create a secondary color by setting any two color channels to 100 percent while setting the third to 0 percent.

- Red + green = yellow
- Green + blue = cyan
- Blue + red = magenta

One other aspect of the additive color model:
- Red + green + blue = white
All these combinations can be seen in the illustration of three colored circles below. Where any two primaries overlap, the secondary appears, and where all three overlap, white appears.

Complementary Colors
Two colors that appear 180 degrees opposite each other on the wheel are referred to as complementary colors.

Adding two complementary colors of equal saturation to each other neutralizes the saturation, resulting in a grayscale tone. This can be seen in the two overlapping color wheels in the illustration below. Where red and cyan precisely overlap, both colors become neutralized.

Understanding the relationship of colors to their complementaries is essential in learning how to eliminate or introduce color casts in an image using the Color Primary or Secondary color correction controls. For example, to eliminate a bluish cast in the highlights of unbalanced daylight, you add a bit of orange to bring all the colors to a more neutral state. This is covered in more detail in The Primary In Room.
The HSL Color Space Model Explained
The HSL color space model is another method for representing color and is typically used for user interface controls that let you choose or adjust colors. HSL stands for hue, saturation, and lightness (roughly equivalent to luminance) and provides a way of visualizing the relationships among luminance, hue, and saturation.

The HSL color space model can be graphically illustrated as a three-dimensional cone. Hue is represented by an angle around the base of the cone, as seen below, while saturation is represented by a color’s distance from the center of the cone to the edge, with the center being completely desaturated and the edge being saturated to maximum intensity. A color’s brightness, then, can be represented by its distance from the base to the peak of the cone.

Color actually provides a three-dimensional video scope that’s capable of displaying the colors of an image within an extruded HSL space, for purposes of image analysis. For more information, see The 3D Scope.
Taking maximum advantage of Color requires careful workflow management. This chapter outlines where Color fits into your post-production workflow.

Color has been designed to work hand in hand with editing applications like Final Cut Pro via XML and QuickTime media support, or with other editorial environments via EDL and image sequence support. While video and film input and editing are taken care of elsewhere, Color gives you a dedicated environment in which to focus on color correction and related effects.

This chapter gives you a quick overview of how to guide your project through a workflow that includes using Color for color correction. Information is provided about both standard and high definition broadcast video workflows, as well as 2K digital intermediate workflows.

This chapter covers the following:
- An Overview of the Color Workflow (p. 35)
- Limitations in Color (p. 37)
- Video Finishing Workflows Using Final Cut Pro (p. 39)
- Importing Projects from Other Video Editing Applications (p. 47)
- Digital Cinema Workflows Using Apple ProRes 4444 (p. 50)
- Finishing Projects Using RED Media (p. 56)
- Digital Intermediate Workflows Using DPX/Cineon Media (p. 65)
- Using EDLs, Timecode, and Frame Numbers to Conform Projects (p. 73)

An Overview of the Color Workflow

All controls in Color are divided into eight tabbed rooms, each of which corresponds to a different stage in a typical color correction workflow. When you move from room to room, the buttons, dials, and trackballs of your control surface (if you have one) remap to correspond to the controls in that room.
Each room gathers all the controls pertaining to that particular step of the color correction process onto a single screen. These rooms are organized from left to right in the order colorists will typically use them, so that after adjusting your project’s preferences in the Setup room, you can work your way across from the Primary controls, to the Secondary controls, Color FX, Primary Out, and finally Geometry as you adjust each shot in your project.

- **Setup**: All projects begin in the Setup room. This is where you import and manage the shots in your program. The grade bin, project settings, and application preferences are also found within the Setup room. For video colorists, the project settings area of the Setup room is where you find the Broadcast Safe controls, which allow you to apply gamut restrictions to the entire program.

- **Primary In**: Primary color corrections affect the entire image, so this room is where you make overall adjustments to the color and contrast of each shot. Color balance and curve controls let you adjust colors in the shadows, midtones, and highlights of the image. The lift, gamma, and gain controls let you make detailed contrast adjustments, which affect the brightness of different areas of the picture. There are also controls for overall, highlight, and shadow saturation, and printer point (or printer light) controls for colorists used to color timing for film.

- **Secondaries**: Secondary color corrections are targeted adjustments made to specific areas of the image. This room provides numerous methods for isolating, or qualifying, the parts of the image you want to correct. Controls are provided with which to isolate a region using shape masks. Additional controls let you isolate areas of the picture using a chroma-keyed matte with individual qualifications for hue, saturation, and luminance. Each shot can have up to eight secondary operations. Furthermore, special-purpose secondary curves let you make adjustments to hue, saturation, and luma within specific portions of the spectrum.

- **Color FX**: The Color FX room lets you create your own custom effects via a node-based interface more commonly found in high-end compositing applications, similar to Shake. These individual effects nodes can be linked together in thousands of combinations, providing a fast way to create many different types of color effects. Your custom effects can be saved in the Color FX bin for future use, letting you apply your look to future projects.

- **Primary Out**: The Primary Out room is identical to the Primary In room except that its color corrections are applied to shots after they have been processed by all the other color grading rooms. This provides a way to post-process your images after all other operations have been performed.
• **Geometry:** The Geometry room lets you pan and scan, rotate, flip, and flop shots as necessary. The Geometry room also provides tools for creating custom masks and for applying and managing motion-tracking analyses. How Geometry room transformations are handled depends on your workflow:

  • For projects being roundtripped from Final Cut Pro, Geometry room transformations are not rendered by Color when outputting the corrected project media. Instead, all the geometric transformations you create in Color are translated into Final Cut Pro Motion tab settings when the project is sent back to Final Cut Pro. You then have the option to further customize those effects in Final Cut Pro prior to rendering and output.

  • For 2K and 4K digital intermediates, as well as projects using 4K native RED QuickTime media, Geometry room transformations are processed by Color when rendering the output media.

  **Note:** When you send a project from Final Cut Pro to Color, compatible Motion tab settings are translated into Geometry room settings. You can preview and adjust these transformations as you color correct. For more information, see The Geometry Room.

• **Still Store:** You can save frames from anywhere in the Timeline using the Still Store, creating a reference library of stills from your program from which you can recall images to compare to other shots you’re trying to match. You can load one image from the Still Store at a time into memory, switching between it and the current frame at the position of the playhead using the controls in the Still Store menu. The Still Store also provides controls for creating and customizing split screens you can use to balance one shot to another. All Still Store comparisons are sent to the preview and broadcast monitor outputs.

• **Render Queue:** When you finish grading your program in Color, you use the Render Queue to manage the rendering of the shots in your project.

### Limitations in Color

Color has been designed to work hand in hand with Final Cut Pro; Final Cut Pro lets you take care of input, editing, and output, while Color allows you to focus on color correction and related effects. Given this relationship, there are specific things it does not do:

• **Recording:** Color is incapable of either scanning or capturing film or video footage. This means that you need to import projects and media into Color from another application.

• **Editing:** Color is not intended to be an editing application. The editing tools that are provided are primarily for colorists working in 2K workflows where the Color project is the final version that will become the digital master. By default, the tracks of imported XML project files are locked to prevent new edits from introducing errors when the project moves back to Final Cut Pro.
To accommodate editorial changes, reconforming tools are provided to synchronize an EDL or Final Cut Pro sequence with the version of that project being graded in Color. For more information, see Reconforming Projects.

• **Filters:** Final Cut Pro FXScript or FxPlug filters are neither previewed nor rendered by Color. However, their presence in your project is maintained, and they show up again once the project is sent back to Final Cut Pro.

  **Note:** It’s not generally a good idea to allow various filters that perform color correction to remain in your Final Cut Pro project when you send it to Color. Even though they have no effect as you work in Color, their sudden reappearance when the project is sent back to Final Cut Pro may produce unexpected results.

• **Final Cut Pro Color Corrector 3-way filters:** Color Corrector 3-way filters applied to clips in your sequence are automatically converted into adjustments to the color balance controls, primary contrast controls, and saturation controls in the Primary In room of each shot to which they’re applied. Once converted, these filters are removed from the XML data for that sequence, so that they do not appear in the sequence when it’s sent back to Final Cut Pro.

  If more than one filter has been applied to a clip, then only the last Color Corrector 3-way filter appearing in the Filters tab is converted; all others are ignored. Furthermore, any Color Corrector 3-way filter with limit effects turned on is also ignored.

• **Transitions:** Color preserves transition data that might be present in an imported EDL or XML file, but does not play the transitions during previews. How they’re rendered depends on how the project is being handled:

  • For projects being roundtripped from Final Cut Pro, transitions are not rendered in Color. Instead, Color renders handles for the outgoing and incoming clips, and Final Cut Pro is relied upon to render each transition after the project’s return.

  • When rendering 2K or 4K DPX or Cineon image sequences, all video transitions are rendered as linear dissolves when you use the Gather Rendered Media command to consolidate the finally rendered frames of your project in preparation for film output. This feature is only available for projects that use DPX and Cineon image sequence media or RED QuickTime media, and is intended only to support film out workflows. *Only dissolves are rendered; any other type of transition (such as a wipe or iris) will be rendered as a dissolve instead.*

• **Superimpositions:** Superimposed shots are displayed in the Timeline, but compositing operations involving opacity and composite modes are neither displayed nor rendered.

• **Speed effects:** Color doesn’t provide an interface for adding speed effects, relying instead upon the editing application that originated the project to do so. Linear and variable speed effects that are already present in your project, such as those added in Final Cut Pro, are previewed during playback, but they are not rendered in Color during output. Instead, Final Cut Pro is relied upon to render those effects in roundtrip workflows.
• **Final Cut Pro generators and Motion projects:** Final Cut Pro generators and Motion projects are completely ignored by Color. How you handle these types of effects also depends on your workflow:

  • If you're roundtripping a project between Final Cut Pro and Color, and you want to grade these effects in Color, you should render these effects as self-contained QuickTime .mov files. Then, edit the new .mov files into your sequence to replace the original effects shots prior to sending your project to Color.

  • If you're roundtripping a project between Final Cut Pro and Color, and there's no need to grade these effects, you don't need to do anything. Even though these effects aren't displayed in Color, their position in the Timeline is preserved, and these effects will reappear in Final Cut Pro when you send the project back. Titles are a good example of effects that don't usually need to be graded.

  • If you're working on a 2K or 4K digital intermediate or RED QuickTime project, you need to use a compositing application like Shake or Motion to composite any effects using the image sequence data.

  **Important:** When you send frames of media to a compositing application, it's vital that you maintain the frame number in the filenames of new image sequence media that you generate. Each image file's frame number identifies its position in that program's Timeline, so any effects being created as part of a 2K digital intermediate workflow require careful file management.

• **Video or film output:** While Color provides broadcast output of your project's playback for preview purposes, this is *not* intended to be used to output your program to tape. This means that when you finish color correcting your project in Color, the rendered output needs to be moved to Final Cut Pro for output to tape or to another environment for film output.

**Video Finishing Workflows Using Final Cut Pro**

If a program has been edited using Final Cut Pro, the process of moving it into Color is fairly straightforward. After editing the program in Final Cut Pro, you must reconform the program, if necessary, to use the original source media at its highest available quality.
Once that task has been accomplished, you can send the project data and files into Color for color correction. Upon completion of the color correction pass, you need to render the result and send the project back to Final Cut Pro for final output, either to tape or as a QuickTime file.

Exactly how you conform your source media in Final Cut Pro depends on the type of media that's used. For more information, see:

- A Tape-Based Workflow.
- Reconforming Online Media in a Tapeless Digital Video Workflow.
- Reconforming Online Media in a Film-to-Tape Workflow.

**A Tape-Based Workflow**

For a traditional offline/online tape-based workflow, the video finishing process is simple. The tapes are captured into Final Cut Pro, possibly at a lower-quality offline resolution to ease the initial editing process by using media that takes less hard disk space and is easier to work with using a wider range of computers.
After the offline edit is complete, the media used by the edited program must be recaptured from the source tapes at maximum quality. The resulting online media is what will be used for the Final Cut Pro–to–Color roundtrip.

The following steps break this process down more explicitly.

**Stage 1: Capturing the Source Media at Offline or Online Resolution**
How you decide to capture your media prior to editing depends on its format. Compressed formats, including DV, DVCPro-50, DVCPro HD, and HDV, can be captured at their highest quality without requiring enormous storage resources. If this is the case, then capturing and editing your media using its native resolution and codec lets you eliminate the time-consuming step of recapturing (sometimes called conforming or reconforming) your media later.

Uncompressed video formats, or projects where there are many, many reels of source media, may benefit from being captured at a lower resolution or with a more highly compressed codec. This will save disk space and also enable you to edit using less expensive equipment. Later, you'll have to recapture the media prior to color correction.

**Stage 2: Editing the Program in Final Cut Pro**
Edit your program in Final Cut Pro, as you would any other project. If you're planning on an extensive use of effects in your program during editorial, familiarize yourself with the topics covered in Limitations in Color.
Stage 3: Recapturing the Source Media at Online Resolution

If you originally captured your source media using an offline format, you need to recapture the media used in your project at the highest available quality prior to sending it to Color.

• If your media was originally recorded using a compressed format (such as DV, DVCPRO-50, DVCPRO HD, or HDV), then recapturing it using the original source codec and resolution is fine; Color can work with compressed media and automatically promotes the image data to higher uncompressed bit depths for higher quality imaging when monitoring and rendering.

• If you’re capturing a higher-bandwidth video format (such as Betacam SP, Digital Betacam, HDCAM, and HDCAM SR) and require high quality but need to use a compressed format to save hard disk space and increase performance on your particular computer, then you can recapture using the Apple ProRes 422 codec, or the higher quality Apple ProRes 422 (HQ) codec.

• If you’re capturing high-bandwidth video and require the highest-quality uncompressed video data available, regardless of the storage requirements, you should recapture your media using Apple Uncompressed 8-bit 4:2:2 or Apple Uncompressed 10-bit 4:2:2.

You may also want to take the opportunity to use the Final Cut Pro Media Manager to delete unused media prior to recapturing in order to save valuable disk space, especially when recapturing uncompressed media. For more information, see the Final Cut Pro 7 User Manual.

Note: Some codecs, such as HDV, can be more processor-intensive to work with than others. In this case, capturing or recompressing the media with a less processor-intensive codec, such as Apple ProRes 422 or Apple ProRes 422 (HQ), will improve your performance while you work in Color, while maintaining high quality and low storage requirements.

Stage 4: Preparing Your Final Cut Pro Sequence

To prepare your edited sequence for an efficient workflow in Color, follow the steps outlined in Before You Export Your Final Cut Pro Project.

Stage 5: Sending the Sequence to Color or Exporting an XML File

When you finish prepping your edited sequence, there are two ways you can send it to Color.

• If Color is installed on the same computer as Final Cut Pro, you can use the Send To Color command to move an entire edited sequence to Color, automatically creating a new project file.

• If you’re handing the project off to another facility, you may want to export the edited sequence as an XML file for eventual import into Color. In this case, you’ll also want to use the Final Cut Pro Media Manager to copy the project’s media to a single, transportable hard drive volume for easy handoff.
Stage 6: Grading Your Program in Color
Use Color to grade your program. When working on a roundtrip from Final Cut Pro, it’s crucial to avoid unlocking tracks or reediting shots in the Timeline. Doing so can compromise your ability to send the project back to Final Cut Pro.

If the client needs a reedit after you’ve started grading, you should instead perform the edit back in Final Cut Pro, and export an XML version of the updated sequence which you can use to quickly update the Color project in progress using the Reconform command. For more information, see Reconforming Projects.

Stage 7: Rendering New Source Media and Sending the Updated Project to Final Cut Pro
When you finish grading, you use the Color Render Queue to render all the shots in the project as a new, separate set of graded media files.

Afterward, you need to send the updated project to Final Cut Pro using one of the two following methods:

• If Color is installed on the same computer as Final Cut Pro, you can use the Send To Final Cut Pro command.

• If you're handing the color-corrected project back to the originating facility, you need to export the Color project as an XML file for later import into Final Cut Pro.

Important: Some parameters in the Project Settings tab of the Setup room affect how the media is rendered by Color. These settings include the Deinterlace Renders, QuickTime Export Codec, Broadcast Safe, and Handles settings. Be sure to verify these and other settings prior to rendering your final output.

Stage 8: Adjusting Transitions, Superimpositions, and Titles in Final Cut Pro
To output your project, you need to import the XML project data back into Final Cut Pro. This happens automatically if you use the Send To Final Cut Pro command. At this point, you can add or adjust other effects that you had applied previously in Final Cut Pro, before creating the program’s final master. Things you may want to consider while prepping the program at this stage include:

• Do you need to produce a "textless" master of the program, or one with the titles rendered along with the image?

• Are there any remaining effects clips that you need to import and color correct within Final Cut Pro?

Stage 9: Outputting the Final Video Master to Tape or Rendering a Master QuickTime File
Once you complete any last adjustments in Final Cut Pro, you can use the Print to Video, Edit to Tape, or Export QuickTime Movie command to create the final version of your program.
Reconforming Online Media in a Tapeless Digital Video Workflow

If a program uses a tapeless video format, the steps are similar to those described in A Tape-Based Workflow; however, they likely involve multiple sets of QuickTime files: the original media at online resolution and perhaps a second set of media files that have been downconverted to an offline resolution for ease of editing. After the offline edit, the online conform involves relinking to the original source media, prior to going through the Final Cut Pro–to–Color roundtrip.

Here's a more detailed explanation of the offline-to-online portion of this workflow.

**Stage 1: Shooting and Backing Up All Source Media**
Shoot the project using whichever tapeless format you've chosen. As you shoot, make sure that you're keeping backups of all your media, in case anything happens to your primary media storage device.

**Stage 2: Creating Offline Resolution Duplicates and Archiving Original-Resolution Media**
If necessary, create offline resolution duplicates of the source media in whatever format is most suitable for your system. Then, archive the original source media as safely as possible.
Important: When you create offline duplicates of tapeless media, it's vital that you duplicate and maintain the original filenames and timecode with which the source files were created. This is critical to guaranteeing that you'll be able to easily relink to the original high-resolution source files once the offline edit is complete.

Stage 3: Editing the Program in Final Cut Pro
Edit your program in Final Cut Pro, as you would any other project. If you're planning on an extensive use of effects in your program during editorial, familiarize yourself with the topics covered in Limitations in Color.

Stage 4: Relinking Your Edited Sequence to the Original Source Media
Once your offline edit is complete, you need to restore the original online-quality source media and relink to or retransfer the high-resolution files.

Stage 5: Prerendering Effects, Sending the Sequence to Color, and Grading
At this point, the workflow is identical to Stage 6: Grading Your Program in Color in A Tape-Based Workflow.

Reconforming Online Media in a Film-to-Tape Workflow
If you're working on a project that was shot on film but will be mastered on video, it must be transferred from film to tape using a telecine prior to being captured and edited in Final Cut Pro. At that point, the rest of the offline and online edit is identical to any other tape-based format.

Here's a more detailed explanation of the offline-to-online portion of this workflow.
Stage 1: **Shooting Your Film**
Shoot the project as you would any other film project.

Stage 2: **Telecining the Dailies**
After the film has been shot, process and telecine the dailies to a video format appropriate for your workflow.

- Some productions prefer to save money up front by doing an inexpensive "one-light" transfer of all the footage to an inexpensive offline video format for the initial offline edit. (A one-light transfer refers to the process of using a single color correction setting to transfer whole scenes of footage.) This can save time and money up front, but may necessitate a second telecine session to retransfer only the footage used in the edit at a higher level of visual quality.

- Other productions choose to transfer all the dailies (or at least the director’s selected takes) via a "best-light" transfer, where the color correction settings are individually adjusted for every shot that’s telecined, optimizing the color and exposure for each clip. The footage is transferred to a high-quality video format capable of preserving as much image data as possible. This can be significantly more expensive up front, but saves money later since a second telecine session is not necessary.

Stage 3: **Capturing the Source Media at Offline or Online Resolution**
How you capture your media prior to editing depends on your workflow. If you telecined offline-quality media, then you might as well capture using an offline-quality codec.

If you instead telecined online-quality media, then you have the choice of either pursuing an "offline/online" workflow or capturing via an online codec and working at online quality throughout the entire program.

Stage 4: **Editing the Program in Final Cut Pro**
Edit your program in Final Cut Pro, as you would any other project. If you’re planning on the extensive use of effects in your program during editorial, familiarize yourself with the topics covered in Limitations in Color.

Stage 5: **Recapturing or Retransferring the Media at Online Resolution**
The way you conform your offline project to online-quality media depends on how you handled the initial video transfer.

- If you originally did a high-quality telecine pass to an online video format, but you captured your source media using an offline format for editing, you need to recapture the media from the original telecine source tapes using the highest-quality uncompressed QuickTime format that you can accommodate on your computer (such as Apple ProRes 4444, Apple ProRes 422 (HQ), or Apple Uncompressed) and relink the new media to your project.
• If you did an inexpensive one-light telecine pass to an offline video format, you'll want to do another telecine pass where you transfer only the media you used in the program at high quality. Using Cinema Tools, you can generate a pull list, which you then use to carefully retransfer the necessary footage to an online-quality video format. Then, you need to recapture the new online transfer of this media using the highest-quality uncompressed QuickTime format that you can accommodate on your computer.

**Important:** Do not use the Media Manager to either rename or delete unused media in your project when working with offline media that refers to the camera negative. If you do, you'll lose the ability to create accurate pull lists in Cinema Tools.

**Stage 6: Prerendering Effects, Sending the Sequence to Color, and Grading**
At this point, the workflow is identical to Stage 6: Grading Your Program in Color in A Tape-Based Workflow.

**Importing Projects from Other Video Editing Applications**
Color is also capable of importing projects from other editing environments, by importing edit decision lists (EDLs). An EDL is an event-based list of all the edits and transitions that make up a program.

Once you've imported your project file into Color and copied the program media onto a storage device with the appropriate performance, you can then link the shots on the Color Timeline with their corresponding media.

• For more information about importing EDLs into Final Cut Pro before sending to Color, see Importing EDLs in a Final Cut Pro–to–Color Roundtrip.

• For more information about importing EDLs directly into Color, see Importing and Notching Preedited Program Masters.

**Importing EDLs in a Final Cut Pro–to–Color Roundtrip**
If you've been provided with an edit decision list of the edited program and a box of source media, you can import the EDL into Final Cut Pro to capture the project's media and prepare the project for sending to Color. In addition to being able to recapture the footage, Final Cut Pro is compatible with more EDL formats than is Color. Also, Final Cut Pro is capable of reading superimpositions, all SMPTE standard transitions, and audio edits, in addition to the video edits.
**Note:** Although capable of importing EDLs directly, Color reads only the video portion of edits in track V1. Video transitions, audio, and superimpositions are ignored.

Here's a more detailed explanation of this workflow.

**Stage 1: Importing the Project into Final Cut Pro**
Import the EDL of the edited project into Final Cut Pro.

**Stage 2: Capturing Media at Online Resolution**
You need to recapture the sequence created when importing the EDL using the highest-quality QuickTime format that you can accommodate on your computer (such as Apple ProRes 422 or Apple Uncompressed).

**Stage 3: Prerendering Effects, Sending the Sequence to Color, and Grading**
At this point, the workflow is identical to that in Stage 6: Grading Your Program in Color in A Tape-Based Workflow.

**Importing and Notching Preedited Program Masters**
Another common way of obtaining a program for color correction is to be provided with an edited master, either on tape or as a QuickTime movie or image sequence, and an accompanying EDL. You can use the EDL to automatically add edits to the master media file in Color (called "notching" the media), to make it easier to grade each shot in the program individually.
**Important:** The EDL import capabilities of Color are not as thorough as those in Final Cut Pro, and are limited only to shots on track V1. All transitions in EDLs are imported as dissolves. Superimpositions and audio are not supported, and will be ignored.

Here's a more detailed explanation of this workflow.

**Stage 1: Capturing the Program Master**
If you were given the program master on tape, you need to capture the entire program using the highest-quality QuickTime format that you can accommodate on your computer (such as Apple ProRes 4444, Apple ProRes 422 (HQ), or Apple Uncompressed). If you're being given the program master as a QuickTime file, you should request the same from whoever is providing you with the media.

For this process to work correctly, it's ideal if the timecode of the first frame of media matches the first frame of timecode in the EDL.

**Stage 2: Importing the EDL into Color and Relinking to the Master Media File**
Either select the EDL from the Projects dialog that appears when you first open Color, or use the File > Import > EDL command. When the EDL Import Settings dialog appears, choose the EDL format, project, EDL, and source media frame rates.

To properly "notch" the master media file, you need to turn on "Use as Cut List," and then choose the master media file that you captured or were given. For more information, see Importing EDLs.
Stage 3: Grading Your Program in Color
Use Color to grade your program, as you would any other.

Stage 4: Rendering New Source Media and Sending the Updated Project to Final Cut Pro
When you finish grading, you use the Color Render Queue to render all the shots in the project as a new, separate set of graded media files.

Afterward, you need to send the updated project to Final Cut Pro using one of the two following methods:

• If Color is installed on the same computer as Final Cut Pro, use the Send To Final Cut Pro command.

• If you’re handing the color-corrected project back to the originating facility, you need to export the Color project as an XML file for later import into Final Cut Pro.

Stage 5: Adjusting Transitions, Superimpositions, and Titles in Final Cut Pro
To output your project, you can use the Send To Final Cut Pro command, or you can export an XML project file that can be manually imported into Final Cut Pro. At this point, you can add other effects in Final Cut Pro, before creating the program’s final master.

Stage 6: Outputting the Final Video Master to Tape or Rendering a Master QuickTime File
Once you complete any last adjustments in Final Cut Pro, you can use the Print to Video, Edit to Tape, or Export QuickTime Movie commands to create the final version of your program.

Digital Cinema Workflows Using Apple ProRes 4444
If you’re working with images that were originated on film, HDCAM SR, or some other high-resolution, RGB-based media, and your intention is to finish and output a project to film, the Apple ProRes 4444 codec enables you to follow a simple, consolidated workflow. Consider the following:

• If you’re working with film, you can scan all footage necessary for the project, and then convert the DPX or Cineon files to Apple ProRes 4444 media in Color.

• If you’re working with DPX or Cineon image sequences from other sources, these can be converted into Apple ProRes 4444 media using Color, as well.

• If you’re working with HDCAM SR media, you can ingest it directly as Apple ProRes 4444 clips using Final Cut Pro with a capture device that supports this. Both HDCAM SR and Apple ProRes 4444 are RGB-based, 4:4:4 color subsampled formats, so one is a natural container for the other.
Once all your source media has been transcoded or captured as Apple ProRes 4444, it can be imported into your Final Cut Pro project. If necessary, you can then create a duplicate set of lower-resolution offline media with which you can edit your project more efficiently.

Upon completion of the offline edit, you then relink the program to the original Apple ProRes 4444 media before sending the sequence to Color, where you’ll be grading your program. Ultimately, you’ll send the finished media that Color renders directly to the film recording facility.
Mastering from a single set of Apple ProRes 4444 media keeps your workflow simple, making media management straightforward, and eliminating the need to retransfer or relink to the source DPX media later. The only disadvantage to this method is that it can require a substantial amount of storage, depending on the length and shooting ratio of the project.

The following steps break this process down more explicitly. Because of the extra steps needed, this workflow assumes that you’re shooting film.

**Stage 1: Running Tests Before You Begin Shooting**
Ideally, you should do some tests before principal photography to see how the film scanner–to–Color–to–film recorder pipeline works with your choice of film formats and stocks. It’s always best to consult with the film lab you’ll be working with in advance to get as much information as possible.
Stage 2: Scanning All Film as DPX Image Sequences
Depending on how the shoot was conducted, you can opt to do a best-light datacine of just the selects, or of all the camera negative (if you can afford it). The scanned 2K or 4K digital source media should be saved as DPX or Cineon image sequences.

To track the correspondence between the original still frames and the offline QuickTime files that you'll create for editing, you should ask for the following:

• A non-drop frame timecode conversion of each frame's number (used in that frame's filename), saved within the header of each scanned image.

• It can also help to organize all of the scanned frames into separate directories, saving all the frames from each roll of negative to separate directories (named by roll). This will help you to keep track of each shot’s roll number later.

Stage 3: Converting DPX Image Sequences to Apple ProRes 4444 QuickTime Files in Color
Since Final Cut Pro doesn't work directly with image sequences, you need to create high-quality, online-resolution QuickTime duplicates using Color before you can begin editing. Once you’ve done this, it's a good idea to archive both the original source media and the converted Apple ProRes 4444 media as safely as possible.

You can use Color to create online-resolution QuickTime versions of each DPX image sequence you need to use in your edit. To do this, create a new project with the Render File Type set to QuickTime and the Export Codec set to Apple ProRes 4444. Then, edit all the shots you want to convert into the Timeline, grade them if necessary, add them to the Render Queue, and click Start Render.

When you convert the DPX files to offline QuickTime files using Color, the timecode metadata stored in the header of each DPX frame is copied into the timecode track of each .mov file that’s created. (If there's no timecode in the DPX headers, the frame number in the DPX filename will be converted into timecode, instead. For more information, see How Does Color Relink DPX/Cineon Frames to an EDL?).

This helps you to maintain the correspondence between the source DPX media and the Apple ProRes 4444 QuickTime files you’ve created, in case you ever need to go back to the original media. To make this easier, enter the roll number of each image sequence into the reel number of the converted QuickTime clip. You can do this in the Final Cut Pro Browser.

For more information, see Converting Cineon and DPX Image Sequences to QuickTime.
Stage 4: **Creating Offline Resolution Clips for Editing in Final Cut Pro (Optional)**
This step is especially useful if you’re working on a project at 4K resolution. High-resolution media can be processor-intensive, reducing application responsiveness and real-time processing unless you have an exceptionally robust system. If this is the case, you can create an offline set of media (using whichever resolution and codec your particular workflow requires) with which to work using the Media Manager in Final Cut Pro.

If you downconvert to a compressed high definition format, such as Apple ProRes 422 or Apple ProRes 422 (HQ), you can offline your project on an inexpensively equipped computer and still be able to output and project it at a resolution suitable for high-quality client and audience screenings during the editorial process.

Once you finish your offline edit, you can easily reconform your sequence to the high-resolution Apple ProRes 4444 source media you generated.

Stage 5: **Doing the Offline Edit in Final Cut Pro**
Edit your project in Final Cut Pro, being careful not to alter the timecode or duration of the offline master media in any way.

Stage 6: **Preparing Your Final Cut Pro Sequence**
To prepare your edited sequence for an efficient workflow in Color, follow the steps outlined in *Before You Export Your Final Cut Pro Project*. If you’re planning on printing to film, it’s prudent to be even more cautious and eliminate any and all effects that are unsupported by Color, since the media rendered by Color will be the final media that’s delivered to the film recording facility.

- Clips using speed effects should be rendered as self-contained QuickTime movies, with the resulting media files reedited into the Timeline to replace the original effects. This is also true for any clip with effects you want to preserve in the final program, including filters, animated effects, composites, opacity settings, and embedded Motion projects.
- The only type of transition that Color is capable of processing is the dissolve. Any other type of transition in the sequence will be rendered as a dissolve of identical duration.
- The only other types of effect that Color supports are Position, Rotation, Scale, and Aspect Ratio Motion tab settings, which are converted into Pan & Scan room settings. While keyframes for these settings in Final Cut Pro cannot be sent to Color, the Pan & Scan settings can be keyframed in Color later.

Stage 7: **Sending the Sequence to Color or Exporting an XML File**
When you finish prepping your edited sequence, there are two ways you can send it to Color.

- If Color is installed on the same computer as Final Cut Pro, you can use the Send To Color command to move an entire edited sequence to Color, automatically creating a new project file.
• If you’re handing the project off to another facility, you may want to export the edited sequence as an XML file for eventual import into Color. In this case, you’ll also want to use the Final Cut Pro Media Manager to copy the project’s media to a single, transportable hard drive volume for easy handoff.

Stage 8: Grading Your Program in Color
Grade your program in Color as you would any other.

Important: When grading scanned film frames for eventual film output, it’s essential to systematically use carefully profiled LUTs (look up tables) for monitor calibration and to emulate the ultimate look of the project when printed out to film. For more information, see Using LUTs.

Stage 9: Rendering Graded Media Out of Color
Once you finish grading the project in Color, use the Render Queue to render out the final media. If the film recording facility you’re working with requires an image sequence, now is the time to:

• Change the Render File Type to DPX or Cineon, depending on what the facility has requested.
• Choose the Printing Density to match your facility’s recommendations.
• If you’ve been using a LUT to monitor your program while you work, turn it off by choosing File > Clear Display LUT. Otherwise, you’ll bake the LUT into the rendered media.
• Double-check the Broadcast Safe and Internal Pixel Format settings to make sure they’re appropriate for your project.

Rendering high-resolution media will take time. Keep in mind that the Render Queue has been set up to let you easily render your project incrementally; for example, you can render out all the shots of a program that have been graded that day during the following night to avoid having to render the entire project at once.

However, when you’re working on a project using 2K image sequence scans, rendering the media is only the first step. The rendered output is organized in the specified render directory in such a way as to easily facilitate managing and rerendering the media for your Color project, but it’s not ready for delivery to the film recording facility until the next step.

Stage 10: Assembling the Final Image Sequence for Delivery
Once every single shot in your program has been rendered, you need to use the Gather Rendered Media command to consolidate all the frames that have been rendered, eliminating handles, rendering dissolves, copying every frame used by the program to a single directory, and renumbering each frame as a contiguously numbered image sequence. Once this has been done, the rendered media is ready for delivery to the film recording facility.
Stage 11: Creating Additional Transitions, Effects, and Titles
In a 2K or 4K workflow, you can also use a compositing application such as Shake to create additional transitions or layered effects, including superimpositions, titles, and other composites, after the color correction has been completed.

Each image file's frame number identifies its position in that program’s Timeline. Because of this, when you send frames to a compositing application, it's vital that the frame numbers in filenames of newly rendered media are identical to those of the original source media. This requires careful file management.

Finishing Projects Using RED Media
RED media has become an important acquisition format for both broadcast and digital cinema. When you install the necessary software to use RED media with Final Cut Studio, you get access to a variety of workflows for ingesting, grading, and mastering programs using native RED QuickTime movies in Final Cut Pro and Color.

This section describes the various RED workflows that Final Cut Studio supports. For information about grading controls that are specific to native RED QuickTime clips, see The RED Tab.

When you’re working on a project that uses RED media, there are essentially four workflows you can follow:

Transcode All Native RED QuickTime Media to Apple ProRes 422 (HQ)
If you're mastering specifically to video, one very simple workflow is to transcode from RED to Apple ProRes 422 (HQ) clips, and then master Apple ProRes 422 (HQ). After initially ingesting and transcoding using the Log and Transfer window, this workflow is similar to the master flowchart shown in Video Finishing Workflows Using Final Cut Pro.

Keep in mind that whenever you transcode native RED R3D media to Apple ProRes using the Log and Transfer window, you preprocess the original RAW image data. For more information, see RED Metadata Versus Color Processing in Transcoded Media.

- **Advantages:** Simple workflow for video mastering. Apple ProRes 422 (HQ) can be easily edited on most current computers. Apple ProRes 422 (HQ) is suitable for high definition video mastering, and media can be sent directly to Color for finishing without the need to reconform.

- **Disadvantages:** Transcoding may take a long time. You lose the quality advantage of being able to grade and finish using the RAW RGB 4:4:4 data that native RED QuickTime files provide.
Ingest Native RED QuickTime Media for Editing and Finishing
It’s also possible to edit and finish using native RED QuickTime media. This is an efficient workflow that skips the need for reconforming, and gives you access to the high-quality native image data when you grade in Color. Since working with native RED QuickTime media is processor-intensive, this workflow may be most appropriate for short-form projects and spots. This workflow is illustrated in Editing and Finishing with RED QuickTime Media.

- **Advantages:** Ingesting RED QuickTime media is fast when compared to transcoding. Skips the need for an offline reconform. Provides maximum data fidelity through direct access to each shot’s native R3D image data.
- **Disadvantages:** RED QuickTime media is processor-intensive when editing.

Ingest Transcoded Apple ProRes Media for Editing; Conform to Native RED QuickTime for Finishing
The most practical workflow for long-form work when you want to be able to grade using native RED QuickTime media involves transcoding the original RED media to Apple ProRes media for efficient offline editing, and then reconforming your edited sequence back to native RED QuickTime media for final mastering and color correction in Color. This workflow is illustrated in Offline Using Apple ProRes; Finishing with RED Media.

- **Advantages:** Apple ProRes 422 (HQ) can be easily edited on most current computers. After you reconform, this workflow provides maximum data fidelity through direct access to each shot’s native R3D image data.
- **Disadvantages:** Reconforming is an extra step that requires good organization.

Improving Performance When Using Native RED QuickTime Media in Color
To get the best performance when working with native RED QuickTime media (especially when working with 4K media, which can be extremely processor-intensive), be sure to turn on Enable Proxy Support in the User Prefs tab of the Setup room. These are the suggested settings for optimal performance:

- Set Grading Proxy to Half Resolution
- Set Playback Proxy to Quarter Resolution

Proxies for native RED QuickTime media are generated on the fly, without the need to prerender proxy files as you do with DPX or Cineon media. For more information on the Color proxy settings, see Using Proxies.
Offline Using Apple ProRes; Finishing with RED Media

An advantage to editing with Apple ProRes media is that it’s less processor-intensive than editing using RED QuickTime files, which makes editing in Final Cut Pro more efficient. After you reconform, you can still work in Color at the higher quality with access to all of the raw image data in the R3D file, since Color can bypass QuickTime and use the RED framework directly to read the native 2K or 4K RGB 4:4:4 data inside of each file.

The only real disadvantages to this workflow are that the initial transcoding stage can be time-consuming, and that later, reconforming is an extra step that requires careful organization.

The following steps break this process down more explicitly.
Stage 1: Archiving the Original RED Media

It's always recommended that you archive all of the original RED media for your project onto one or more backed-up volumes. Whether you're shooting with CF cards or a RED drive, you should always copy the entire contents of each CF card or drive that you've finished recording with to an individually named folder on your archive volume.

- **If you're using CF cards**: The contents of each card should be copied into separate directories. For example, if you've shot a project using 12 CF cards, at the end of the process you should have 12 different directories (perhaps named “MyGreatProject_01” through “MyGreatProject_12”), each of which contains the entire contents of the CF card to which it corresponds.

- **If you're using RED drives**: You should copy the entire contents of the drive to a new folder every time you fill it up or are finished with a particular part of your shoot. For example, if you're archiving the contents of the drive after every day's shoot, then after four days you should have four directories (perhaps named “MyGreatProject_Day01” through “MyGreatProject_Day04”).

Each folder or disk image you copy RED media into must have a unique name; preferably one that clearly identifies the contents. After you copy the RED media into these folders, they will contain one or more sub-folders with an .RDM extension that contain the actual RED media. The name of the enclosing RDM folder will be used as the reel name for each clip that's ingested by Final Cut Pro during the log and transfer process.

After you initially copy the RED media, you may elect to change the name of the RDM folders to something more readable (the .RDM extension itself is optional). If you make such changes, make sure that the name of each folder is unique, and do not under any circumstances change the names of any folders or files that appear within.

After you've ingested the media using the Log and Transfer window, **do not change the name of the RDM folder again**. Doing so will jeopardize your ability to later reconform offline sequences to the original RED source media.

**Important**: It's not recommended to enter new reel names for RED media that you ingest using the Reel field of the Log and Transfer window.

Stage 2: Ingesting Media Using Apple ProRes to Perform the Offline-Quality Edit

If it's necessary to edit your program at offline quality for efficiency, transcode the archived RED media to one of the Apple ProRes codecs using the Log and Transfer window in Final Cut Pro.

See the *Final Cut Pro 7 User Manual* for more information about transcoding on ingest, and which codec to choose for offline work.
Stage 3: Editing Using Apple ProRes Media

Edit your project in Final Cut Pro, being careful not to alter the timecode of the offline master media in any way. If you want to minimize the amount of preparation you’ll be doing later in Stage 5: Preparing Your Final Cut Pro Sequence, keep the following limitations in mind while you edit:

- Restrict transitions in your project to cross dissolves only. When you render DPX image sequences out of Color and use the Gather Rendered Media command to prepare a single image sequence for film printing, Color automatically processes all cross dissolves in your program. Other transitions are not supported, and will instead be processed as cross dissolves if they’re present in your project.

- Keyframes are not sent from Final Cut Pro to Color, so don’t use the Motion tab to create animated Pan & Scan effects. Instead, use the Pan & Scan tab in the Geometry room of Color, which lets you scale, recenter, change the aspect ratio of, and rotate your clips, and which can be keyframed. Pan & Scan effects are rendered along with your grades when you render DPX or Cineon image sequences out of Color.

- Don’t use superimpositions, transfer modes, speed effects, or filters, unless you’re planning on prerendering these clips (exporting each as a self-contained QuickTime clip and reediting them into the Timeline to replace the original effects) as Apple ProRes 4444 media before you send them to Color. Color does not render these effects.

Stage 4: Reconforming Your Project to Native RED QuickTime Media

Once your edit is locked, prepare your edited sequence to be media-managed by moving all video clips that aren’t being superimposed as part of a compositing operation down to track V1. This makes navigation and grade management much easier once you start working in Color, and also eliminates unused clips directly from the Timeline, reducing the amount of media needing to be reconformed.

Next, you’ll media manage your project to create an offline version of your edited sequence with the appropriate sequence settings, and then batch transfer the resulting sequence using the Log and Transfer window to reingest native RED QuickTime media from the originally archived RED media directories.

See the Final Cut Pro 7 User Manual for more information.
Stage 5: Preparing Your Final Cut Pro Sequence

To prepare your edited sequence for an efficient workflow in Color, follow the steps outlined in Before You Export Your Final Cut Pro Project. If you’re planning on printing to film, it’s prudent to be even more cautious and eliminate any and all effects that are unsupported by Color, since the media rendered by Color will be the final media that’s delivered to the film recording facility.

- Clips using speed effects should be rendered as self-contained QuickTime movies, with the resulting media files reedited into the Timeline to replace the original effects. This is also true for any clip with effects you want to preserve in the final program, including filters, animated effects, composites, opacity settings, and embedded Motion projects.
- The only type of transition that Color is capable of processing is the dissolve. Any other type of transition in the sequence will be rendered as a dissolve of identical duration.
- The only other types of effect that Color supports are Position, Rotation, Scale, and Aspect Ratio Motion tab settings, which are converted into Pan & Scan room settings. While keyframes for these settings in Final Cut Pro cannot be sent to Color, the Pan & Scan settings can be keyframed in Color later.

Stage 6: Sending the Finished Sequence to Color

When you finish prepping your edited sequence, there are two ways you can send it to Color.

- If Color is installed on the same computer as Final Cut Pro, you can use the Send To Color command to move an entire edited sequence to Color, automatically creating a new project file.
- If you’re handing off the project to another facility, you may want to export the edited sequence as an XML file for eventual import into Color. In this case, you’ll also want to use the Final Cut Pro Media Manager to copy the project’s media to a single, transportable hard drive volume for easy handoff.

Stage 7: Grading Using Additional RED Tab Settings in the Primary In Room

Once in Color, you have access to each clip’s camera setting metadata via the RED tab in the Primary In room. You can use the RED image data as is, or make adjustments as necessary. For more information, see The RED Tab.

You may also find it to your advantage to use a proxy setting in Color to speed up effects processing as you work, especially if you’re working with 4K source media. For example, setting Grading Proxy to Half Resolution and Playback Proxy to Quarter Resolution will significantly improve real-time performance as you work in Color, while still allowing you to monitor your data with complete color accuracy at approximately 1K. For more information, see Using Proxies.

**Important:** Clips that have been transcoded to Apple ProRes 422 (HQ) cannot access these native camera settings, as they no longer contain the native RED raw image data.
Stage 8: Choosing How to Render the Final Graded Media

When working with native RED QuickTime media, the frame size of your final graded media is determined by the Resolution Presets menu in the Project Settings tab of the Setup room. For more information, see Resolution and Codec Settings.

The format you use to render your final graded media depends on whether you’re planning on printing to film, or sending the program back to Final Cut Pro for output to video.

- **If you’re rendering for film output:** Change the Render File Type pop-up menu to DPX or Cineon (depending on what the facility doing the film printing asks for), and choose the appropriate 2K or 4K resolution from the Resolution Preset pop-up menu. If you choose DPX, you also need to choose the appropriate Printing Density. For more information, see Choosing Printing Density When Rendering DPX Media.

- **If you’re rendering to send back to Final Cut Pro for video output:** Keep the Render File Type pop-up menu set to QuickTime and choose an appropriate mastering codec from the QuickTime Export Codec pop-up menu. For more information, see Compatible QuickTime Codecs for Output. Keep in mind that the RED QuickTime format is a read-only format; you cannot master a program using this format.

**Note:** Rendering native RED QuickTime media is processor-intensive, and rendering times can be long, especially at 4K resolutions.

Stage 9: Assembling the Final Image Sequence for Delivery, or Sending Back to Final Cut Pro

The final stage of finishing your project depends, again, on whether you’re printing to film, or outputting to video.

- **If you’re rendering for film output:** Once every single shot in your program has been rendered, use the Gather Rendered Media command to consolidate all the frames that have been rendered, eliminating handles, rendering dissolves, copying every frame used by the program to a single directory, and renumbering each frame as a contiguously numbered image sequence. Once this has been done, the rendered media is ready for delivery to the film recording facility. For more information, see Gather Rendered Media.

- **If you’re rendering to send back to Final Cut Pro for video output:** Simply send your project back to Final Cut Pro after you finish rendering it. For more information, see Sending Your Project Back to Final Cut Pro.

Editing and Finishing with RED QuickTime Media

The advantage of this workflow is that it skips the need for reconforming, giving you access to high-quality image data when you grade in Color. Ingesting RED QuickTime media is fast when compared to transcoding. This is a good workflow for projects such as short-form and spots.
The main disadvantage is that RED QuickTime media is processor-intensive when editing. Because of performance limitations, editing with less powerful computers or editing a feature length show using 4K RED QuickTime media may not be practical.

The following steps break this process down more explicitly.

**Stage 1: Importing Media as Native RED QuickTime Clips**
Import all of your RED media using the Native option in the Log and Transfer window. For more information, see the *Final Cut Pro 7 User Manual*.

**Stage 2: Editing Using Native RED QuickTime Media**
Edit your project in Final Cut Pro. For the smoothest editing experience, choose Unlimited RT from the Timeline RT pop-up menu, set Playback Video Quality to Low or Medium, and set Playback Frame Rate to Full.
For more information on editing programs that will be printed to film, see Stage 3: Editing Using Apple ProRes Media.

**Stage 3: Preparing Your Final Cut Pro Sequence, Sending to Color, Grading, Rendering, and Finishing**

Because you’re already working with native RED QuickTime media, no reconforming is necessary. At this point, the workflow is identical to Stage 5: Preparing Your Final Cut Pro Sequence.

**Use Unlimited RT When Editing Native RED QuickTime Media in Final Cut Pro**

As mentioned previously, RED QuickTime media is processor-intensive to work with in Final Cut Pro. For the smoothest editing experience, choose Unlimited RT from the Timeline RT pop-up menu, set Playback Video Quality to Low or Medium, and set Playback Frame Rate to Full.

**RED Metadata Versus Color Processing in Transcoded Media**

The Color, Color Temp, and View RED camera settings in use while shooting are stored as metadata within each recorded R3D file. If you ingest or reconform using native RED QuickTime media, this metadata remains intact, and is accessible via the RED tab of the Primary In room. This is the most flexible way to work, as this image metadata has no effect on the actual RAW R3D data that the camera has recorded, and, in fact, if you’re unhappy with how the current metadata settings are processing the image, you can change them to retrieve additional image data from the RAW source.

When you transcode R3D media to one of the Apple ProRes codecs using the Log and Transfer window, this metadata is used to preprocess the color and contrast of the transcoded media as long as the RED FCP Log and Transfer plugin submenu of the Action pop-up menu is set to Native, which is the default setting. The result is that each transcoded clip visually matches the image that was monitored during the shoot. This preprocessing is “baked” into each ingested clip. If you want to later reapply a different type of image preprocessing to a clip, you need to reingest it from the original source media.

If necessary, you can choose other color processing options from the RED FCP Log and Transfer plugin submenu of the Action pop-up menu. For more information, see the *Final Cut Pro 7 User Manual.*
Digital Intermediate Workflows Using DPX/Cineon Media

Color supports grading for 2K and 4K digital intermediate workflows. Simply put, the term *digital intermediate* (DI) describes the process of performing all effects and color correction using high-resolution digital versions of the original camera negative. Color can work with 2K and 4K 10-bit log image sequences produced by datacine scanners, processing the image data with extremely high quality and rendering the result as an image sequence suitable for film output.

The following sections describe different 2K and 4K workflows that you can follow and show you how to keep track of your image data from stage to stage.

- For more information on tapeless online/offline DI workflows, see *A Tapeless DI Workflow*.
- For more information about DI workflows involving telecined offline media, see *A Digital Intermediate Workflow Using Telecined Media*.
- For more information about how Color reconforms media in DI workflows, see *Using EDLs, Timecode, and Frame Numbers to Conform Projects*.

**A Tapeless DI Workflow**

The easiest digital intermediate (DI) workflow is one where you scan all footage necessary for the offline edit and then create a duplicate set of offline media to edit your project with. Upon completion of the offline edit, you then relink the program to the original 2K or 4K source frames in Color.
Deriving the offline media from the original digital media keeps your workflow simple and eliminates the need to retransfer the source film later. The only disadvantage to this method is that it can require an enormous amount of storage space, depending on the length and shooting ratio of the project.

The following steps break this process down more explicitly.

**Stage 1: Running Tests Before Shooting**
Ideally, you should do some tests before principal photography to see how the film scanner–to–Color–to–film recorder pipeline works with your choice of film formats and stocks. It's always best to consult with the film lab you'll be working with in advance to get as much information as possible.

**Stage 2: Scanning All Film as 2K or 4K DPX Image Sequences**
Depending on how the shoot was conducted, you could opt to do a best-light datacine of just the selects or of all the camera negative, if you can afford it. The scanned 2K digital source media should be saved as DPX or Cineon image sequences.
To track the correspondence between the original still frames and the offline QuickTime files that you'll create for editing, you should ask for the following:

- A non-drop frame timecode conversion of each frame's number (used in that frame's filename) saved within the header of each scanned image.
- It can also help to organize all of the scanned frames into separate directories, saving all the frames from each roll of negative to separate directories (named by roll).
- The resulting DPX files should be named using the following format:
  \texttt{fileName\_0123456.dpx}
(For more information on naming DPX and Cineon files, see Required Image Sequence Filenaming.)

**Stage 3: Converting the DPX Image Sequences to Offline-Resolution QuickTime Files**
Create offline-resolution duplicates of the source media in whatever format is most suitable for your editing system. Then, archive the original source media as safely as possible.

When you convert the DPX files to offline QuickTime files:

- The roll number of each image sequence (taken from the name of the directory that encloses the frames being converted) is used as the reel number for each .mov file.
- The timecode values stored in the header of each frame file are used as the timecode for each .mov file. If there's not timecode in the header, the frame number in the filename is converted to timecode and used, instead.

You can use Color to perform this downconversion by creating a new project with the Render File Type set to QuickTime and the Export Codec set to the codec you want to use. Then, simply edit all the shots you want to convert into the Timeline, add them to the Render Queue, and click Start Render. For more information, see Converting Cineon and DPX Image Sequences to QuickTime.

You can also use Compressor to perform this downconversion. For more information, see the Compressor documentation.

**Tip:** If you downconvert to a compressed high definition format, such as Apple ProRes 422 or Apple ProRes 422 (HQ), you can offline your project on an inexpensively equipped computer system and still be able to output and project it at a resolution suitable for high-quality client and audience screenings during the editorial process.

**Stage 4: Doing the Offline Edit in Final Cut Pro**
Edit your project in Final Cut Pro, being careful not to alter the timecode or duration of the offline media in any way.
Stage 5: Preparing Your Final Cut Pro Sequence
To prepare your edited sequence for an efficient workflow in Color, follow the steps outlined in Before You Export Your Final Cut Pro Project. Because you’ll be exporting an EDL to Color in order to relink to the original DPX image sequences, it’s prudent to be extremely conservative and eliminate any and all effects that are unsupported by the CMX EDL formats, or by Color itself.

Cross dissolves are the one exception. These are the only type of transition that Color supports. Any other type of transition will be rendered as a cross dissolve of identical length.

Stage 6: Exporting an EDL
When you finish with the edit, you need to generate an EDL in either the CMX 340, CMX 3600, or GVG 4 Plus formats.

Important: You cannot use the Send To Color command to move projects to Color that are being reconformed to DPX or Cineon media.

Stage 7: Importing the EDL into Color and Relinking to the Original DPX Media
Use the File > Import > EDL command to import the EDL. In the Import EDL dialog, specify the directory where the original high-resolution source media is located, so that the EDL is imported and the source media is relinked in one step. For more information, see Importing EDLs.

Stage 8: Grading Your Program in Color
Grade your program in Color as you would any other. For better performance, it’s advisable to use the Proxy controls in the User Prefs tab of the Setup Room to work at a lower resolution than the native 2K or 4K frame size of the media. For more information, see Using Proxies.

Important: When grading scanned film frames, it’s essential to systematically use carefully profiled LUTs for monitor calibration and to emulate the ultimate look of the project when printed out to film. For more information, see Using LUTs.

Stage 9: Conforming Transitions, Effects, and Titles
In a 2K workflow, you also need to use a compositing application such as Shake to create any transitions or layered effects, including superimpositions, titles, and other composites, using the 2K image sequence data.

Important: Each image file’s frame number identifies its position in that program’s Timeline. Because of this, when you send frames to a compositing application, it’s vital that the frame numbers in filenames of newly rendered media are identical to those of the original source media. This requires careful file management.
Stage 10: Rendering Your Media Out of Color
Once you finish grading the project in Color, use the Render Queue to render out the final media. The Render Queue has been set up to let you easily render your project incrementally; for example, you can render out all the shots of a program that have been graded that day during the following night to avoid rendering the entire project at once.

However, when you’re working on a project using 2K image sequence scans, rendering the media is only the first step. The rendered output is organized in the specified render directory in such a way as to easily facilitate managing and rerendering the media for your Color project, but it’s not ready for delivery to the film recording facility until the next step.

Stage 11: Assembling the Final Image Sequence for Delivery
Once every single shot in your program has been rendered, you need to use the Gather Rendered Media command to consolidate all the frames that have been rendered, eliminating handles, copying every frame used by the program to a single directory, and renumbering each frame as a contiguously numbered image sequence. Once this has been done, the rendered media is ready for delivery to the film recording facility.
A more traditional way to edit and color correct a project is to do an offline edit using a less expensive telecine transfer of the dailies, and then do a datacine film scan of only the shots used in the edit to create the online media.

The following steps break this process down more explicitly.

**Stage 1: Shooting the Film**
Ideally, you should do some tests before principal photography to see how the film scanner–to–Color–to–film recorder pipeline works with your choice of film formats and stocks. It’s always best to consult with the film facility you’ll be working with in advance to get as much information as possible.
**Stage 2: Telecining the Dailies**

Once the film has been shot, telecine the dailies to a video format that’s appropriate for the offline edit. Whether or not you telecine to a high definition video format for the offline depends on the configuration of the editing system you’ll be working with and the amount of hard disk space available to you.

Of more importance is the frame rate at which you choose to telecine the dailies.

- To eliminate an entire media management step, it’s recommended that you telecine the film directly to a 23.98 fps video format.

- Otherwise, you can telecine to a 29.97 fps video format and use Cinema Tools in a second step to perform 3:2 pull-down removal.

To more easily maintain the correspondence between the telecined video and the 2K or 4K film frames that will be scanned later, you should request that:

- A **marker frame** is assigned to each roll of film at a point before the first shot begins, with a hole punch permanently identifying that frame. This marker frame is assigned the timecode value of XX:00:00:00 (where XX is an incremented hour for each subsequent camera roll being transferred), and determines the absolute timecode for each shot on that roll.

- The timecode recorded to tape during the offline telecine must be non-drop frame.

- Each roll of negative should be telecined to a separate reel of tape. This way, the reels specified by the EDL will match the rolls of camera negative from which the shots are scanned.

- If the transfer is being done strictly for offline editing, you can ask for a window burn that displays both timecode and edgecode to provide an additional means of reference. If you’re transferring film to a 4:3 aspect ratio video format, you may elect to have this window burn made in the black letterboxed area so it doesn’t obscure the image. It may also be possible to write the edgecode number of the source film to the user bit of VITC timecode for electronic tracking. Ask the facility doing the transfer what would be best for your situation.

**Stage 3: Using Cinema Tools and Final Cut Pro to Perform the Offline Edit**

As with any other film edit, generate a Cinema Tools database from the ATN, FLEx, FTL, or ALE telecine log files provided by the telecine operator, then export an XML-based batch capture list you can import into Final Cut Pro to use to capture the corresponding media and edit the program.

*Important:* When working with offline media that tracks the original camera negative, **do not** use the Media Manager to either rename or delete unused media in your project. If you do, you’ll lose the ability to create accurate pull lists in Cinema Tools.
Stage 4: Preparing Your Final Cut Pro Sequence
To prepare your edited sequence for an efficient workflow in Color, follow the steps outlined in Before You Export Your Final Cut Pro Project. Because you’ll be exporting an EDL to Color in order to relink to the original DPX image sequences, it’s prudent to be extremely conservative and eliminate any and all effects that are unsupported by the CMX EDL formats, or by Color itself.

Cross dissolves are the one exception. These are the only type of transition that Color supports. Any other type of transition will be rendered as a cross dissolve of identical length.

Stage 5: Exporting an EDL for Color and a Pull List for the Datacine Transfer
Once the offline edit is complete, you need to export a pull list out of Final Cut Pro to give to the facility doing the final datacine transfer at 2K or 4K resolution. You also need to export the entire project as an EDL for importing and conforming in Color.

- The pull list specifies which shots were used in the final version of the edit. (This is usually a subset of the total amount of footage that was originally shot.) Ideally, you should export a pull list that also contains the timecode In and Out points corresponding to each clip in the edited project. This way, the timecode data can be written to each frame that’s scanned during the datacine transfer to facilitate conforming in Color.
- The EDL moves the project's edit data to Color and contains the timecode data necessary to conform the scanned image sequence frames into the correct order.

Stage 6: Doing a Datacine Transfer of the Selected Shots from Negative to DPX
Using the pull list generated by Cinema Tools, have a datacine transfer made of every shot used in the project.

During the datacine transfer, specify that the timecode of each frame of negative be converted to frames and used to generate the filenames for each scanned DPX file, and that the timecode also be written into the DPX header of each shot. The names of the resulting image sequence should take the following form: fileName_0123456.dpx. For more information about filenaming conventions, see Required Image Sequence Filenaming.

Each image sequence from the film scanner must be saved into a directory that is named with the number of the roll of camera negative from which it was scanned. There should be separate directories for each roll of camera negative that's scanned.

Stage 7: Importing the EDL into Color and Relinking to the Original DPX Media
Use the File > Import > EDL command to import the EDL. In the Import EDL dialog, you also specify the directory where the original high-resolution source media is located, so that the EDL is imported and the source media is relinked in one step.
Stage 8: Grading Your Program in Color
Grade your program in Color as you would any other. For better performance, it’s advisable to use the Proxy controls in the User Prefs tab of the Setup room to work at a lower resolution than the native 2K or 4K frame size of the media. For more information, see Using Proxies.

**Important:** When grading scanned film frames, it’s essential to systematically use carefully profiled LUTs for monitor calibration and to emulate the ultimate look of the project when printed out to film. For more information, see Using LUTs.

Stage 9: Conforming Transitions, Effects, and Titles, Rendering Media, and Gathering Rendered Media
At this point, the process is the same as in Stage 9: Conforming Transitions, Effects, and Titles in A Tapeless DI Workflow.

Using EDLs, Timecode, and Frame Numbers to Conform Projects
Using careful data management, you can track the relationship of the original camera negative to the video or digital transfers that have been made for offline editing using timecode. The following sections provide information on how Color tracks these correspondences.

- For more information on how Color relinks DPX images to EDLs, see How Does Color Relink DPX/Cineon Frames to an EDL?
- For more information on how color parses EDLs for DI conforms, see Parsing EDLs for Digital Intermediate Conforms.
- For more information on how your image sequences should be named for DI workflows, see Required Image Sequence Filenaming.

How Does Color Relink DPX/Cineon Frames to an EDL?
The key to a successful conform in Color is to make sure that the timecode data in the EDL is mirrored in the scanned DPX or Cineon frames you’re relinking to. The correspondence between film frames and timecode is created during the first telecine or datacine transfer session.

How Is Film Tracked Using Timecode?
A *marker frame* is assigned to the very beginning of each roll of film, at a point before the first shot begins (typically before the first flash frame). A hole is punched into the negative, which permanently identifies that frame. This marker frame is assigned the timecode value of XX:00:00:00 (where XX is an incremented hour for each subsequent camera roll being transferred), creating an absolute timecode reference for each frame of film on that roll. Each camera roll of film is usually telecined to a new reel of videotape (each reel of tape usually starts at a new hour), or datacined to a separate directory of DPX files.
This makes it easy to create and maintain a film frame-to-timecode correspondence between the original camera negative and the transferred video or DPX media. This correspondence carries through to the captured or converted QuickTime media that you edit in Final Cut Pro. As an added benefit of this process, you can always go back to the original rolls of camera negative and retransfer the exact frames of film you need, as long as you accurately maintain the reel number and timecode of each clip in your edited sequence.

If you’re having a datacine transfer done, you also need to request that the frame numbers incorporated into the filenames of the transferred image files be based on the absolute timecode that starts at each camera roll’s marker frame. Your final DPX or Cineon image sequences should then have frame numbers in the filename that, using a bit of mathematical conversion, match the timecode value in the header information, providing valuable data redundancy.

**How Color Relinks DPX/Cineon Media to EDLs Using Timecode**

Later, when Color attempts to relink the EDL that you’ve exported from Final Cut Pro to the transferred DPX or Cineon image sequence media, it relies on several different methods, depending on what information is available in the image sequence files:

- First, Color looks for a timecode value in the header metadata of each DPX or Cineon frame file. If this is found, it's the most reliable method of relinking.
- If there's no matching timecode number in the header metadata, then Color looks for a correspondence between the timecode value requested in the EDL and the frame numbers in the filename of each DPX or Cineon frame. This also requires that the files be strictly named. For more information, see Required Image Sequence Filenaming.
- Color also looks for each shot’s corresponding reel number (as listed in the EDL) in the name of the directory in which the media is stored. Each frame of DPX or Cineon media from a particular roll of camera negative should be stored in a separate directory that’s named after the roll number it was scanned from. If there are no roll numbers in the enclosing directory names, then Color attempts to relink all the shots using the timecode number only.

After you import an EDL with linked DPX or Cineon image sequence media, a Match column appears in the Shots browser. This column displays the percentage of confidence that each shot in the Timeline has been correctly linked to its corresponding DPX, Cineon, or QuickTime source media, based on the methods used to do the linking. For more information, see Explanation of Percentages in the Match Column.

**Relinking DPX/Cineon Frames to an EDL Using a Cinema Tools Database**

If issues arise when conforming an EDL to DPX or Cineon media in Color, you can create a Cinema Tools database with which to troubleshoot the problem.
If you don't already have a Cinema Tools database tracking your film media, you can easily create one. To create a Cinema Tools database from one or more directories of DPX or Cineon image sequences, simply drag all of the enclosing directories onto the Cinema Tools application icon, and a database is generated automatically. If necessary, you can use the Cinema Tools interface to check the reel numbers and timecode values of each shot, correcting any problems you find.

Afterward, when you're conforming an EDL to DPX or Cineon media in Color, you can choose the Cinema Tools database as your source directory in the EDL Import Settings window. (See Importing EDLs for more information.) This way, your updated reel numbers and timecode values will be used to link your Color project to the correct source media.

For more information on creating Cinema Tools databases from DPX or Cineon media, see the Cinema Tools documentation.

**Note:** Changing information in a Cinema Tools database does nothing to alter the source media files on disk.

**Parsing EDLs for Digital Intermediate Conforms**

This section explains how Color makes the correspondence between the timecode values in an EDL and the frame numbers used in the timecode header or filename of individual image sequence frames.

Here's a sample line from an EDL:

```
001 004 V C 04:34:53:04 04:35:03:04 00:59:30:00 00:59:40:00
```

In every EDL, the information is divided up into eight columns:

- The first column contains the edit number. This is the first edit in the EDL, so it is labeled 001.
- The second column contains the reel number, 004. This is what the directory that contains all of the scanned DPX or Cineon image files from camera roll 004 should be named.
- The next two columns contain video/audio track and edit information that, while used by Color to assemble the program, isn't germane to conforming the media.
- The last four columns contain timecode—they're pairs of In and Out points.
  - The first pair of timecode values are the In and Out points of the original source media (usually the telecined tape in ordinary online editing). In a digital intermediate workflow, this is used for naming and identifying the scanned frames that are output from the datacine.
  - The second pair of In and Out points identifies that shot's position in the edited program. These are used to place the media in its proper location on the Timeline.
**Required Image Sequence Filenaming**

Here’s a sample filename of the first image sequence file that corresponds to the EDL event shown in *Parsing EDLs for Digital Intermediate Conforms*:

```
fileName_0494794.dpx
```

The first portion of the filename for each scanned frame (the alpha characters and underscore) is an ignored but necessary part of the filename. The file’s frame number should equal the (non-dropframe) timecode conversion of that value appearing in the EDL.

For example, a frame with timecode 05:51:18:28 would have a frame number of 632368. Numeric extensions must always be padded to seven digits; in this case, you would add one preceding 0, like this:

```
fileName_0632368.dpx
```

The following filename formats are also acceptable:

```
fileName 0632368.dpx
fileName0632368.dpx
fileName-0632368.dpx
fileName.0632368.dpx
fileName.0632368.dpx
```

*Important:* For Color to be able to link to a media file, filenames need at minimum an alpha-only character name (consisting of at least one upper- or lowercase character), frame number, and a .dpx or .cin file extension.
You can work in Color either by using a mouse with the onscreen interface, or, more directly, by using a dedicated control surface that’s been designed for professional color correction work.

This chapter covers the general interface conventions used by Color. It describes the use of controls that are shared by multiple areas of the interface, as well as some of the specialized controls that are unique to color correction applications.

This chapter covers the following:

• Setting Up a Control Surface (p. 78)
• Using Onscreen Controls (p. 78)
• Using Organizational Browsers and Bins (p. 82)
• Using Color with One or Two Monitors (p. 88)
Setting Up a Control Surface

Color was designed from the ground up to support control surfaces specifically designed for color correction from manufacturers such as Tangent and JL Cooper Designs. These control surfaces typically include three trackballs that correspond to the three overlapping tonal zones of the Primary and Secondary color balance controls (shadows, midtones, and highlights), three rotary controls for the three contrast controls (black level, gamma, and white point), and a number of other rotary controls and buttons that support different functions depending on which room you’ve selected.

You can either choose a control surface to use when Color starts up, or click Show Control Surface Dialog in the User Prefs tab of the Setup room to choose an available control surface at any time. For more information on setting up a control surface, see Setting Up a Control Surface. For more information on configuring a control surface from within Color, see Control Surface Settings.

Using Onscreen Controls

If you don’t have a control surface, you can still operate every feature in Color using the onscreen controls. In addition to the standard buttons, checkboxes, and pop-up menus common to most applications, Color uses some custom controls that are described in this section. See the referenced sections for more information on:

• Using the Mouse
• Tabs
• Using Text Fields and Virtual Sliders
• Using Timecode Fields
• Using Color Balance Controls
Using the Mouse
Color supports the use of a three-button mouse, which provides quick access to shortcut menus and various navigational shortcuts. Color also supports the middle scroll wheel or scroll ball of a three-button mouse, either for scrolling or as a button.

<table>
<thead>
<tr>
<th>Mouse button</th>
<th>Documentation reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left mouse button</td>
<td>Click</td>
</tr>
<tr>
<td>Middle mouse button</td>
<td>Middle mouse button or middle-click</td>
</tr>
<tr>
<td>Right mouse button</td>
<td>Right-click (identical to Control-click with a single button mouse)</td>
</tr>
</tbody>
</table>

Note: Many controls can be accelerated up to ten times their normal speed by pressing the Option key while you drag.

Tabs
Tabs are used to navigate among the eight different Color “rooms.” Each room is a distinct portion of the interface that contains all the controls necessary to perform a specific task. Changing rooms changes the available interface, the keyboard shortcuts, and the mapping of the control surface controls.

Some rooms have additional features that are revealed via tabs within that room.

Using Text Fields and Virtual Sliders
There are four types of data that can populate edit fields in Color:
- Timecode
- Text, including filenames, directory paths, and so forth
- Whole numbers; fields that display whole numbers cannot accept either decimals or fractional values
- Percentages and fractional values, such as 0.25 or 1.873

There are four ways you can modify text fields.

To enter text into a field using the keyboard
1 Move the pointer into the text field you want to edit, and do one of the following:
   - Click once within any field to place the insertion point at the position you clicked.
   - Double-click within any field to select the word at the position of the pointer.
   - Triple-click within any field to select the entire contents of that field.
The text in that field becomes highlighted.
2 Type something new.
3 Press Return to confirm the change.

To modify the value of a numeric or percentage-based text field with a virtual slider
1 Move the pointer to the field you want to adjust.
2 Middle-click and drag to the left to decrease its value, or to the right to increase its value.
3 Release the mouse button when you’re finished.

To modify the value of a numeric or percentage-based text field with a scroll wheel
1 Move the pointer to the field you want to adjust.
2 Without clicking in the field, roll the scroll wheel or ball up to increase that field’s value, or down to decrease that field’s value.

To adjust a field using a shortcut menu
- Control-click or right-click any field, and choose one of the following options from the shortcut menu:
  - Reset: Resets the field to its default setting.
  - Min: Chooses the minimum value available to that field.
  - Max: Chooses the maximum value available to that field.
  - Set as Default: Changes the default value of a parameter to whatever value is currently specified. After changing the default value, you can change the value of that parameter back to the value you specified by clicking Reset.

Using Timecode Fields
Timecode fields display timing information, such as media In and Out points, and the position of the playhead. Time is represented in Color in one of two ways:

- Within fields, most time values are represented with standard SMPTE timecode. SMPTE timecode is represented by four colon-delimited pairs of digits: hh:mm:ss:ff, where hh is hours, mm is minutes, ss is seconds, and ff is frames.
- Time values in the Timeline ruler may be displayed as non-drop frame timecode, drop frame timecode, or frames.

Note: Drop frame timecode appears with a semicolon between the seconds and frames positions.

Here are some pointers for entering values into the hours, minutes, seconds, and frames positions of timecode fields:

- Time values are entered from left to right (similar to entering a duration into a microwave); however, the last value you type is assumed to be the last digit of the frames position.
- Press Return whenever you’ve finished typing a timecode value to confirm the new value you entered.
• If you enter a partial number, the rightmost pair of numbers is interpreted as frames and each successive pair of numbers to the left populates the remaining seconds, minutes, and hours positions. Omitted numbers default to 00.

For example, if you enter 1419, Color interprets it as 00:00:14:19.

• When you enter timecode in a field, you don’t need to enter all of the separator characters (such as colons); they’re automatically added between each pair of digits.

• You can type a period to represent a pair of zeros when entering longer durations. For example, type “3.” (3 and a period) to enter timecode 00:00:03:00. The period is automatically interpreted by Color as 00.

• To enter 00:03:00:00, type “3..” (3 and two periods). These periods insert pairs of zeros into both the seconds and frames position.

• Type “3...” to enter 03:00:00:00.

• Use the Plus Sign key (+) to enter a series of single-digit values for each time position. For example, type “1+5+8” to enter timecode 00:01:05:08.

Using Color Balance Controls
Color controls are used in several rooms in Color to let you choose and modify colors using the HSL model.

• Dragging within the main color wheel lets you simultaneously adjust the hue and saturation of the selected color.

A crosshair within the color wheel shows the current color value that’s being selected. The remaining controls depend on the type of color control being displayed.

• Dragging up and down within the multicolored Hue slider lets you adjust the hue.

• Dragging up within the single-colored Saturation slider increases the saturation of the current hue; dragging down decreases its saturation.

• Dragging up within the single-colored Brightness slider increases the brightness of the current color; dragging down decreases its brightness.
The angle at which colors appear on the color wheel of color controls can be customized to match the interface of other color correction systems you may be used to. In addition, the speed with which control surface joyballs (trackballs) adjust the corresponding Color color controls can be modified. For more information, see Control Surface Settings.

Using Organizational Browsers and Bins
Color offers several browsers and bins for organizing shots, media, and grades that share some common controls. All these browsers and bins are used to manage files on your hard disk, rather than data that’s stored within the Color project file itself. As a result, their controls are used to navigate and organize the directory structure of your hard disk, much as you would in the Finder. See the following sections for more information on:

• The File Browser
• The Shots Browser
• The Grades Bin
• Corrections Bins
• Browser, Still Store, Grades, and Corrections Bins Controls
• How Are Grades and Corrections Saved and Organized?

The File Browser
The browser that dominates the left half of the Setup room lets you navigate the directory structure of your computer’s disk drives (and by extension any RAID, DAS, and SAN volumes that are currently mounted) in order to find and import compatible QuickTime and still image media files.

It’s important to remember that the file browser is not the same as a project bin. The files displayed within the file browser are not associated with your Color project in any way unless you drag them into the Timeline manually, or relink the shots of an imported project to their associated media files on disk using the Relink Media or Reconnect Media command.

Note: The file browser displays only directories and media files that are compatible with Color.
When you select a media file in the file browser, a panel appears to the right displaying the first frame of that file along with information underneath.

![File Browser Panel](image)

The information given includes:

- **Shot Name**: The filename
- **Duration**: Its total duration
- **Codec**: The codec used to encode that file
- **Resolution**: The frame size of the file, width by height
- **Frame Rate**: The frame rate of the file
- **Timecode**: The timecode value of the first frame in that file
- **Import**: This button lets you edit the currently selected shot into the Timeline at the current position of the playhead.

**Collapsing the File Browser**
If you like, the file browser can be collapsed so that the tabbed area on the right can occupy the entire Color window.

**To collapse the file browser**
- Move the pointer to the file browser divider at the right side of the file browser, and when it’s highlighted in blue, click once to collapse it.
To expand the file browser

- Move the pointer to the file browser divider at the left side of the window, and when it’s highlighted in blue, click once to expand it.

For more information on the Setup room, see Configuring the Setup Room.

**The Shots Browser**

The other browser in the Setup room is the Shots browser. This browser lets you see all the shots that are in the current project in either icon or list view.

In icon view, you can create groups of shots to which you can apply a single correction or grade to at once. For more information, see Managing Grades in the Shots Browser.

In list view, you can sort all of the shots using different info fields. For more information on using the Shots browser, see Using the Shots Browser.

**The Grades Bin**

The Grades bin, in the Setup room, lets you save and organize grades combining primary, secondary, and Color FX corrections into a single unit.
You can use this bin to apply saved grades to other shots in the Timeline. The contents of the Grades bin are available to all Color projects opened while logged into that user account. For more information on saving and applying grades, see Saving Grades into the Grades Bin.

**Corrections Bins**

The Primary In and Out, Secondaries, and Color FX rooms all allow you to save the corrections made inside those rooms as individual presets that you can apply to later shots. The contents of corrections bins are available to all Color projects opened while logged into that user account.

- **Primary In and Out:** Let you save and organize primary corrections. The Primary In and Primary Out rooms both share the same group of saved corrections.
- **Secondaries:** Lets you save and organize secondary corrections.
- **Color FX:** Lets you save and organize Color FX corrections.

**Corrections Versus Grades**

There is a distinct difference between corrections and grades in Color. Corrections refer to adjustments made within a single room. You have the option to save individual corrections inside the Primary In and Out, Secondaries, and Color FX rooms and apply them to shots individually.

A grade can include multiple corrections across several rooms; you can save one or more primary, secondary, and Color FX corrections together. By saving a group of corrections as a grade, you can apply them all together as a single preset.

**Browser, Still Store, Grades, and Corrections Bins Controls**

All browsers and bins share the following controls:

**Display Controls**

All browsers and bins have display controls that let you choose how you want to view and organize their contents.

- **List View button:** Displays the contents of the current directory as a list of filenames.
- **Icon View button:** Displays the contents of the current directory as icons.
- **Icon Size slider:** Appears only in icon view. Scales the size of icons.
**Directory Navigation Controls**

The file browser and Grades and corrections bins also have directory navigation controls that you can use to organize and browse the grades and corrections that are saved on your hard disk.

- **Up Directory:** Moves to and displays the contents of the parent directory.

- **Home Directory:** Navigates to the appropriate home directory for that browser or bin. This is not your Mac OS X user home directory. The home directory is different for each bin:
  - **File browser:** The Home button takes you to the currently specified Color media directory.
  - **Primary In, Secondaries, Color FX, and Primary Out:** Home takes you to the appropriate subdirectory within the /Users/username/Library/Application Support/Color directory. Each room has its own corresponding subdirectory, within which are stored all the corrections you’ve saved for future use.
  - **Still Store:** Home takes you to the StillStore directory inside the current project directory structure.

**File Controls**

The file browser and Grades and corrections bins also have directory creation and navigation controls at the bottom.

- **File field:** Displays the file path of the currently viewed directory.

- **Directory pop-up menu:** This pop-up menu gives you a fast way to traverse up and down the current directory hierarchy or to go to the default Color directory for that room.

- **New Folder button:** Lets you create a new directory within the currently specified path. You can create as many directories as you like to organize the grades and corrections for that room.

- **Save button:** This button saves the grade or correction settings of the shot at the current position of the playhead in the directory specified in the above text fields.
Load button: Applies the selected grade or correction to the shot that’s at the current position of the playhead (if no other shots are selected) or to multiple selected shots (ignoring the shot at the playhead if it’s not selected). As with any Color bin, items displayed can be dragged and dropped from the bin into the Timeline.

How Are Grades and Corrections Saved and Organized?
Grades and corrections that you save using the Grades and Corrections bins in Color are saved within the Color preferences directory in your /Users/username/Library/Application Support/Color directory.

<table>
<thead>
<tr>
<th>Saved correction category</th>
<th>Location on disk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grades</td>
<td>/Users/username/Library/Application Support/Color/Grades/</td>
</tr>
<tr>
<td>Primary corrections</td>
<td>/Users/username/Library/Application Support/Color/Primary/</td>
</tr>
<tr>
<td>Secondary corrections</td>
<td>/Users/username/Library/Application Support/Color/Secondary/</td>
</tr>
<tr>
<td>Color FX corrections</td>
<td>/Users/username/Library/Application Support/Color/Effects/</td>
</tr>
</tbody>
</table>

Saved grades and corrections in these bins are available to every project you open.

Individual corrections in each of the above directories are saved as a pair of files: an .lsi file that contains a thumbnail for visually identifying that grade, and the specific file for that type of correction which actually defines its settings. Unless you customized the name, both these files have the same name, followed by a dot, followed by the date (day month year hour.minute.secondTimeZone), followed by the file extension that identifies the type of saved correction it is.

- Grade_Name.date.lsi: The thumbnail image used to represent that grade in icon view
- Grade_Name.date.pcc: Primary correction file
- Grade_Name.date.scc: Secondary correction file
- Grade_Name.date.cfx: Color FX correction file

Saved grades are, in fact, file bundles that contain all the correction files that make up that grade. For example, a grade that combines primary, secondary, and Color FX corrections would be a directory using the name given to the grade, "Grade_Name.date.grd," containing the following files:

- Grade_Name.date.lsi
- Grade_Name.date.pcc
- Grade_Name.date.scc
- Grade_Name.date.cfx
Reorganizing Saved Corrections and Grades in the Finder
Each of the corrections bins in Color simply mirrors the contents of the corresponding subdirectory in the /Users/username/Library/Application Support/Color directory. You can use the Finder to reorganize your saved corrections and grades by creating new subdirectories and moving previously saved grades and corrections into them.

When you move saved corrections from one directory to another, it’s important that you copy both the .lsi thumbnail image for that grade and the .pcc, .scc, or .cfx file that contains the actual grade information, together.

If you reorganize saved grades and corrections in the Finder while Color is open, you need to manually refresh the contents of the Grades and corrections bins you changed so that they correctly display the current contents.

To update the contents of the currently displayed corrections bin
- Click the Home button.

Moving Saved Corrections and Grades to Other Computers
If you have saved corrections and grades that you want to move to Color installations on other computers, you can simply copy the folders described in How Are Grades and Corrections Saved and Organized? to a portable storage device and then copy their contents into the corresponding folders on the new system. The next time you open Color, the saved corrections and grades will appear as they did before.

Using Color with One or Two Monitors
Color is compatible with both one- and two-monitor computer configurations, and requires a minimum resolution of 1680 x 1050 in either mode. Most users will benefit from using Color in dual display mode with two monitors, as this provides the most screen real estate and also allows for the most flexible use of the preview and video scopes displayed in the Scopes window of the second monitor.

However, Color can also be used in single display mode, which lets you operate Color in situations where a second display is not available. Single display mode is only recommended on 30-inch Cinema Displays.

**Warning:** It is not recommended to run Color on a system with more than one graphics card. For two-monitor support, both monitors should be connected to the same graphics card.
To switch between single and dual display modes
Do one of the following:

- Choose Window > Single Display Mode or Dual Display Mode.
- Press Shift-Command-0 to switch between modes.

You must quit Color and reopen it for this change to take effect.
Color provides powerful tools for managing projects and media as you work.

This chapter describes the commands and methods used to create and save projects, move projects from Final Cut Pro to Color and back again, and link and otherwise manage your projects and media once they’re within Color. It also covers compatible media formats, EDL import and export, and the conversion of DPX and Cineon image sequences to QuickTime media.

This chapter covers the following:

• Creating and Opening Projects (p. 92)
• Saving Projects (p. 92)
• Saving and Opening Archives (p. 95)
• Moving Projects from Final Cut Pro to Color (p. 95)
• Importing EDLs (p. 101)
• EDL Import Settings (p. 102)
• Relinking Media (p. 104)
• Importing Media Directly into the Timeline (p. 105)
• Compatible Media Formats (p. 106)
• Moving Projects from Color to Final Cut Pro (p. 112)
• Exporting EDLs (p. 114)
• Re conforming Projects (p. 115)
• Converting Cineon and DPX Image Sequences to QuickTime (p. 115)
• Importing Color Corrections (p. 117)
• Exporting JPEG Images (p. 118)
Creating and Opening Projects

When you open Color, you're presented with a dialog from which you can open an existing project or create a new one. Most users will send projects to Color straight from Final Cut Pro, but there are specific workflows that require you to create a new project in Color.

To open an existing project
Do one of the following:

- If Color is already open, choose File > Open (or press Command-O), choose a project from the Projects dialog, then click Open.
- Double-click a Color project file in the Finder.
- Open Color, choose a Color project file using the Projects dialog, then click Open.

Color can have only one project open at a time, so opening a second project closes the one that was originally open.

To create a new project when Color is first opened
1. Open Color.
   The Projects dialog opens to the Default Project Directory you chose when you first opened Color.
2. Click New Project.
   The New Project dialog appears.
3. Type a name for the project in the Name of New Project field, then click Save.
   A new project is created and opened.

To create a new project while Color is open
1. If necessary, save the current project.
   Color can have only one project open at a time, so creating a new project will close the currently open project.
2. Choose File > New (or press Command-N).
3. Click New Project.
   The New Project dialog appears.
4. Type a name for the project in the Name of New Project field, then click Save.
   A new project is created and opened.

Saving Projects

Saving a project works the same way in Color as it does in any other application you've used. As with any application, you should save early and often as you work.
To save a project
- Choose File > Save (or press Command-S).

To revert the project to the last saved state
- Choose File > Revert (or press Command-R).

Color also has an automatic saving mechanism which, when turned on, saves the current project at an interval set by the Auto Save Time (Minutes) parameter in the User Prefs tab of the Setup room. By default, automatic saving is turned on, with the interval set to 5 minutes. For more information, see Auto Save Settings.

*Note:* Whenever you manually save a project, an archive is also automatically saved with the date and time as its name. When a project is automatically saved, an archive is not created. This prevents your archive list from being inundated with entries. For more information, see Saving and Opening Archives.

**What Is a Color Project?**

The only shots that are in your project are those in the Timeline (which are also mirrored in the Shots browser). Color projects only contain a single sequence of shots. Furthermore, Color projects have no organizational notion of shots that aren’t actually in the Timeline, and so they contain no unused media.
The Contents of Color Projects

Color projects are actually bundles. Inside each Color project bundle is a hierarchical series of directories, each of which contains specific components belonging to that project, which are either image or XML files. It’s possible to open a Color bundle using the Show Package Contents command in the Finder. The directory structure and contents of these bundles are described here.

- **Archives directory**: Contains all the saved archives of that project. Each archive is compressed using both .tar and .gzip compression (a “tarball”) and is identified with the .tgz extension.
- **.lsi file**: This is an image file that contains the frame at the position of the playhead when you last saved.
- **.pdl file**: This is the XML-based project file itself, which contains all the information that organizes the shots, timing, and grades used in that project.
- **Shots directory**: Each shot in your project’s Timeline has a corresponding subdirectory here. Each subdirectory contains some or more of the following:
  - **Grade1 (through 4) subdirectories**: These directories contain all the correction files associated with that grade.
  - **ShotName.Lsi file**: This is that shot’s thumbnail as displayed in the Timeline.
  - **ShotName.si file**: This file contains that shot’s name, media path, and timing information.
  - **Grade_Name.date.pcc**: Primary correction description
  - **Grade_Name.date.scc**: Secondary correction description
  - **Grade_Name.date.cfx**: Color FX correction description
  - **PanAndScan subdirectory**: This directory contains a .kfd file that stores keyframe data and a .pns file that stores pan and scan data.
  - **shot_notes.txt file**: If a note is present for that shot, it’s saved here.
- **StillStore directory**: This directory contains all the Still Store images that you’ve saved for reference within that project. Each reference still has two corresponding files, an .lsi file which is that image’s thumbnail icon and a .sri file which is the full-resolution image (saved using the DPX image format).

*Important*: It is *not* recommended that you modify the contents of Color project files unless you know exactly what you’re doing. Making changes manually could cause unexpected problems.
Saving and Opening Archives

An archive is a compressed duplicate of the project that’s stored within the project bundle itself. For efficiency, the archive file lacks the thumbnail and Still Store image files that the full version of the project contains. Archives only save the state of the internal project file, Timeline, shot settings, grades, corrections, keyframes, and Pan & Scan settings, which are easily compressed and occupy little space.

Whenever you manually save your project, an archive is automatically created that is named using the date and time at which it was saved. If you want to save an archive of your project at a particular state with a more easily identifiable name, you can use the Save Archive As command.

To save an archive of the project with a specific name
1. Choose File > Save Archive As (or press Command-Option-S).
2. Type a name into the Archive Name field, then click Archive.

There is no limit to the number of archives you can save, so the archives list can grow quite long. Archives are compressed using both .tar and .gzip (a “tarball”) so they take up little room. All archive files for a particular project are saved in the Archives subdirectory inside that project bundle.

Later, if anything should happen to your project file’s settings, or if you want to return the project to a previously archived state, you can load one of the archive files.

To open an archive
2. Select an archive to open from the Load Archive window, then click Load Archive.

Opening an archive overwrites the current state of the project with that of the archive.

Moving Projects from Final Cut Pro to Color

One of the easiest ways of importing a project is to send a Final Cut Pro sequence to Color using one of two XML-based workflows. This section discusses how to prepare your projects in Final Cut Pro and how to send them using XML. For more information, see:

- Before You Export Your Final Cut Pro Project
- Using the Send To Color Command in Final Cut Pro
- Importing an XML File into Color
- Video Finishing Workflows Using Final Cut Pro
Before You Export Your Final Cut Pro Project
Whether you’re working on your own project, or preparing a client’s project in advance of a Color grading session, you should take some time to prepare the Final Cut Pro sequence you’ll be sending in order to ensure the best results and smoothest workflow. Here are some recommended steps.

Move Clips That Aren’t Being Composited to Track V1 in the Timeline
Editors often use multiple tracks of video to assemble scenes, taking advantage of the track ordering rules in Final Cut Pro to determine which clips are currently visible. It’s generally much faster and easier to navigate and work on a project that has all its clips on a single video track. It’s recommended that you move all video clips that aren’t being superimposed as part of a compositing operation down to track V1.

Remove Unnecessary Video Filters
You aren’t required to remove video filters from a sequence you’re sending to Color. In fact, if there are one or more effects filters that you want to keep, then it’s perfectly fine to leave them in. However, it’s not usually a good idea to allow filters that perform color correction operations (such as Brightness and Contrast, RGB Balance, or Desaturate) to remain in your sequence. Even though they have no effect as you work in Color, they’ll be redundant after you’ve made additional corrections, and their sudden reappearance when the project is sent back to Final Cut Pro may produce unexpected results.

Organize All Color Corrector 3-Way Filters
Color Corrector 3-way filters applied to clips are handled differently; they’re automatically converted into Primary In room adjustments. However, if more than one filter has been applied to a clip, then only the last Color Corrector 3-way filter appearing in the Filters tab is converted; all others are ignored. Furthermore, any Color Corrector 3-way filter with Limit Effects turned on is also ignored.

 Converted Color Corrector 3-way filters are removed from the XML data for that sequence, so that they do not appear in the sequence when it’s sent back to Final Cut Pro.

Note: Because Final Cut Pro is a Y’C₆B₆C₇R processing application, and Color is an RGB processing application, Color Corrector 3-way conversions are only approximations and will not precisely match the original corrections made in Final Cut Pro.

Divide Long Projects into Reels
To better organize rendering and output, and to maximize performance when you work with high-bandwidth formats (such as uncompressed high definition, RED, or DPX media), you should consider breaking long-form projects down into separate 15- to 23-minute sequences (referred to as reels) prior to sending them to Color. While reel length is arbitrary, film reels and broadcast shows often have standard lengths that fall within this range. (Twenty-two minutes is standard for a film reel.) If your project has an unusually large number of edits, you might consider dividing your program into even shorter reels.
Each reel should begin and end at a good cut point, such as the In point of the first shot of a scene, the Out point of the last shot of a scene, or the end of the last frame of a fade to black. As you’re creating your reels, make sure you don’t accidentally omit any frames in between each reel. This makes it easier to reassemble all of the color-corrected reels back into a single sequence when you’re finished working in Color.

**Tip:** Breaking a single program into reels is also the best way for multi-room facilities to manage simultaneous rendering of projects. If you have multiple systems with identical graphics cards and identical versions of Color in each room, you can open a reel in each room and render as many reels simultaneously as you have rooms. Each system must have identical graphics cards as the type of GPU and amount of VRAM may affect render quality. For more information, see The Graphics Card You’re Using Affects the Rendered Output.

### Export Self-Contained QuickTime Files for Effects Clips You Need to Color Correct
Color is incapable of either displaying or working with the following types of clips:

- Generators
- Motion projects

If you want to grade such clips in Color, you need to export them as self-contained QuickTime files and reedit them into the Timeline of your Final Cut Pro sequence to replace the original effects before you send the sequence to Color.

If you don’t need to grade these effects in Color, then you can simply send the project with these clips as they are, and ignore any gaps that appear in Color. Even though these effects won’t appear in Color, they’re preserved within the XML of the Color project and they will reappear when you send that project back to Final Cut Pro.

**Tip:** Prior to exporting a project from Final Cut Pro, you can also export a single, self-contained QuickTime movie of the entire program and then reimport it into your project and superimpose it over all the other clips in your edited sequence. Then, when you export the project to Color, you can turn this “reference” version of the program on and off using track visibility whenever you want to have a look at the offline effects or color corrections that were created during the offline edit.

### Use Uncompressed or Lightly Compressed Still Image Formats
If your Final Cut Pro project uses still image files, then Color supports every still format that Final Cut Pro supports. (Color supports far fewer image file formats for direct import; see Compatible Image Sequence Formats for more information.) For the best results, you should consider restricting stills in your project to uncompressed image formats such as .tiff, or if using .jpg stills, make sure they’re saved at high quality to avoid compression artifacts. If you’ve been using low-quality placeholders for still images in your program, now is the time to edit in the full-resolution versions.
It’s also important to make sure that the stills you use in your Final Cut Pro project aren’t any larger than 4096 x 2304, which is the maximum image size that Color supports. If you’re using larger resolution stills in your project, you may want to export them as self-contained QuickTime files with which to replace the original effects.

To optimize rendering time, Color only renders a single frame for each still image file. When your project is sent back to Final Cut Pro, that clip reappears as a still image clip in the Final Cut Pro Timeline.

**Important:** If any stills in your project are animated using Scale, Rotate, Center, or Aspect Ratio parameter keyframes from Final Cut Pro, these keyframes do not appear and are not editable in Color, but they are preserved and reappear when you send your project back to Final Cut Pro. For more information, see [Exchanging Geometry Settings with Final Cut Pro](#).

**Make Sure All Freeze Frame Effects Are on Track V1**
All freeze frame effects need to be on track V1 for Color to correctly process them. After rendering, freeze frames continue to appear in the sequence that is sent back to Final Cut Pro as freeze frame clips.

**Important:** Freeze frame clips on any other video track will not be rendered, and will reappear after the sequence is sent to Final Cut Pro as the original, ungraded clip.

**Make Sure All Clips Have the Same Frame Rate**
It’s not recommended to send a sequence to Color that mixes clips with different frame rates, particularly when mixing 23.98 fps and 29.97 fps media. The resulting graded media rendered by Color may have incorrect timecode and in or out points that are off by a frame. If you have one or more clips in your sequence with a frame rate that doesn’t match the timebase of the sequence, you can use Compressor to do a standards conversion of the mismatched clips. For more information, see [Rendering Mixed Format Sequences](#).

**Media Manage Your Project, If Necessary**
If you’re delivering a Final Cut Pro project to a Color suite at another facility, you may want to eliminate unused media to save disk space (especially if you’ll be recapturing uncompressed media), and consolidate all the source media used by your project into a single directory for easy transport and relinking. This is also a good step to take prior to recapturing your media, to avoid recapturing unnecessary media.

**Recapture Offline Media at Online Quality, If Necessary**
If the project was edited at offline quality, you need to recapture all the source media at the highest available quality before you send it to Color. Be sure you choose a high-quality codec, either using the native codec that the source footage was recorded with or using one of the supported uncompressed codecs. For more information on which codecs are supported by Color, see [Compatible Media Formats](#).
**Important:** If you’re recapturing or transcoding video clips that were originally recorded with a Y’C₆C₈ format, be sure that the codec you use to recapture, export, or transcode your media doesn’t clamp super-white and overly high chroma components from the original, uncorrected media. It’s usually better to correct out-of-gamut values within Color than it is to clamp these levels in advance, potentially losing valuable image data.

**Check All Transitions and Effects If You Plan to Render 2K or 4K Image Sequences for Film Out**

When rendering out 2K or 4K DPX or Cineon image sequences, all video transitions are rendered as linear dissolves when you use the Gather Rendered Media command to consolidate the finally rendered frames of your project in preparation for film output. This feature is only intended to support film out workflows. Any other type of transition (such as a wipe or iris) will be rendered as a dissolve instead, so it’s a good idea to go through your project and change the type and timing of your transitions as necessary before sending your project to Color.

Furthermore, effects that would ordinarily reappear in a sequence that is sent back to Final Cut Pro, such as speed effects, superimpositions, composites, video filters, motion settings that don’t translate into Pan & Scan parameters, generators, and Motion projects, will not be rendered if you render 2K or 4K DPX or Cineon image sequences for film output. In this case, it’s best to export all such clips as self-contained QuickTime files with which to replace the original effects, before you send the sequence to Color.

**Using the Send To Color Command in Final Cut Pro**

Once you’ve prepared your sequence, you can use the Send To Color command in Final Cut Pro to automatically move your sequence into Color (as long as Final Cut Pro and Color are installed on the same computer).

You can only send whole sequences to Color. It’s not possible to send individual clips or groups of clips from a sequence unless you first nest them inside a sequence.

**To send a sequence from Final Cut Pro to Color**

1. Open the project in Final Cut Pro.
2. Select a sequence in the Browser.
3. Do one of the following:
   - Choose File > Send To > Color.
   - Control-click the selection, then choose Send To > Color from the shortcut menu.
4. Choose a name for the project to be created in Color, then click OK.

   A new Color project is automatically created in the default project directory specified in User Preferences. The shots that appear in the Timeline should match the original Final Cut Pro sequence that was sent.
Don’t Reedit Projects in Color
By default, all the video tracks of projects sent from Final Cut Pro are locked. When you’re grading a project, it’s important to avoid unlocking them or making any editorial changes to the shots in the Color Timeline if you’re planning to send the project back to Final Cut Pro.

If you need to make an editorial change, reedit the original sequence in Final Cut Pro, export a new XML file, and use the Reconform command to update the Color Timeline to match the changes. For more information, see Reconforming Projects. For more information about Final Cut Pro XML files, see the Final Cut Pro 7 User Manual.

Importing an XML File into Color
If you need to deliver a Final Cut Pro sequence and its media to another facility to be graded using Color, you can also use the Export XML command in Final Cut Pro to export the sequence. For more information about exporting XML from Final Cut Pro, see the Final Cut Pro 7 User Manual.

In Color, you then use the Import XML command to turn the XML file into a Color project. To speed up this process, you can copy the XML file you want to import into the default project directory specified by Color.

To import an XML file into Color
1 Do one of the following:
   • Open Color.
   • If Color is already open, choose File > Import > XML.

2 Choose an XML file from the Projects dialog.

3 Click Load.

A new Color project is automatically created in the default project directory specified in User Preferences. The shots that appear in the Timeline should match the original Final Cut Pro sequence that was exported.

Don’t Reedit Imported XML Projects in Color
By default, all the video tracks of imported XML projects are locked. When you’re grading a project, it’s important to avoid unlocking them or making any editorial changes to the shots in the Color Timeline if you’re planning to send the project back to Final Cut Pro.

If you need to make an editorial change, reedit the original sequence in Final Cut Pro, export a new XML file (see the Final Cut Pro 7 User Manual for more information), and use the Reconform command to update the Color Timeline to match the changes. For more information, see Reconforming Projects.
Importing EDLs
You can import an EDL directly into Color. There are two reasons to use EDLs instead of XML files:

- To color correct a video master file: You can approximate a tape-to-tape color correction workflow by importing an EDL and using the Use As Cut List option to link it to a corresponding master media file (either a QuickTime .mov file or a DPX image sequence).

  **Note:** If you’re going to work this way, it’s best to work with uncompressed media and to work in reels of 20 minutes or less to avoid potential performance bottlenecks caused by sequences with an excessive number of edit points.

- To import a 2K digital intermediate project: EDLs are also the only way to import projects as part of a 2K digital intermediate workflow when you’re relinking the project to DPX image sequences from film scans. For more information, see Digital Intermediate Workflows Using DPX/Cineon Media.

Color imports the following EDL formats:
- Generic
- CMX 340
- CMX 3600
- GVG 4 Plus

To speed up the process of importing an EDL, you can copy all EDL files to the default project directory specified by Color.

**To import an EDL**

1. Do one of the following:
   - Open Color.
   - If Color is already open, Choose File > Import > EDL.

2. Choose an EDL file from the Projects dialog.
The EDL Import Settings dialog appears, defaulting to the default project directory specified in the User Prefs tab of the Setup room.

3 Choose the appropriate project properties from the available lists and pop-up menus. For more information, see EDL Import Settings.

4 When you finish choosing all the necessary settings, click Import.

A new project is created, and the EDL is converted into a sequence of shots in the Timeline. The position of each shot should match the Timeline of the original project.

Note: If the Source Directory you specified has any potential media conflicts (for example, two clips with overlapping timecode or a missing reel number), you see a warning dialog that gives you the option of writing a text file log of all potential conflicts to help you sort them out.

EDL Import Settings
The settings in this dialog determine the options used when importing an EDL into Color.

- **EDL Format**: The format of the EDL file you're importing.

- **Project Frame Rate**: The frame rate of the Color project you're about to create. In most cases, this should match the frame rate of the EDL you're importing.

- **EDL Frame Rate**: Choose the frame rate of the EDL you're importing. If the EDL Frame Rate is 29.97 fps but you set the Project Frame Rate to 24 fps, Color will automatically do the necessary conversions to remove 3:2 pull-down from the shots in the project.

  Note: This option lets you deal with workflows where the imported EDL was generated from an offline edit of a project using telecined 29.97 fps video, but the subsequent scanned 2K image sequences were reacquired at film's native 24 fps.

- **Source Frame Rate**: The frame rate of the source media on disk that you're linking to.

- **Use As Cut List**: This checkbox lets you specify that this EDL should be used as a cut list to “notch” a matching video master file.
• **Project Resolution**: The resolution of the Color project you’re creating. In general, this should match the resolution of the source media that you’re linking to.

• **Height**: The height of the selected frame size.

• **Width**: The width of the selected frame size.

• **Source Directory**: The directory specified here directs the EDL parser to the exact path where the DPX or Cineon scans or QuickTime files associated with that project are located. You can specify the location of the source media by typing the directory path into this field, or clicking Browse to use the file browser. There are two methods you use to link an EDL to the source media it corresponds to.

• If you simply choose a directory that contains media, that media will be linked using each clip’s timecode track and reel number. If you’re linking to DPX or Cineon scans, the methods used are described in How Does Color Relink DPX/Cineon Frames to an EDL?

• Choose a Cinema Tools database, if one is available. When you choose a Cinema Tools database associated with the Final Cut Pro project that created an EDL, Cinema Tools is directed to relink the EDL with all associated DPX, Cineon, or even QuickTime media based on information within the database. The advantage of this method is that, in the event of problems, you can troubleshoot the Cinema Tools database independently to resolve the discrepancy before trying to import the EDL into Color. For more information, see Relinking DPX/Cineon Frames to an EDL Using a Cinema Tools Database.

After you initiate EDL import, if the Source Directory you specified has any potential media conflicts (for example, two clips with overlapping timecode or a missing reel number), you see a warning dialog that gives you the option of writing a text file log of all potential conflicts to help you sort them out.

After import, a Match column appears in the Shots browser of the Setup room. This column displays the percentage of confidence that each shot in the Timeline has been correctly linked to its corresponding DPX, Cineon, or QuickTime source media, based on the methods used to do the linking. For more information on how EDLs are linked with DPX or Cineon image sequence frames, see How Does Color Relink DPX/Cineon Frames to an EDL? For more information on the Match column in the Shots browser, see Explanation of Percentages in the Match Column.
**Note:** The source directory you choose can be either a local volume, or a volume on a SAN or LAN with sufficient performance to accommodate the data rate of the project’s media.

- **Browse Button:** This button opens the file browser, allowing you to set the source directory for the EDL you want to import. Choosing a directory populates the Source Directory field.

## Relinking Media

If necessary, you can manually relink media to a Color project. When you use the Relink command, Color matches each shot in the Timeline with its corresponding media file using the following criteria:

- Starting timecode
- Filename

If neither of these criteria matches, you’re given the following warning:

![Warning dialog](image)

If you click Yes and proceed with relinking to a different file, then the original Source In and Source Out values for that shot will be overwritten with those of the new clip.

**To relink every shot in your project**

1. Choose File > Reconnect Media.

2. Choose the directory where the project’s media is saved from the Choose Media Path dialog, then click Choose.

   If that directory contains all the media used by the project, then every shot in the Timeline is automatically relinked. If there are still missing media files, you are warned, and these shots will remain offline; you need to use the Reconnect Media command again to relink them.

**To relink a single shot in the Timeline**

1. Control-click or right-click a shot in the Timeline, then choose Relink Media from the shortcut menu.

2. Choose a clip to relink to from the Select Media To Relink dialog, then click Load.

   If the name and starting timecode of the media file matches that of the shot in the Timeline, the media link is restored.
Importing Media Directly into the Timeline

You also have the option of importing media files to the Timeline directly, which lets you use Color to process digital dailies and convert DPX or Cineon image sequences to suitable QuickTime formats. You can import individual shots, or entire folders of shots.

For more information on doing batch DPX to QuickTime conversions, see Converting Cineon and DPX Image Sequences to QuickTime.

To import a single shot into the Timeline

1. Do one of the following:
   - Choose File > Import > Clip.
   - Click the Setup tab.
2. Use the navigation controls at the top left of the file browser to find the directory containing the media you want to import.

Tip: If the media you need is on another hard drive, click the Up Directory button repeatedly until you’re at the top level of your computer’s directory structure, then double-click the Volumes directory to open it. This will provide you with a list of all the hard drives and partitions that are currently mounted on your system. From here, it should be easy to find the media you need.

3. Double-click the directory to open it, then click to select an individual media file to import into the Timeline.

4. Do one of the following:
   - Double-click the shot in the file browser to edit the shot into the Timeline at the position of the playhead.
   - Drag the shot directly into the Timeline.
   - Click the Import button below that shot’s preview to edit the shot into the Timeline at the position of the playhead.

5. If you import a shot into an empty Timeline in Color, you’ll be asked if you want to change the project settings to match those of the shot you’re importing. Click Yes if you want to do so. (This is recommended.)
Once shots have been placed into the Timeline, save your project.

**To import a folder of shots into the Timeline**

1. Do one of the following:
   - Choose File > Import > Clip.
   - Click the Setup tab.
2. Use the navigation controls at the top left of the file browser to find the directory containing the media you want to import.
   
   *Tip:* If the directory you need is on another hard drive, click the Up Directory button repeatedly until you’re at the top level of your computer’s directory structure, then double-click the Volumes directory to open it. This will provide you with a list of all the hard drives and partitions that are currently mounted on your system. From here, it should be easy to find the directory you need.
3. Click once to select the directory.
   An Import Folder button appears within the file browser.
4. Click the Import Folder button to edit every shot within that folder into the Timeline, one after the other, starting at the position of the playhead.

   *Important:* When you import a folder of shots, all shots that are contained by subfolders within the selected folder are also imported. This makes it convenient to import an entire nested hierarchy of image sequence media that has been organized into multiple individual folders.

**Compatible Media Formats**

Color is compatible with a wide variety of QuickTime files and image sequences. The following sections provide information about all of these formats:

- Compatible QuickTime Codecs for Import
- Compatible Third-Party QuickTime Codecs
- Compatible Image Sequence Formats

**Compatible QuickTime Codecs for Import**

The list of codecs that are supported by Color is limited to high-quality codecs suitable for media exchange and mastering. Codec support falls into four categories, listed in the chart that follows:

- QuickTime codecs that are supported by Color when importing projects and media. (These appear in column 1 of the table below.)
• A subset of codecs that can be used for rendering your final output when Original Format is chosen in the Export Codec pop-up menu of the Project Settings tab of the Setup room. (These appear in column 2.) Original Format is only available when you’ve used the Send To Color command in Final Cut Pro or when you’ve imported a Final Cut Pro file that’s been exported as an XML file.

• By default, only seven codecs are available in the Export Codec pop-up menu for upconverting your source media to a higher-quality format. (These appear in column 3.) These include the Apple ProRes 422, Apple ProRes 422 (HQ), and Apple ProRes 4444 codecs, and the Apple Uncompressed 8-bit 4:2:2 and Apple Uncompressed 10-bit 4:2:2 codecs. Apple ProRes 422 (LT) and Apple ProRes 422 (Proxy) are included for offline media conversions in digital intermediate and other workflows.

• If you’ve installed a video interface from AJA, you should see an additional option—AJA Kona 10-bit RGB.

Important: Many of the codecs in column 1 that Color supports for media import, such as the XDCAM, MPEG IMX, and HDV families of codecs, cannot be rendered using the Original Format option. If the media in your project uses a codec that’s not supported for output, every shot in your project will be rendered using one of the supported codecs listed in column 3. For more information, see Some Media Formats Require Rendering to a Different Format.

<table>
<thead>
<tr>
<th>Supported for import</th>
<th>Supported as original format</th>
<th>Supported as export codec</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animation</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Apple Intermediate Codec</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Apple Pixlet</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Apple ProRes 422 (Proxy)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Apple ProRes 422 (LT)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Apple ProRes 422</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Apple ProRes 422 (HQ)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>AVCHD</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>AVC-Intra</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>DVC PRO 50 - NTSC</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVC PRO 50 - PAL</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DV - PAL</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DV/DVC PRO - NTSC</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVC PRO - PAL</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVC PRO HD 1080i50</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVC PRO HD 1080i60</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Supported for import</td>
<td>Supported as original format</td>
<td>Supported as export codec</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>DVCPRO HD 1080p25</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVCPRO HD 1080p30</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVCPRO HD 720p50</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVCPRO HD 720p60</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DVCPRO HD 720p</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>H.264</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>HDV 720p24</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>HDV 720p25</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>HDV 720p30</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>HDV 1080p24</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>HDV 1080p25</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>HDV 1080p30</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>HDV 1080i60</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>HDV 1080i50</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Photo - JPEG</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>MPEG IMX 525/60 (30 Mb/s)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>MPEG IMX 525/60 (40 Mb/s)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>MPEG IMX 525/60 (50 Mb/s)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>MPEG IMX 625/50 (30 Mb/s)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>MPEG IMX 625/50 (40 Mb/s)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>MPEG IMX 625/50 (50 Mb/s)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Uncompressed 8-bit 4:2:2</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Uncompressed 10-bit 4:2:2</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>XDCAM EX</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>XDCAM HD 1080i50 (35 Mb/s VBR)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>XDCAM HD 1080i60 (35 Mb/s VBR)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>XDCAM HD 1080p24 (35 Mb/s VBR)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>XDCAM HD 1080p25 (35 Mb/s VBR)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>XDCAM HD 1080p30 (35 Mb/s VBR)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>XDCAM HD 422</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
**Compatible Third-Party QuickTime Codecs**
Color supports the following third-party codecs from AJA for import:

- AJA Kona 10-bit Log RGB
- AJA Kona 10-bit RGB
  
  **Note:** The AJA Kona codecs are not installed by QuickTime by default and are available only from AJA.

Color also supports native RED QuickTime files when you install the necessary RED software for Final Cut Studio. For more information, visit [http://www.red.com](http://www.red.com).

**Compatible QuickTime Codecs for Output**
The purpose of Color is to create high-quality, color-corrected media that can be reimported into Final Cut Pro for output to tape, QuickTime conversion, or compression for use by DVD Studio Pro. For this reason, the list of codecs that are supported for rendering out of Color is limited to high-quality codecs suitable for media exchange and mastering.

- **Apple ProRes 422:** A medium-bandwidth, high-quality compressed codec, suitable for mastering standard definition video. Encodes video at 10 bits per channel with 4:2:2 chroma subsampling. Supports a variable bit rate (VBR) of 35 to 50 mbps. Supports any frame size.

- **Apple ProRes 422 (HQ):** A higher-bandwidth version of Apple ProRes 422, suitable for capturing and mastering high definition video. Supports a variable bit rate (VBR) of 145 to 220 mbps. Supports any frame size.

- **Apple ProRes 4444:** The highest-bandwidth version of Apple ProRes, suitable for high definition or digital cinema mastering. Lightly compressed, with a variable bit rate (VBR) depending on frame size and frame rate. (An example is 330 mbps at 1920x1080 60i or 1280x720 60p.) Encodes video at up to 10 bits per channel with 4:4:4 chroma subsampling. Supports a lossless compressed alpha channel, although Color does not render alpha channel data.

- **Uncompressed 8-bit 422:** A completely uncompressed, 8-bit per channel codec with 4:2:2 chroma subsampling. Supports any frame size. Suitable for mastering any format of video.

- **Uncompressed 10-bit 422:** A completely uncompressed, 10-bit per channel codec with 4:2:2 chroma subsampling. Supports any frame size. Suitable for mastering any format of video.
Color also supports the following two offline-quality codecs for workflows in which you convert DPX or Cineon image sequences to offline-quality QuickTime clips for editing. Because they’re so highly compressed, these codecs are not suitable for high-quality mastering. DPX/Cineon conversions to QuickTime clone both the timecode and reel number of each shot. For more information, see Converting Cineon and DPX Image Sequences to QuickTime.

- **Apple ProRes 422 (LT):** A more highly compressed codec than Apple ProRes 422, averaging 100 Mbps at 1920 x 1080 60i and 1280 x 720 60p. Designed to allow low-bandwidth editing at full-raster frame sizes, eliminating awkward frame-size conversions when conforming offline-to-online media for finishing and mastering.

- **Apple ProRes 422 (Proxy):** An even more highly compressed codec than Apple ProRes 422 (LT), averaging 36 Mbps at 1920 x 1080 24p, or 18 Mbps at 1280 x 720 24p. Designed to allow extremely low-bandwidth editing at full-raster frame sizes, eliminating awkward frame-size conversions when conforming offline-to-online media for finishing and mastering.

Color supports the following third-party codec for rendering.

- **AJA Kona 10-bit RGB**

  **Note:** The AJA Kona codecs are not installed by QuickTime by default and are available only from AJA.

You can render your project out of Color using one of several high-quality mastering codecs, regardless of the codec or level of compression that is used by the source media. You can take advantage of this feature to facilitate a workflow where you import compressed media into Color and then export the corrected output as uncompressed media before sending your project to Final Cut Pro. This way, you reap the benefits of saving hard disk space and avoiding rerendering times up front, while preserving all the quality of your high–bit depth adjustments when you render your output media prior to sending your project back to Final Cut Pro.
Which Codec Should You Use for Export?

When choosing the codec you want to use for rendering the final output, there are four considerations:

- If you’ll be outputting to a high-bandwidth RGB format (such as HDCAM SR), or are mastering 2K or 4K RGB media using QuickTime, you should export your media using the Apple ProRes 4444 codec for the highest-quality result. This format is appropriate for mastering at a quality suitable for film out, but the results will require a fast computer and accelerated storage for playback.

- If you’ll be outputting to a high-bandwidth Y′C₈C₉ video format (such as Betacam SP, Digital Betacam, HDCAM, and DVCPRO HD) and require the highest-quality video data available, regardless of storage or system requirements, you should export your media using the Apple Uncompressed 10-bit 4:2:2 codec.

- If you’ll be outputting to one of the above video formats and require high quality, but need to use a compressed format to save hard disk space and increase performance on your particular computer, then you can export using the Apple ProRes 422 codec (good for standard definition) or the higher-quality Apple ProRes 422 (HQ) codec (good for high definition), both of which are 10-bit, 4:2:2 codecs.

- If your system is not set up to output such high-bandwidth video, and your program uses a source format that’s supported by the Original Format option in the QuickTime Export Codecs pop-up menu in the Project Settings tab of the Setup room, you’ll be able to render back to the original codec used by your Final Cut Pro sequence. If your codec is unsupported, the QuickTime Export Codecs pop-up menu will default to Apple ProRes 422. For more information on which codecs can be rendered using the Source Format, see Compatible Media Formats.

Compatible Image Sequence Formats

Although Color supports a wide variety of image formats for clips that are edited into Final Cut Pro projects that are sent to Color, the list of supported image formats that you can import directly into Color is much shorter. The following RGB-encoded image formats are compatible with Color, and are primarily intended for importing image sequences directly into the Color Timeline.

- **Cineon (import and export):** A high-quality image format developed by Kodak for digitally scanning, manipulating, and printing images originated on film. Developed as a 10-bit log format to better contain the greater latitude of film for exposure.

- **DPX (import and export):** The Digital Picture eXchange format was derived from the Cineon format and is also used for high-quality uncompressed digital intermediate workflows. Color supports 8-bit and 10-bit log DPX and Cineon image files.
• **TIFF (import only):** The Tagged Image File Format is a commonly used image format for RGB graphics on a variety of platforms. Color is compatible with 16-bit TIFF sequences.

• **JPEG (import only):** A highly compressed image format created by the Joint Photographic Experts Group. The amount of compression that may be applied is variable, but higher compression ratios create visual artifacts, visible as discernible blocks of similar color. JPEG is usually used for offline versions of image sequences, but in some instances (with minimal compression) this format may be used in an online workflow. JPEG is limited to 8-bit encoding.

• **JPEG 2000 (import only):** Developed as a high-quality compressed format for production and archival purposes, JPEG 2000 uses wavelet compression to allow compression of the image while avoiding visible artifacts. Advantages include higher compression ratios with better visible quality, options for either lossless or lossy compression methods, the ability to handle both 8- and 16-bit linear color encoding, error checking, and metadata header standardization for color space and other data.

*Important:* Only Cineon and DPX are supported for rendering image sequences out of Color.

### Moving Projects from Color to Final Cut Pro

Once you finish grading your project in Color, there are two ways of moving it back to Final Cut Pro if you’re planning on mastering on video. For more information, see:

• **Sending Your Project Back to Final Cut Pro.**
• **Exporting XML for Final Cut Pro Import.**
• **Revising Projects After They’re Sent to Final Cut Pro.**

### Sending Your Project Back to Final Cut Pro

After you grade your project in Color, you need to render it (described in *The Render Queue*) and then send it back to Final Cut Pro. This is accomplished using XML, as your Color project is automatically converted to XML data and then reconverted to a Final Cut Pro sequence. There are two ways you can initiate this process.

*Important:* Projects using Cineon or DPX image sequences can’t be sent back to Final Cut Pro.

**To send a graded, rendered project to Final Cut Pro using the Send To command**

1 Go through the Timeline and choose which grade you want to use for each of the clips in your project.

Since each shot in your program may have up to four separately rendered versions of media in the render directory, the rendered media that each shot is linked to in the exported XML project file is determined by its currently selected grade.
2 Choose File > Send To > Final Cut Pro.

There are two possible warnings that may come up at this point:

- If you haven’t rendered every shot in Color at this point, you are warned. It’s a good idea to click No to cancel the operation and render all of your shots prior to sending the project back to Final Cut Pro.

- If the codec or frame size has been changed, either by you or as a result of rendering your media to a mastering quality format, you are presented with the option to change the sequence settings of the sequence being sent. For more information, see Some Media Formats Require Rendering to a Different Format.

A new sequence is automatically created within the original Final Cut Pro project from which the program came. However, if the Final Cut Pro project the program was originally sent from is unavailable, has been renamed, or has been moved to another location, then a new Final Cut Pro project will be created to contain the new sequence. Either way, every clip in the new sequence is automatically linked to the color-corrected media you rendered out of Color.

**Exporting XML for Final Cut Pro Import**

Another way of moving a Color project back to Final Cut Pro is to export an XML version of your Color project.

**To export an XML file back to Final Cut Pro for final output**

1 Go through the Timeline and choose which grade you want to use for each of the clips in your project.

Since each shot in your program may have up to four separately rendered versions of media in the render directory, the rendered media that each shot is linked to in the exported XML project file is determined by its currently selected grade.

2 Chose File > Export > XML.

3 When the Export XML Options dialog appears, click Browse.

4 Enter a name for the XML file you’re exporting in the File field of the Export XML File dialog.

5 Choose a location for the file, then click Save.

6 Click OK.

A new XML project file is created, and the clips within are automatically linked to the media directory specified in the Project Settings tab in the Setup room.

*Note:* If you haven’t exported rendered media from your Color project yet, the XML file is linked to the original project media.
Revising Projects After They’re Sent to Final Cut Pro
If you need to make revisions to the color corrections of a sequence that you’ve already
sent from Color to Final Cut Pro, don’t send the sequence named “from Color” back to Color.
The correct method is to quit Final Cut Pro, reopen the originating Color project, make
your changes, and then do one of the following:

• If you didn’t change the grade number used by any of the shots in Color, simply rerender the clips you changed, save the Color project, and then reopen the Final Cut Pro project that has the sequence that was originally sent “from Color.” The rerendered media overwrites the previous media, and is immediately reconnected when you reopen the Final Cut Pro project.

• If you do change the grade number of any of the shots in Color, you need to send the project back to Final Cut Pro, and use the new “from Color” sequence to finish your program.

This makes it easier to manage your media, easier to keep track of your revisions, and prevents any of your clips from being rendered twice unnecessarily.

Exporting EDLs
You can export EDLs out of Color, which can be a good way of moving projects back to other editorial applications. When exporting an EDL, it’s up to the application with which you’ll be importing the EDL to successfully relink to the media that’s rendered out of Color.

Note: To help facilitate media relinking, the media path is written to the comment column in the exported EDL, although not all editing applications support this convention.

To export an EDL
1 Choose File > Export > EDL.
2 When the Export EDL dialog appears, click Browse.
3 Enter a name for the EDL you’re exporting in the File field of the Export EDL File dialog, choose a location for the file, then click Save.
4 If you didn’t change any of the shot names when you exported the final rendered media for this project, turn on “Use original media name.”
5 Click OK.

A new EDL file is created, and the clips within are linked to the media directory you specified.
Reconforming Projects

Whether your project was sent from Final Cut Pro, or imported via an EDL from any other editing environment, you have the option of automatically reconforming your Color project to match any editorial changes made to the original Final Cut Pro sequence, which can save you hours of tedious labor.

Color matches each project to the sequence that was originally sent to Color using an internal ID number. Because of this, you can only reconform by reediting the actual sequence that you originally sent to Color. Any attempt to reconform a duplicate of the original sequence will not work.

**To reconform an XML-based Color project**

1. Export an updated XML file of the reedited Final Cut Pro sequence from Final Cut Pro.
2. Open the Color project you need to update, then choose File > Reconform.
3. Select the XML file that was exported in step 1 using the Reconform XML dialog, then click Load.

The shots in the Timeline should update to reflect the imported changes, and the Reconform column in the Shots browser is updated with the status of every shot that was affected by the Reconform operation.

You can also reconform projects that were originally imported using EDLs.

**To reconform an EDL-based Color project**

1. Export an updated EDL of the reedited sequence from the originating application.
2. Open the Color project you need to update, then choose File > Reconform.
3. Select the EDL file that was exported in step 1 using the Reconform dialog, then click Load.

As is the case when you reconform an XML-based project, the Reconform column in the Shots browser in the Setup room is updated with the status of each shot that’s been modified by the Reconform operation. This lets you identify shots that might need readjustment as a result of such changes, sorting them by type for fast navigation. For more information, see Column Headers in the Shots Browser.

Converting Cineon and DPX Image Sequences to QuickTime

You can use Color to convert Cineon and DPX image sequences to QuickTime files to facilitate a variety of workflows.

- If you’re starting out with 2K or 4K DPX or Cineon film scans or digital camera output, you can downconvert matching QuickTime media files at offline resolution by choosing a smaller resolution preset, and choosing ProRes 422 as the QuickTime export codec. You can then use this media to do an offline edit.
• Alternately, you can convert 2K and 4K DPX and Cineon image sequences into finishing-quality QuickTime media files by simply choosing ProRes 4444 as the QuickTime export codec.

• If your project media is in the QuickTime format, but you want to output a series of Cineon or DPX image sequences, you can do this conversion as well.

The timecode of converted DPX or Cineon film scans is copied to the new media that’s created. This allows you to track the correspondence between the QuickTime clips you generate, and the original image sequences from which they came. This conversion uses the following rules:

• Timecode header metadata in DPX or Cineon files, if present, is converted into a timecode track in each converted QuickTime file.

• If there is no timecode header data in the DPX or Cineon files, then the frame numbers used in the filename of the image sequence are converted into timecode and written to the timecode track of the converted QuickTime files. (For more information, see Required Image Sequence Filenaming.)

• If a directory containing DPX or Cineon image sequences has the reel number of those sequences as its name (highly recommended), that number will be used as the reel number of the converted QuickTime files.

When converting from Cineon and DPX to high definition or standard definition QuickTime video (and vice versa), Color automatically makes all necessary color space conversions. Log media is converted to linear, and Rec. 701 and 601 color spaces are taken into account.

To convert Cineon or DPX image sequences to QuickTime media

1 Create a new, empty project. (For more information, see Creating and Opening Projects.)

2 Using the file browser, select the folder that contains all of the shots you want to convert, and click the Import Folder button to edit every shot within that folder into the Timeline. When you import a folder of shots, all shots that are contained by subfolders within the selected folder are also imported. This makes it convenient to import an entire nested hierarchy of image sequence media that has been organized into multiple individual folders. For more information about importing media into the Timeline, see Importing Media Directly into the Timeline.

3 Open the Project Settings tab of the Setup room, and do the following:
   a Click Project Render Directory, choose a render directory for the converted media, then click Choose.
   b Choose QuickTime from the Render File Type pop-up menu.
   c Choose a resolution from the Resolution Presets pop-up menu.
Choose the codec you want to convert the image sequences to from the Export Codec pop-up menu. (For more information about choosing a suitable output codec, see Compatible QuickTime Codecs for Output.)

4 If necessary, grade the shots to make any corrections to the offline media that you’ll be generating.

Sometimes, the source media from a particular camera or transfer process needs a specific color correction or contrast adjustment in order to look good during the offline edit. If this is the case, you can use a single correction to adjust every shot you’re converting (the equivalent of a one-light transfer). At other times, you’ll want to individually correct each shot prior to conversion to provide the best-looking media you can for the editing process (the equivalent of a best-light transfer).

Tip: To quickly apply a single correction to every shot in the Timeline, grade a representative shot in the Primary In room, then click Copy to All.

5 Open the Render Queue, then click Add All.

6 Click Start Render.

All of the shots are converted, and the rendered output is written to the currently specified render directory.

Important: After you’ve rendered the converted output, it’s a good idea to save the Color project file you created to do the conversion, in case you need to reconvert the media again. You might do this to improve the “one-light” color correction you applied to the converted media, or to change the codec used to do the conversion. Keeping the original conversion project makes it easy to reconvert your media in the same order, with the same automatically generated file names, so you can easily reconnect a Final Cut Pro sequence containing previously converted media to a new set of reconverted media.

For more information about options in the Render File Type, Resolution Presets, and Export Codec pop-up menus, see Resolution and Codec Settings.

Importing Color Corrections

The File > Import > Color Corrections command lets you apply the grades and color corrections from the shots of one project file to those within the currently open project. It’s meant to be used with Color projects that are based on the same source, so that a newly imported version of a project you’ve already been working on can be updated with all the grades that were applied to the previous version.

For this command to work properly, the project you’re importing the color corrections from must have the same number of shots in the Timeline as the project you’re applying the imported color corrections to. The shot numbers in each project are used to determine which color correction is copied to which shot. For example, the color correction from shot 145 in the source project is copied to shot 145 in the destination project.
After using this command, all grades in the destination project are overwritten with those from the source.

To import the color corrections from one project to another
1. Open the Color project into which you want to import the corrections.
2. Choose File > Import > Color Corrections.
3. In the Projects dialog, select the Color project containing the corrections you want to import, then click Load.

The shots in the currently open project are updated with the color corrections from the other project file.

Exporting JPEG Images
Color also provides a way of exporting a JPEG image of the frame at the position of the playhead. JPEG images are exported at the current size of the Preview area of the Scopes window.

To export a JPEG image of the frame at the current position of the playhead
1. Move the playhead to the frame you want to export.
2. Choose Export > JPEG Still.
3. Enter a name in the File field and select a directory using the Save Still As dialog.
   
   **Note:** This defaults to the Still Store subdirectory inside the project bundle.
4. Click Save.

The frame is saved as a JPEG image to the location you selected. JPEG images are exported with a frame size that matches the size of the Preview area of the Scopes window.
Before you start working on your project, take a moment to configure your Color working environment and project settings in the Setup room.

The Setup room serves many purposes. It’s where you import media files, sort and manage saved grades, organize and search through the shots used in your program, choose your project’s render and broadcast safe settings, and adjust user preferences.

This chapter covers the following:

• The File Browser (p. 119)
• Using the Shots Browser (p. 122)
• The Grades Bin (p. 128)
• The Project Settings Tab (p. 129)
• The Messages Tab (p. 135)
• The User Preferences Tab (p. 135)

The File Browser
The file browser, occupying the left half of the Setup room, lets you directly navigate the directory structure of your hard disk. It’s like having a miniature Finder right there in the Setup room. Keep in mind that the file browser is not a bin. The files displayed within the file browser are not associated with your Color project in any way unless you drag them into the Timeline manually or relink the shots of an imported project to their associated media files on disk using the Relink Media or Reconnect Media command.
By default, the file browser displays the contents of the default media directory when Color opens.

For more information on how to use the file browser, see Importing Media Directly into the Timeline. For more information on importing project data from other applications, see Importing and Managing Projects and Media.

**File Browser Controls**
These two buttons are at the top of the file browser.

- **Up Directory button**: Moves to the next directory up the current file path.
- **Home Directory button**: Moves to the currently specified default media directory.
Media Information and DPX/Cineon Header Metadata

When you click a shot to select it, an enlarged thumbnail appears to the right of the list of media.

Underneath the thumbnail, information appears about the shot, including its name, duration, resolution, frame rate, and timecode. If it’s an image sequence, its white point, black point, and transfer mode metadata also appear. Depending on the type of media, one or two buttons may appear at the bottom of the file browser.

Fix Headers Button

If the selected shot (or shots) is an image sequence, the Fix Headers button appears. Clicking it opens the DPX Header Settings window, which lets you change the transfer mode (Linear or Logarithmic), the Low Reference (black point) and High Reference (white point), of DPX and Cineon image sequences that may have incorrect data in the headers. Change the parameters to the necessary settings and click Fix to rewrite this header data in all of the currently selected shots.
Import Button
Selecting one or more shots and clicking Import edits the selection into the end of the current Timeline for an unlocked project. This is useful if you’re using Color to convert DPX or Cineon image sequences to QuickTime, or vice versa. For more information, see Importing Media Directly into the Timeline.

Note: You cannot import media into locked projects. This includes any project sent from Final Cut Pro.

Using the Shots Browser
The Shots browser lists every shot used by the current program that appears in the Timeline.

This bin can be used for sorting the shots in your program using different criteria, selecting a group of shots to apply an operation to, or selecting a shot no matter where it appears in the Timeline. For more information, see:

• Shots Browser Controls
• Column Headers in the Shots Browser
• Customizing the Shots Browser
• Adding Notes to Shots in the Shots Browser
• Selecting Shots and Navigating Using the Shots Browser

Shots Browser Controls
These controls are used to control both what and how items are viewed in the Shots browser.

• Icon View button: Click to put the shot area into icon view.
• List View button: Click to put the shot area into list view.
• Shots browser: Each shot in your project appears here, either as a thumbnail icon or as an entry (in list view).
Choosing the Current Shot and Selecting Shots in the Shots Browser

Icons or entries in the Shots browser are colored based on their selected state.

- **Dark gray**: The shot is not currently being viewed, nor is it selected.
- **Light gray**: The shot at the current position of the playhead is considered to be the current shot and is highlighted with gray in both the Timeline (at the bottom of the screen) and the Shots browser. The current shot is the one that’s viewed and that is corrected when the controls in any room are adjusted.
- **Cyan**: You can select shots other than the current shot. Selected shots are highlighted with cyan in both the Timeline and the Shots browser. To save time, you can apply grades and corrections to multiple selected shots at once.

Goto Shot and Find Fields in the Shots Browser

The Goto Shot and Find fields let you jump to and search for specific shots in your project. These fields work with the Shots browser in either icon or list view modes.

To go to a specific shot

- Enter a number in the Goto Shot field, then press Enter.

The list scrolls down to reveal the shot with that number, which is automatically selected, and the playhead moves to the first frame of that shot in the Timeline.

To search for a specific shot

1. Click the header of the column of data you want to search.
2. Enter a name in the Search field.

As soon as you start typing, the Shots browser empties except for those items that match the search criteria. As you continue to type, the Shots browser dynamically updates to show the updated list of corresponding items.

**Note:** All searches are performed from the first character of data in the selected column, read from left to right. The Find function is not case-sensitive.

To reveal all shots after a Find operation

- Select all of the text in the Find field, then press Delete.

All shots should reappear in the Shots browser.
Column Headers in the Shots Browser

When the Shots browser is in list view, up to nine columns of information are visible.

- **Shots Browser Column Headers**: These columns appear when the Shots browser is in list view.
  - **Number**: Lists a shot's position in the edit. The first shot is 1, the second is 2, and so on.
  - **Shot Name**: The name of that shot, based on its filename.
  - **Colorist**: Lists the name that occupied the Colorist field in the Project Settings when that shot was last corrected. This column is useful for keeping track of who worked on which shots when multiple colorists are assigned to a project.
  - **Status**: Shows that shot's rendered status. You can right-click on this column for any selected shot and choose a new state from the shortcut menu. For more information on the five possible render states, see Possible Render States in the Status Column.
  - **Reconform**: Lists whether that shot has been affected by a Reconform operation. For example, you can sort by this column to quickly identify and navigate to new shots that aren't yet graded because they were added to the Timeline as a result of a Reconform operation. For more information on reconforming a project, see Reconforming Projects. For more information on the four possible Reconform flags, see Possible Flags in the Reconform Column.
  - **Time Spent**: This column appears only when the Show Time button below the Shots browser is turned on. It shows how much time has been spent grading that particular shot. Color keeps track of how long you spend working on each shot in each program, in order to let you track how fast you've been working.
  - **Notes**: The Notes column provides an interface for storing and recalling text notes about specific shots. Shots with notes appear with a checkmark in this column.
  - **Match**: The Match column only appears when a project has been created by importing an EDL into Color. This column displays the percentage of confidence that each shot in the Timeline has been correctly linked to its corresponding DPX, Cineon, or QuickTime source media. The confidence value is based on the methods used to do the linking. For more information, see Explanation of Percentages in the Match Column.

Possible Render States in the Status Column

Each shot has one of five possible render states that appear in the Status column of the Shots browser:

- **Queued**: The shot has been added to the Render Queue.
- **Rendering**: The shot is currently being rendered.
- **Rendered**: The shot has been successfully rendered.
• **To Do:** The shot has not yet been corrected in any room.
• **Aborted:** Rendering of this shot has been stopped.

**Possible Flags in the Reconform Column**
Each shot that has been affected by a Reconform operation has one of four possible flags that appear in the Reconform column of the Shots browser:

• **Shorten:** The shot has been shortened.
• **Content Shift:** The shot’s duration and position in the Timeline are the same, but its content has been slipped.
• **Moved:** The shot has been moved to another position in the Timeline.
• **Added:** This shot has been added to the project.

**Explanation of Percentages in the Match Column**
The Match column displays the percentage of confidence that each shot in the Timeline has been correctly linked to the corresponding DPX, Cineon, or QuickTime source media, based on the methods used to do the linking. The percentages displayed correspond to the following linking methods:

• 100% confidence means the timecode for that shot in the EDL matched the timecode found in the header data of the corresponding DPX or Cineon frame, and the EDL reel number matched the name of the directory in which that frame appears.

• 75% confidence means the timecode for that shot in the EDL matched the frame number of that DPX or Cineon frame, and the EDL reel number matched the name of the directory in which that frame appears. For more information on timecode–to–frame number conversions, see Required Image Sequence Filenaming.

• 50% confidence means the timecode for that shot in the EDL matched the timecode found in the header data of the corresponding DPX or Cineon frame, but the reel number could not be matched to the name of the directory in which that frame appears.

• 25% confidence means the timecode for that shot in the EDL matched the frame number of that DPX or Cineon frame, but the reel number could not be matched to the name of the directory in which that frame appears. For more information on timecode–to–frame number conversions, see Required Image Sequence Filenaming.

• 0% confidence means that no media could be found to match the timecode for that shot in the EDL, and the shot is offline in the Color Timeline.

**Customizing the Shots Browser**
The following procedures describe ways you can sort and modify the Shots browser.
**To sort the Shots browser by any column**
- Click a column’s header to sort by that column.

Shots are sorted in descending order only. Numbers take precedence over letters, and uppercase takes precedence over lowercase.

**To resize a column in the Shots browser**
- Drag the right border of the column you want to resize.

**To reveal or hide the Time Spent column**
- Click Show Time, located underneath the Shots browser.

---

**Adding Notes to Shots in the Shots Browser**
Color provides an interface for keeping track of client or supervisor notes on specific shots as you work on a project.

**To add a note to a shot, or to read or edit an existing note**
1. Open the Setup room, then click the Shots tab.
2. Control-click or right-click the Notes column of the Shots browser, then choose Edit File from the shortcut menu.
   A plain text editing window appears.
3. Enter your text.
4. To save the note and close it, do one of the following:
   - Press Command-S, then close the window.
   - Close the window and click Save in the dialog that appears.
When you’ve added a note to a shot, a checkmark appears in the Notes column.

To remove a note from a shot
- Control-click or right-click the Notes column of the Shots browser, then choose Delete File from the shortcut menu.

**Note:** Notes are saved within the subdirectory for that particular shot, within the /shots/ subdirectory inside that project bundle. Removing a note deletes the note file.

**Selecting Shots and Navigating Using the Shots Browser**
You can use the Shots browser to quickly find and select specific shots—for example, to apply a single grade to a group of shots at once. You can also use the Shots browser to quickly navigate to a particular shot in the Timeline. These procedures work whether the Shots browser is in icon or list view.

**To select one or more shots**
Do one of the following:
- Click any shot in the Shots browser to select that shot.
- Command-click any group of shots to select a noncontiguous group of shots.
- Click any shot, and then Shift-click a second shot to select a contiguous range of shots from the first selection to the second.

Selected shots appear with a cyan overlay.

**To navigate to a specific shot in the Timeline using the Shots browser**

Do one of the following:

- Double-click any shot.
- Type a number into the Goto Shot field.

The new current shot turns gray in the Shots browser, and the playhead jumps to the first frame of that shot in the Timeline. That shot is now ready to be corrected using any of the Color rooms.

### The Grades Bin

The Grades bin in the Setup room lets you save and manage *grades* that you can use in your programs.

A grade, as described in *Using the Color Interface*, can contain one or more of the following individual corrections:

- Primary
- Secondary
- Color FX
- Primary Out
By applying a grade to one or more shots, you can apply multiple corrections all at once. Grades saved into the Grades bin are available to all Color projects opened while logged into that user account. The Grades bin can display grades in either icon or list view, and shares the same controls as the other bins in Color. For more information on using the Grades bin controls, see Using Organizational Browsers and Bins.

For more information on saving and applying grades, see Saving Grades into the Grades Bin.

The Project Settings Tab
The options in the Project Settings (Prjct Settings) tab are saved individually on a per-project basis. They let you store additional information about that project, adjust how the project is displayed, and specify how the shots in that project will be rendered.

For more information, see:
• Informational and Render Directory Settings
• Resolution and Codec Settings
• Broadcast Safe Settings
• Handles

Informational and Render Directory Settings
These settings provide information about Color and your project and let you set up the directory into which media generated by that project is written.

• Project Name: The name of the project. This defaults to the name of the project file on disk, but you can change it to anything you like. Changing the project name does not change the name of the project file.
• **Render Dir:** The render directory is the default directory path where media files rendered for this project are stored. (For more information about rendering Color projects, see The Render Queue.) It's always best to choose the appropriate location for the render directory before you add items to the Render Queue, to make sure your shots are rendered in the correct location. If the specified render directory becomes unavailable the next time you open a project, you will be prompted to choose a new one.

• **Project Render Dir button:** Clicking this button lets you select a new project render directory using the Choose Project Render Directory dialog.

• **Colorist:** This field lets you store the name of the colorist currently working on the project. This information is useful for identifying who is working on what in multi-suite post-production facilities, or when moving a project file from one facility to another.

• **Client:** This field lets you store the name of the client of the project.

**Resolution and Codec Settings**
These settings let you set up the display and render properties of your project. They affect how your program is rendered both for display purposes, and when rendering the final output.

• **Display LUT:** A display LUT (look up table) is a file containing color adjustment information that's typically used to modify the monitored image that's displayed on the preview and broadcast displays. LUTs can be generated to calibrate your display using hardware probes, and they also let you match your display to other characterized imaging mediums, including digital projection systems and film printing workflows. If you've loaded a display LUT as part of a color management workflow, this field lets you see which LUT file is being used. For more information on LUT management, see Monitoring Your Project.
• **Frame Rate:** This field displays the frame rate that the project is set to. Your project’s frame rate is set when the project is created, and it can be changed by a pop-up menu so long as no shots appear in the Timeline. Once one or more shots have been added to the Timeline, the project’s frame rate cannot be changed.

• **Resolution Presets pop-up menu:** This pop-up menu lists all of the project resolutions that Color supports, including PAL and NTSC standard definition, high definition, 2K and 4K frame sizes. The options that are available in this menu are sometimes limited by the currently selected QuickTime export codec.

If you change the Resolution Preset to a different frame size than the one the project was originally set to, how that frame size affects the final graded media that is rendered depends on the source media you’re using, and the Render File Type you’ve chosen:

• If you’re rendering QuickTime media, each shot in your project is rendered at the same frame size as the original source media. The new Resolution Preset you choose only affects the resolution of the sequence that is sent back to Final Cut Pro. Pan & Scan settings are converted to Motion tab settings when the project is sent back to Final Cut Pro.

• If your project uses 4K native RED QuickTime media, each shot in your project is rendered at the new resolution you’ve specified. Any Pan & Scan tab adjustments you’ve made are also rendered into the final media. (2K native RED QuickTime media is rendered the same as other QuickTime media.)

• If the Render File Type pop-up menu is set to DPX or Cineon, then each shot in your project is rendered at the new resolution you’ve specified. Any Pan & Scan tab adjustments you’ve made are also rendered into the final media.

*Important:* Whenever you change resolutions, a dialog appears asking “Would you like Color to automatically scale your clips to the new resolution?” Clicking Yes automatically changes the Scale parameter in the Pan & Scan tab of the Geometry room to conform each clip to the new resolution, letterboxing or pillarboxing clips as necessary to avoid cropping. Clicking No leaves the Scale parameter of each clip unchanged, but may result in the image being cropped if the new resolution is smaller than the previous resolution.

If the QuickTime export codec allows custom frame sizes, the width and height fields below can be edited. Otherwise, they remain uneditable. If these fields are set to a user-specified frame size, the Resolution Presets pop-up menu displays “custom.”

• **Width:** The currently selected width of the frame size

• **Height:** The currently selected height of the frame size
• **Printing Density pop-up menu:** This pop-up menu can only be manually changed when the Render File Type is set to DPX. It lets you choose how to map 0 percent black and 100 percent white to the minimum and maximum numeric ranges that each format supports. Additionally, the option you choose determines whether or not super-white values are preserved. For more information, see Choosing Printing Density When Rendering DPX Media.

  **Note:** Choosing Cineon as the Render File Type limits the Printing Density to Film (95 Black - 685 White : Logarithmic), while choosing QuickTime as the Render File Type limits it to Linear (0 Black - 1023 White).

• **Render File Type pop-up menu:** This parameter is automatically set based on the type of media your project uses. If you send a project from Final Cut Pro, this parameter is set to QuickTime, and is unalterable. If you create a Color project from scratch, this pop-up menu lets you choose the format with which to render your final media. When working on 2K and 4K film projects using image sequences, you'll probably choose Cineon or DPX, while video projects will most likely be rendered as QuickTime files.

• **Deinterlace Renders:** Turning this option on deinterlaces all shots being viewed on the preview and broadcast displays and also deinterlaces media that’s rendered out of Color.

  **Note:** Deinterlacing in Color is done very simply, by averaging both fields together to create a single frame. The resulting image may appear softened. There is also a deinterlacing parameter available for each shot in the Shot Settings tab next to the Timeline, which lets you selectively deinterlace individual shots without deinterlacing the entire program. For more information, see The Settings 2 Tab.

• **Deinterlace Previews:** Turning this option on deinterlaces all shots being viewed on the preview and broadcast displays but media rendered out of Color remains interlaced.

• **QuickTime Export Codecs pop-up menu:** If QuickTime is selected in the Render File Type pop-up menu, this pop-up menu lets you choose the codec with which to render media out of your project. If this menu is set to Original Format, the export codec will automatically match the codec specified in the sequence settings of the originating Final Cut Pro sequence. (This option is only available when using the Send To Color command or when importing an exported Final Cut Pro XML file.)

  The QuickTime Export codec does not need to match the codec used by the source media. You can use this menu to force Color to upconvert your media to a minimally compressed or uncompressed format. The options in this pop-up menu are limited to the QuickTime codecs that are currently supported for rendering media out of Color.
**Note:** You can render your project out of Color using one of several high-quality mastering codecs, regardless of the codec or level of compression that is used by the source media. You can use the QuickTime Export Codecs pop-up menu to facilitate a workflow where you import compressed media into Color and then export the corrected output as uncompressed media before sending your project to Final Cut Pro. This way, you reap the benefits of saving hard disk space and avoiding rerendering times up front, while preserving all the quality of your high–bit depth adjustments when you render your output media prior to sending your project back to Final Cut Pro. The codecs most suitable for mastering include Apple Uncompressed 8-bit 4:2:2, Apple Uncompressed 10-bit 4:2:2, Apple ProRes 422, and Apple ProRes 422 (HQ). For more information, see Compatible QuickTime Codecs for Output.

**Broadcast Safe Settings**

When color correcting any program destined for broadcast, it’s important to obtain the specific quality control (QC) guidelines from the broadcaster. There are varying standards for the maximum and minimum allowed IRE, chroma, and composite amplitude, and some broadcasters are more conservative than others.

The Broadcast Safe settings let you set up Color to limit the minimum and maximum luma, chroma, and composite values of shots in your program. These settings are all completely customizable to accommodate any QC standard and prevent QC violations.

<table>
<thead>
<tr>
<th>Broadcast Safe</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ceiling IRE</td>
<td>100.000000</td>
</tr>
<tr>
<td>Floor IRE</td>
<td>0.000000</td>
</tr>
<tr>
<td>Amplitude</td>
<td>0.000000</td>
</tr>
<tr>
<td>Phase</td>
<td>0.000000</td>
</tr>
<tr>
<td>Offset</td>
<td>0.000000</td>
</tr>
<tr>
<td>Chroma Limit</td>
<td>50.000000</td>
</tr>
<tr>
<td>Composite Limit</td>
<td>110.000000</td>
</tr>
</tbody>
</table>

- **Broadcast Safe button:** Turning on Broadcast Safe enables broadcast legalization for the entire project, affecting both how it’s displayed on your secondary display and broadcast monitor and how it’s rendered for final output. This button turns the following settings on and off:
  - **Ceiling IRE:** Specifies the maximum luma that’s allowable, in analog IRE units. Signals with luma above this limit will be limited to match this maximum value.
  - **Floor IRE:** Specifies the minimum luma that’s allowable, in analog IRE units. Signals with luma below this limit will be limited to match this minimum value.
  - **Amplitude:** This is not a limiting function. Instead, it lets you apply an adjustment to the amplitude of the chroma. The default value of 0 results in no change.
• Phase: Lets you adjust the phase of the chroma. If Amplitude is set to 0, no change is made.

• Offset: Lets you adjust the offset of a chroma adjustment. If Amplitude is set to 0, no change is made.

• Chroma Limit: Sets the maximum allowable saturation. The chroma of signals with saturation above this limit will be limited to match this maximum value.

• Composite Limit: Sets the maximum allowable combination of luma and chroma. Signals exceeding this limit will be limited to match this maximum value.

---

**Ways of Using Broadcast Safe**

The Broadcast Safe parameters can be set to match the required QC guidelines for your program. When enabled, they guarantee that your program will not exceed these standards while you monitor your program and when you render the finally corrected media. There are three ways you can limit broadcast levels in your program.

**Turn Broadcast Safe On, and Leave It Turned On While You Make Your Adjustments**

The safest way to work (and the default behavior of new projects) is to simply turn Broadcast Safe on at the beginning of your work, and leave it on throughout your entire color correction pass. With practice, you can tell if a highlight or shadow is being crushed too much by looking at the image on the monitor and watching for clumping exhibited at the top and bottom of the graphs in the Waveform scope. If the image is being clipped more than you prefer, you can make a correction to adjust the signal.

**Turn Broadcast Safe Off While Making an Adjustment, Then Turn It Back On to Render Output**

If you leave Broadcast Safe on, illegal portions of the signal are always limited, and it can be difficult to see exactly how much data is being clipped. When you’re color correcting media that was consistently recorded with super-white levels and high chroma, you may find that it’s sometimes a good idea to turn the Broadcast Safe settings off while you do an initial color correction pass, so you can more easily see which parts of the signal are out of bounds and make more careful judgments about how you want to legalize it.

**Turn Enable Clipping On for Individual Shots in Your Program**

The Enable Clipping button in the Basic tab of the Primary Out room lets you set ceiling values for the red, green, and blue channels for individual shots in your program (RGB clipping). This lets you prevent illegal broadcast values in shots to which you’re applying extreme primary, secondary, or Color FX corrections, without turning on Broadcast Safe for the entire program. If Enable Clipping and Broadcast Safe are both on, the lowest standard is applied. For more information, see Ceiling Controls.
Handles
This field lets you specify a duration of extra media to be added to the head and tail of each media file that’s rendered out of Color. When a project is sent back to Final Cut Pro, handles allow editors to make small adjustments without running out of corrected media. The default value is 00:00:00:00.

Note: Although Color doesn’t allow you to preview transition effects as you work, shots that are joined by transitions are automatically rendered with handles in order to provide the necessary overlap for the transitions to work. This is true whether or not you’ve set handles greater than zero.

The Messages Tab
The Messages tab contains a running list of all the warnings and error messages that are generated by Color while it operates. Messages highlighted in yellow are warnings. Messages highlighted in red signify that an error has occurred (for example, “Directory not writable trying to re-save a project.”). There are no controls in the Messages tab.

The User Preferences Tab
The User Preferences (User Prefs) tab contains settings that affect the operation of Color with any project you open. It includes options for customizing control surface sensitivity, Timeline display, playback behavior, video output, and the bit depth that’s used for both display and rendering.

The state of each of these settings is automatically saved whenever they're changed. If necessary, you can restore the settings to their original defaults.

To reset the default user preferences
- Click Reset Preferences, at the bottom of the User Preferences tab.
For more information, see:
• Media and Project Directories
• Control Surface Settings
• User Interface Settings
• Grade and Scope Color Controls
• Limit Shadow Adjustments and Show Control Surface Controls
• Using Proxies
• Playback, Processing, and Output Settings
• How Do Bit Depth and Channel Data Correspond?
• Auto Save Settings

**Media and Project Directories**

The Media and Project directories let you control where new files are saved by default.

- *Default Project Dir.:* The default directory where all new Color projects are saved. This is also the default directory that appears in the dialogs for the Import EDL and Import XML commands. Click the Browse button to choose a new directory.

- *Default Media Dir.:* The default directory for the file browser. This is also the default media location used by the Import EDL and Import XML commands. Click the Browse button to choose a new directory.

- *Default Render Dir.:* The default directory for media that's rendered by Color for export. Click the Browse button to choose a new directory.
Control Surface Settings
If you're using a control surface with Color, the following parameters let you adjust how motion applied to a particular control corresponds to the resulting adjustment that's made.

- **Hue Wheel Angle**: This parameter specifies the angle at which colors appear on the color wheel of color controls in the Color interface and the corresponding angle at which these colors are adjusted when using the joyballs of a control surface. This is customizable in order to accommodate colorists who are used to working with different systems:
  - 122 is the default angle of red for DaVinci color correction systems, which corresponds to the angle at which red appears on a Vectorscope. This is the default Color setting.
  - 0 is the default angle of red for Pogle color correction systems, which corresponds to the orientation of the controls of the older Mk III telecine.

- **Encoder Sensitivity**: This parameter controls the speed with which the rotation of knobs on a control surface changes the value of their associated Color controls.
- **Jog/Shuttle Sensitivity**: This parameter controls the speed at which the playhead moves relative to the amount of rotation that's applied to a control surface's Jog/Shuttle wheel.
• **Joyball Sensitivity**: This parameter controls how quickly color balance controls are adjusted when using a control surface’s joyballs to adjust the Shadow, Midtone, and Highlight color controls in the Primary In, Secondary, and Primary Out rooms. The default setting is 1, which is extremely slow. Raise this value to increase the rate at which corrections are made with the same amount of joyball motion.

**User Interface Settings**
The following settings let you customize the Color interface.

- **UI Saturation**: This value controls how saturated the Color user interface controls appear. Many colorists lower the UI saturation to avoid eye fatigue and the potential for biasing one’s color perception during sessions. UI saturation also affects the intensity of colors displayed by the Scopes window when the Monochrome Scopes option is turned off.
- **Frames/Seconds/Minutes/Hours**: These buttons let you choose how time is displayed in the Timeline ruler. They do not affect how time is represented in the other timecode fields in Color.
- **Show Shot Name**: Turning this option on displays each shot’s name in the Timeline.
- **Show Shot Number**: Turning this option on displays the shot number for each shot in the Timeline.
- **Show Thumbnail**: With this setting turned on, single frame thumbnails appear within every shot in the Timeline.
- **Loop Playback**: Turning this option on loops playback from the current In point to the Out point of the Timeline. How this affects playback depends on how the Playback Mode is set. For more information, see [Switching the Playback Mode](#).
• **Maintain Framerate**: This setting determines whether or not frames are dropped in order to maintain the project’s frame rate during playback.

• **If Maintain Framerate is turned on (the default)**: The current frame rate is maintained no matter what the current processing workload is. If the currently playing grade is processor-intensive, then frames will be dropped during playback to maintain the project’s frame rate. If not, playback occurs in real time.

• **If Maintain Framerate is turned off**: Every frame is always played back. If the currently playing grade is processor-intensive, playback will slow to avoid dropping frames. If not, playback may actually occur faster than real time.

• **Synchronize Refresh (slower)**: Turning this option on eliminates video refresh artifacts in the monitored image. (These may appear as "tearing" of the video image.) It affects playback performance, but only slightly, resulting in a playback penalty of approximately 1 fps.

**Grade and Scope Color Controls**
The following parameters use miniature color controls that operate identically to those described in **Color Casts Explained**.

• **Grade Complete color control**: The color that’s displayed in the Timeline render bar for rendered shots. The default color is green.

• **Grade Queued color control**: The color that’s displayed in the Timeline render bar for shots that have been added to the Render Queue, but that are not yet rendered. The default color is yellow.
• Grade Aborted color control: The color that’s displayed in the Timeline render bar for shots that have had their rendering stopped. The default color is red.

• Monochrome Scopes: Turning this option on draws the video scope graticules with a single color (specified by the Scope Color option, below). Many colorists prefer this display to avoid eye fatigue. On the other hand, it also eliminates the full-color display in the Vectorscope. Another option for those wishing to have color feedback in the scopes is to lower the UI Saturation setting to a less vivid intensity.

• Scope Color: This color control lets you adjust the color that’s used to draw the video scope graticules when Monochrome Scopes is turned on.

Limit Shadow Adjustments and Show Control Surface Controls
These controls are used to limit shadow adjustments and display the Control Surface Startup dialog.

• Limit Shadow Adjustments: When this option is turned on, a falloff is applied to the Shadows color and contrast adjustments such that 0 percent values (pure black) receive 100 percent of the correction, while 100 percent values (pure white) receive 0 percent of the correction. When this option is turned off, adjustments made to the Shadows color and contrast controls are applied uniformly to the entire image.

• Show Control Surface Dialog: Turning this option on immediately opens the Control Surface Startup dialog, from which you can choose a Color-compatible control surface with which to work. While this option is turned on, the Control Surface Startup dialog appears every time you open Color. If you don’t have a control surface, turn this option off.
Using Proxies

If you're working with a project that uses Cineon or DPX image sequences, you can use the Color proxy mechanism to work faster with high-resolution media. The proxy mechanism in Color is not available to projects using QuickTime media, unless you're using native RED QuickTime media. RED QuickTime media is capable of generating proxy data on the fly depending on how the Render Proxy, Grading Proxy, and Playback Proxy pop-up menus are set.

- **Enable Proxy Support:** Turning this button on enables the use of lower-resolution substitute media, called proxies, in place of the source media in your project. Using proxies increases playback, grading, and rendering performance, although your shots are displayed at lower quality. If you're grading DPX or Cineon media, proxies may only be used once they've been generated; proxies are generated using the same format as the source media. (For more information on how to generate proxies, see Generating and Deleting Proxies.)

If you're grading native RED QuickTime media, you can turn on proxy resolutions at any time, without the need to generate proxy media; they're generated on the fly.

**Note:** In all cases, while resolution may be reduced, proxies are completely color-accurate.

- **Render Proxy pop-up menu:** Lets you choose a proxy resolution with which to render your output media. This can be useful if you want to quickly render a set of media to test the return trip of a roundtrip workflow. This menu defaults to Half Resolution and, in most cases, should be left at that setting.

- **Grading Proxy pop-up menu:** Lets you choose a proxy resolution to use while adjusting the controls in any of the rooms. This increases the interactivity of the user interface and the speed with which the image being worked on updates while you adjust different grading controls. When you finish making an adjustment, the image goes back to its full resolution.

- **Playback Proxy pop-up menu:** Lets you choose a proxy resolution to use during playback, increasing your playback frame rate by lowering the quality of the image. When playback stops, the image goes back to its full resolution.
Generating and Deleting Proxies

In order to use proxies while working on projects using DPX and Cineon media, you need to first generate a set of half- and quarter-resolution proxy media for your project.

To generate a set of proxy media for your project
- Choose File > Proxies > Generate Proxies.

To delete all the proxies that have been generated for a project
- Choose File > Proxies > Delete Proxies.

**Important:** The proxy mechanism is not available for projects using QuickTime files, unless they’re native RED QuickTime media. Native RED QuickTime media uses the proxy mechanism, but proxies are generated on the fly, so you don’t have to use the Generate Proxies command.

Playback, Processing, and Output Settings

The following settings affect playback quality, render quality, and performance.

- **Video Output pop-up menu:** The options in this pop-up menu correspond to the video output options available to the broadcast video interface that’s installed on your computer. Choose Disabled to turn off video output altogether.

**Note:** Currently, Digital Cinema Desktop previews and Apple FireWire output are not available for monitoring the output from Color.
• **Force RGB:** This option is disabled for standard definition projects. This setting is meant to be used when you’re working with high definition Y’CbCr source media that you’re monitoring on an external broadcast monitor via a supported broadcast video interface. It determines how the RGB image data that’s calculated internally by Color is converted to Y’CbCr image data for display:

  - **If Force RGB is turned off:** This conversion is done by Color in software. This consumes processor resources and may noticeably reduce your real-time performance as a result.
  
  - **If Force RGB is turned on:** Color sends RGB image data straight to the broadcast video interface that’s installed on your computer and relies on the interface to do the conversion using dedicated hardware. This lightens the processing load on your computer and is recommended to optimize your real-time performance. When monitoring legalized video between 0 and 100 IRE, there should be a minimal difference between the image that’s displayed with Force RGB turned on or off. When Force RGB is turned on, super-white and out-of-gamut chroma values will not be displayed by your broadcast display, nor will they appear on external video scopes analyzing your broadcast video interface’s output. This limitation only affects monitoring; the internal image processing performed by Color retains this data. As a result, you will always see super-white image data on the Color software scopes when it’s present, and uncorrected super-white and out-of-gamut chroma levels are always preserved when you export your final media. If Broadcast Safe is turned on in the Project Settings, you may not notice any difference in the display of these "illegal" levels, since they're being limited by Color.

• **Disable Vid-Out During Playback:** Turning this option on disables video output via your broadcast interface during playback. While paused, the frame at the position of the playhead is still output to video. This is useful if your project is so effects-intensive that video playback is too slow to be useful. With this option turned on, you can make adjustments and monitor the image while paused and then get a look at the program in motion via the preview display, which usually plays faster.

• **Update UI During Playback:** Turning this option on allows selected windows of the Color interface to update dynamically as the project plays back. This updates the controls and scopes during playback from grade to grade, but potentially slows playback performance, so it’s off by default. There are two options:

  - **Update Primary Display:** Updates the main interface controls in the Primary In, Secondaries, Color FX, Primary Out, and Geometry rooms. Turning this option on lets you see how the controls change from grade to grade and how they animate if you have keyframed grades.

  - **Update Secondary Display:** Updates the Scopes window. This is the way to get updated video scopes during playback. With this option turned off, the video preview still plays, but the video scopes disappear.
• *Radial HSL Interpolation*: This setting affects how keyframed color adjustments are interpolated from one hue to another.

• Turning this setting on causes keyframed changes in hue to be animated *radially*, with the hue cycling through all hues on the color wheel in between the current and target hues. This results in visible color cycling if you're animating a change from one hue to any other that's not directly adjacent on the color wheel. This is the method that Final Cut Pro uses when animating color adjustments in the Color Corrector and Color Corrector 3-way filters.

• With this setting turned off (the default state), keyframed changes in hue are animated *linearly*, directly from one point on the color wheel to another. This results in the most direct animated adjustments and minimizes unwanted color cycling. This is the method that the DaVinci and Pogle systems use to animate color adjustments.

• *Internal Pixel Format pop-up menu*: The options available in this pop-up menu depend on the graphics card you have installed in your computer. The option you choose from this pop-up menu determines the bit depth Color uses for the internal processing of color, both during real-time playback and when rendering the final output. Bit depth is expressed as the number of bits per color channel and describes the total number of values used to display the range of color by every pixel of an image. Higher bit depths result in a higher-quality image, but are more processor-intensive to play back and render.
Tip: Depending on your system's performance, you may find it advantageous to work at a lower bit depth in order to maximize real-time performance. Then, you can switch to the desired bit depth prior to rendering your final output to maximize image quality. However, if you graded your program with the Internal Pixel Format pop-up menu set to 8- through 16-bit, changing it to Floating Point may alter how certain Color FX operations work. If you intend to work at a lower bit depth but render at Floating Point, it’s a good idea to double-check all shots with Color FX corrections applied to them prior to rendering to make sure that they look the way you intended.

• 8-bit: The lowest bit depth at which Color can operate, and the least processor-intensive.

• 10-bit: The minimum recommended bit depth for projects incorporating secondary color correction and vignetting, regardless of the source.

• 12-bit: A higher bit depth supported by some video cards.

• 16-bit: An extremely high-quality bit depth. It has been suggested that 16-bit is the best linear equivalent to 10-bit log when working on images scanned from film.

• Floating Point: The highest level of image-processing quality available in Color, and recommended if your graphics card doesn’t support 10- through 16-bit image processing. Refers to the use of floating-point math to store and calculate fractional data. This means that values higher than 1 can be used to store data that would otherwise be rounded down using the integer-based 8-bit, 10-bit, 12-bit, and 16-bit depths. Floating Point is a processor-intensive bit depth to work with, so plan for longer rendering times. Floating Point is not available on systems with 128 MB or less of VRAM.
How Does Working in Floating Point Affect Image Processing?

Aside from providing a qualitative edge when processing high-resolution, high-bit depth images, setting the Internal Pixel Format to Floating Point changes how image data is handed off from one room to the next, specifically in the Color FX and Primary Out rooms.

At 8- through 16-bit, out-of-range image data (luma or chroma going below the Floor IRE or above the Ceiling IRE of the Broadcast Safe settings, or below 0 and above 110 if Broadcast Safe is turned off) is clipped as your image goes from one room to another. Out-of-range image data is also clipped as the image is handed off from one node to another in the Color FX room.

If you set the Internal Pixel Format to Floating Point, out-of-range image data is still clipped as it moves from the Primary In room to the Secondaries room, and from the Secondaries room to the Color FX room. However, starting with the Color FX room, out-of-range image values are preserved as image data is handed off from node to node. Furthermore, out-of-range image data is preserved when the image goes from the Color FX room to the Primary Out room.

Here’s an example of how this works. At 16 bit, if you raise the highlights of an image beyond 110 percent in the Color FX room, then lower the highlights in the Primary Out room, your highlights stay clipped.

At Floating Point, if you raise the highlights beyond 110 percent, and then lower them again in the Primary Out room, all of the image data is retrievable.
Because of this, you may occasionally notice differences between images that were initially corrected at less than 16-bit, and the same images changed to render at Floating Point. This is particularly true in the Color FX room.

For more information about bit depth, see How Do Bit Depth and Channel Data Correspond?

**How Do Bit Depth and Channel Data Correspond?**

The actual range of values used by each channel for every pixel at a given bit depth is calculated by taking 2 to the \( n \)th power, where \( n \) is the bit depth itself. For example, the range of values used for 8-bit color is 2 to the 8th power, or 256 values per channel. The range of values for 16-bit color is 2 to the 10th power, or 65536 values per channel.

However, this isn't the whole story. How much of the available numeric range is actually used depends on how the image data is encoded.

- **Full Range**: Image data using the RGB color space encodes each color channel using the full numeric range that's available. This means that 8-bit video color channels use a value in the range of 0–255 and 10-bit channels use a range of 1–1023.

- **Studio Range**: 8- and 10-bit video image data that's stored using the \( Y'C_bC_r \) color space uses a range of values for each channel. This means that a subset of the actual range of available values is used, in order to leave the headroom for super-black and super-white that the video standard requires.

  For example, the luma of 8-bit \( Y'C_bC_r \) uses the range of 16–236, leaving 1–15 and 235–254 reserved for headroom in the signal. The luma of 10-bit \( Y'C_bC_r \) uses the range of 64–940, with 4–63 and 941–1019 reserved for headroom.

  Furthermore, the lowest and highest values are reserved for non-image data, and the chroma components (\( C_b \) and \( C_r \)) use a wider range of values (16–240 for 8-bit video, and 64–960 for 10-bit video).

**Auto Save Settings**

Two settings let you turn on or off automatic saving in Color.

- **Auto-Save Projects**: Turning this option on enables automatic saving.
- **Auto-Save Time (Minutes)**: Specifies how many minutes pass before the project is saved again. This is set to 5 minutes by default.
Auto Saving saves only the current project. It does not create an archived copy of the project. For more information about creating and recalling archives, see Saving and Opening Archives.
The equipment and methods with which you monitor your work are critical to producing an accurate result.

The importance of proper monitoring for color correction cannot be overemphasized. This chapter covers the monitoring options available in Color, including the configuration of the Scopes window, options for broadcast video output, the generation and use of LUTs for calibration and simulation, and how the Still Store is output to video for monitoring and evaluation.

This chapter covers the following:
- The Scopes Window and Preview Display (p. 149)
- Monitoring Broadcast Video Output (p. 151)
- Using Display LUTs (p. 153)
- Monitoring the Still Store (p. 159)

The Scopes Window and Preview Display
The simplest way to monitor your work in Color is with the Scopes window. This is the second of the two windows that comprise the Color interface. You can configure Color to use one or two displays.

Using two displays, the Scopes window is viewed on the second one, occupying its own display. Using one display, the Scopes window shares the screen with the Color window.

To switch between the Color and Scopes windows
- Choose Window > Composer (or press Command-Shift-1) to switch to the Color user interface.
- Choose Window > Viewer (or press Command-Shift-2) to switch to the Color Scopes window.

To switch between single and dual display modes
Do one of the following:
- Choose Window > Single Display Mode or Dual Display Mode.
Press Command-Shift-0 to switch between both modes.

The Scopes window provides a preview display of the image that you’re working on, and it can also show either two (in single-display mode) or three (in dual-display mode) video scopes to aid you in image evaluation. For more information, see Analyzing Signals Using the Video Scopes.

The preview display shows you either the frame at the current position of the playhead in the Timeline, as it appears with all the corrections you’ve applied in all rooms (unless you choose Grade > Disable Grade), or the currently enabled Still Store image. Whichever image is shown in the preview display is mirrored on the broadcast monitor that’s connected to the video output of your computer. The preview display is also affected by LUTs that you import into your Color project.

Note: The only other time the current frame is not displayed is when one of the alternate secondary display methods is selected in the Previews tab of the Secondaries room. For more information, see Controls in the Previews Tab.

The preview display in the Scopes window can be switched between full- and partial-screen modes.

To switch the preview image between full- and quarter-screen
Do one of the following:

- Control-click or right-click the preview image in the Scopes window, then choose Full Screen from the shortcut menu.
- Double-click the image preview in the Scopes window.

All video scopes are hidden while the preview display is in full-screen mode.

---

Using the Preview Display as Your Evaluation Monitor

Whether or not the preview display in the Scopes window is appropriate to use as your evaluation monitor depends on a number of factors, the most important of which is the amount of confidence you have in the quality of your preview display.

Many users opt to use the preview display as an evaluation monitor, especially when grading scanned film in a 2K workflow, but you need to make sure that you’re using a monitor capable of displaying the range of contrast and color necessary for maintaining accuracy to your facility’s standards. Also, success depends on proper monitor calibration, combined with color profiling and simulation of the eventual film output using LUT management. (See What Is a LUT? for more information.)
Monitoring Broadcast Video Output
For the most accurate monitoring of broadcast programs, Color outputs standard and high definition video using supported third-party video interfaces. The drivers installed for the interface you have determine what resolutions, bit depths, and frame rates are available for outputting to an external monitor.

To turn on external video monitoring
- Choose an option from the Video Output pop-up menu, in the User Prefs tab of the Setup room.

To turn off external video monitoring
- Choose Disabled from the Video Output pop-up menu, in the User Prefs tab of the Setup room.

For more information about monitoring, see:
- Mixing and Matching Program and Viewing Resolutions
- Bit Depth and Monitoring
- Choose Your Monitor Carefully
- Set Up Your Viewing Environment Carefully
- Calibrate Your Monitor Regularly
- Adjust the Color Interface for Your Monitoring Environment

Mixing and Matching Program and Viewing Resolutions
Ideally, you should monitor your program at its native resolution (in other words, the resolution of its source media). However, Color will do its best to output the video at whatever resolution is set in the Video Output pop-up menu of the User Prefs tab. If the Video Output pop-up menu is set to a different resolution than the currently selected Resolution Preset, then Color will automatically scale the image up or down as necessary to fit the image to the display size.

Bit Depth and Monitoring
The working bit depth can have a significant impact on the quality of your monitored image. The monitored bit depth depends on three factors:
- The bit depth of the source media
- The bit depth selected in the Video Output pop-up menu
- The bit depth selected in the Internal Pixel Format pop-up menu
Other than specifying or choosing the initial shooting or transfer format, the bit depth of the source media on disk is predetermined (usually 8-bit, 10-bit, or 10-bit log). Since low bit depths can be prone to banding and other artifacts during the color correction process (especially when gradients are involved), it’s usually advantageous to process the video at a higher bit depth than that of the original source media (secondary corrections and vignettes can especially benefit).

Color will process and output your video at whatever bit depth you select. However, most broadcast video interfaces max out at 10-bit resolution. For maximum quality while monitoring, you should set the Internal Pixel Format to the highest bit depth you want to work at and make sure the Video Output pop-up menu is set to a 10-bit option.

**Note:** Video noise and film grain often minimize the types of artifacts caused by color correction operations at low bit depths, so the advantages of working at higher bit depths are not always obvious to the naked eye.

Monitoring at high bit depths is processor-intensive, however, and can reduce your real-time performance. For this reason, you also have the option of lowering the bit depth while you work and then raising it when you’re ready to render the project’s final output.

For more information about the monitoring options available in the User Prefs tab, see Playback, Processing, and Output Settings.

**Choose Your Monitor Carefully**

It’s important to choose a monitor that’s appropriate to the critical evaluation of the type of image you’ll be grading. At the high end of the display spectrum, you can choose from CRT-based displays, a new generation of flat-panel LCD-based displays, and high-end video projectors utilizing a variety of technologies.

You should choose carefully based on your budget and needs, but important characteristics for critical color evaluation include:

- Compatibility with the video formats you’ll be monitoring
- Compatibility with the video signal you’ll be monitoring, such as $Y'P_BP_R$, SDI, HD-SDI, or HDMI
- Suitable black levels (in other words, solid black doesn’t look like gray)
- A wide contrast range
- Appropriate brightness
- User-selectable color temperature
- Adherence to the Rec. 601 (SD) or 709 (HD) color space standards as appropriate
- Proper gamma (also defined by Rec. 709)
- Controls suitable for professional calibration and adjustment
Note: For all these reasons, consumer televisions and displays are not typically appropriate for professional work, although they can be valuable for previewing how your program might look in an average living room.

Set Up Your Viewing Environment Carefully
The environment in which you view your monitor also has a significant impact on your ability to properly evaluate the image.

- There should be no direct light spilling on the front of your monitor.
- Ambient room lighting should be subdued and indirect, and there should be no direct light sources within your field of view.
- Ambient room lighting should match the color temperature of your monitor (6500K in North and South America and Europe, and 9300K in Asia).
- There should be indirect lighting behind the viewing monitor that’s between 10–25% of the brightness of the installed monitor set to display pure white.
- The ideal viewing distance for a given monitor is approximately five times the vertical height of its screen.
- The color of the room within your working field of vision should be a neutral gray.

These precautions will help to prevent eye fatigue and inadvertent color biasing while you work and will also maximize the image quality you’ll perceive on your display.

Calibrate Your Monitor Regularly
Make sure you calibrate your monitor regularly. For maximum precision, some monitors have integrated probes for automatic calibration. Otherwise, you can use third-party probes and calibration software to make the same measurements. In a purely broadcast setting, you can also rely on the standard color bars procedure you are used to.

For more information on adjusting a monitor using color bars, see Calibrating Your Monitor.

Adjust the Color Interface for Your Monitoring Environment
The Color interface is deliberately darkened in order to reduce the amount of light spill on your desktop. If you want to subdue the interface even further, the UI Saturation setting in the User Prefs tab of the Setup room lets you lower the saturation of most of the controls in the Primary In, Secondaries, and Primary Out rooms, as well as the color displayed by the video scopes.

Using Display LUTs
Color supports the use of 3D look up tables (LUTs) for calibrating your display to match an appropriate broadcast standard or to simulate the characteristics of a target output device (for example, how the image you’re correcting will look when printed to film).
Color is represented on CRTs, LCD flat panels, video projectors, and film projectors using very different technologies. If you show an identical test image on two different types of displays—for example, a broadcast display and a video projector—you can guarantee there will be a variation in color between the two. This variation may not be noticeable to the average viewer, but as a colorist, you need a predictable viewing environment that adheres to the standards required for your format, and to make sure that you aren’t driven crazy by changes being requested as a result of someone’s viewing the program on a display showing incorrect color.

There is also variation within a single category of device:
• CRT monitors from different manufacturers use different phosphor coatings.
• Digital projectors are available using many types of imaging systems.
• Projected film is output using a variety of printing methods and film stocks.

All these variables inevitably result in significant color variation for any image going from one viewing environment to another. One solution to this is calibration using LUTs.

**What Is a LUT?**
Simply put, look up tables (LUTs) are precalculated sets of data that are used to adjust the color of an image being displayed with the *gamut* and *chromaticity* of device A to match how that image would look using the gamut and chromaticity of device B.

The *gamut* of a particular device represents the total range of colors that can be displayed on that device. Some types of displays are capable of displaying a greater range of colors than others. Furthermore, different video and film standards specify different gamuts of color, such that colors that are easily represented by one imaging medium are out of bounds for another. For example, film is capable of representing far more color values than the broadcast video standard.
Chromaticity refers to the exact values a display uses to represent each of the three primary colors. Different displays use different primary values; this can be seen on a chromaticity diagram that plots the three primaries as points against a two-dimensional graph representing hue and saturation within the visible spectrum. Since all colors represented by a particular display are a mix of the three primaries, if the three primary points vary from display to display, the entire gamut of color will shift.

While the chromaticity diagram shown above is useful for comparing displays on paper, to truly represent the hue (color), saturation (intensity of color), and lightness (luminance from black to white) that defines a complete gamut, you need to use a 3D color space.

When extruded into 3D space, the gamut and chromaticity of different devices create different shapes. For example, the standard RGB color space can be represented with a simple cube (as seen in the ColorSync Utility application):
Each corner of the cube represents a different mix of the R,G,B tristimulus values that represent each color. The black corner is (0,0,0), the opposing white corner is (1,1,1), the blue corner is (0,0,1), the red corner is (1,0,0), and so forth. The RGB color cube is an idealized abstraction, however. Actual display devices appear with much different shapes, defined by their individual gamut and chromaticity.

To accurately transform one device’s gamut to match that of another involves literally projecting its gamut into a 3D representation and then mathematically changing its shape to match that of the other device or standard. This process is referred to as characterizing a device and is the standard method used by the color management industry. Once calculated, the method of transformation is stored as a 3D LUT file.

Once a device has been characterized and the necessary LUT has been calculated, the hard computational work is done, and the LUT can be used within Color to modify the output image without any significant impact on real-time performance.

**When Do You Need a LUT?**

The following examples illustrate situations in which you should consider using LUTs:

- **If you’re matching multiple displays in a facility:** LUTs can be useful for calibrating multiple displays to match a common visual standard, ensuring that a program doesn’t look different when you move it to another room.

- **If you’re displaying SD or HD video on a nonbroadcast monitor:** You can use a LUT to emulate the Rec. 601 (SD) or 709 (HD) color space and gamma setting that’s appropriate to the standard of video you’re viewing.

- **If you’re displaying video or film images using a video projector:** You can use a LUT to calibrate your device to match, as closely as possible, the gamut of the broadcast or film standard you’re working to.

- **If you’re grading images destined to be printed to film:** You can use a LUT to profile the characteristics of the film printing device and film stock with which you’ll be outputting the final prints, in order to approximate the look of the final projected image while you work.
**Important:** LUTs are no substitute for a high-quality display. In particular, they’ll do nothing to improve muddy blacks, an inherently low contrast range, or a too-narrow gamut.

### When Don’t You Need a LUT?

If you’re color correcting video and monitoring using a properly calibrated broadcast display that’s compatible with the standard of video that you’re displaying, it’s not generally necessary to use a LUT.

### Generating LUTs

There are several ways you can generate a LUT.

**Create One Yourself Using Third-Party Software**

There are third-party applications that work in conjunction with hardware monitor probes to analyze the characteristics of individual displays and then generate a LUT in order to provide the most accurate color fidelity possible. Because monitor settings and characteristics drift over time, it’s standard practice to periodically recalibrate displays every one to two weeks.

If you’re creating a LUT to bring another type of display into line with broadcast standards (such as a digital projector), you’ll then use additional software to modify the calibration LUT to match the target display characteristics you require.

**Have One Created for You**

At the high end of digital intermediate for film workflows, you can work with the lab that will be doing the film print and the company that makes your monitor calibration software to create custom LUTs based on profiles of the specific film recorders and film stocks that you’re using for your project.

This process typically involves printing a test image to film at the lab and then analyzing the resulting image to generate a target LUT that, together with your display’s calibration LUT (derived using a monitor probe and software on your system), is used to generate a third LUT, which is the one that’s used by Color for monitoring your program as you work.

**Creating LUTs in Color**

In a pinch, you can match two monitors by eye using the controls of the Primary In room and generating a LUT to emulate your match directly out of Color.

You can also export a grade as a “look” LUT to see how a particular correction will affect a digitally recorded image while it’s being shot. To do this, the crew must be using a field monitor capable of loading LUTs in the .mga format.

**To create your own LUT**

1. Arrange your Color preview display and the target monitor so that both can be seen at the same time.
2 Load a good evaluation image (such as a Macbeth chart) into the Timeline.
3 Display the same image on the target display using a second reliable video source.
4 Open the Primary In room and adjust the controls appropriate to make the two images match.
5 Choose File > Export > Display LUT.
6 When the Save LUT As dialog appears, enter a name for that LUT into the File field, choose a location to save the file, and click Save.
   
   By default, LUTs are saved to the /Users/username/Library/Application Support/Color/LUTs directory.

   **Important:** If your project is already using a LUT when you export a new one, the currently loaded LUT is concatenated with your adjustments, and the combination is exported as the new LUT.

**Using LUTs**
All LUTs used and generated by Color are 3D LUTs. Color uses the .mga LUT format (originally developed by Pandora), which is compatible with software by Rising Sun Research, Kodak, and others. If necessary, there are also applications available to convert LUTs from one format into another.

LUTs don’t impact processing performance at all.

**To use a LUT**
1 Choose File > Import > Display LUT.
2 Select a LUT file using the Load LUT dialog, then click Load.

   **Note:** By default, LUTs are saved to the /Users/username/Library/Application Support/Color/LUTs directory.

   The LUT immediately takes effect, modifying the image as it appears on the preview and broadcast displays. LUTs that you load are saved in a project’s settings until you specifically clear the LUT from that project.

**To stop using a LUT**
- Choose File > Clear Display LUT.

To share a LUT with other Color users, you must provide them with a copy of the LUT file. For ease of use, it’s best to place all LUT files into the /Users/username/Library/Application Support/Color/LUTs directory.
Monitoring the Still Store
The Still Store lets you save and recall images from different parts of your project that you can use to compare to shots you’re working on. The Still Store is basically an image buffer that lets you go back and forth between the currently loaded Still Store image and the current image at the position of the playhead. You have options for toggling between the full image and a customizable split-screen view that lets you see both images at once.

When you enable the Still Store, the full-screen or split-screen image is sent to both the preview and broadcast displays. To go back to viewing the frame at the position of the playhead by itself, you need to disable the Still Store.

Enabled Still Store images are analyzed by the video scopes, and they are affected by LUTs. For more information on using the Still Store, see The Still Store.
The Timeline provides you with an interface for navigating through your project, selecting shots to grade, and limited editing.

The Timeline and the Shots browser (in the Setup room) both provide ways of viewing the shots in your project. The Shots browser gives you a way to nonlinearly sort and organize your shots, while the Timeline provides a sequential display of the shots in your program arranged in time. In this chapter, you'll learn how to use the Timeline to navigate and play through the shots in your program, as well as how to perform simple edits.

This chapter covers the following:

• Basic Timeline Elements (p. 162)
• Customizing the Timeline Interface (p. 163)
• Working with Tracks (p. 165)
• Selecting the Current Shot (p. 166)
• Timeline Playback (p. 166)
• Zooming In and Out of the Timeline (p. 169)
• Timeline Navigation (p. 170)
• Selecting Shots in the Timeline (p. 171)
• Working with Grades in the Timeline (p. 172)
• The Settings 1 Tab (p. 174)
• The Settings 2 Tab (p. 175)
• Editing Controls and Procedures (p. 176)
Basic Timeline Elements
The Timeline is divided into a number of tracks that contain the shots, grades, and keyframes used by your program.

- **Render bar:** The render bars above the Timeline ruler show whether or not a shot is unrendered (red), or has been rendered (green).
- **Timeline ruler:** Shows a time scale for the Timeline. Dragging within the Timeline ruler lets you move the playhead, scrubbing through the program.
- **Playhead:** Shows the position of the currently displayed frame in the Timeline. The position of the playhead also determines the current shot that’s being worked on.
- **Video tracks and shots:** Each shot in the program is represented within one of the video tracks directly underneath the Timeline ruler. Color only allows you to create up to five video tracks when you’re assembling a project from scratch, but will accommodate however many superimposed video tracks there are in imported projects.

  **Note:** Color does not currently support compositing operations. During playback, superimposed clips take visual precedence over clips in lower tracks.
- **Track resize handles:** The tracks can be made taller or shorter by dragging their resize handles up or down.
- **Lock icon:** The lock icon shows whether or not a track has been locked.
- **Grades tracks:** Color allows you to switch among up to four primary grades applied to each shot. This option lets you quickly preview different looks applied to the same shot, without losing your previous work. Each grade is labeled Grade 1–4.
Each of the four grades may include one or more Primary, Secondary, Color FX, and Primary Out corrections. By default, each grade appears with a single primary grade bar, but additional correction bars appear at the bottom if you’ve made adjustments to any of the other rooms for that grade. Each correction bar has a different color.

- **P(imary) bar**: Shows whether a primary correction has been applied.
- **S(secondary) bar**: Shows whether one or more secondary corrections have been applied.
- **CFX (color FX) bar**: Shows whether a Color FX correction has been applied.
- **PO (primary out) bar**: Shows whether a Primary Out correction has been applied.
- **Tracker area**: If you add a motion tracker to a shot and process it, the tracker’s In and Out points appear in this area, with a green bar showing how much of the currently selected tracker has been processed. If no tracker is selected in the Tracking tab of the Geometry room, nothing appears in this area. For more information, see The Tracking Tab.
- **Keyframe graph**: This track contains both the keyframes and the curves that interpolate the change from one keyframe’s value to another. For more information about keyframing corrections and effects, see Keyframing.

**Customizing the Timeline Interface**

There are a number of ways you can customize the visual interface of the Timeline. See the following sections for specifics:

- Customizing Unit and Information Display
- Resizing Tracks in the Timeline

**Customizing Unit and Information Display**

The following options in the User Prefs tab of the Setup room let you change how shots are shown in the Timeline.
To change the units used in the Timeline ruler
Do one of the following:

- Click the Setup room tab, then click the User Prefs tab and click the Frames, Seconds, Minutes, or Hours button corresponding to the units you want to use.

- Press one of the following keys:
  - Press F to change the display to frames.
  - Press S to change the display to seconds.
  - Press M to change the display to minutes.
  - Press H to change the display to hours.

To customize the way shots are displayed in the Timeline

- Click the Setup room tab, then click the User Prefs tab. Turn on or off individual shot appearance settings to suit your needs.

Three settings in the User Prefs tab of the Setup room let you customize the way shots appear in the Timeline.

- *Show Shot Name:* Turning this on displays each shot’s name in the Timeline.
- *Show Shot Number:* Turning this on displays each shot’s number in the Timeline.
- *Show Shot Thumbnail:* With this setting turned on, single frame thumbnails appear within every shot in the Timeline.

Resizing Tracks in the Timeline

You can also resize the tracks in the Timeline, making them taller or shorter, as you prefer. Video tracks, the grades track, and the keyframe graph are all resized individually.

To resize all video tracks, the grades track, or the keyframe graph

- Drag the center handle of the gray bar at the bottom of any track in the Timeline until all tracks are the desired height.
To resize individual tracks
- Hold down the Shift key, then drag the center handle of the gray bar at the bottom of the track you want to resize until it’s the desired height.

*Note:* The next time you resize all video tracks together, individually resized tracks snap to match the newly adjusted track size.

### Working with Tracks
This section describes different ways you can change the state of tracks in the Timeline as you work.

*Note:* The tracks of imported XML projects are automatically locked. For the best roundtrip results, these tracks should not be unlocked.

#### To lock or unlock a track
- Control-click or right-click anywhere within a track, then choose one of the following from the shortcut menu:
  - *Lock Track:* Locks all the shots so that they can’t be moved or edited.
  - *Unlock Track:* Allows shots to be moved and edited.
  
  *Note:* You can also lock the grades track in the Timeline using the same methods.

#### To hide or show a track
- Control-click or right-click anywhere within a track, then choose one of the following:
  - *Hide Track:* Disables a track such that superimposed shots are neither visible nor selectable when the playhead passes over them.
  - *Show Track:* Makes a track visible again. Superimposed shots take precedence over shots on lower tracks and are selected by default whenever that track is visible.

*Tip:* Prior to exporting a project from Final Cut Pro, you can export a self-contained QuickTime movie of the entire program and superimpose it over the other clips in your edited sequence. Then, when you export the project to Color, you can turn this “reference” version of the program on and off using track visibility whenever you want to have a look at effects or color corrections that were created during the offline edit.

#### To add a track
- Control-click or right-click anywhere within a track, then choose New Track from the shortcut menu.

#### To remove a track
- Control-click or right-click anywhere within a track, then choose Remove Track from the shortcut menu.

*Note:* You cannot remove the bottom track.
Selecting the Current Shot

Whichever shot you move the playhead to becomes the current shot. The current shot is the one that’s adjusted whenever you manipulate any of the controls in the Primary In, Secondary, Color FX, Primary Out, or Geometry room. There can only be one current shot at a time. It’s the only one that’s highlighted in light gray.

As you move the playhead through the Timeline, the controls and parameters of all rooms automatically update to match the grade of the current shot at the position of the playhead.

If there is more than one shot stacked in multiple video tracks at any point in the Timeline, the topmost shot becomes the current shot except in the following two cases:

• Shots on hidden tracks cannot become the current shot. If there’s a superimposed shot that doesn't let you expose the settings of a shot underneath, you can hide the superimposed track.

• Offline shots are invisible, and any shots appearing underneath in the Timeline automatically have their settings exposed in the Color interface.

To make a shot in the Timeline the current shot

Do one of the following:

- Double-click any shot in the Timeline.
- Move the playhead to a new shot.

Note: When you double-click a shot, the Timeline moves so that the shot is centered in the Timeline, and it becomes the current shot.

Timeline Playback

In general, the purpose of playback in Color is to preview how your various corrections look when the shot you’re working on is in motion or how the grades that are variously applied to a group of clips look when they’re played together. For this reason, playback works somewhat differently than in applications like Final Cut Pro.
In Color, playback is always constrained to the area of the Timeline from the In point to the Out point. If the playhead is already within this area, then playback begins at the current position of the playhead, and ends at the Out point. If the playhead happens to be outside of this area, it automatically jumps to the In point when you next initiate playback. This makes it faster to loop the playback of a specific shot or scene in the Timeline, which is a common operation during color correction sessions. For more information, see:

- Starting and Stopping Playback
- Switching the Playback Mode
- Loop Playback
- Maintain Framerate

**Starting and Stopping Playback**
The following controls let you play and stop your program.

*Important:* When you start playback, you enter a mode in which you’re unable to work with the Color controls until you stop playback.

**To play the program**
Do one of the following:

- Press the Space bar.
- Press J to play backward, or L to play forward.
- Click the Play Forward or Play Backward button.

**To stop the program**
Do one of the following:

- Press the Space bar while the program is playing.
- Press Escape.
- Press K.

**Color and JKL**
Color has a partial implementation of the JKL playback controls found in other editing applications. However, the finer points of JKL, such as slow-motion and frame-by-frame playback, are not implemented.
Switching the Playback Mode
The playback mode lets you choose whether the In and Out points are automatically changed to match the duration of the current shot whenever you move the playhead or whether they remain set to a larger portion of your program.

Shot Mode
Shot mode is the default playback method. Whenever the playhead moves to a new shot, the Timeline In and Out points are automatically changed to match that shot’s Project In and Project Out points. As a result, playback is constrained to just that shot. If Loop Playback is turned on, the playhead will loop repeatedly over the current shot until playback is stopped.

Note: You can still click other shots in the Timeline to select them, but the In and Out points don’t change until the playhead is moved to intersect another shot.

Movie Mode
When you first enter movie mode, the Timeline In point is set to the first frame of the first shot in the Timeline, and the Out point is set to the last frame of the last shot. This allows you to play through as many shots as you like, previewing whole scenes of your project. While in movie mode, you can also set your own In and Out points wherever you want, and they won’t update when you move the playhead to another shot.

Placing Your Own In and Out Points
Regardless of what playback mode you’ve chosen, you can always manually set new In and Out points wherever you want to. When you set your own In and Out points, the playback mode changes to movie mode automatically.

To switch the playback mode
Do one of the following:

- Choose Timeline > Toggle Playback Mode.
- Press Shift-Control-M.

To customize the playback duration
1 Move the playhead to the desired In point, then press I.
2 Move the playhead to the desired Out point, then press O.

Loop Playback
If Loop Playback is turned on, the playhead jumps back to the In point whenever it reaches the Out point during playback.

To turn on loop playback
1 Click the Setup room tab, then click the User Prefs tab.
2 Click the Loop Playback button to turn it on.
Maintain Framerate
The Maintain Framerate setting in the User Prefs tab of the Setup room determines whether or not frames are dropped in order to maintain the project’s frame rate during playback.

- **If Maintain Framerate is turned on (the default):** The current frame rate is maintained no matter what the current processing workload is. If the currently playing grade is processor-intensive, then frames will be dropped during playback to maintain the project’s frame rate. If not, playback occurs in real time.
- **If Maintain Framerate is turned off:** Every frame is always played back. If the currently playing grade is processor-intensive, playback will slow in order to avoid dropping frames. If not, playback may actually occur at faster than real time.

Zooming In and Out of the Timeline
The following controls let you zoom in and out of your program in the Timeline, changing how many shots are visible at once.

How far you can zoom in to the Timeline depends on what units the Timeline ruler is set to display. The larger the units the Timeline is set to display, the farther you can zoom out. For example, in order to view more shots in the Timeline simultaneously, you can zoom out farther when the Timeline ruler is set to Minutes than when it’s set to Frames.

*Note:* Zooming using the mouse allows you to zoom in or out as far as you want to go; the Timeline ruler’s units change automatically as you zoom.

**To zoom in to and out of the Timeline**

1. Move the playhead to a position in the Timeline where you want to center the zooming operation.
2. With the pointer positioned within the Timeline, do one of the following:
   - Choose Timeline > Zoom In, or press Minus Sign (–) to zoom in.
   - Choose Timeline > Zoom Out, or press Equal Sign (═) to zoom out.
     *Note:* You can also use the Plus Sign (+) and Minus Sign (–) keys in the numeric keypad to zoom in to or out of the Timeline.

**To zoom in to and out of the Timeline using the mouse**
- Right-click in the Timeline ruler, then drag right to zoom in, or left to zoom out.

**To fit every shot of your program into the available width of the Timeline**
- Press Shift-Z.
Timeline Navigation
The following procedures let you navigate around your program in the Timeline, scrolling through it, and moving the playhead from shot to shot.

To move the playhead from shot to shot
Do one of the following:
- Drag within the Timeline ruler to scrub the playhead from shot to shot.
- Press Up Arrow to move to the first frame of the next shot to the left.
- Press Down Arrow to move to the first frame of the next shot to the right.
- Click the Next Shot or Previous Shot buttons.

To move from frame to frame
Do one of the following:
- Press Left Arrow to go to the previous frame.
- Press Right Arrow to go to the next frame.

To go to the first or last frame of your project
- Press Home to go to the first frame.
- Press End to go to the last frame.

To go to the current In or Out point
- Press Shift-I to go to the In point.
- Press Shift-O to go to the Out point.

When there are more tracks than can be displayed within the Timeline at once, small white arrows appear either at the top, the bottom, or both, to indicate that there are hidden tracks in the direction that’s indicated.

When this happens, you can scroll vertically in the Timeline using the middle mouse button.

To scroll around the Timeline horizontally or vertically without moving the playhead
Do one of the following:
- Middle-click and drag the contents of the Timeline left, right, up, or down.
- To scroll more quickly, hold down the Option key while middle-clicking and dragging.
Selecting Shots in the Timeline

There are certain operations, such as copying primary corrections, that you can perform on selected groups of shots. Color provides standard methods of selecting one or more shots in the Timeline.

Note: You can also select shots using the Shots browser. For more information, see Using the Shots Browser.

To select a shot in the Timeline

- Click any shot.
  
  Selected shots appear with a cyan highlight in the Timeline.

To select a contiguous number of shots

1. Click the first of a range of shots you want to select.
2. Shift-click another shot at the end of the range of shots.

   All shots in between the first and second shots you selected are also selected.

To select a noncontiguous number of shots

- Command-click any number of shots in the Timeline.

Note: Command-clicking a selected shot deselects it.

To select all shots in the Timeline

- Choose Edit > Select All (or press Command-A).
To deselect all shots in the Timeline
Do one of the following:

- Choose Edit > Deselect All (or press Command-Shift-A).
- Select a previously unselected shot to clear the current selection.
- Click in an empty area of the Timeline.

**Important:** If the current shot at the position of the playhead is not selected, it will not be automatically included in the selection when you apply saved corrections or grades from a bin.

**Working with Grades in the Timeline**

Each shot in the Timeline can be switched among up to four different grades, shown in the grades track.

These four grades let you store different looks for the same shot. For example, if you’ve created a satisfactory grade, but you or your client would like to try “one other thing,” you can experiment with up to three different looks, knowing that you can instantly recall the original, if that’s what’s ultimately preferred.

Only one grade actually affects a shot at a time—whichever grade is selected in the Timeline is the grade you will see on your preview and broadcast displays. All unselected grades are disabled. For more information on creating and managing grades, see [Managing Corrections and Grades](#).

By default, each shot in a new project starts off with a single empty grade, but you can add another one at any time.

**To add a new grade to a shot**

Do one of the following:

- Move the playhead to the shot you want to add a new grade to, then press Control-1 through Control-4.
- Control-click or right-click the grade you want to switch to, then choose Add New Grade from the shortcut menu.
If there wasn't already a grade corresponding to the number of the grade you entered, one will be created. Whenever a new grade is added, the grades track expands, and the new grade becomes the selected grade. New grades are clean slates, letting you begin working from the original state of the uncorrected shot.

To select the current grade
1 Move the playhead to the shot you want to switch the grade of.
2 Do one of the following:
   • Click the grade you want to switch to.
   • Press Control-1 through Control-4.
   • Control-click or right-click the grade you want to switch to, then choose Select Grade \([x]\) from the shortcut menu, where \(x\) is the number of the grade you're selecting.

That shot in the Timeline is updated with the newly selected grade.

To reset a grade in the Timeline
1 Move the playhead to the shot you want to switch the grade of.
2 Control-click or right-click the grade you want to reset to in the grades track of the Timeline, then choose Reset Grade \([x]\) from the shortcut menu, where \(x\) is the number of the grade.

When you reset a grade, every room associated with that grade is reset, including the Primary In, Secondary, Color FX, and Primary Out rooms. The Geometry room is unaffected.

For more information, see Managing Corrections and Grades.

To delete a grade in the Timeline
1 Move the playhead to the shot you want to remove the grade from.
2 Control-click or right-click the grade you want to reset to in the grades track of the Timeline, then choose Remove Grade \([x]\) from the shortcut menu, where \(x\) is the number of the grade.

Note: If the grades track is locked, you cannot delete grades.
The Settings 1 Tab

The timing properties listed in the Settings 1 tab are not editable. Instead, they reflect each shot’s position in the Timeline and the properties of the source media that each shot is linked to.

- **Project In and Project Out**: Defines the location of the shot in the Timeline.

- **Trim In and Trim Out**: Defines the portion of source media that’s actually used in the project, relative to the total available duration of the source media file on disk. The Trim In and Trim Out timecodes cannot be outside the range of Source In and Source Out parameters.

- **Source In and Source Out**: Defines the start and end points of the original source media on disk. If Trim In is equal to Source In and Trim Out is equal to Source Out, there are no unused handles available in the source media on disk—you are using all available media.

- **Frame Rate pop-up menu**: This pop-up menu lets you set the frame rate of each clip individually. This setting overrides the Frame Rate setting in the Project Settings tab. For most projects using source media in the QuickTime format, this should be left at the default settings. For projects using DPX image sequences as the source media, this pop-up menu lets you change an incorrect frame rate in the DPX header data.
The Settings 2 Tab
The Settings 2 tab contains additional settings that let you modify the header data of DPX and Cineon image files.

- **Override Header Settings**: Selecting this button enables the Printing Density pop-up menu to be manually changed, so that you can override the printing density settings in the DPX header for the current shot.

- **Printing Density pop-up menu**: This pop-up menu is initially disabled, displaying the numeric range of values that 0 percent black and 100 percent white are mapped to in the source media. There are three options:
  - Film (95 Black - 685 White : Logarithmic)
  - Video (65 Black - 940 White : Linear)
  - Linear (0 Black - 1023 White)

If you're working with logarithmic DPX and Cineon film scans, the default black point is typically 95, and the default white point is typically 685. When you first load a project that uses scanned film media, it’s important to make sure that the Black Point and White Point settings aren’t filled with spurious data. Check with your lab to verify the appropriate settings, and if the settings in your source media don’t match, turn on Override Header Settings, and then choose a new printing density from this pop-up menu. For more information, see Choosing Printing Density When Rendering DPX Media.

- **DeInterlace**: Selecting this button lets you individually deinterlace clips. This setting overrides the Deinterlace Renders and Deinterlace Previews settings in the Project Settings tab. When DeInterlace is turned on, both video fields are averaged together to create a single frame.

- **Copy To All**: Copies the current header settings to every single shot in the Timeline. This is useful if you find that the header data for all of the film scan media your program uses is incorrect. Use this with extreme caution.

- **Copy To Selected**: Copies the current header settings to all currently selected shots in the Timeline. Useful if your project consists of a variety of scanned media from different sources with different header values.
Editing Controls and Procedures

Color is not intended to be an editing environment, and as a result its editing tool set isn’t as complete as that of an application like Final Cut Pro. In fact, most of the time you want to be careful not to make any editorial changes at all to your project in Color, for a variety of reasons:

- If you unlock the tracks of projects that were imported via XML or sent from Final Cut Pro and that will be returning to Final Cut Pro, you risk disrupting the project data, which will prevent you from successfully sending the project back to Final Cut Pro.
- If you make edits to a project that was sent from Final Cut Pro, you’ll only be able to send a simplified version of that project back to Final Cut Pro which contains only the shots and transitions in track V1, and the Pan & Scan settings in the Geometry room.
- If you import an EDL and make edits, you can export an EDL from Color that incorporates your changes; however, that EDL will only contain the shots and transitions in track V1.
- If the project you’ve imported is synchronized to an audio mix, making any editorial changes risks breaking the audio sync.

However, if you’re working on a project where these issues aren’t important, you can use editing tools and commands in Color to edit shots in unlocked tracks in the Timeline.

Tip: If you need to make an editorial change, you can always reedit the original sequence in Final Cut Pro, export a new XML file, and use the Reconform command to update the Color Timeline to match the changes you made.

Select Tool

The Select tool is the default state of the pointer in Color. As the name implies, this tool lets you select shots in the Timeline, move them to another position in the edit, or delete them.

It’s a good idea to reselect the Select tool immediately after making edits with any of the other tools, to make sure you don’t inadvertently continue making alterations in the Timeline that you don’t intend.

To reposition a shot in the Timeline

- Drag the shot to another position in the Timeline.

When you move a shot in the Timeline, where it ends depends on the In point’s relation to shots that are already there. Shots you move in Color never overwrite other shots. Instead, the other shots in the Timeline are moved out of the way to make way for the incoming shot, and the program is rippled as a result.

- If the In point of the moved shot overlaps the first half of another shot, nothing is changed.
• If the In point of the moved shot overlaps the second half of another shot, the shot you’re moving will be insert edited, and all other shots in the Timeline will be rippled to the right to make room.

• If you’re moving a shot into an area of the Timeline where it doesn’t overlap with any other shot, it’s simply moved to that area of the Timeline without rippling any other shots.

To delete a shot in the Timeline
1 Select one or more shots in the Timeline.
2 Do one of the following:
   • Press Delete.
   • Press Forward Delete.

The result is a lift edit, which leaves a gap in the Timeline where that shot used to be. No other shots move as a result of deleting a shot.

Roll Tool
The Roll tool lets you adjust the Out point and In point of two adjacent shots simultaneously. If you like where two shots are placed in the Timeline, but you want to change the cut point, you can use the Roll tool. No shots move in the Timeline as a result; only the edit point between the two shots moves. This is a two-sided edit, meaning that two shots’ edit points are affected simultaneously; the first shot’s Out point and the next shot’s In point are both adjusted by a roll edit. However, no other shots in the sequence are affected.

Note: When you perform a roll edit, the overall duration of the sequence stays the same, but both shots change duration. One gets longer while the other gets shorter to compensate. This means that you don’t have to worry about causing sync problems between linked shot items on different tracks.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Before edit</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>After edit</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the example above, shot B gets shorter while shot C becomes longer, but the combined duration of the two shots stays the same.

To perform a roll edit
1 Do one of the following to choose the Roll edit tool:
   • Choose Timeline > Roll Tool.
   • Press Control-R.
2 Move the pointer to the edit point between the two shots that you want to roll, and drag it either left or right to make the edit.

The Timeline updates to reflect the edit you’re making.

**Ripple Tool**

A ripple edit adjusts a shot’s In or Out point, making that shot longer or shorter, without leaving a gap in the Timeline. The change in duration of the shot you adjusted ripples through the rest of the program in the Timeline, moving all shots that are to the right of the one you adjusted either earlier or later in the Timeline.

A ripple edit is a one-sided edit, meaning that you can only use it to adjust the In or Out point of a single shot. All shots following the one you’ve adjusted are moved—to the left if you’ve shortened it or to the right if you’ve lengthened it. This is a significant operation that can potentially affect the timing of your entire program.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before edit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
</tr>
<tr>
<td>After edit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Important:* Ripple edits can be dangerous if you are trying to maintain sync between your program in Color and the original audio in the Final Cut Pro sequence or source EDL that is being mixed somewhere else entirely, since the shots in your Color project may move forward or backward while the externally synced audio doesn’t.

**To perform a ripple edit**

1 Do one of the following to choose the Ripple edit tool:
   - Choose Timeline > Ripple Tool.
   - Press Control-T.

2 Move the pointer to the In or Out point of the shot you want to shorten or lengthen, then drag it either left or right to make the edit.

The Timeline updates to reflect the edit you’re making, with all the shots following the one you’re adjusting moving to the left or right to accommodate the change in timing.

**Slip Tool**

Performing a slip edit doesn’t change a shot’s position or duration in the Timeline; instead it changes what portion of that shot’s media appears in the Timeline by letting you change its In and Out points simultaneously.
This means that the portion of the shot that plays in the Timeline changes, while its position in the Timeline stays the same. No other shots in the Timeline are affected by a slip edit, and the overall duration of the project remains unaffected.

In the example above, the slip edit changes the In and Out points of shot B, but not its duration or position in the sequence. When the sequence plays back, a different portion of shot B’s media will be shown.

To perform a slip edit
1 Move the playhead to the shot you want to adjust, in order to be able to view the change you’re making as you work.
2 Do one of the following to choose the Slip edit tool:
   • Choose Timeline > Slip Tool.
   • Press Control-Y.
3 Move the pointer to the shot you want to slip, then drag it either left or right to make the edit.

Unlike Final Cut Pro, Color provides no visual feedback showing the frames of the new In and Out points you’re choosing with this tool. The only image that’s displayed is the frame at the current position of the playhead being updated as you drag the shot back and forth. This is why it’s a good idea to move the playhead to the shot you’re adjusting before you start making a slip edit.

Split Tool
The Split tool lets you add an edit point to a shot by cutting it into two pieces. This edit point is added at the frame you click in the Timeline. This can be useful for deleting a section of a shot or for applying an effect to a specific part of a shot.

To split one shot into two
1 Do one of the following to choose the Split tool:
   • Choose Timeline > Split Tool.
   • Press Control-X.
2 Move the pointer to the Timeline ruler, and when the split overlay appears (a vertical white line intersecting the shots in the Timeline), drag it to the frame of the shot where you want to add an edit point.

3 Click to add an edit point.

The Timeline updates to reflect the edit you’ve made, with a new edit point appearing at the frame you clicked.

**Splice Tool**

Whenever you cut a shot with the Split tool, the original shot is split into two shots separated by a through edit. There is no visual indication of through edits in the Color Timeline, but any edit point that splits an otherwise contiguous range of frames is considered to be a through edit, which can be joined back together with the Splice tool.

Joining two shots separated by a through edit merges them back into a single shot. You cannot join two shots that aren’t separated by a through edit; if you try you’ll simply get a warning message.

*Important:* When you splice two shots that have different grades and corrections, the grades and corrections of the shot to the left overwrite those of the shot to the right.

**To splice two shots into one**

1 Do one of the following to choose the Splice tool:
   - Choose Timeline > Splice Tool.
   - Press Control-Z.

2 Move the pointer to the Timeline ruler, and when the splice overlay appears (a vertical white line intersecting the shots in the Timeline), drag it to the edit point you want to splice.

3 Click to splice that edit point.

The Timeline updates to reflect the edit you’ve made, and the two shots that were previously separated by a through edit are spliced into one.

**Create an Edit Command**

The Create an Edit command in the Timeline menu (Control-V) is similar to the Split tool. It cuts a single shot in the Timeline into two at the current position of the playhead. Using this command eliminates the need to choose a tool.

**To create an edit point**

1 Move the playhead to the frame where you want to add an edit point.

2 Do one of the following:
   - Choose Timeline > Create an Edit.
   - Press Control-V.
The Timeline updates to reflect the edit you’ve made, with a new edit point appearing at the position of the playhead.

**Merge Edits Command**
The Merge Edits command (Control-B) is similar to the Splice tool. It joins two shots separated by a through edit at the current position of the playhead into a single shot. Using this command eliminates the need to choose a tool.

**To merge two shots into one at a through edit point**
1. Move the playhead to the frame at the through edit you want to merge.
2. Do one of the following:
   - Choose Timeline > Merge Edits.
   - Press Control-B.

The Timeline updates to reflect the edit you’ve made, and the two shots that were previously separated by a through edit are merged into one.

*Important:* When you splice two shots that have different grades and corrections, the grades and corrections of the shot to the left overwrite those of the shot to the right.

**Snapping**
When snapping is on, clips “snap to” the 00:00:00:00 time value in the Timeline.

**To turn snapping on or off**
- Choose Timeline > Snapping.
In addition to a well-calibrated broadcast display, video scopes provide a fast and accurate way to quantitatively evaluate and compare images.

Color provides most of the video scope displays that you'd find in other online video and color correction suites and includes a few that are unique to software-based image analysis. Together, these scopes provide graphic measurements of the luma, chroma, and RGB levels of the image currently being monitored, helping you to unambiguously evaluate the qualities that differentiate one shot from another. This feature lets you make more informed decisions while legalizing or comparing shots in Color.

This chapter covers the following:

• What Scopes Are Available? (p. 183)
• Video Scope Options (p. 185)
• Analyzing Images Using the Video Scopes (p. 187)

What Scopes Are Available?
The following video scopes are available in the Scopes window:

• The Waveform Monitor
• The Parade Scope
• The Overlay Scope
• The Red/Green/Blue Channels Scopes
• The Luma Scope
• The Chroma Scope
• The Y′C_bC_r Scope
• The Vectorscope
• The Histogram
• The RGB Histogram
• The R, G, and B Histograms
- The Luma Histogram
- The 3D Scope
- The RGB Color Space
- The HSL Color Space
- The Y’C_bC_r Color Space
- The IPT Color Space

The location where the video scopes appear depends on whether Color is configured to single- or dual-display mode:

- **In single-display mode:** Two video scopes are displayed underneath the video preview in the Scopes window, which is positioned to the left of the Color interface window.
• In dual-display mode: Up to three video scopes are displayed in the Scopes window, in addition to the video preview.

The Accuracy of Color Video Scopes

To create a real-time analysis of the video signal (even during adjustment and playback), Color downsamples the current image to a resolution of 384 x 192. The downsampled image is then analyzed and the resulting data displayed by the currently selected scopes. This same downsampled resolution is used regardless of the original resolution of the source media.

Using this method, every pixel contributes to the final analysis of the image. In tests, the graphs produced by the Color video scopes closely match those produced by dedicated video scopes and are extremely useful as an aid to evaluating and matching shots while you work in Color. However, you should be aware that the Color analysis is still an approximation of the total data. Dedicated video scopes are still valuable for critical evaluation.

Note: If you're concerned about catching stray out-of-gamut pixels while you make adjustments for QC purposes, you can turn on the Broadcast Safe settings to protect yourself from QC violations. For more information, see Broadcast Safe Settings.

Video Scope Options

You can modify the display and behavior of the video scopes in a number of ways.

To turn on real-time video scope updates
1 Open the User Prefs tab located inside the Setup room.
2 Select Update UI During Playback.
3 To set the video scopes to update during playback, select Update Secondary Display.

*Tip:* You can turn off Update Primary Display to improve playback performance.

Some scopes can be switched among different modes.

**To change a scope to a different mode**
- Click the button corresponding to the mode you want at the top of that scope.

Any quadrant containing a video scope can also be switched to a different kind of scope.

**To switch the layout of the Scopes window**
- Do one of the following:
  - Control-click or right-click within any scope, then choose a different scope from the shortcut menu.
  - Move the pointer within any region of the Scopes window, and press W (Waveform), V (Vectorscope), H (Histogram), or C (3D scopes) to change scopes.

You can zoom in to all scopes to get a closer look at the graph.

**To zoom a scope’s display**
- Do one of the following:
  - Roll the scroll wheel or scroll ball of your mouse down to zoom in to a particular scope’s display, and up to zoom out.
  - Click one of the percentage buttons in the upper-left corner of the Vectorscope to scale the scope’s display.

The 3D video scopes can also be rotated in space so that you can view the analysis from any angle.

**To reposition any 3D scope**
- Do one of the following:
  - Drag horizontally or vertically to rotate the scope model in that direction.
  - Hold down the middle mouse button and drag to reposition the scope model in that direction.

**To reset any scope to its original scale and orientation**
- Control-click or right-click within any scope, then choose Reset from the shortcut menu.
Some scopes can be displayed in color.

To turn video scope color on and off
1. Open the User Prefs tab, located inside the Setup room.
2. Click Monochrome Scopes to turn scope color on or off.

Scope color is affected by the following customizable parameters:
- *When Monochrome Scopes is turned off*: The UI Saturation parameter determines how intense the scope colors are.
- *When Monochrome Scopes is turned on*: The Scope Color control directly underneath controls the color of the scope graticules.

Analyzing Images Using the Video Scopes
The following sections describe the use of each scope that Color provides:
- The Waveform Monitor
- The Vectorscope
- The Histogram
- The 3D Scope
- Sampling Color for Analysis

The Waveform Monitor
The Waveform Monitor is actually a whole family of scopes that shows different analyses of luma and chroma using *waveforms*.

What Is a Waveform?
To create a waveform, Color analyzes lines of an image from left to right, with the resulting values plotted vertically on the waveform graticule relative to the scale that’s used—for example, –20 to 110 IRE (or –140 to 770 mV) on the Luma graph. In the following image, a single line of the image is analyzed and plotted in this way.
To produce the overall analysis of the image, the individual graphs for each line of the image are superimposed over one another.

Because the waveform's values are plotted in the same horizontal position as the portion of the image that's analyzed, the waveform mirrors the image to a certain extent. This can be seen if a subject moves from left to right in an image while the waveform is playing in real time.

With all the waveform-style scopes, high luma or chroma levels show up as spikes on the waveform, while low levels show up as dips. This makes it easy to read the measured levels of highlights or shadows in the image.

**Changing the Graticule Values**
The Waveform Monitor is the only scope in which you can change the numeric values used to measure the signal. By default, the Waveform Monitor is set to measure in IRE, but you can also switch the scope to measure using millivolts (mV) instead by clicking one of the buttons to the right of the waveform selection buttons.
Waveform Analysis Modes
The Waveform Monitor has eight different modes. For more information, see:

- The Parade Scope
- The Overlay Scope
- The Red/Green/Blue Channels Scopes
- The Luma Scope
- The Chroma Scope
- The Y’C_bC_r Scope

The Parade Scope
The Parade scope displays separate waveforms for the red, green, and blue components of the image side by side. If Monochrome Scopes is turned off, the waveforms are tinted red, green, and blue so you can easily identify which is which.

Note: To better illustrate the Parade scope’s analysis, the examples in this section are shown with Broadcast Safe disabled so that image values above 100 percent and below 0 percent won’t be clipped.
The Parade scope makes it easy to spot color casts in the highlights and shadows of an image, by comparing the contours of the top and the bottom of each waveform. Since whites, grays, and blacks are characterized by exactly equal amounts of red, green, and blue, neutral areas of the picture should display three waveforms of roughly equal height in the Parade scope. If not, the correction is easy to make by making adjustments to level the three waveforms.

Before color correction

After color correction
The Parade scope is also useful for comparing the relative levels of reds, greens, and blues between two shots. If one shot has more red than another, the difference shows up as an elevated red waveform in the one and a depressed red waveform in the other, relative to the other channels. In the first shot, the overall image contains quite a bit of red. By comparison, the second shot has substantially less red and far higher levels of green, which can be seen immediately in the Parade scope. If you needed to match the color of these shots together, you could use these measurements as the basis for your correction.

An elevated red channel betrays the degree of the color cast.

An elevated green channel reveals a different correction to be made.

The Parade scope also lets you spot color channels that are exceeding the chroma limit for broadcast legality, if the Broadcast Safe settings are turned off. This can be seen in waveforms of individual channels that either rise too high or dip too low.
The Overlay Scope
The Overlay scope presents information that’s identical to that in the Parade scope, except that the waveforms representing the red, green, and blue channels are superimposed directly over one another.

This can make it easier to spot the relative differences or similarities in overlapping areas of the three color channels that are supposed to be identical, such as neutral whites, grays, or blacks.

Another feature of this display is that when the video scopes are set to display color (by turning off the Monochrome Scopes parameter), areas of the graticule where the red, green, and blue waveforms precisely overlap appear white. This makes it easy to see when you’ve eliminated color casts in the shadows and highlights by balancing all three channels.

The Red/Green/Blue Channels Scopes
These scopes show isolated waveforms for each of the color channels. They’re useful when you want a closer look at a single channel’s values.
The Luma Scope
The Luma scope shows you the relative levels of brightness within the image. Spikes or drops in the displayed waveform make it easy to see hot spots or dark areas in your picture.

The difference between the highest peak and the lowest dip of the Luma scope’s graticule shows you the total contrast ratio of the shot, and the average thickness of the waveform shows its average exposure. Waveforms that are too low are indicative of images that are dark, while waveforms that are too high may indicate overexposure.

Underexposed waveform

Well-exposed waveform

Overexposed waveform

If you’re doing a QC pass of a program with the Broadcast Safe settings turned off, you can also use the scale to easily spot video levels that are over and under the recommended limits.
The Chroma Scope
This scope shows the combined $C_B$ and $C_R$ color difference components of the image. It’s useful for checking whether or not the overall chroma is too high, and also whether it’s being limited too much, as it lets you see the result of the Chroma Limit setting being imposed when Broadcast Safe is turned on.

For example, the following graph shows extremely saturated chroma within the image:

![Graph showing chroma spikes before and after Broadcast Safe]

When you turn Broadcast Safe on with the default Chroma Limit value of 50, you can see that the high chroma spikes have been limited to 50.

The $Y’C_BC_R$ Scope
This scope shows the individual components of the $Y’C_BC_R$ encoded signal in a parade view. The leftmost waveform is the luma ($Y’$) component, the middle waveform is the $C_B$ color difference component, and the rightmost waveform is the $C_R$ color difference component.

![Graph showing individual components]

Chapter 8 Analyzing Signals Using the Video Scopes
The Vectorscope

The Vectorscope shows you the overall distribution of color in your image against a circular scale. The video image is represented by a graph consisting of a series of connected points that all fall at about the center of this scale. For each point within the analyzed graph, its angle around the scale indicates its hue (which can be compared to the color targets provided), while its distance from the center of the scale represents the saturation of the color being displayed. The center of the Vectorscope represents zero saturation, and the farther from the center a point is, the higher its saturation.

If the Monochrome Scopes option is turned off in the User Prefs tab of the Setup room, then the points of the graph plotted by the Vectorscope will be drawn with the color from that part of the source image. This can make it easier to see which areas of the graph correspond to which areas of the image.

Comparing Saturation with the Vectorscope

The Vectorscope is useful for seeing, at a glance, the hue and intensity of the various colors in your image. Once you learn to identify the colors in your shots on the graph in the Vectorscope, you will be better able to match two images closely because you can see where they vary. For example, if one image is more saturated than another, its graph in the Vectorscope will be larger.
Spotting Color Casts with the Vectorscope
You can also use the Vectorscope to spot whether there’s a color cast affecting portions of the picture that should be neutral (or desaturated). Crosshairs in the Vectorscope graticule indicate its center. Since desaturated areas of the picture should be perfectly centered, an off-center Vectorscope graph representing an image that has portions of white, gray, or black clearly indicates a color imbalance.

The Color Targets
The color targets in the Vectorscope line up with the traces made by the standard color bar test pattern, and can be used to check the accuracy of a captured video signal that has recorded color bars at the head.

These targets also correspond to the angles of hue in the color wheels surrounding the Color Balance controls in the Primary In and Out and Secondaries rooms. If the hues of two shots you’re trying to match don’t match, the direction and distance of their offset on the Vectorscope scale give you an indication of which direction to move the balance control indicator to correct for this.

At a zoom percentage of 75 percent, the color targets in the Vectorscope are calibrated to line up for 75 percent color bars. Zooming out to 100 percent calibrates the color targets to 100 percent color bars. All color is converted by Color to RGB using the Rec. 709 standard prior to analysis, so color bars from both NTSC and PAL source video will hit the same targets.

Note: If Broadcast Safe is turned on, color bars’ plots may not align perfectly with these targets.
The I Bar
The –I bar (negative I bar) shows the proper angle at which the hue of the dark blue box in the color bars test pattern should appear. This dark blue box, which is located to the left of the 100-percent white reference square, is referred to as the inphase signal, or I for short.

The I bar (positive I bar) overlay in the Vectorscope is also identical to the skin tone line in Final Cut Pro. It's helpful for identifying and correcting the skin tones of actors in a shot. When recorded to videotape and measured on a Vectorscope, the hues of human skin tones, regardless of complexion, fall along a fairly narrow range (although the saturation and brightness vary). When there's an actor in a shot, you'll know whether or not the skin tones are reproduced accurately by checking to see if there's an area of color that falls loosely around the I bar.

If the skin tones of your actors are noticeably off, the offset between the most likely nearby area of color in the Vectorscope graph and the skin tone target will give you an idea of the type of correction you should make.
The Q Bar
The Q bar shows the proper angle at which the hue of the purple box in the color bars test pattern should appear. This purple box, which is located at the right of the 100-percent white reference square, is referred to as the +Quadrature signal, or Q for short.

When troubleshooting a video signal, the correspondence between the Inphase and +Quadrature components of the color bars signal and the position of the –I and Q bars shows you whether or not the components of the video signal are being demodulated correctly.

The Histogram
The Histogram provides a very different type of analysis than the waveform-based scopes. Whereas waveforms have a built-in correspondence between the horizontal position of the image being analyzed and that of the waveform graph, histograms provide a statistical analysis of the image.

Histograms work by calculating the total number of pixels of each color or luma level in the image and plotting a graph that shows the number of pixels there are at each percentage. It’s really a bar graph of sorts, where each increment of the scale from left to right represents a percentage of luma or color, while the height of each segment of the histogram graph shows the number of pixels that correspond to that percentage.

The RGB Histogram
The RGB histogram display shows separate histogram analyses for each color channel. This lets you compare the relative distribution of each color channel across the tonal range of the image.
For example, images with a red color cast have either a significantly stronger red histogram, or conversely, weaker green and blue histograms. In the following example, the red cast in the highlights can be seen clearly.

![Image of a red color cast in highlights](image)

**The R, G, and B Histograms**
The R, G, and B histograms are simply isolated versions of each channel's histogram graph.

**The Luma Histogram**
The Luma histogram shows you the relative strength of all luminance values in the video frame, from black to super-white. The height of the graph at each step on the scale represents the number of pixels in the image at that percentage of luminance, relative to all the other values. For example, if you have an image with few highlights, you would expect to see a large cluster of values in the Histogram display around the midtones.

![Image of a luma histogram](image)

The Luma histogram can be very useful for quickly comparing the luma of two shots so you can adjust their shadows, midtones, and highlights to match more closely. For example, if you were matching a cutaway shot to the one shown above, you can tell just by looking that the image below is underexposed, but the Histogram gives you a reference for spotting how far.

![Image of an underexposed image](image)
The shape of the Histogram is also good for determining the amount of contrast in an image. A low-contrast image, such as the one shown above, has a concentrated clump of values nearer to the center of the graph. By comparison, a high-contrast image has a wider distribution of values across the entire width of the Histogram.

![Histogram Image](image)

**The 3D Scope**

This scope displays an analysis of the color in the image projected within a 3D area. You can select one of four different color spaces with which to represent the color data.

**The RGB Color Space**

The RGB color space distributes color in space within a cube that represents the total range of color that can be displayed:

- Absolute black and white lie at two opposing diagonal corners of the cube, with the center of the diagonal being the desaturated grayscale range from black to white.
- The three primary colors—red, green, and blue—lie at the three corners connected to black.
- The three secondary colors—yellow, cyan, and magenta—lie at the three corners connected to white.

In this way, every color that can be represented in Color can be assigned a point in three dimensions using hue, saturation, and lightness to define each axis of space.
The sides of the cube represent color of 100-percent saturation, while the center diagonal from the black to white corners represents 0-percent saturation. Darker colors fall closer to the black corner of the cube, while lighter colors fall closer to the diagonally opposing white corner of the cube.

**The HSL Color Space**

The HSL (Hue, Saturation, and Luminance) color space distributes a graph of points within a two-pointed cone that represents the range of color that can be displayed:

- Absolute black and white lie at two opposing points at the top and bottom of the shape.
- The primary and secondary colors are distributed around the familiar color wheel, with 100-percent saturation represented by the outer edge of the shape, and 0-percent saturation represented at the center.

In this way, darker colors lie at the bottom of the interior, while lighter colors lie at the top. More saturated colors lie closer to the outer sides of the shape, while less saturated colors fall closer to the center of the interior.

**The Y′C₈C₉ Color Space**

The Y′C₈C₉ color space is similar to the HSL color space, except that the outer boundary of saturation is represented with a specifically shaped six-sided construct that shows the general boundaries of color in broadcast video.
The outer boundary does not identify the broadcast-legal limits of video, but it does illustrate the general range of color that's available. For example, the following image has illegal saturation and brightness.

If you turn on the Broadcast Safe settings, the distribution of color throughout the $Y'C_BC_R$ color space becomes constricted.

The IPT Color Space
The IPT color space is a perceptually weighted color space, the purpose of which is to more accurately represent the hues in an image distributed on a scale that appears uniformly linear to your eye.

While the RGB, HSL, and $Y'C_BC_R$ color spaces present three-dimensional analyses of the image that are mathematically accurate, and allow you to see how the colors of an image are transformed from one gamut to another, they don't necessarily show the distribution of colors as your eyes perceive them. A good example of this is a conventionally calculated hue wheel. Notice how the green portion of the hue wheel presented below seems so much larger than the yellow or red portion.
The cones of the human eye that are sensitive to color have differing sensitivities to each of the primaries (red, green, and blue). As a result, a mathematically linear distribution of analyzed color is not necessarily the most accurate way to represent what we actually see. The IPT color space rectifies this by redistributing the location of hues in the color space according to tests where people chose and arranged an even distribution of hues from one color to another, to define a spectrum that “looked right” to them.

In the IPT color space, I corresponds to the vertical axis of lightness (desaturated black to white) running through the center of the color space. The horizontal plane is defined by the P axis, which is the distribution of red to green, and the T axis, which is the distribution of yellow to blue.

Here’s an analysis of the test image within this color space.

**Sampling Color for Analysis**
The 3D video scope also provides controls for sampling and analyzing the color of up to three pixels within the currently displayed image. Three *swatches* at the bottom of the video scope let you sample colors for analysis by dragging one of three correspondingly numbered crosshairs within the image preview area. A numerical analysis of each sampled color appears next to the swatch control at the bottom of the 3D video scope.

The color channel values that are used to analyze the selected pixel change depending on which color space the 3D scope is set to. For example, if the 3D scope is set to RGB, then the R, G, and B values of each selected pixel will be displayed. If the 3D scope is instead set to Y’CbCr, then the Y’, Cb, and Cr values of the pixel will be displayed.

You can choose different samples for each shot in the Timeline, and the position of each shot’s sampling crosshairs is saved as you move the playhead from clip to clip. This makes it easy to compare analogous colors in several different shots to see if they match.
This analysis can be valuable in situations where a specific feature within the image needs to be a specific value. For example, you can drag swatches across the frame if you’re trying to adjust a black, white, or colored background to be a uniform value, or if you have a product that’s required to be a highly specific color in every shot in which it appears.

**Note:** These controls are visible only when the 3D scope is occupying an area of the Scopes window.

**To sample and analyze a color**

1. Click one of the three color swatch buttons at the bottom of the 3D scope.

2. Click or drag within the image preview area to move the color target to the area you want to analyze.

As you drag the color target over the image preview, four things happen:

- The color swatch updates with that color.
- The H, S, and L values of the currently analyzed pixel are displayed to the right of the currently selected swatch.
• Crosshairs identify the value's location within the three-dimensional representation of color in the 3D scope itself.

Each color target is numbered to identify its corresponding color swatch.

• A vertical line appears within the Hue, Sat, and Lum curves of the Secondaries room, showing the position of the sample pixels relative to each curve.
The Primary In room provides your main interface for color correcting each shot. For every shot, this is where you begin, and in many cases this may be all you need.

Simply speaking, *primary corrections* are color corrections that affect the entire image at once. The Primary In room provides a variety of controls that will be familiar to anyone who’s worked with other image editing and color correction plug-ins and applications. Each of these controls manipulates the contrast and color in the image in a different way.

*Note:* Many of the controls in the Primary In room also appear in the Secondaries and Primary Out rooms, in which they have identical functionality.

This chapter covers the following:

- What Is the Primary In Room Used For? (p. 207)
- Where to Start in the Primary In Room? (p. 208)
- Contrast Adjustment Explained (p. 210)
- Using the Primary Contrast Controls (p. 212)
- Color Casts Explained (p. 222)
- Using Color Balance Controls (p. 224)
- The Curves Controls (p. 234)
- The Basic Tab (p. 245)
- The Advanced Tab (p. 249)
- Using the Auto Balance Button (p. 251)
- The RED Tab (p. 252)

**What Is the Primary In Room Used For?**

Typically, you'll use the Primary In room to do tasks such as the following:

- To adjust image contrast, so that the shadows are deep enough, the highlights are bright enough, and the overall lightness of the image is appropriate to the scene.
• To adjust color in the highlights and midtones to correct for unwanted color casts due to a video camera’s incorrect white balance settings, or lighting that was inappropriate for the type of film stock that was used.

• To make changes to the overall color and contrast of an image in order to change the apparent time of day. For example, you might need to alter a shot that was photographed in the late afternoon to look as if it were shot at high noon.

• To adjust the color and contrast of every shot in a scene so that there are no irregularities in exposure or color from one shot to the next.

All these tasks and more can be performed using the tools that are available in the Primary In room. In fact, when working on shows that require relatively simple corrections, you may do all your corrections right here, including perhaps a slight additional adjustment to warm up or cool down the image for purely aesthetic purposes. (On the other hand, you can also perform different stages of these necessary corrections in other rooms for organizational purposes. For more information about how to split up and organize corrections in different ways, see Managing a Shot’s Corrections Using Multiple Rooms.)

The Primary In room also lets you make specific adjustments. Even though the Primary In room applies corrections to the entire image, you can target these corrections to specific aspects of the picture. Many of the controls in the Primary In room are designed to make adjustments to specific regions of tonality. In other words, some controls adjust the color in brighter parts of the picture, while other controls only affect the color in its darker regions. Still other types of controls affect specific color channels, such that you can lower or raise the green channel without affecting the red or blue channels.

Where to Start in the Primary In Room?
Many colorists use the tools in the Primary In room in a specific order. This order is used to organize the sections of this document to provide you with a workflow with which to get started. In general, you’ll probably find that you work on most images using the following steps.

• Stage 1: Adjusting the Contrast of the Image
• Stage 2: Adjusting the Color Balance of the Image
• Stage 3: Adjusting the Saturation of the Image
• Stage 4: Making More Specific Adjustments
Stage 1: Adjusting the Contrast of the Image
Most colorists always begin by correcting the contrast of an image before moving on to adjusting its color. This adjustment can be made using the primary contrast controls, the Luma curve control, and the Master Lift, Master Gain, and Master Gamma controls in the Basic tab.

Stage 2: Adjusting the Color Balance of the Image
Once the black and white points of the image have been determined, the color balance is tackled. Fast adjustments to the color balance in the shadows, midtones, and highlights can be made using the primary color balance controls. More detailed adjustments can be made using the red, green, and blue curves controls, and specific numeric adjustments can be made using the Red, Green, and Blue Lift, Gamma, and Gain controls in the Advanced tab.

Stage 3: Adjusting the Saturation of the Image
Once you’re happy with the quality of the color, you can make adjustments to raise or lower the saturation, or intensity, of the colors in the image. The Saturation, Highlight Sat., and Shadow Sat. controls in the Basic tab let you adjust the overall saturation or only the saturation within specific tonal regions.
Stage 4: Making More Specific Adjustments

If you still feel that there are specific aspects of the image that need further adjustment after Stages 1 through 3, you can turn to the curves controls, which let you make targeted adjustments to the color and contrast of the image within specifically defined zones of tonality. Past a certain point, however, it may be easier to move on to the Secondaries room, covered in The Secondaries Room.

Contrast Adjustment Explained

If you strip away the color in an image (you can do this by setting the Saturation control to 0), the grayscale image that remains represents the luma component of the image, which is the portion of the image that controls the lightness of the image. As explained in The Y’CbCr Color Model Explained, the luma of an image is derived from a weighted ratio of the red, green, and blue channels of the image which corresponds to the eye’s sensitivity to each color.

Although luma was originally a video concept, you can manipulate the luma component of images using the contrast controls in Color no matter what the originating format. These controls let you adjust the lightness of an image more or less independently of its color.

Note: Extreme adjustments to image contrast will affect image saturation.
What Is the Contrast Ratio of a Shot?
One of the most important adjustments you can make to an image is to change its contrast ratio. The contrast ratio of an image is the difference between the darkest pixel in the shadows (the black point) and the lightest pixel in the highlights (the white point). The contrast ratio of an image is easy to quantify by looking at the Waveform Monitor or Histogram set to Luma. High-contrast images have a wide distribution of values from the black point to the white point.

Low-contrast images, on the other hand, have a narrower distribution of values from the black point to the white point.

The Shadows, Midtones, and Highlights contrast sliders let you make individual adjustments to each of the three defining characteristics of contrast.

Note: Contrast adjustments made with the primary contrast sliders can affect the saturation of the image. Raising luma by a significant amount can reduce saturation, while reducing luma can raise image saturation. This behavior is different from that of the Color Corrector 3-way filter in Final Cut Pro, in which changes to contrast have no effect on image saturation.
Using the Primary Contrast Controls
The primary contrast controls consist of three vertical sliders that are used to adjust the black point, the distribution of midtones, and the white point of the image.

Each slider is a vertical gradient. Dragging down lowers its value, while dragging up raises its value. A blue bar shows the current level at which each slider is set, while the third number in the Output display (labeled $L$) below each color control shows that slider’s numeric value. Contrast adjustment is a big topic. For more information, see:

- Adjusting the Black Point with the Shadow Slider
- Adjusting the Midtones with the Midtone Slider
- Adjusting the White Point with the Highlight Slider
- Expanding and Reducing Image Contrast
- Contrast Affects Color Balance Control Operation

Using Contrast Sliders with a Control Surface
In the Primary In, Secondary, and Primary Out rooms, the three contrast sliders usually correspond to three contrast rings, wheels, or knobs on compatible control surfaces. Whereas you can adjust only one contrast slider at a time using the onscreen controls with a mouse, you can adjust all three contrast controls simultaneously using a hardware control surface.

When you’re using a control surface, the Encoder Sensitivity parameter in the User Pref tab of the Setup room lets you customize the speed with which these controls make adjustments. For more information, see Control Surface Settings.
Adjusting the Black Point with the Shadow Slider

The behavior of the Shadow contrast slider depends on whether or not the Limit Shadow Adjustments preference (in the User Prefs tab of the Setup room) is turned on. (For more information, see User Interface Settings.)

- **If Limit Shadow Adjustments is turned off:** Contrast adjustments with the Shadow slider are performed as a simple lift operation. The resulting correction uniformly lightens or darkens the entire image, altering the shadows, midtones, and highlights by the same amount. This can be seen most clearly when adjusting the black point of a linear black-to-white gradient, which appears in the Waveform Monitor as a straight diagonal slope. Notice how the entire slope of the gradient in the Waveform Monitor moves up.

![Adjusting the Black Point with the Shadow Slider](image)
• If Limit Shadow Adjustments is turned on: The black point is raised, but the white point remains at 100 percent. This means that when you make any adjustments with the Shadow contrast slider, all midtones in the image are scaled between the new black point and 100 percent. Notice how the top of the slope in the Waveform Monitor stays in place while the black point changes.

You’ll probably leave the Limit Shadow Adjustments control turned on for most of your projects, since this setting gives you the most control over image contrast (and color, as you’ll see later) in your programs.
Contrast adjustments to the shadows are one of the most frequent operations you'll perform. Lowering the blacks so that the darkest shadows touch 0 percent (seen in the bottom of the Waveform Monitor’s graph or on the left of the Histogram’s graph when either is set to Luma) deepens the shadows of your image. Deeper shadows can enrich the image and accentuate detail that was being slightly washed out before.

Lowering the blacks even more, (called crushing the blacks because no pixel can be darker than 0 percent), creates even higher-contrast looks. Crushing the blacks comes at the expense of losing detail in the shadows, as larger portions of the image become uniformly 0 percent black. This can be seen clearly in the black portion of the gradient at the bottom of the image.

*Note:* Even if Limit Shadow Adjustments is turned on, you can still make lift adjustments to the image using the Master Lift parameter in the Basic tab. See [Master Contrast Controls](#).

**Adjusting the Midtones with the Midtone Slider**

The Midtone contrast slider lets you make a nonlinear adjustment to the distribution of midtones in the image (sometimes referred to generically as a *gamma* adjustment). What this means is that you can adjust the middle tones of the image without changing the darkness of the shadows or the lightness of the highlights.
Here are two examples of using the Midtone contrast slider. The midtones have been lowered in the following image. Notice how the overall image has darkened, with more of the picture appearing in the shadows; however, the highlights are still bright, and the shadow detail has not been lost. The top and bottom of the gradient’s slope in the Waveform Monitor remain more or less in place, and the slope itself curves downward, illustrating the nonlinear nature of the adjustment.

Next, the Midtone slider is raised. The image has clearly lightened, and much more of the picture is in the highlights. Yet the deepest shadows remain rich and dark, and the detail in the highlights isn’t being lost since the highlights are staying at their original level. Again, the top and bottom of the gradient’s slope in the Waveform Monitor remain more or less in place, but this time the slope curves upward.
No matter what contrast ratio you decide to employ for a given shot, the Midtone slider is one of your main tools for adjusting overall image lightness when creating mood, adjusting the perceived time of day, and even when simply ensuring that the audience can see the subjects clearly.

**Note:** Even though midtones adjustments leave the black and white points at 0 and 100 percent respectively, extreme midtones adjustments will still crush the blacks and flatten the whites, eliminating detail in exchange for high-contrast looks.

**Adjusting the White Point with the Highlight Slider**
The Highlight slider is the inverse of the Shadow slider. Using this control, you can raise or lower the white point of the image, while leaving the black point relatively untouched. All the midtones of the image are scaled between your new white point and 0 percent.

If the image is too dark and the highlights seem lackluster, you can raise the Highlight slider to brighten the highlights, while leaving the shadows at their current levels. Notice that the black point of the gradient's slope in the Waveform Monitor remains at 0 percent after the adjustment.

**Note:** In this example, Broadcast Safe has been turned off, and you can see the white level of the gradient clipping at the maximum of 109 percent.
If the highlights are too bright, you can lower the Highlight slider to bring them back down, without worrying about crushing the blacks.

Overly bright highlights are often the case with images shot on video, where super-white levels above the broadcast legal limit of 100 percent frequently appear in the source media (as seen in the previous example). If left uncorrected, highlights above 100 percent will be clipped by the Broadcast Safe settings when they’re turned on, resulting in a loss of highlight detail when all pixels above 100 percent are set to 100 percent.

By lowering the white point yourself, you can bring clipped detail back into the image.

Note: Values that are clipped or limited by Color are preserved internally and may be retrieved in subsequent adjustments. This is different from overexposed values in source media, which, if clipped at the time of recording, are lost forever.
While modest adjustments made with the Highlight slider won’t affect the black point, they will have an effect on the midtones that is proportional to the amount of your adjustment. The influence of the Highlight slider falls off toward the shadows, but it’s fair to say that adjustments made with the Highlight slider have a gradually decreasing effect on approximately the brightest 80 percent of the image.

For this reason, you may find yourself compensating for a Highlight slider adjustment’s effect on the midtones of your image by making a smaller inverse adjustment with the Midtone slider.

The suitable white point for your particular image is highly subjective. In particular, just because something is white doesn’t mean that it’s supposed to be up at 100 percent. Naturally bright features such as specular highlights, reflected glints, and exposed light sources are all candidates for 100 percent luma. (Chances are these areas are at super-white levels already, so you’ll be turning the brightness down if broadcast legality is an issue.)

On the other hand, if you’re working on an interior scene with none of the previously mentioned features, the brightest subjects in the scene may be a wall in the room or the highlights of someone's face, which may be inappropriately bright if you raise them to 100 percent. In these cases, the brightness at which you set the highlights depends largely on the kind of lighting that was used. If the lighting is subdued, you’ll want to keep the highlights lower than if the lighting is intentionally bright.

**Expanding and Reducing Image Contrast**
For a variety of reasons, it’s often desirable to stretch the contrast ratio of an image so that it occupies the widest range of values possible, without introducing unwanted noise. (This can sometimes happen in underexposed images that require large contrast adjustments.)
Most images don’t start out with the highest-contrast ratio possible for the shot. For example, even in well-exposed shots, video cameras often don’t record black at 0 percent, instead recording black levels at around 3 to 4 percent. For this reason alone, small adjustments to lower the black point often impress without the need to do much more.

In other cases, an image that is slightly over or underexposed may appear washed out or muddy, and simple adjustments to lower the darkest pixels in the image and raise the brightest pixels in the image to widen the contrast ratio have an effect similar to “wiping a layer of grime off the image” and are often the first steps in simply optimizing a shot.

In other cases, you may choose to deliberately widen the contrast ratio even further to make extreme changes to image contrast. This may be because the image is severely underexposed, in which case you need to adjust the Highlight and Midtone sliders in an effort to simply make the subjects more visible. You might also expand the contrast ratio of an otherwise well-exposed shot to an extreme, crushing the shadows and clipping the highlights to create an extremely high-contrast look.

**Important:** When you expand the contrast of underexposed shots, or make other extreme contrast adjustments, you may accentuate film grain and video noise in the image. This is particularly problematic when correcting programs that use video formats with low chroma subsampling ratios. For more information, see [Chroma Subsampling Explained](#).
Of course, you also have the option to lower the contrast ratio of an image. This might be done as an adjustment to change the apparent time of day (dulling shadows while maintaining bright highlights for a noon-time look) or simply as a stylistic choice (lighter shadows and dimmer highlights for a softer look).

![Image with contrast adjustments](image)

**What Exactly Is Image Detail?**

Image detail is discussed frequently in this and other chapters, mainly within the context of operations that enhance perceived detail, and those that result in the loss of image detail. Simply put, image detail refers to the natural variation in tone, color, and contrast between adjacent pixels.

Because they occur at the outer boundaries of the video signal, the shadows and highlights of an image are most susceptible to a loss of image detail when you make contrast adjustments. This results in the "flattening" of areas in the shadows or highlights when larger and larger groups of pixels in the picture are set to the same value (0 in the shadows and 100 in the highlights).

It's important to preserve a certain amount of image detail in order to maintain a natural look to the image. On the other hand, there's no reason you can't discard a bit of image detail to achieve looks such as slightly crushed blacks, or widely expanded contrast for a "high-contrast look" with both crushed blacks and clipped whites. Just be aware of what, exactly, is happening to the image when you make these kinds of adjustments.
Contrast Affects Color Balance Control Operation
There’s another reason to expand or otherwise adjust the contrast ratio of an image before making any other color corrections. Every adjustment you make to the contrast of an image changes which portions of that image fall into which of the three overlapping tonal zones the color balance controls affect (covered in Using Color Balance Controls). For example, if you have a low-contrast image with few shadows, and you make an adjustment with the Shadow color balance control, the resulting correction will be small, as you can see in the following gradient.

![Gradient Image]

If, afterward, you adjust the Shadow or Midtone contrast sliders to lower the shadows, you’ll find more of the image becoming affected by the same color correction, despite the fact that you’ve made no further changes to that color control.

![Gradient Image]

This is not to say that you shouldn’t readjust contrast after making other color corrections, but you should keep these interactions in mind when you do so.

Color Casts Explained
A color cast is an unwanted tint in the image due to the lighting, the white balance of the video camera, or the type of film stock used given the lighting conditions during the shoot. Color casts exist because one or more color channels is inappropriately strong or weak. Furthermore, color casts aren’t usually uniform across an entire image. Often, color casts are stronger in one portion of the image (such as the highlights) and weaker or nonexistent in others (the shadows, for example).
If you examine an image with a color cast in the Waveform Monitor set to Parade, you can often see the disproportionate levels of each channel that cause the color cast when you examine the tops of the waveforms (representing the highlights) and the bottoms of the waveforms (representing the shadows).

Note: For clarity, the Parade scope is shown with the tinted red, green, and blue waveforms that appear when Monochrome Scopes is turned off in the User Prefs tab.

When Is a Color Cast a Creative Look?
It's important to bear in mind that color casts aren't always bad things. In particular, if the director of photography is being creative with the lighting, there may in fact be color casts throughout the tonal range of the image. It's important to distinguish between color casts that are there either accidentally or because of conditions of the shoot and the stylistic choices made when lighting each scene. In all cases, clear communication between the director of photography and the colorist is essential.
Using Color Balance Controls
The color balance controls (which are sometimes referred to as *hue wheels*) work as virtual trackballs on the screen; however, they consist of three separate controls.

• *Color Balance wheel*: A virtual trackball that lets you adjust the hue (set by the handle’s angle about the center) and saturation (set by the handle’s distance from the center) of the correction you’re using to rebalance the red, green, and blue channels of the image relative to one another. A handle at the center of the crosshairs within the wheel shows the current correction. When the handle is centered, no change is made.

• *Hue slider*: This slider lets you change the hue of the adjustment without affecting the saturation.

• *Saturation slider*: This slider lets you change the saturation of the adjustment without affecting the hue. Drag up to increase the saturation, and down to decrease it.

• *H, S reset button*: Clicking the H, S reset button resets the color balance control for that tonal zone. If you’re using a control surface, this corresponds to the color reset control for each zone. (These are usually one of a pair of buttons next to each color balance trackball.)

• *L reset button*: Clicking the L reset button resets the contrast slider for that tonal zone. If you’re using a control surface, this corresponds to the contrast reset control for each zone. (These are usually one of a pair of buttons next to each color balance trackball.)

• *Output display*: The output display underneath each color control shows you the current hue and saturation values of the color balance control and the lightness value of the contrast slider for that zone.

*Note*: The color balance controls can be accelerated to 10x their normal speed by pressing the Option key while you drag.
Using Color Balance Controls with a Control Surface
The three color balance controls correspond to the three trackballs, or joyballs, on compatible control surfaces. Whereas you can only adjust one color balance control at a time using the onscreen controls with a mouse, you can adjust all three color balance controls simultaneously using a hardware control surface.

When you’re using a control surface, the Hue Wheel Angle and Joyball Sensitivity parameters in the User Prefs tab of the Setup room let you customize the operation of these controls. For more information on adjusting these parameters, see Control Surface Settings.

Rebalancing a Color Cast
By dragging the handle of a color balance control, you can rebalance the strength of the red, green, and blue channels of an image to manipulate the quality of light in order to either correct such color casts or introduce them for creative purposes. The color balance controls always adjust all three color channels simultaneously.

In the following example, the image has a red color cast in the highlights, which can be confirmed by the height of the top of the red channel in the Parade scope.
To correct this, you need to simultaneously lower the red channel and raise the blue channel, which you can do by dragging the Highlight color balance control. The easy way to remember how to make a correction of this nature is to drag the color balance control handle toward the secondary of the color that’s too strong. In this case, the color cast is a reddish/orange, so dragging the color control in the opposite direction, toward bluish/cyan, rebalances the color channels in the appropriate manner. The Midtone color balance control is used because the majority of the image that’s being adjusted lies between 80 and 20 percent.

If you watch the Parade scope while you make this change, you can see the color channels being rebalanced, while you also observe the correction affecting the image on your broadcast display.

There are three color balance controls in the Primary In, Secondaries, and Primary Out rooms. Each one lets you make adjustments to specific tonal regions of the image.
About Shadows, Midtones, and Highlights Adjustments

Like many other color correction environments, Color provides a set of three color balance controls for the specific adjustment of color that falls within each of three overlapping zones of image tonality. These tonal zones are the shadows, midtones, and highlights of the image. If you were to reduce the tonality of an image into these three zones, it might look something like the following illustration.

Three zone controls allow you to make targeted adjustments to the color that falls within the highlights of an image, without affecting color in the shadows. Similarly, they allow you to make separate adjustments to differently lit portions of the image to either make corrections or achieve stylized looks.
To prevent obvious banding or other artifacts, adjustments to the three tonal zones overlap broadly, with each color balance control's influence over the image diminishing gradually at the edges of each zone. This overlap is shown in the following graph.

The ways in which these zones overlap are based on the OpenCDL standard, and their behavior is described below.

*Important*: If you’re used to the way the Color Corrector 3-way filter works in Final Cut Pro, you’ll want to take some time to get used to the controls of the Primary In room, as they respond somewhat differently. Also, unlike adjustments using the Color Corrector 3-way filter in Final Cut Pro, adjustments made using the color balance control affect the luma of the image, altering its contrast ratio.
Shadows Color Adjustments
The behavior of the Shadow color balance control depends on whether or not the Limit Shadow Adjustments preference is turned on. (For more information, see User Interface Settings.)

• *If Limit Shadow Adjustments is turned off:* Color adjustments made using the Shadow control are performed as a simple add operation. (The color that’s selected in the Shadow color control is simply added to that of every pixel in the image.) The resulting correction affects the entire image (and can be seen clearly within the gradient at the bottom of the image), producing an effect similar to a tint.
• *If Limit Shadow Adjustments is turned on:* A linear falloff is applied to color adjustments made with the Shadow control such that black receives 100 percent of the adjustment and white receives 0 percent of the adjustment. This is the method to use if you want to be able to selectively correct shadows while leaving highlights untouched.

![Image](image.jpg)

*Note:* To better illustrate the effect of the Shadow color control, the previous examples were shown with Broadcast Safe turned off so that image values below 0 percent wouldn’t be clipped.

**Midtones Color Adjustments**
Adjustments made with the Midtone color balance control apply the correction using a power operation (the new pixel value = old pixel value \(^{\text{adjustment}}\)). The result is that midtones adjustments have the greatest effect on color values at 50 percent lightness and fall off as color values near 0 and 100 percent lightness.

![Image](image.jpg)
This lets you make color adjustments that exclude the shadows and highlights in the image. For example, you could add a bit of blue to the midtones to cool off an actor’s skin tone, while leaving your shadows deep and untinted and your highlights clean and pure.

**Highlights Color Adjustments**

Adjustments made using the Highlight color balance control apply a *multiply* operation to the image—the color that’s selected in the Highlight color control is simply multiplied with that of every pixel in the image. By definition, multiply color correction operations fall off in the darker portions of an image and have no effect whatsoever in regions of 0 percent black.
The Highlight color control is extremely useful for correcting color balance problems resulting from the dominant light source that’s creating the highlights, without inadvertently tinting the shadows. In the following example, a bit of blue is added to the highlights to neutralize the orange from the tungsten lighting.

**Color Balance Control Overlap Explained**

The broadly overlapping nature of color correction adjustments made with the three color balance controls is necessary to ensure a smooth transition from adjustments made in one tonal zone to another, in order to prevent banding and other artifacts. In general, adjustments made to the color in one tonal zone also affect other tonal zones in the following ways:

- Adjustments made to the Shadow color controls overlap the midtones and the darker portion of the highlights but exclude areas of the image at the highest percentages.
- Adjustments made to the midtones affect the broadest area of the image but don’t affect the lowest percentages of the shadows or the highest percentages of the highlights.
- Adjustments made to the highlights affect the midtones as well, but not the lowest percentages of the shadows.

**Controlling Color Balance Control Overlap**

While the tonal zones that are affected by the three color balance controls are predefined by the mathematical operations they perform, it is possible to exert some control over what areas of an image are being affected by the corrections of a particular color balance control. This is done by applying opposing corrections with other color balance controls.
The following example shows this principal in action. If you adjust the Highlight color balance control to add blue to a linear gradient, you'll see the following preview.

As you can see, this change affects both the whites and midtones. If you want to restrict the correction that's taking place in the midtones, while leaving the correction at the upper portion of the whites, you can take advantage of the technique of using complementary colors to neutralize one another, making a less extreme, opposite adjustment with the Midtone color balance control.

The result is that the highlights correction that had been affecting the midtones has been neutralized in the lower portion of the midtones.

Although making opposing adjustments to multiple color balance controls may seem contradictory, it's a powerful technique. With practice, you'll find yourself instinctively making adjustments like this all the time to limit the effect of corrections on neighboring zones of tonality.
The Curves Controls
The curves controls, located underneath the color controls in the Primary In room, provide an additional method for adjusting the color and contrast of your images. If you're familiar with image editing applications such as Photoshop, chances are you've used curves before.

The three main differences between the curves controls and the color balance controls are:

• The curves controls let you make adjustments to as many specific tonal ranges that you choose to define, while the color balance controls affect three predefined tonal ranges.

• Each curves control affects only a single color channel, while the color balance controls let you quickly adjust all three color channels simultaneously.

• Curves cannot be animated with keyframes, although every other parameter in the Primary In and Primary Out rooms can be.

Color balance controls are usually faster to use when making broad adjustments to the shadows, midtones, and highlights of the image. Curves, on the other hand, often take more time to adjust, but they allow extremely precise adjustments within narrow tonal zones of the image, which can border on the kinds of operations typically performed using secondary color correction.

*Important:* While the power of curves can be seductive, be wary of spending too much time finessing your shots using the curves controls, especially in client sessions where time is money. It's easy to get lost in the minutiae of a single shot while the clock is ticking, and such detail work may be faster to accomplish with other tools.

How Curves Affect the Image
Curves work by remapping the original color and luma values to new values that you choose, simply by changing the height of the curve. The x axis of the graph represents the source values that fall along the entire tonal range of the original image, from black (left) to white (right). The y axis of the graph represents the tonal range available for adjustment, from black (bottom) to white (top).
Without any adjustments made, each curve control is a flat diagonal line; in other words, each source value equals its adjustment value, so no change is made.

If part of a curve is raised by one or more control points, then the tonal area of the image that corresponds to that part of the curve is adjusted to a higher value. In other words, that part of the image is lightened.

If part of a curve is lowered with one or more control points, then the tonal area of the image that corresponds to that part of the curve is adjusted to a lower value. In other words, that part of the image is darkened.
**Curve Editing Control Points and B-Splines**

By default, each curve has two *control points*. The bottom-left control point is the black point and the top-right control point is the white point for that channel. These two control points anchor the bottom and top of each curve.

![Control Points](image)

Curves in Color are edited using B-Splines, which use control points that aren't actually attached to the curve control to "pull" the curve into different shapes, like a strong magnet pulling thin wire. For example, here's a curve with a single control point that's raising the highlights disproportionately to the midtones:

![Control Point Pulling](image)

The control point hovering above the curve is pulling the entire curve upward, while the ends of the curve are pinned in place.

The complexity of a curve is defined by how many control points are exerting influence on the curve. If two control points are added to either side and moved down, the curve can be modified as seen below.

![Control Points Added](image)
To make curves sharper, move their control points closer together. To make curves more gentle, move the control points farther away from one another.

The following procedures describe how to create, remove, and adjust the control points that edit curves controls.

**To add control points to a curve**
- Click anywhere on the curve itself.

**To adjust a control point**
- Drag it anywhere within the curve control area.

**To remove control points from a curve**
- Drag a point up or down until it's outside the curve control area.

**To remove all control points from a curve**
- Click the reset button (at the upper-left side of each curve graph) for the curve from which you want to clear control points.

**Using Curves to Adjust Contrast**
One of the most easily understood ways of using curves is to adjust contrast with the Luma curve. The Luma curve actually performs a simultaneous adjustment to the red, green, and blue channels of the image (as you can see if you take a look at the Parade scope while making Luma curve adjustments), so the overall effect is to adjust the lightness of the image.

*Note:* Adjustments made to the Luma curve may affect its saturation. Raising luma by a significant amount can reduce its saturation.
You can draw a general correspondence between the controls described in Contrast Adjustment Explained and the black point, midtones, and white point of the Luma curve. For example, moving the black point of the curve up raises the black point.

Moving the white point of the curve down lowers the white point of the image.

These two control points roughly correspond to the Shadow and Highlight contrast controls. If you add a third control point to the Luma curve somewhere in the center, you can adjust the distribution of midtones that fall between the black and white points. This adjustment is similar to that of using the Midtone contrast control. Moving this middle control point up raises the distribution of midtones, lightening the image while leaving the white and black points pinned in place.
Moving the same control point down lowers the distribution of midtones, darkening the image while leaving the white and black points pinned in place.

While these three control points can mimic the functionality of the Shadow, Midtone, and Highlight contrast controls, the true power of curves comes from the ability to add several control points to make targeted adjustments to the lightness of specific tonal regions in the image.

**The Luma Curve Limits the Range of the Primary Contrast Sliders**

One important aspect of the curves controls is that they can limit the range of subsequent adjustments with the primary contrast sliders in the same room. This can be clearly seen when you make an adjustment to lower the white point of the image using the Luma curve. Afterward, you’ll find yourself unable to use the Highlight contrast slider to raise the image brightness above the level that’s set by the Luma curve. You can still make additional contrast adjustments in other rooms.

**An Example of the Luma Curve in Use**

The following example illustrates how to make very specific changes to the contrast of an image using the Luma curve. In this shot, the sky is significantly brighter than the rest of the image. In order to bring viewer attention more immediately to the subject sitting at the desk, you need to darken the sky outside the window, without affecting the brightness of the rest of the image.
To make adjustments to a Luma curve

1. Before making any actual adjustments, pin down the midtones and shadows of the image by adding a control point to the curve without moving it either up or down.

Adding control points to a portion of a curve that you don’t want to adjust, and leaving them centered, is a great way to minimize the effect of other adjustments you’re making to specific areas of an image. When you add additional control points to adjust the curve, the unedited control points you placed will help to limit the correction.

**Tip:** When adding multiple control points to a curve, you can use the grid to identify where to position parts of a curve you want to be at the original, neutral state of the image. At its uncorrected state, each curve passes through the diagonal intersections of the background grid.

2. To make the actual adjustment, drag the white point at the upper-right corner down to darken the sky.

You want to make sure that you don’t drag the new control point down too far, since it’s easy to create adjustments that look unnatural or solarized using curves, especially when part of a curve is inverted.
That was a very targeted adjustment, but you can go further. Now that the sky is more subdued, you may want to brighten the highlights of the man’s face by increasing the contrast in that part of the image.

3 Add a control point below the first control point you created, and drag it up until the man’s face lightens.

The man’s face is now brighter, but the shadows are now a bit washed out.

4 Add one last control point underneath the last control point you created, and drag it down just a little bit to deepen the shadows, without affecting the brighter portions of the image.

As you can see, the Luma curve is a powerful tool for making extremely specific changes.

**Using Curves to Adjust Color**

Unlike the color balance controls, which adjust all three color channels simultaneously, each of the color curves controls affects a single color channel. Additionally, the red, green, and blue color curves let you make adjustments within specific areas of tonality defined by the control points you add to the curve. This means that you can make very exact color adjustments that affect regions of the image that are as narrow or broad as you define.
What Is Color Contrast?
Contrast in this documentation usually describes the differences between light and dark tones in the image. There is another way to describe contrast, however, and that is the contrast between different colors in an image. Color contrast is a complex topic, touching upon hue, color temperature, lightness, and saturation. To greatly simplify this diverse topic, color contrast can pragmatically refer to the difference in color that exists in different regions of the image.

In the following example, the image starts out with an indiscriminate color cast; in other words, there is red in the shadows, red in the midtones, and red in the highlights, so there aren’t many clearly contrasting colors in different areas of the image. By removing this color cast from some parts of the image, and leaving it in others, you can enhance the color contrast between the main subject and the background. In images for which this is appropriate, color contrast can add depth and visual sophistication to an otherwise flat image.

Correcting a Color Cast Using Curves
In the following example, you’ll see how to make a targeted correction to eliminate a color cast from the lower midtones, shadows, and extreme highlights of an image, while actually strengthening the same color cast in the lower highlights.

The following image has a distinct red color cast from the shadows through the highlights, as you can see by the elevated red waveform in the Parade scope.

Note: For clarity, Broadcast Safe has been turned off so you can better see the bottoms of the waveforms in the Parade scope.

In this particular shot, you want to keep the red fill light on the woman’s face, as it was intentionally part of the look of the scene. However, to deepen the shadows of the scene and make the subject stand out a little more from the background, you’d like to remove some of the red from the shadows.
To make a targeted color cast correction

1 Add a control point to the red curve near the bottom of the curve, and pull down until the red color cast becomes subdued.

This should coincide with the bottom of the red waveform in the Parade scope lining up with the bottoms of the green and blue waveforms.

This operation certainly neutralizes the red in the shadows; unfortunately, because this one control point is influencing the entire curve, the correction also removes much of the original red from the midtones as well.

Tip: If you're wondering where you should place control points on a curve to make an alteration to a specific area of the image, you can use the height of the corresponding graphs in the Waveform Monitor set to either Parade (if you're adjusting color) or Luma (if you're adjusting the Luma curve). For example, if you want to adjust the highlights of the image, you'll probably need to place a control point in the curve at approximately the same height at which the highlights appear in the Waveform graph.
2 Add another control point near the top of the red curve, and drag it up until some red "fill" reappears on the side of the woman’s face.

![Image of curve control](image1.png)

This adjustment adds the red back to the woman’s face, but now you’ve added red to the highlights of the key light source, as well.

![Image of woman's face with red highlights](image2.png)

Since the key light for this shot is the sun coming in through the window, this effect is probably inappropriate and should be corrected.

3 Drag the control point for the white point in the red curve control down until the red in the brightest highlights of the face is neutralized, but not so far that the lighting begins to turn cyan.

![Image of curve control](image3.png)
At this point, the correction is finished. The red light appears in the fill light falling on the woman's face, while the shadows and very brightest highlights from the sun are nice and neutral, enhancing the color contrast of the image.

Here is a before-and-after comparison so you can see the difference.

**The Basic Tab**
The Basic tab contains the controls for Saturation, as well as Master Lift, Gamma, and Gain parameters that let you make additional adjustments to the contrast of your image.

For more information, see:

- Saturation Controls
- Master Contrast Controls
**Saturation Controls**

*Saturation* describes the intensity of the color in an image. Image saturation is controlled using three parameters which, similar to the other controls in the Primary In room, let you make individual adjustments to different tonal zones of an image. Like the contrast and color controls, tonality-specific saturation adjustments fall off gently at the edges of each correction to ensure smooth transitions.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Saturation</strong></td>
<td>1.00000</td>
</tr>
<tr>
<td><strong>Highlight Sat.</strong></td>
<td>1.00000</td>
</tr>
<tr>
<td><strong>Shadow Sat.</strong></td>
<td>1.00000</td>
</tr>
</tbody>
</table>

- **Saturation**: This parameter controls the saturation of the entire image. The default value of 1 makes no change to image saturation. Reducing this value lowers the intensity of the color of every pixel in the image; at 0 the image becomes a grayscale monochrome image showing only the luma. Raising the saturation increases the intensity of the color. The maximum saturation you can obtain by adjusting the “virtual slider” of this parameter with the mouse is 4. However, you can raise this parameter to even higher values by entering a number directly into this field.

Original image

Saturation reduced by more than half
Beware of raising image saturation too much; this can result in colors that start to "bleed" into one another and a signal that's illegal for broadcast.

A dramatically oversaturated image

If the Broadcast Safe settings are turned on, the legality of the image will be protected, but you may see some flattening in particularly colorful parts of the image that results from the chroma of the image being limited at the specified value. You can see this in the Vectorscope by the bunching up at the edges of the graph. Even if you're not working on a project for video, severely oversaturated colors can cause problems and look unprofessional.

• **Highlight Sat.** This parameter controls the saturation in the highlights of your image. You can selectively desaturate the highlights of your image, which can help legalize problem clips, as well as restore some white to the brightest highlights in an image.

Highlight saturation turned up

Highlight saturation turned all the way down
• **Shadow Sat.:** This parameter controls the saturation in the shadows of your image. You can selectively desaturate the shadows on your image to create deeper looking blacks and to eliminate inappropriate color in the shadows of your images for a more cinematic look.

![Shadow saturation turned up](image1)

![Shadow saturation turned all the way down](image2)

**Master Contrast Controls**

Three additional parameters also affect image contrast. For more information on contrast adjustments, see *Contrast Adjustment Explained*.

| Master Lift | 0.000000 |
| Master Gain | 1.000000 |
| Master Gamma | 1.000000 |

• **Master Lift:** Unlike the primary Shadow contrast slider, the Master Lift parameter only functions as an add or subtract operator, making an overall luma adjustment to the entire image regardless of how the Limit Shadow Adjustments control is set. For more information on lift adjustments, see *Adjusting the Black Point with the Shadow Slider*.

• **Master Gain:** This parameter works exactly the same as the primary Highlight contrast slider, adjusting the white point while leaving the black point at its current level and scaling all the midtones in between the two.

• **Master Gamma:** This parameter works exactly the same as the primary Midtone contrast slider, adjusting the distribution of midtones between 0 and 100 percent.
The Advanced Tab
This tab contains another set of parameters for adjusting each of the three primary color channels within each of the three tonal zones. Additionally, there is a set of Printer Points controls for colorists who are used to optical color grading for film.

For more information, see:
• RGB Controls
• Printer Points Controls

RGB Controls
These parameters provide per-channel control over contrast and color. These are not numerical representations of any of the other controls in the Primary In room. Like the parameters in the Basic tab, they're available as an additional set of controls.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Lift</td>
<td>0.00000</td>
</tr>
<tr>
<td>Green Lift</td>
<td>0.00000</td>
</tr>
<tr>
<td>Blue Lift</td>
<td>0.00000</td>
</tr>
<tr>
<td>Red Gain</td>
<td>1.00000</td>
</tr>
<tr>
<td>Green Gain</td>
<td>1.00000</td>
</tr>
<tr>
<td>Blue Gain</td>
<td>1.00000</td>
</tr>
<tr>
<td>Red Gamma</td>
<td>1.00000</td>
</tr>
<tr>
<td>Green Gamma</td>
<td>1.00000</td>
</tr>
<tr>
<td>Blue Gamma</td>
<td>1.00000</td>
</tr>
</tbody>
</table>

Typically, these parameters are adjusted when the Auto Balance button is used to automatically adjust a shot. (For more information, see Using the Auto Balance Button.) However, you can use them as you see fit.

• *Red, Green, and Blue Lift*: These parameters work exactly the same as the Master Lift parameter, but affect the individual color channels.

• *Red, Green, and Blue Gain*: These parameters work exactly the same as the Master Gain parameter, but affect the individual color channels.

• *Red, Green, and Blue Gamma*: These parameters work exactly the same as the Master Gamma parameter, but affect the individual color channels.
Printer Points Controls
These parameters are available for colorists who are used to working with the printer points system for color timing film. Employed by film printing machines, the printer points system allows color correction to be performed optically, by shining filtered light through the conformed camera negatives to expose an intermediate positive print, in the process creating a single reel of film that is the color-corrected print.

The process of controlling the color of individual shots and doing scene-to-scene color correction is accomplished using just three controls to individually adjust the amount of red, green, and blue light that exposes the film, using a series of optical filters and shutters. This method of making adjustments can be reproduced digitally using the Printer Points parameters.

Tip: These parameters are controllable using knobs on most compatible control surfaces.

What Is a Printer Point?
Each of the Red, Green, and Blue parameters is adjusted in discrete increments called printer points (with each point being a fraction of an f-stop, the scale used to measure film exposure). Color implements a standard system employing a total range of 50 points for each channel, where point 25 is the original neutral state for that color channel. Technically speaking, each point represents 1/4 of an f-stop of exposure (one f-stop represents a doubling of light). Each full stop of exposure equals 12 printer points.

Making Adjustments Using Printer Points
Unlike virtually every other control in the Primary In room, the Red, Green, and Blue Printer Points parameters make a uniform adjustment to the entire color channel, irrespective of image tonality.

Also unique is the way in which adjustments are made. To emulate the nature of the filters employed by these kinds of machines, raising a parameter such as the Printer Points Red parameter doesn’t actually boost the red; instead, it removes red, causing the image to shift to cyan (the secondary of green and blue). To increase red, you actually need to decrease the Printer Points Red parameter.

Increasing or decreasing all three Printer Points parameters together darkens the image (by raising all three parameters) or lightens it (by lowering all three parameters). Making disproportionate adjustments to the three channels changes the color balance of the image relative to the adjustment, altering the color of the image and allowing for the correction or introduction of color casts.
The Printer Points Parameters
These parameters control calibration and individual printer points for each color channel.

- **Printer Points Calibration**: This value calibrates the printer points system according to the film gamma standard you wish to use. The default value of 7.8 is derived by multiplying the value 12 (points per f-stop) by a value of 0.65 (the default film gamma standard used). 0.65 * 12 = 7.8. To recalibrate for a different film gamma value, insert your own gamma value into the equation.

- **Printer Points Red**: The value with which to raise or lower the red channel.

- **Printer Points Green**: The value with which to raise or lower the green channel.

- **Printer Points Blue**: The value with which to raise or lower the blue channel.

  **Note**: There is also a printer points node available in the Color FX room, which works identically to the parameters covered in this section.

Using the Auto Balance Button
The Auto Balance button performs an automatic analysis of the current shot, based on the frame at the position of the playhead. This is useful for quickly bringing a problem shot with a subtly inobvious color cast to a neutral state, prior to performing further color correction.

When you click this button, Color automatically samples the darkest and lightest 5 percent of the image’s Luma channel in order to determine how to make shadow and highlight adjustments to neutralize any color casts that are present in the image. In addition, the black and white points of the image are adjusted to maximize image contrast, so that the shot occupies the widest available range from 0 to 100.

  **Note**: Unlike the Auto Balance controls in the Final Cut Pro Color Corrector 3-way filter, the Auto Balance button is completely automatic, and does not require you to select individual areas of the image for analysis.

To use the Auto Balance button
1. Move the playhead in the Timeline to a representative frame of the shot you want to automatically color balance.
2 Click Auto Balance.

Once the analysis has been performed, the Red, Green, and Blue Lift and Gain parameters in the Advanced tab of the Primary In room are automatically set to contain the results of these adjustments. The result should render whites, grays, and blacks in the image completely neutral.

Since the necessary adjustments are made to the Lift and Gain parameters in the Advanced tab, the main Shadow, Midtone, Highlight, and Curves controls remain unused and remain available to you for further adjustment of the image.

The RED Tab

When native RED QuickTime media is sent to or imported into Color, a RED tab appears in the Primary In room, next to the Basic and Advanced tabs. There is no corresponding RED tab in the Primary Out room.

Important: This tab only appears if you’ve installed the appropriate RED supporting software for Final Cut Studio.

The RED camera writes raw, linear light image data to the R3D files that are recorded. The controls found in the RED camera’s Audio/Video menus in no way alter the way the image data is written within each R3D file. Instead, whatever settings were chosen at the time are stored within each recorded clip as metadata (similar to a LUT) that determines how these media files are displayed by compatible software. This metadata can be overridden during the Log and Transfer process in Final Cut Pro.
For clips that were imported with native color metadata, the RED tab provides access to the clip Color, Color Temp, and View metadata originally written by the RED camera. However, this metadata can also be overwritten during ingest using a custom color processing option in the Log and Transfer window. These parameters are provided so that you can begin grading each clip in the state at which it was originally monitored during the shoot, or at which it was ingested using the Final Cut Pro Log and Transfer window.

### Note:
Although there is functional overlap between the controls found in this tab and those found elsewhere in Color, the Kelvin and Tint controls are specially calibrated to provide the most photometrically accurate white balance adjustments for RED QuickTime media.

- **Enabled**: Turns all of the parameters found within the RED tab on or off. Turning Enabled off suspends the effect of these parameters on the final rendered image in Color.
- **Saturation**: This parameter is available in the RED camera's Color submenu, and adjusts the color intensity of the image. The overall range is 0 (monochome) through 5.0 (extremely high), where 1 is unity.
• **Kelvin**: This value is set by options in the RED camera’s Color Temp menu, along with Tint. This setting is designed to compensate for the “warmth” of the available lighting to keep white elements of the scene looking neutral. Low Kelvin values will compensate for “warmer” lighting (such as tungsten), while higher Kelvin values compensate for “cool” lighting (such as noon-day sun or overcast days). Two user-selectable options set Kelvin to predetermined values: Tungsten (3,200K), and Daylight (5,600K). The Auto WB option automatically chooses a custom value for this parameter based on analysis of a white card, while Manual WB lets the operator choose any value. The correction made by this parameter is designed to work specifically with RED linear light image data to provide the most photometrically correct result.

• **Tint**: This value is adjustable within the RED camera’s Color Temp menu, along with Kelvin. Tint is designed as an additional white balance compensation for light sources with a green or magenta component, such as fluorescent or sodium vapor bulbs. The correction made by this parameter is designed to work specifically with RED linear light image data to provide the most photometrically correct result.

• **Exposure**: Available in the RED camera’s Color menu. Increases and lowers image lightness in increments calibrated to f-stops. When raising the signal up to 100 or lowering it down to 0, the image is clipped at the boundaries of broadcast legality. The overall range is –7 to +7, where 0 is unity.

• **Red, Green, and Blue Gain**: Available in the RED camera’s Gain submenu. Allows individual adjustment of each color channel. Adjusting any of these gain parameters boosts or lowers the maximum value of the corresponding color channel and scales the midtones while pinning the bottom of the channel to 0 percent. Lowering does the opposite. The overall range is 0 to 10, where 1 is unity.

• **Contrast**: Available in the RED camera’s Color menu. Raising the contrast boosts the highlights and lowers the shadows, while leaving the midtones centered around 50 percent unaffected. As the video signal reaches the boundaries of 100 and 0 percent, it’s compressed rather than clipped. The overall range is –1 to +1, where 0 is unity.

• **Brightness**: Available in the RED camera’s Color menu. Raises and lowers image lightness. When raising the signal close to 100 or lowering it down to 0, the image is compressed rather than clipped. The overall range is –10 to +10, where 0 is unity.

• **Gamma pop-up menu**: In-camer, the Gamma setting is determined by the Color Space option that’s selected in the RED Camera’s View menu. (It’s not available as an individually adjustable parameter.) There are six options for gamma available in Color.
  - **Linear**: No gamma adjustment is applied, linear-to-light as captured by the Mysterium sensor.
  - **Rec. 709**: The standard Gamma curve as specified by the Rec. 709 standard for video gamma.
  - **REDspace**: Similar to Rec. 709, but tweaked to be perceptually more appealing, with higher contrast and lighter midtones.
- **REDlog**: A nonlinear, logarithmic gamma setting that maps the native 12-bit RED image data to a 10-bit curve. The blacks and midtones that occupy the lowest 8 bits of the video signal maintain the same precision as in the original 12-bit data, while the highlights that occupy the highest 4 bits are compressed. While this reduces the precision of detail in the highlights, this is a relative loss as the linearly encoded data has an overabundance of precision.

- **PDLOG 685**: Another logarithmic gamma setting that maps the native 12-bit RED image data into the linear portion of a Cineon or film transfer curve.

- **Color Space pop-up menu**: These options are available in the RED Camera’s View menu. (In-camera, these options are tied to corresponding gamma settings.)
  - **CameraRGB**: Identified on the camera as RAW, this mode bypasses the RED camera matrix and represents the original, uncorrected sensor data.
  - **REDspace**: Fits the raw RED image data into a color space that's larger than that of Rec. 709. Appropriate for digital cinema mastering and film output.
  - **Rec. 709**: Fits the raw RED image data into the standard color space specified by the Rec. 709 standard for high definition video. Appropriate for HD video mastering.

- **ISO pop-up menu**: A gain operation (similar to Exposure), which pins the black point at 0 while raising or lowering the white point of the image, linearly scaling everything in between. The range is 100–2000; 320 is the default unity gain setting (no change is made). Raising the signal too much can result in clipping.

  **Important**: Changing the ISO setting of your RED camera does not alter the recorded data. However, since it changes the lightness of the image you’re monitoring during the shoot, it will influence how you light the scene and adjust the camera’s iris.
Secondary color correction controls let you isolate a portion of an image and selectively adjust it without affecting the rest of the picture.

Once you’ve made your initial corrections using the Primary In room, the next step in adjusting any shot is to move on to the Secondaries room to make more targeted adjustments.

This chapter covers the following:
- What Is the Secondaries Room Used For? (p. 258)
- Where to Start in the Secondaries Room? (p. 259)
- The Enabled Button in the Secondaries Room (p. 260)
- Choosing a Region to Correct Using the HSL Qualifiers (p. 261)
- Controls in the Previews Tab (p. 268)
- Isolating a Region Using the Vignette Controls (p. 270)
- Adjusting the Inside and Outside of a Secondary Operation (p. 277)
- The Secondary Curves Explained (p. 278)
- Reset Controls in the Secondaries Room (p. 283)
What Is the Secondaries Room Used For?

The Secondaries room has been designed for maximum flexibility. While its central purpose is to facilitate targeted corrections to specific features of the image, it can be used for a variety of tasks.

- **Isolating areas for targeted corrections:** This is the primary purpose of the Secondaries room. Using a variety of techniques, you can perform functions such as isolating the highlights in an image to change the quality of light; targeting the color of an overly bright sweater to desaturate it without affecting the rest of the image; or selecting an actor’s face to create a post-production sunburn. Once you master the ability to selectively adjust portions of the image, the possibilities are endless.

- **Creating vignetting effects:** Traditionally, vignettes used for creative purposes described a darkening around the edges of the image that used to be created with mattes or lens filters. You can create any type of vignette you need using either preset or custom shapes, to darken or otherwise flag areas of the image. Vignettes can be used to focus viewer attention by highlighting a subject in the foreground or by shading background features that you don’t want sticking out.
• **Digitally relighting areas of the image:** The same feature can be used in a different way, drawing custom shapes to isolate regions of the image and add beams or pools of light where previously there were none. This can come in handy in situations where the lighting is a bit flat, and you want to add some interest to a feature in the scene.

![Before After](image)

• **Making modifications changing the Primary In correction:** A somewhat unconventional use of the Secondaries room is to apply an additional correction to the entire image on top of the original correction you made with the Primary In room. When all three secondary qualifiers are set to include the entire image (which is the default setting), adjustments made with the color balance, contrast, and saturation controls affect everything in the frame, just as they do in the Primary In room. You can use this to keep stylized adjustments separate from the baseline corrections you’re making in the Primary In room. For more information on this type of workflow, see Managing a Shot’s Corrections Using Multiple Rooms.

### Where to Start in the Secondaries Room?

The process of secondary color correction is fairly straightforward and involves the following steps.

• Stage 1: Isolating the Region You Need to Adjust
• Stage 2: Making Color Balance, Contrast, and Saturation Adjustments
• Stage 3: Moving Through the Eight Tabs to Make More Corrections

### Stage 1: Isolating the Region You Need to Adjust

There are three basic methods you can use to isolate, or qualify, features or areas within an image in the Secondaries room:

• Key on a range of color, saturation, or brightness.
• Use a shape as a mask.
• Use one of the secondary curves to selectively adjust a portion of the spectrum.
All these methods are described in this chapter. Once you’ve selected a region of the image to work on, the Control pop-up menu lets you apply separate operations to the inside and outside of the selection.

**Stage 2: Making Color Balance, Contrast, and Saturation Adjustments**
After you’ve qualified an area for correction, you can use the same color balance controls, primary contrast sliders, Saturation and Lift/Gain/Gamma parameters in the Basic tab, as well as the RGB parameters in the Advanced tab that are available in the Primary In room. For more information about these controls, see *The Primary In Room*.

*Note:* There is one additional correction parameter available in the Secondaries room that’s not available in the Primary In and Out rooms, and that is the Global Hue parameter. Using Global Hue, you can rotate the hue of every single color in the image at once. Unlike the other parameters in the Secondaries room, Global Hue affects every pixel of the image, and is not limited by the HSL qualifiers or the vignette controls.

**Stage 3: Moving Through the Eight Tabs to Make More Corrections**
Once you’ve completed the correction at hand, you can move on to the next secondary operation you need to perform. The Secondaries room supports up to eight separate secondary operations (although you may only have seven if you’re in single display mode).

In the next few sections, you’ll learn how to isolate areas of the image in different ways.

**The Enabled Button in the Secondaries Room**
The Enabled button, at the top left of the Secondaries control area, is one of the most important controls in this room. Each of the eight tabs in the Secondaries room has its own Enabled button.

Whenever you make an adjustment to any parameter or control in the Secondaries room, this button is automatically turned on.

This button can be used to disable any Secondaries tab. For example:

- You can turn the Enabled button off and on to get a before-and-after preview of how the secondary is affecting the image.
- You can turn the Enabled button off to disable a secondary effect without resetting it, in case you want to bring it back later.
The state of the Enabled button is also keyframable. This means you can use keyframes to control this button to turn a secondary effect on and off as the shot plays. For more information on keyframing, see Keyframing Secondary Corrections.

Choosing a Region to Correct Using the HSL Qualifiers

One of the most common ways of isolating a feature for targeted correction is to use the HSL qualifiers (so named because they qualify part of the image for correction) to key on the portion you want to color correct. HSL stands for hue, saturation, and lightness, which are the three properties of color that together define the entire range of color that can be represented digitally.

HSL qualification is often one of the fastest ways to isolate irregularly shaped subjects, or subjects that are moving around in the frame. However, as with any chroma or luma key, the subject you’re trying to isolate should have a color or level of brightness that’s distinct from the surrounding image. Fortunately, this is not unusual, and reddish skin tones, blue skies, richly saturated clothing or objects, and pools of highlights and shadows are often ideal subjects for secondary correction.

If you’re familiar with the Limit Effect controls of the Color Corrector 3-way filter in Final Cut Pro, you’ll find that the Secondaries room HSL controls work more or less the same way.
The HSL controls work as a chroma keyer. By selecting ranges of hue, saturation, and lightness, you create a matte that is then used to define the region to which corrections are applied. Everything outside the matte remains unaffected (although you can also specify which portion of the matte you want to adjust, the inside or the outside).

The HSL Qualifier controls always sample image data from the original, uncorrected image. This means that no matter what adjustments have been made in the Primary In room, the original image values are actually used to pull the key. For example, even if you completely desaturate the image in the Primary In room, you can still pull a chroma key in the Secondaries room.

**Tip:** It is not necessary to use all three qualifiers when keying on a region of the image. Each qualifier has a checkbox and can be turned on and off individually. For example, if you turn off the H (hue) and S (saturation) controls, you can use the L (lightness) control by itself as a luma keyer. This is a powerful technique that lets you isolate areas of an image based solely on image brightness.

**Creating Fast Secondary Keys Using the HSL Eyedropper**
The eyedropper, at the top-left corner of the Basic tab, provides a quick and easy way to sample color values from images you’re correcting.
To use the eyedropper to pull a secondary key

1 Click the eyedropper.

The eyedropper becomes highlighted, and crosshairs appear superimposed over the image in the preview and broadcast monitors. You use these crosshairs to sample the HSL values from pixels in the image.

2 Move the mouse to position the crosshairs on a pixel with the color you want to key on, then click once to sample color from a single pixel.

The crosshairs disappear, and the HSL controls are adjusted to include the sampled values in order to create the keyed matte. In addition, the Enabled button turns on automatically (which turns on the effect of the secondary operation in that tab). The Previews tab becomes selected in the middle of the Secondaries room, showing the keyed matte that’s being created by the HSL qualifiers. (For more information, see Controls in the Previews Tab.)

Once you’ve created the keyed matte, the next step is to use the color correction controls at the top of the Secondaries room to actually make the correction. For more information, see The Primary In Room.
In addition to sampling individual color values, you can also use the eyedropper to sample an entire range of values.

**To use the eyedropper to sample a range of values**
- Click the eyedropper, then drag the crosshairs over the range of pixels you want to sample. The HSL controls expand to include the entire range of hues, saturation, and lightness in the pixels you sampled. As a result, the keyed matte in the Previews tab is much more inclusive.

![Image of eyedropper and crosshairs]

**To expand the HSL selection using the eyedropper**
- Click the eyedropper, then hold down the Shift key and either click a single pixel or drag over a range of pixels with the crosshairs.

  The crosshairs disappear, and the HSL controls are expanded to include the range of sampled values you dragged on to expand the keyed matte in the Previews tab.

  **Note:** When selecting a range of multiple HSL values, you can only select a contiguous range of values. You cannot, for example, exclude yellow if you’ve included both red and green, since yellow falls in between. If you need to select noncontiguous HSL ranges, you should use multiple secondary operations. For example, choosing red with Secondaries tab 1, and choosing green with Secondaries tab 2.

**The HSL Controls**
You don’t have to use the eyedropper to select a range of HSL values. You can also use the HSL controls at the top of the Basic tab to select specific ranges of hue, saturation, and lightness directly.

Each of these qualifiers can be turned on and off individually. Each qualifier that’s turned on contributes to the keyed matte. Turning a qualifier off means that aspect of color is not used.
Each qualifier has three sets of handles—center, range, and tolerance—which correspond to three knobs on compatible control surfaces. These handles can also be manipulated directly onscreen using the mouse.

**HSL Qualifiers Explained**

To make HSL adjustments efficiently, you should have an in-depth understanding of the nature of each type of adjustment.

- **H (hue):** Defines the range of colors that contribute to the key. Using hue by itself to define a keyed matte can yield similar results to using the Hue, Sat, and Lum secondary curves. Because the visible spectrum is represented by a wraparound gradient, the H handles are the only ones that wrap around the ends of this control, allowing you to select a complete range of blue to green, when necessary.

- **S (saturation):** Defines the range of saturation that contributes to the key. Using saturation by itself to define a keyed matte can be effective for manually limiting oversaturated colors. Using saturation and hue, but excluding lightness, lets you manually limit specific colors throughout the image regardless of their lightness.

- **L (lightness):** Defines the range of lightness that contributes to the key. Using lightness by itself to define a keyed matte is an extremely powerful technique that lets you quickly isolate regions of the highlights, midtones, or shadows to perform specific adjustments such as increasing or reducing the specific lightness of shadows, or manipulating the color within highlights.

- **Reset button:** Resets all three qualifiers to the default state, which is an all-inclusive selection.

**HSL Qualifier Controls**

This section describes the HSL qualifier controls.

- **Center:** A single handle defines the middle of the selected range of values.

- **Range:** An inner pair of handles to the left and right of the center handle defines the initial range of values that contribute to the keyed matte. These are the solid white pixels seen in the matte.
• **Tolerance:** An outer pair of handles defines a range of values that surround the range values to create falloff, giving a soft edge to the keyed matte. These are the lighter gray pixels seen in the matte.

**Adjusting the HSL Controls**
This section explains how to adjust the HSL controls.

**To adjust the center point for any qualifier**
- Drag anywhere within the center of the two Range handles.

![Diagram showing adjustment](image)

**To make a symmetric adjustment to the Range handles**
- Drag the Range handles directly, or drag anywhere between the Range and Tolerance handles (if the tolerance is wide enough) to widen or narrow the range.

![Diagram showing symmetric adjustment](image)

**To make an asymmetric adjustment to the Range handles**
- Hold down the Shift key and drag the handle you want to adjust; the opposing handle remains fixed in place.

![Diagram showing asymmetric adjustment](image)

When you make an asymmetric adjustment, the center point also readjusts to match the new range.

**Note:** You cannot make asymmetric adjustments using knobs on a control surface.
To adjust the Tolerance handles
- Drag anywhere outside of the Center, Range, and Tolerance handles to widen or narrow the tolerance.

You can also make asymmetric adjustments to tolerance by holding down the Shift key while dragging.

The Color Swatches
A set of six swatches underneath the HSL qualifiers lets you automatically set the Hue qualifier to a narrow range that’s centered on one of the primary red, green, and blue, and secondary cyan, magenta, and yellow colors.

The swatches can be useful when you need to quickly make a hue selection for a feature in the image that corresponds to one of these colors. When you choose one of these swatches, the Saturation and Lightness controls remain completely unaffected.

To adjust the Hue qualifier using one of the color swatches
- Shift-click any of the swatches.

The Hue qualifier resets itself to select the corresponding range of color.

Key Blur
The Key Blur parameter lets you apply a uniform blur to the keyed matte in order to soften it. This can go a long way toward making an otherwise noisy or hard-to-pull key usable. This parameter defaults to 0, with a maximum possible value of 8.
**Note:** You can manually set the key blur to even higher values by typing them directly into the Key Blur field.

One of the nice things about keying for color correction is that, unlike keying to create a visual effects composite, you don’t always have to create keyed mattes with perfect edges or completely solid interiors. Often an otherwise mediocre key will work perfectly well, especially when the adjustment is subtle, so long as the effect doesn’t call attention to itself by adding noise, or by causing vibrating “chatter” around the edges of the matte.

For example, holes in a keyed matte often correspond to shadows that are falling on the subject you’re isolating. If you’re making a naturalistic adjustment to the highlights of the image, you probably don’t want to include such shadowed areas in the correction, so there’s no need to make further adjustments to the matte.

**Check Your Secondary Keys During Playback**
It’s always important to double-check to see how the secondary keys you pull look during playback. Sometimes a secondary operation that looked perfectly good while you were making the correction exhibits flickering or “chatter” at the edges that is the result of noise, or of including a range of marginal values that are just at the edge of the selected range. (This happens frequently for “hard-to-key” features in an image.) In these cases, additional adjustments may be necessary to eliminate the problem.

Also, secondary keys that work well in one part of a shot may not work as well a couple of seconds later if the lighting changes. Before moving on, it’s always a good idea to see how a secondary operation looks over the entire duration of a shot.

**Controls in the Previews Tab**
The Previews tab is a two-part display that helps you guide your adjustments while you use the HSL qualifiers and the vignette controls. Two reduced-resolution images show you different views of the operation you’re performing.
**Note:** The Matte Preview Mode and Vignette Outline appear in the preview display of the Scopes window only when the Previews tab in the Secondaries room is selected.

- **Vignette preview:** The image on the left (above) shows you the position and size of the currently selected vignette shape, when the Vignette button is enabled. When you use the square or circle vignette, this window also contains an onscreen control you can use to move, resize, and soften the vignette. If you've selected a user shape in the Geometry room instead, you’ll see a noneditable outline of that shape. For more information, see Isolating a Region Using the Vignette Controls.

- **HSL qualifier preview:** The image on the right shows you the matte that’s being generated by the HSL qualifiers. This window does not include the mask that’s generated by the vignette controls, nor does it display the HSL matte as it appears when the Key Blur parameter is used. (The final HSL matte as it’s modified by both vignetting and key blur is visible in the preview display only when the Matte Preview Mode is set to Matte Only.)

  The white areas of the mask indicate the parts of the image that are selected with the current qualification settings, that will be affected by the adjustments you make. The black areas of the image are the parts of the picture that remain unaffected.

- **Matte Preview Mode buttons:** These buttons control what is visible in the preview display in the Scopes window. There are three modes:
  - **Final image:** Shows a preview of how the final effect looks. This is similar to the ordinary preview that’s displayed in the Scopes window, except that it also shows the vignette outline, when the Vignette button is enabled.
  - **Desaturated preview:** The areas of the image that are selected with the current qualification settings appear in color, while the areas of the image that remain unaffected are desaturated and appear monochrome.
• **Matte only**: Shows the actual matte being used to limit the effect. This is similar to the image displayed in the HSL Qualifier preview display, except that it shows the sum of the vignette mask and the HSL mask, as well as the results of the mask as it’s modified by the Key Blur parameter.

  ![](image1)

  **Final image**  
  **Desaturated preview**

  ![](image2)

  **Matte only**

• **Vignette outline button**: When the Vignette button is turned on, the Vignette outline button lets you display or hide the vignette outline that appears in the Preview window.

**Isolating a Region Using the Vignette Controls**

The vignette controls give you an extremely fast way to isolate areas of an image that are geometrically round or rectangular, such as the face of someone in close-up, or a window in the background. Vignettes are also useful for isolating subjects that are too hard to key using the HSL qualifiers.

On the other hand, if the subject you’re vignetting moves, you need to either keyframe the shape to move along with it (see Keyframing) or use motion tracking to automatically create a path for the shape to follow. (For more information, see The Tracking Tab.)
Vignettes can also be used to select large regions of the frame for brightening or darkening. One common example of this is to use a shape to surround a region of the image you want to draw the viewer’s attention to, switch the Control pop-up menu to Outside, and darken the background outside of this shape using the contrast sliders to make the subject “pop out” more, visually.

![Before and After vignette adjustment](image)

Lastly, if the square or circle vignettes aren’t sufficient for isolating an irregularly shaped subject, you can create a custom User Shape in the Shapes tab of the Geometry room, and use that to limit the correction. You could go so far as to rotoscope (the process of tracing something frame by frame) complex subjects in order to create highly detailed adjustments that are too difficult to isolate using the HSL qualifiers.

User Shapes can be edited and animated only in the Geometry room, but the mattes they create can be used to isolate adjustments in any of the eight Secondaries tabs.

![User Shape example](image)

**The Vignette Controls**

The vignette controls are located underneath the Previews tab. Some of these controls can also be manipulated using the onscreen controls in the Previews tab.
Note: If you have a compatible control surface, you can also use its controls to customize the vignette. See Setting Up a Control Surface for more information.

• **Vignette button:** This button turns the vignette on or off for that tab.

• **Use Tracker pop-up menu:** If you’ve analyzed one or more motion trackers in the current project, you can choose which tracker to use to automatically animate the position of the vignette using this pop-up menu. To disassociate a vignette from the tracker’s influence, choose None.

  Note: When Use Tracker is assigned to a tracker in your project, the position of the vignette (the center handle) is automatically moved to match the position of the keyframes along that tracker’s motion path. This immediately transforms your vignette, and you may have to make additional position adjustments to move the vignette into the correct position. This is especially true if the feature you’re vignetting is not the feature you tracked.

• **Shape pop-up menu:** This pop-up menu lets you choose a shape to use for the vignette.
  
  • **Square:** A user-customizable rectangle. You can use the onscreen controls in the Previews tab or the other vignette parameters to modify its position and shape. For more information, see Using the Onscreen Controls to Adjust Vignette Shapes.
  
  • **Circle:** A user-customizable oval. You can either use the onscreen controls in the Previews tab, or the other vignette parameters to modify its position and shape.
  
  • **User Shape:** Choosing User Shape from the Shape pop-up menu automatically moves you to the Shapes tab of the Geometry room, where you can click to add points to draw a custom shape to use for the vignette. When you finish, click the Attach button, and then go back to the Secondaries room to make further adjustments. When you use a User Shape as the vignette, the rest of the vignette parameters become unavailable; you can modify and animate that shape only from the Shapes tab of the Geometry room. For more information, see The Shapes Tab.

**Parameters That Adjust Square or Circle Vignettes**
The following parameters are only available when you use the Square or Circle options in the Shape pop-up menu.

• **Angle:** Rotates the current shape.

• **X Center:** Adjusts the horizontal position of the shape.

• **Y Center:** Adjusts the vertical position of the shape.

• **Softness:** Blurs the edges of the shape.
• **Size**: Enlarges or shrinks the shape.
• **Aspect**: Adjusts the width-to-height ratio of the shape.

**Using the Onscreen Controls to Adjust Vignette Shapes**
The Angle, X Center, Y Center, Softness, Size, and Aspect parameters can all be adjusted via onscreen controls in the image on the left of the Previews tab.

![Vignette Controls](image)

**Note**: Although you can also view the outlines that correspond to these onscreen controls in the preview display of the Scopes window when you turn the Vignette Outline button on, this outline has no onscreen controls that you can manipulate. You can only make these adjustments in the Previews tab.

**To move the vignette**
- Drag anywhere inside or outside the shape in the Previews tab to move the vignette in that direction.

  The X Center and Y Center parameters are simultaneously adjusted. Color uses the same coordinate system as Final Cut Pro to define position.

**To resize the vignette**
Do one of the following:
- Drag any of the four corners of the vignette to resize the vignette relative to the opposite corner, which remains locked in position.
- Option-drag to resize the vignette relative to its center. (The center of a vignette is visible as green crosshairs.)
- Shift-drag to resize the vignette while locking its aspect, enlarging or reducing the shape without changing its width-to-height ratio.

  Depending on the operation you perform, the X and Y Center, Size, and Aspect parameters may all be adjusted.
To rotate the vignette
- Right-click or Control-click any of the four corners of the vignette and drag to rotate it to the left or right.

To adjust the softness of the vignette
- Middle-click and drag to blur the edges of the vignette.

This adjustment modifies the Softness parameter. The degree of softness is visualized in the Previews tab with a pair of concentric circles. The inner circle shows where the edge blurring begins, and the outer circle shows where the edge blurring ends, along with the shape.

**Animating Vignettes**
One of the most common operations is to place an oval over someone’s face and then either lighten the person, or darken everything else, to draw more attention to the subject’s face. If the subject is standing still, this is easy, but if the subject starts to shift around or move, you need to animate the vignette using keyframes so that the lighting effect follows the subject. For more information on keyframing, see Keyframing.

Another option is to use the motion tracker to automatically track the moving subject, and then apply the analyzed motion to the vignette. For more information, see *The Tracking Tab*.

**Creating a User Shape for Vignetting**
The following procedure outlines how you use the User Shape option in the Shape pop-up menu of the vignette controls.

**To use a user shape for vignetting**
1. Open the Secondaries room, click one of the eight Secondaries tabs to select which secondary operator to work on, and then select the Vignette checkbox to enable the vignette controls.
2. Choose User Shape from the Shape pop-up menu.

The Shapes tab of the Geometry room opens, with a new shape in the shapes list to the right, ready for you to edit.
3 Click in the Geometry preview area to add control points outlining the feature you want to isolate, then click the first control point you created to close the shape and finish adding points.

The shapes you draw in the Geometry room default to B-Spline shapes, which use control points that are unattached to the shape they create to push and pull the shape into place (similar to the B-Splines used by the curves controls in the Primary In and Out rooms). You can also change these shapes to simple polygons if you need a shape with hard angles rather than curves, by clicking the Polygon button in the Shapes tab. For more information on working with shapes, see The Shapes Tab.

Tip: If you’re not sure how many control points to add to create the shape you want, don’t hesitate to create a few more than you think you’ll need. It’s easy to edit them after they’re created, but you can’t add or remove control points to shapes that have already been created.

4 If necessary, edit the shape to better fit the feature you’re trying to isolate by dragging the control points to manipulate the shape.
5 To feather the edge of the shape, increase the value of the Softness parameter.

Two additional editable shapes appear to the inside and outside of the shape you drew. The inner shape shows where the feathering begins, while the outer shape shows the very edge of the feathered shape. If necessary, each border can be independently adjusted.

6 As an optional organizational step, you can type an identifying name into the Shape Name field, and press Return to accept the change.

7 Click Attach, at the top of the Shapes tab, to attach the shape you’ve created to the tab of the Secondary room you were in. (The number of the secondary tab should be displayed in the Current Secondary field at the top of the Shapes tab.)

8 If necessary, you can also add keyframes or motion tracking to animate the shape to match the motion of the camera or subject, so the shape you created matches the action of the shot.

9 When you finish with the shape, open the Secondaries room.
You’ll see the shape you created within the vignette area of the Previews tab. At this point, the matte that’s created by the shape can be used to limit the corrections you make, as with any other secondary matte.
When you use a user shape, the vignette controls in the secondary tab to which it's assigned become disabled. If at any point you need to edit the shape, you must do so in the Geometry room; the secondary corrections that use that shape will automatically update to reflect your changes.

**Using Secondary Keying and Vignettes Together**

When you turn on the vignette controls while also using the HSL qualifiers to create a secondary key, the vignette limits the matte that's created by the key. This can be extremely helpful when the best-keyed matte you can produce to isolate a feature in the frame results in unwanted selections in the background that you can't eliminate without reducing the quality of the matte. In this case, you can use the vignette as a *garbage matte*, to eliminate parts of the keyed matte that fall outside the vignette shape.

**Adjusting the Inside and Outside of a Secondary Operation**

You can choose whether the color, contrast, and saturation adjustments you make affect the inside or the outside of the isolated feature using the Control pop-up menu.

One of the most powerful features of the Secondaries room is the ability to apply separate corrections to the inside and outside of a secondary matte in the same tab. This means that each of the eight secondary tabs can actually hold two separate corrections.

Whenever you choose another region to work on, the controls update to reflect those settings.

- **Control pop-up menu**: The Control pop-up menu also provides additional commands for modifying these settings.
  - **Inside**: The default setting. When set to Inside, all adjustments you make affect the interior of the secondary matte (the area in white, when looking at the mask itself).
• *Outside:* When set to Outside, all adjustments you make in that tab affect the exterior of the secondary matte (the area in black). Making a darkening adjustment to the outside of a softly feathered circle matte that surrounds the entire frame is one way of creating a traditional vignette effect.

Before outside adjustment  
After

• *Copy Inside to Outside:* Copies the correction that’s currently applied to the inside of the matte to the outside as well. This is a handy operation if you want to copy the same correction to the outside as a prelude to making a small change, so that the difference between the corrections applied to the inside and the outside is not so large.

• *Copy Outside to Inside:* Copies the correction that’s applied to the outside to the inside.

• *Swap:* Switches the corrections that are applied to the inside and outside of the secondary matte, so that they’re reversed.

**The Secondary Curves Explained**

The secondary curves are a deceptively powerful set of controls that allow you to make very small or large adjustments to the hue, saturation, and luminance of an image based solely on regions of hue that you specify using control points on a curve.

*Important:* Curves cannot be animated with keyframes, although just about every other parameter in the Secondaries room can be.
These curves work much differently than the curves controls of the Primary In room. Each of the secondary curves controls defaults to a flat horizontal line running halfway through the graph area.

The visible spectrum is represented along the surface of the curve by a wrap-around gradient, the ends of which wrap around to the other side of the curve. The control points at the left and right of this curve are linked, so that moving one moves the other, to ensure a smooth transition if you make any adjustments to red, which wraps around the end of the curve.

**Tip:** If you're having a hard time identifying the portion of curve that affects the part of the image you want to adjust, you can use the color swatches in the 3D scopes to sample a pixel from the preview, and a horizontal indicator will show the point on the curve that corresponds to the sampled value. For more information, see Sampling Color for Analysis.

Adding points to the surface of this curve lets you define regions of hue that you want to adjust. Raising the curve in these regions increases the value of the particular aspect of color that's modified by a specific curve, while lowering the curve decreases the value.
For example, if you add four control points to the Saturation curve to lower the green-through-blue range of the curve, you can smoothly desaturate everything that’s blue and green throughout the frame, while leaving all other colors intact.

![Before and After](image)

Sat curve adjustment

One of the nicest aspects of these controls is that they allow for extremely specific adjustments to narrow or wide areas of color, with exceptionally smooth transitions from the corrected to the uncorrected areas of the image. In many instances, the results may be smoother than might be achievable with the HSL qualifiers.

Another key advantage these controls have over the HSL qualifiers is that you can make simultaneous adjustments to noncontiguous ranges of hue. In other words, you can boost or lower values in the red, green, and blue areas of an image while minimizing the effect of this adjustment on the yellow, cyan, and magenta portions of the image.
The secondary curves use B-Splines, just like the primary curves controls. In fact, you add and edit control points on the secondary curves in exactly the same way. For more information, see Curve Editing Control Points and B-Splines.

**Important:** Adjustments made using the secondary curves cannot be limited using the vignette or HSL controls.

**Using the Secondary Curves**

This section provides examples of how to use each of the three kinds of secondary curves.

**Important:** Curves cannot be animated with keyframes, although just about every other parameter in the Secondaries room can be.

**The Hue Curve Tab**

When you raise or lower part of the secondary Hue curve, you make a hue adjustment similar to the one you make when you use the Global Hue control, except that you only rotate the hue value for the selected range of hue specified by the curve. Raising the curve shifts the values toward red, while lowering the curve shifts the values toward blue.

![Before and After images of hue curve adjustment](image)

This control can be valuable for making narrow, shallow adjustments to the reddish/orange section of the spectrum that affects skin tones, in order to quickly and smoothly add or remove warmth.
**The Sat Curve Tab**
Raising the Saturation curve increases the saturation in that portion of the spectrum, while lowering it decreases the saturation. This is a powerful tool for creating stylized looks that enhance or subdue specific colors throughout the frame.

![Sat curve adjustment](image.png)

Before

After
The Lum Curve Tab
Raising the Luminance curve lightens the colors in that portion of the spectrum, while lowering it darkens them. This is a good tool to use when you need to make contrast adjustments to specific regions of color.

Before Lum curve adjustment

After

Reset Controls in the Secondaries Room
The Secondaries room has two reset buttons, which are used to reset adjustments made in the secondary tabs.

- *Reset Secondary button:* Resets only the currently open secondary tab.
- *Reset All Secondaries button:* Resets every secondary tab in the Secondaries room. Use this button with care.
When the primary and secondary color correction controls aren’t enough to achieve the look you need, Color FX lets you create sophisticated effects using a node-based interface.

The Color FX room is a node-based effects environment. It’s been designed as an open-ended toolkit that you can use to create your own custom looks by processing an image with combinations of operations that take the form of nodes. Each node is an individual image processing operation, and by connecting these nodes into combinations, called node trees, you can create sophisticated effects of greater and greater complexity.

This chapter covers the following:

- The Color FX Interface Explained (p. 286)
- How to Create Color FX (p. 286)
- Creating Effects in the Color FX Room (p. 294)
- Using Color FX with Interlaced Shots (p. 300)
- Saving Favorite Effects in the Color FX Bin (p. 301)
- Node Reference Guide (p. 302)
The Color FX Interface Explained
The Color FX room is divided into four main areas.

The functionality of these areas is as follows:

- **Node list**: A list at the left of the Color FX room contains every image processing operation that you can add. Some of these nodes are single input, performing that operation to whatever image is input into them, while others are multi-input, taking multiple versions of the image and combining them using different methods. All nodes are alphabetically organized.

- **Node view**: The Node view, at the center of the Color FX room, is the area where nodes that you create appear and are connected together and arranged into the node trees that create the effect.

- **Parameters tab**: When you select a node in the Node view, its parameters appear in this tab so that you can adjust and customize them.

- **Color FX bin**: This bin works similarly to the corrections and Grades bins, giving you a way of saving effects that you create for future use.

How to Create Color FX
The Color FX room is not a compositing environment in which you combine multiple images together. The only image you can bring into this room for processing is that of the current shot. You create effects by assembling one or more image processing nodes into node trees; these work together to reprocess the image in different ways. For more information, see:

- How Node Trees Work
- Node Inputs and Outputs Explained
- Creating and Connecting Nodes
• Adjusting Node Parameters
• Bypassing Nodes
• Cutting, Copying, and Pasting Nodes

How Node Trees Work
In the Color image processing pipeline, the Color FX room processes the image as it appears after whatever corrections have been applied in the Primary In and Secondaries rooms. Unattached node inputs automatically connect to the state of the image as it’s affected by the Primary In and Secondaries rooms. This is how each node tree begins, with an empty input that’s automatically connected to the corrected image.

Note: The sole exception to this is the Color node, which generates a frame of solid color that you can use with multi-input math nodes to tint an image in different ways.

To perform more operations on an image, you simply add more nodes, connecting the outputs of previously added nodes to the inputs of new nodes using noodles.

You can think of a node tree as a waterfall of image processing data. Image processing operations begin at the top and cascade down, from node to node. Each node exerts its effect on the image that’s output from the node above it, until the bottom is reached, at which point the image is at its final state.
The very last node in any node tree must be the Output node. This is the node that sends the image that’s been processed by the Color FX room back into the Color image processing pipeline. If there is no Output node, or if the Output node is disconnected, then the node tree will have no effect on that shot, and its effect will not be rendered by the Render Queue.

**Note:** A CFX bar will only appear in the grades track of the Timeline for clips with connected Output nodes. For more information on correction bars in the Timeline, see Basic Timeline Elements.

**Node Inputs and Outputs Explained**
Single input nodes take the image and perform an operation upon it. Single input nodes can only process one incoming image at a time, so you can only connect a single noodle to any one input.

Multi-input nodes are designed to combine multiple variations of the image in different ways, in order to produce a single combined effect. These nodes provide multiple inputs so that you can connect multiple noodles.
Any node’s output, on the other hand, can be connected to multiple nodes in order to feed duplicate versions of the image as it appears at that point in the tree to multiple operations.

When you position the pointer over any node’s input, a small tooltip appears that displays its name. This helps you to identify which input to connect a node to so you can achieve the result you want.

Creating and Connecting Nodes
In this section, you’ll learn the methods used to add, delete, and arrange nodes to a tree to create any effect.

To add a node to the Node view along with an automatically attached Output node
- Drag the first node you create from the Node list into the Node view.

The first node you drag into the Timeline from the Node list always appears with an Output node automatically connected to it.

To add a new node to the Node view
Do one of the following:
- Double-click any node in the Node list.
- Select a node from the Node list, then click Add.
- Drag a node from the Node list into the Node view.
New nodes always appear disconnected in the Node view.

**To insert a new node between two nodes that are already connected**
- Drag a node from the Node list on top of the noodle connecting any two nodes, and drop it when the noodle turns blue.

![Diagram of inserting a new node](image1.png)

**To automatically attach a new node to the input or output of a previously created node**
- Drag a node from the Node list so that the hand pointer is directly on top of a disconnected input or output, then drop it.

![Diagram of automatically attaching a new node](image2.png)

The new node appears with a noodle connecting it to the node input or output you dropped it onto.

**To delete one or more nodes from the Node view**
- Select one or more nodes in the Node view, then press Delete or Forward Delete.
The node disappears, and any noodles that were connected to it are disconnected.

**To connect the output of one node to the input of another**
- Drag a noodle from the output of one node to the input of another.
Noodles are green while they’re being created, but turn gray once they’re connected.
To disconnect a node from the one above it
Do one of the following:

- Click the input of any node with a connected noodle to disconnect it.

- Drag a noodle from the input of the node you want to disconnect to any empty area of the Node view.

Tip: If you want to eliminate the effect a node is having without deleting or disconnecting it, you can turn on its Bypass button, at the top of the Parameters tab. For more information, see Bypassing Nodes.

When you're working on large node trees, it pays to keep them organized so that their operation is clear.

To rearrange nodes in the Node view
Do one of the following:

- Drag a single node in any direction.

- Drag a selection box over a group of nodes, then drag any of the selected nodes into any direction to move them all together.

Adjusting Node Parameters
The operation of most nodes can be customized using parameters that vary from node to node, depending on a node’s function. All node parameters appear in the Parameters tab, to the left of the Color FX bin.

To show any node’s parameters in the Parameters tab
- Click once on the node you want to edit.
Selected nodes appear highlighted in cyan, and if a selected node has any parameters, they appear to the right, ready for editing. You can edit node parameters the same way you edit parameters in any other room.

You can also choose the point in a node tree at which you want to view the image.

**To show the image being processed at any node in the Node view**
- Double-click the node you want to view.

The currently viewed node appears highlighted in yellow, and the image as it appears at that node in the tree appears in the onscreen preview and broadcast output displays.

**Note:** Because double-clicking a node loads its image and opens its parameters in the Parameters tab, it appears with a blue outline as well.

For more information on making adjustments to a node while viewing the effect on another node downstream in the node tree, see Viewing a Node’s Output While Adjusting Another’s Parameters.

**Viewing a Node’s Output While Adjusting Another’s Parameters**
When you’re creating multinode effects, it’s often valuable to view a node that appears at the bottom of the node tree while you’re adjusting a node that’s farther up the tree. This way you can adjust any parameter while viewing its effect on the entire tree’s operation.

In the following example, a high-contrast gauzy look is created with a series of nodes consisting of the B&W, Curve, and Blur nodes on one side (to create a gauzy overlay), and a Bleach Bypass on the other (providing high contrast), with both sides connected to a Multiply node to create the gauzy combination.
As you fine-tune this effect, you want to adjust the amount the black-and-white image contributes to the final effect by adjusting the Curve node, but you need to view the output of the Multiply node in order to see how far to make the adjustment. In this case, you double-click the Multiply node so that it becomes the viewed node (highlighted in yellow).

Then, click the Curve node once to load its parameters into the Parameters tab. (The node becomes highlighted in cyan.)

**Bypassing Nodes**

Each node has a Bypass button that appears at the top of its list of parameters. Click Bypass to turn off the effect that node has on the tree without deleting the node from the Node view.
Bypassed nodes are outlined with an orange dotted line.

If you want to suspend the effect of an entire node tree without deleting it or individually turning on each node’s Bypass button, you must disconnect the Output node entirely.

**Cutting, Copying, and Pasting Nodes**
You can cut, copy, and paste selected nodes in the Color FX room. Using the Copy and Paste operations, you can duplicate one or more nodes whenever necessary. This can be especially useful when creating color effects for projects using interlaced media. (For more information, see Using Color FX with Interlaced Shots.)

To cut one or more selected nodes

- Choose Edit > Cut (or press Command-X).
  
  The selected nodes are removed from the Node view, and are copied to the Clipboard.

To copy one or more selected nodes

- Choose Edit > Copy (or press Command-C).
  
  The selected nodes are copied to the Clipboard.

To paste nodes that you’ve previously cut or copied

- Choose Edit > Paste (or press Command-V).
  
  New instances of whichever nodes were previously cut or copied to the Clipboard appear in the Node view.

**Creating Effects in the Color FX Room**
This section outlines some of the most common operations you’ll perform in the Color FX room. For more information, see:

- Using Single Input Nodes
- Using Layering Nodes
- Math Layering Nodes Explained
- Creating Layered Effects Using Mattes
Using Single Input Nodes
The simplest use of this room is to apply one or two single-input nodes to create a stylized effect. In this case, all you need to do is add the nodes you want to use, connect them together in the order in which you want them applied, and then add an Output node to the very end.

In the following example, a Bleach Bypass node (which alters the saturation and contrast of an image to simulate a chemical film process) is followed by a Curve node (to further alter image contrast), which is followed by the Output node that must be added to the end of all node trees.

Using Layering Nodes
A more sophisticated use of nodes is to use multi-input nodes to combine two or more separately processed versions of the image for a combined effect.
In one of the simplest examples, you can tint an image by attaching a Color node (which generates a user-definable color) to one input of a Multiply layering node.

![Diagram showing a Color node connected to a Multiply node]

This adjustment multiplies the color with the corrected image. (Remember, disconnected inputs always link to the corrected image data.) Because of the way image multiplication works, the lightest areas of the image are tinted, while progressively darker areas are less tinted, and the black areas stay black.

![Image before and after tinting]

In a slightly more complicated example, the image is processed using three nodes: a Duotone node (which desaturates the image and remaps black and white to two customizable colors), a Curve node (to darken the midtones), and a Blur node. The result is connected to one input of an Add node (with both Bias parameters set to 1).

![Diagram showing a Duotone node connected to a Curve node, which is connected to a Blur node, which is connected to an Add node]

Chapter 11  The Color FX Room
The Duotone, Curve, and Blur nodes tint, darken, and blur the image prior to adding it to the corrected image (coming in via input 2), and the result is a diffusion effect with hot, glowing highlights.

![Image of two images side by side]

**Math Layering Nodes Explained**

The layering nodes shown in Using Layering Nodes use simple math to combine two differently modified versions of the image together. These mathematical operations rely on the following numerical method of representing tonality in each of the three color channels of an image:

- **Black = 0** (so black for RGB = 0, 0, 0)
- **Midtone values in each channel are fractional, from .00001 through .999999**
- **White = 1** (so white for RGB = 1, 1, 1)

Bear these values in mind when you read the following sections.

**Add**

The pixels from each input image are added together. Black pixels have a value of 0, so black added to any other color results in no change to the image. All other values are raised by the sum of both values. The order in which the inputs are connected doesn’t matter.

Add operations are particularly well suited to creating aggressive glowing effects, because they tend to raise levels very quickly depending on the input images. Bear in mind that the best way of controlling which areas of the image are being affected when using an Add operation is to aggressively control the contrast of one of the input images. The darker an area is, the less effect it will have.

**Note:** By default, the Bias parameters of the Add node divide each input image’s values by half before adding them together. If the results are not as vivid as you were hoping for, change the Source 1 and Source 2 Bias parameters to 1.
**Difference**
The pixels from the image that’s connected to Source 1 are subtracted from the pixels from the image that’s connected to Source 2. Black pixels have a value of 0, so any color minus black results in no change to the Source 1 image. The order in which the inputs are connected matters.

This node is useful for darkening the Source 1 image based on the brightness of the Source 2 image.

**Multiply**
The pixels from each input image are multiplied together. White pixels have a value of 1, so white multiplied with any other color results in no change to the other image. However, when black (0) is multiplied with any other color, the result is black.

When multiplying two images, the darkest parts of the images remain unaffected, while the lightest parts of the image are the most affected. This is useful for tinting operations, as seen previously, as well as for operations where you want to combine the darkest portions of two images.

**Creating Layered Effects Using Mattes**
An extremely important method of creating layered effects involves using a grayscale matte to control where in an image two inputs are added together. The Alpha Blend node has three inputs that work together to create exactly this effect.

This node blends the Source 2 input to the Source 1 input in all the areas where the Source 3 Alpha input image is white. Where the Alpha input image is black, only the Source 1 input is shown.
Any grayscale image can be used to create a matte that you can connect to the Alpha input, for a variety of effects. In the following example, a Curve node is used to manipulate the contrast of an image so that an Edge Detector node can better isolate the edges to create a grayscale matte; a Blur node is used to soften the result, and an Invert node is used to reverse the black and white areas of the matte so that the edges of the face become the areas of the matte that are transparent, or not to be adjusted.

This matte is connected to the Alpha input of the Alpha Blend node (the third input). A Blur node is then connected to the Source 2 input.
The Blur node blurs the corrected image, but the matte image that’s connected to the Alpha input limits its effect to the areas of the image that don’t include the image detail around the edges that were isolated using the Edge Detector node.

As you can see, the image that’s connected to the Alpha input of the Alpha Blend node limits the way the Source 1 and Source 2 inputs are combined. This is but one example of the power of the Alpha Blend node. You can use this node to limit many different effects.

**Using Color FX with Interlaced Shots**

One of the limitations of the Color FX room is that many effects need to be specially assembled when you’re working on interlaced video.

When you’re creating an effect for an interlaced shot, you need to separate each field at the beginning of the node tree with two Deinterlace nodes, one set to Even and one set to Odd. Once that’s done, you need to process each individual field using identical node trees.

When you’re finished with the effect, you need to reassemble the fields into frames using the Interlace node, connecting the Even branch of the node tree to the Even input on the left and the Odd branch of the node tree to the Odd input on the right. The Output node is attached to the Interlace node, and you’re finished.
If you don’t process each field separately, you may encounter unexpected image artifacts, especially when using filtering and transform nodes such as Blur, Sharpen, Stretch, and Translate.

**Saving Favorite Effects in the Color FX Bin**

When you’ve created a Color FX effect you really like, you can save it for future use using the Color FX bin. This bin works the same way as the corrections bins in every other room.

**To save an effect in the Color FX bin**

1. Move the playhead to a shot with a node tree you want to save.
2. Type a name for the effect into the File field underneath the bin. (This step is optional, but recommended.)
3. Click Save.

The effect is saved with a thumbnail taken from the shot it was saved from. Entering a custom name is optional, but recommended, to help you keep track of all your corrections. If you don’t enter a name, saved corrections (and grades) are automatically named using the default `Effect.Date.Time.cfx` convention.

**To apply a saved effect or grade to a single shot**

1. Move the playhead to the shot you want to apply the effect to.
2. Do one of the following:
   - Double-click the effect you want to apply.
   - Select an effect, then click the Load button underneath the bin.
   - Drag the effect onto the shot you want to apply it to.

The selected effect is applied to the shot at the position of the playhead. You can also apply a saved effect to multiple shots.

**To apply a saved effect to multiple shots**

1. Select all of the shots you want to apply the correction to in the Timeline.
2. Do one of the following:
   • Double-click the effect in the bin.
   • Select a saved effect, then click the Load button underneath the bin.
   • Drag the saved effect onto the selected shots in the Timeline.

The effect is then applied to all selected shots in the Timeline.

For more information on saving and managing corrections, see Managing Corrections and Grades.

**Node Reference Guide**

This node reference guide contains a brief description of each node that appears in the Node list. It’s broken down into three sections:

- Layer Nodes
- Effects Nodes
- Utility Nodes

**Layer Nodes**

The following nodes have multiple inputs and are used to combine two or more differently processed versions of the corrected image in different ways.

**Add**

Mathematically adds each pixel from the two input images together. Add operations are particularly well suited to creating aggressive glowing effects, because they tend to raise levels very quickly depending on the input images. Bear in mind that the best way of controlling which areas of the image are being affected when using an Add operation is to aggressively control the contrast of one of the input images. The darker an area is, the less effect it will have.

The order in which the inputs are connected does not matter. Add has two parameters:

- **Source 1 Bias**: Controls how much of the Source 1 image is added to create the final result by multiplying the value in each channel by the specified value. Defaults to 0.5.
- **Source 2 Bias**: Controls how much of the Source 2 image is added to create the final result by multiplying the value in each channel by the specified value. Defaults to 0.5.

**Alpha Blend**

This node blends (similar to the Blend node) the Source 2 input to the Source 1 input in all the areas where the Source 3 Alpha input image is white. Where the Alpha input image is black, only the Source 1 input is shown. The order in which the inputs are connected affects the output.
Blend
This node mixes two inputs together based on the Blend parameter. The order in which
the inputs are connected does not matter. Blend has one parameter:

- **Blend**: When set to 0, only Input 1 is output. When set to .5, Input 1 and Input 2 are
blended together equally and output. When set to 1, only Input 2 is output.

Darken
Emphasizes the darkest parts of each input. Overlapping pixels from each image are
compared, and the darkest pixel is preserved. Areas of white from either input image
have no effect on the result. The order in which the inputs are connected does not matter.

Difference
The pixels from the image that’s connected to Source 1 are subtracted from the pixels
from the image that’s connected to Source 2. Black pixels have a value of 0, so any color
minus black results in no change to the image from Source 1. Since this is subtraction,
the order in which the inputs are connected matters.

Interlace
The images connected to each input are interlaced. The Left input is for the Even field,
and the Right input is for the Odd field. This node is used at the end of node trees that
begin with Deinterlace nodes to process effects for projects using interlaced media.

Lighten
Lighten emphasizes the lightest parts of each input. Overlapping pixels from each image
are compared, and the lightest pixel is preserved. The order in which the inputs are
connected does not matter.

Multiply
The pixels from each input image are multiplied together. White pixels have a value of
1, so white multiplied with any other color results in no change to the other image.
However, when black (0) is multiplied with any other color, the result is black.

When multiplying two images, the darkest parts of the images remain unaffected, while
the lightest parts of the image are the most affected. This is useful for tinting operations,
as well as for operations where you want to combine the darkest portions of two images.

RGB Merge
The three inputs are used to insert individual channels into the red, green, and blue color
channels. You can split the three color channels apart using the RGB Split node, process
each grayscale channel individually, and then reassemble them into a color image again
with this node.

Effects Nodes
The following nodes have a single input and are used to apply a single correction or effect
to an image.
**B&W**
Desaturates the image to produce a monochrome image consisting of only the Luma component. This is done using very specific math, adding together 0.299 of the red channel, 0.587 of the green channel, and 0.114 of the blue channel to arrive at the final monochrome result.

**Bleach Bypass**
Raises the contrast and desaturates the image. Simulates laboratory silver-retention processes used to raise image contrast in film by skipping the bleaching stage of film development, leaving exposed silver grains on the negative which boost contrast, increase grain, and reduce saturation.

**Blur**
Blurs the image. Blur has one parameter:

- *Spread*: The amount of blur. Can be set to a value from 0 (no blur) to 40 (maximum blur).

**Clamp**
Two parameters clip the minimum and maximum values in the image. Clamp has two parameters:

- *Min*: The minimum level in the image. Any levels below this value are set to this value.
- *Max*: The maximum level in the image. Any levels above this value are set to this value.

**Curve**
A curve that affects image contrast similar to the Luma curve in the Primary In room. Selecting this node displays a curve control in the Parameters tab that works identically to those found in the Primary In room. Four buttons below let you choose which channel the curve operates upon:

- *Luma*: Sets the curve to adjust the luma component of the image.
- *Red*: Sets the curve to adjust the red color channel of the image.
- *Green*: Sets the curve to adjust the green color channel of the image.
- *Blue*: Sets the curve to adjust the blue color channel of the image.

**Duotone**
Desaturates the image, mapping the black and white points of the image to two user-customizable colors to create tinted images with dual tints from white to black. Duotone has two parameters:

- *Light Color*: The color that the white point is mapped to.
- *Dark Color*: The color that the black point is mapped to.
**Edge Detector**

A Convolution filter that boosts image contrast in such a way as to reduce the image to the darkest outlines that appear throughout. Edge Detector has three parameters:

- **B&W**: Desaturates the resulting image. Useful when using this node to generate mattes.
- **Scale**: Adjusts the white point. Lowering Scale helps increase contrast and crush midtone values to emphasize the outlines.
- **Bias**: Adjusts overall contrast. Lowering Bias increases contrast, while raising it lowers contrast.

**Exposure**

Raises the highlights or crushes the shadows, depending on whether you raise or lower the Exposure parameter. This node has one parameter:

- **Exposure**: Raising this parameter raises the highlights while keeping the black point pinned. Setting this parameter to 0 results in no change. Lowering this parameter scales the image levels down, crushing the shadows while lowering the highlights by a less severe amount.

**Film Grain**

Adds noise to the darker portions of an image to simulate film grain or video noise due to underexposure. Highlights in the image are unaffected. This node is useful if you have to match a clean, well-exposed insert shot into a scene that’s noisy due to underexposure. Also useful for creating a distressed film look. This node has three parameters:

- **Grain Intensity**: Makes the noise more visible by raising its contrast ratio (inserting both light and dark pixels of noise) as well as the saturation of the noise.
- **Grain Size**: Increases the size of each “grain” of noise that’s added. Keep in mind that the size of the film grain is relative to the resolution of your project. Film grain of a particular size applied to a standard definition shot will appear “grainer” than the same-sized grain applied to a high definition shot.
- **Monochrome**: Turning this button on results in the creation of monochrome, or grayscale, noise, with no color.

**Film Look**

An “all-in-one” film look node. Combines the Film Grain operation described above with an “s-curve” exposure adjustment that slightly crushes the shadows and boosts the highlights. Contrast in the midtones is stretched, but the distribution of the midtones remains centered, so there’s no overall lightening or darkening. This node has three parameters:

- **Grain Intensity**: Makes the noise more visible by raising its contrast ratio (inserting both light and dark pixels of noise) as well as the saturation of the noise.
• **Grain Size:** Increases the size of each “grain” of noise that’s added. Keep in mind that the size of the film grain is relative to the resolution of your project. Film grain of a particular size applied to a standard definition shot will appear “grainier” than the same-sized grain applied to a high definition shot.

• **Contrast:** Makes an “s-curve” adjustment to contrast, which crushes the shadows and boosts the highlights, while leaving the midtones centered. A value of 0 preserves the original contrast of the corrected image, while a value of 1 is the maximum contrast expansion that is possible with this node.

**Gain**

Adjusts contrast by raising or lowering the white point of the image while leaving the black point pinned in place, and scaling the midtones between the new white point and the black point. This node has four parameters:

• **Gain:** Adjusts the red, green, and blue channels simultaneously, for an overall change to image highlights and midtones.

• **Red Gain:** Adjusts the red channel only, enabling color correction based on a white point adjustment for that channel.

• **Green Gain:** Adjusts the green channel only, enabling color correction based on a white point adjustment for that channel.

• **Blue Gain:** Adjusts the blue channel only, enabling color correction based on a white point adjustment for that channel.

**Gamma**

Makes a standard gamma adjustment, which makes a nonlinear adjustment to raise or lower the distribution of midtones of the image while leaving the black and white points pinned in place. This is a power function, \( f(x) = x^a \). This node has four parameters:

• **Gamma:** Adjusts the red, green, and blue channels simultaneously, for an overall change to image midtones.

• **Red Gamma:** Adjusts the red channel only, enabling color correction based on a gamma adjustment for that channel.

• **Green Gamma:** Adjusts the green channel only, enabling color correction based on a gamma adjustment for that channel.

• **Blue Gamma:** Adjusts the blue channel only, enabling color correction based on a gamma adjustment for that channel.
Grain Reduction
Reduces grain and noise in an image by averaging adjacent pixels in that frame according to the values specified in the Master, Red, Green, and Blue Scale parameters. Edge detection can be used to preserve sharpness in areas of high-contrast detail via the Edge Retention parameter, and a sharpening operation can be applied after grain reduction to boost overall detail. Because some shots have noise that’s more apparent in specific color channels, you can make independent adjustments to each channel. This node has six parameters:

- **Master Scale**: Averages the adjacent pixels of every color channel in the image to reduce grain and noise, at the expense of a certain amount of image softness.
- **Red Scale**: Selectively averages pixels in the red channel.
- **Green Scale**: Selectively averages pixels in the green channel.
- **Blue Scale**: Selectively averages pixels in the blue channel.
- **Edge Retention**: Uses edge detection to isolate areas of high-contrast detail in the image (such as hair, eyes, and lips in an actor’s close-up), and excludes those areas of the image from the Grain Reduction operation to preserve the most valuable image detail from softening. Higher values preserve more of the original image in these areas.
- **Post Sharpening**: Applies a Sharpening Convolution filter after the Grain Reduction operation to try and restore some lost detail once the grain has been softened. Use this parameter sparingly—if you set this too high, you’ll end up reintroducing the grain you’re trying to reduce.

Hue
Rotates the hue of every pixel in the entire image. This node has one parameter:

- **Shift**: The amount by which you want to shift the hue. This is not done in degrees, as is represented in the Vectorscope. Instead, you use a value from –1 to 1, where –1, 0, and 1 place the hue at the original values.

Invert
Inverts the image. Useful for creating “positives” from the image negative. Also useful for reversing a grayscale image that you’re using as a matte with the Alpha Blend node, to reverse the portions of the matte that will be solid and transparent.

Lift
Lift uniformly lightens or darkens the entire image, altering the shadows, midtones, and highlights by the same amount. This node has four parameters:

- **Lift**: Adjusts the red, green, and blue channels simultaneously, for an overall change to image brightness.
- **Red Lift**: Adjusts the red channel only, enabling color correction based on a lift adjustment for that channel.
• *Green Lift:* Adjusts the green channel only, enabling color correction based on a lift adjustment for that channel.

• *Blue Lift:* Adjusts the blue channel only, enabling color correction based on a lift adjustment for that channel.

**Maximum**
Averages adjacent pixels together (how many is based on the Brush Size parameter) to produce a single, larger pixel based on the brightest value in that pixel group. Larger values result in flattened, almost watercolor-like versions of the image. This node is also useful for expanding the white areas and smoothing out grayscale images that you’re using as mattes. This node has one parameter:

• *Brush Size:* Defines how many pixels are averaged into a single, larger pixel. Extremely large values result in progressively larger, overlapping square pixels of uniform color, emphasizing lighter pastel-like tones in the image.

**Minimum**
Averages adjacent pixels together (how many is based on the Brush Size parameter) to produce a single, larger pixel based on the darkest value in that pixel group. Larger values result in flattened, darkened versions of the image. This node is also useful for expanding the black areas and smoothing out grayscale images that you’re using as mattes. This node has one parameter:

• *Brush Size:* Defines how many pixels are averaged into a single, larger pixel. Extremely large values result in progressively larger, overlapping square pixels of uniform color, emphasizing darker, muddier tones in the image.

**Printer Lights**
Provides Red, Green, and Blue parameters for color correction that work identically to the printer points controls in the Advanced tab of the Primary In room. For more information, see [Printer Points Controls](#).

**Saturation**
Raises or lowers overall image saturation, making the image more or less colorful. If you use the Saturation node to completely desaturate an image, all three color channels are blended together equally to create the final monochrome result, which looks different then if you had used the B&W node. This node has one parameter:

• *Saturation:* The default value of 1 produces no change. 0 is a completely desaturated image, while the maximum value of 10 produces an excessively saturated, hyper-stylized version of the image.
Scale RGB
Expands or contracts the overall contrast ratio of a shot, from the black point to the white point, centering the midpoint of this operation at a percentage of image tonality that you specify. This node has two parameters:

- **Scale**: The amount by which to expand or contract the overall contrast ratio in the shot. This is a multiplicative operation, so a value of 1 produces no change, while larger values increase the contrast ratio, and smaller values decrease the contrast ratio.
- **Center**: Specifies the percentage of image tonality upon which the expansion and contraction is centered, so the original image values at this percentage remain at that percentage. The default value of 0.5 adjusts the white and black points equally in both directions (the white point goes up, the black point goes down, and whatever values are at 50 percent remain at 50 percent). A value of 0 pins the black point while applying the entire adjustment to the white point, and a value of 1 pins the white point while applying the entire adjustment to the black point.

Sharpen
Applies a Sharpen Convolution filter that selectively enhances contrast in areas of image detail to provide the illusion of sharpness. Should be used sparingly as this operation also increases the sharpness of film grain and video noise. This node has one parameter:

- **Sharpen**: Higher values increase image detail contrast. A value of 0 does no sharpening.

Smooth Step
Applies a nonadjustable “s-curve” adjustment to slightly crush the blacks and boost the whites, leaving the black and white points pinned at 0 and 100 percent. Designed to emulate the exposure tendencies of film at the “toe” and “shoulder” of the image. This is a similar contrast adjustment to that made by the Film Look node.

Stretch
Provides separate vertical and horizontal scaling operations that let you “squeeze” and “stretch” the image. You can change the center pixel at which this scaling is performed. This node has four parameters:

- **Horizontal Center**: The pixel at which horizontal scaling is centered. The center pixel doesn’t move; instead, the scaling of the image is relative to this position.
- **Vertical Center**: The pixel at which vertical scaling is centered. The center pixel doesn’t move; instead, the scaling of the image is relative to this position.
- **Horizontal Scale**: Specifies how much to stretch the image, horizontally. Higher values stretch the image outward, while lower values squeeze the image inward. The default value at which the image is unchanged is 1.
- **Vertical Scale**: Specifies how much to stretch the image, vertically. Higher values stretch the image outward, while lower values squeeze the image inward. The default value at which the image is unchanged is 1.
**Translate**
Offsets the image relative to the upper-right corner. This node has two parameters:
- *Horizontal Offset*: Moves the image left.
- *Vertical Offset*: Moves the image down.

**Utility Nodes**
The following nodes don’t combine images or create effects on their own. Instead, they output color channel information or extract matte imagery in different ways. All these nodes are meant to be used in combination with other layering and effects nodes to create more complex interactions.

**Color**
Produces a frame of solid color. This can be used with different layering nodes to add colors to various operations. This node has one control:
- *Color*: A standard color control lets you choose the hue, saturation, and lightness of the color that’s generated.

**Deinterlace**
Removes the interlacing of a shot in one of three ways, corresponding to three buttons. You can use this node to either remove interlacing by blending the fields together, or you can use two Deinterlace nodes to separate the Even and Odd fields of an interlaced shot prior to processing each field separately and reassemble them using the Interlace node. This node has three buttons:
- *Merge*: Outputs the blended combination of both fields.
- *Even*: Outputs only the Even field, line-doubled to preserve the current resolution.
- *Odd*: Outputs only the Odd field, line-doubled to preserve the current resolution.

**HSL Key**
An HSL keyer that outputs a grayscale matte which you can use to isolate effects using the Alpha Blend node, or simply to combine with other layering nodes in different ways. This keyer works identically to the one found in the Secondaries room. For more information, see Choosing a Region to Correct Using the HSL Qualifiers.

**Output**
This must be the last node in any node tree. It outputs the effect created within the Color FX room to the main Color image processing pipeline for rendering. If an Output node is not connected to the node tree, that effect will not be rendered by the Render Queue.
**RGB Split**
Outputs the red, green, and blue color channels individually, depending on which button you click. Each grayscale color channel can then be independently manipulated with different node tree branches, before being reassembled using the RGB Merge node. This node has three checkboxes:

- **Red**: Outputs the red channel.
- **Green**: Outputs the green channel.
- **Blue**: Outputs the blue channel.

**Vignette**
Creates a simple square or circle vignette. This vignette appears as a color-against-grayscale preview if the Vignette node is viewed directly. When the results are viewed “downstream,” by viewing a different node that’s processing its output, the true grayscale image is seen. This node has the following parameters:

- **Use Tracker**: If you’ve analyzed one or more motion trackers in the current project, you can choose which tracker to use to automatically animate the position of the vignette from this pop-up menu. To disassociate a vignette from the tracker’s influence, choose None.

- **Shape Type**: Lets you choose the type of vignette, either Circle or Square.

- **Invert**: Click this button to make the white area black, and the black area white.

- **X Center**: Adjusts the horizontal position of the shape.

- **Y Center**: Adjusts the vertical position of the shape.

- **Size**: Enlarges or shrinks the shape.

- **Aspect**: Adjusts the width-to-height ratio of the shape.

- **Angle**: Rotates the current shape.

- **Softness**: Blurs the edges of the shape.
The Primary Out room provides an additional set of controls for overall color correction, but it can also be used as a tool to trim the grades applied to a selected group of shots.

This chapter covers the different uses of the Primary Out room, which shares the same controls as the Primary In room. For more information about primary color correction controls, see The Primary In Room.

This chapter covers the following:
• What Is the Primary Out Room Used For? (p. 313)
• Making Extra Corrections Using the Primary Out Room (p. 314)
• Understanding the Image Processing Pipeline (p. 314)
• Ceiling Controls (p. 315)

What Is the Primary Out Room Used For?
The controls and functionality of the Primary Out room duplicate those of the Primary In room. This includes sharing saved corrections as the Primary In and Out rooms access the same saved corrections in their bins.

The Primary Out room is valuable for three main reasons:
• It provides an extra room that you can use to make additional modifications to a shot’s grade, without changing the adjustments applied using the Primary In room.
• The Primary Out room comes after the Primary In, Secondaries, and Color FX rooms in the image processing pipeline, so you can apply adjustments to the overall image after the corrections and effects have been added in the other rooms.
• There are three additional controls in the Primary Out room that don’t exist in the Primary In room. The Ceiling parameters give you one more way to limit the color values in a shot to legalize or stylize them.
Making Extra Corrections Using the Primary Out Room

The Color interface was designed for flexibility. The functionality of each of the color correction rooms overlaps broadly, and although each room has been arranged to optimize certain types of operations, you can perform corrections using whichever controls you prefer.

In many cases, colorists like to split up different steps of the color correction process among different rooms. This is detailed in Managing a Shot's Corrections Using Multiple Rooms.

Using this approach, you might perform a shot’s main correction using the Primary In room, use the Secondaries room for stylized “look” adjustments, and then apply one of your previously saved “secret sauce” Color FX room effects to give the shot its final grade.

Once your client has had the opportunity to screen the program, you’ll no doubt be given additional notes and feedback on your work. It’s at this time that the value of the Primary Out room becomes apparent.

Up until now, this room has remained unused, but because of that, it’s a great place to easily apply these final touches. Because you can apply these final corrections in a completely separate room, it’s easy to clear them if the client changes his or her mind.

Furthermore, it’s easy to use the Primary Out room to apply changes that affect an entire scene to multiple clips at once (sometimes referred to as trimming other grades).

To trim one or more selected grades using the Primary Out room

1. Move the playhead to the shot you want to adjust, then click the Primary Out room.
2. Make whatever adjustments are required using the color and contrast controls.
3. Select all the shots in the Timeline that you want to apply these adjustments to.
4. Click Copy To Selected.

The corrections you made in the Primary Out room of the current shot are applied to every shot you’ve selected.

Note: The Copy To Selected command overwrites any previous settings in the Primary Out room of each selected clip, so if you need to make a different adjustment, you can simply repeat the procedure described above to apply it to each selected shot again.

Understanding the Image Processing Pipeline

Another use of the Primary Out room is to apply corrections to clips after the corrections that have been applied in each of the previous rooms.
As the processed image makes its way from the Primary In to the Secondaries to the Color FX rooms, the corrections in each room are applied to the image that’s handed off from the previous room. Since the Primary Out room is the very last correction room in every grade, it processes the image that’s output from the Color FX room. You can take advantage of this to apply overall corrections to the post-processed image.

In the following example, a series of corrections that affect saturation are made in each of the rooms, but the Primary Out room is used to reduce the saturation of the end result. You can see that the final correction modifies the collective output from every other room.

**Primary In Adjustment**  
(Original image adjustment)

**Secondary Adjustment**  
(Boost orange saturation)

**Color FX Adjustment**  
(Add blue vignette)

**Primary Out Adjustment**  
(Saturation adjustment affects the sum of all corrections)

---

**Ceiling Controls**

Lastly, the Primary Out room has a single group of controls that aren’t found in the Primary In room. The Enable Clipping button in the Basic tab of the Primary Out room lets you turn on the effect of the three individual ceiling parameters for the red, green, and blue color channels of the current shot.

This option lets you prevent illegal broadcast values in shots to which you’re applying extreme Primary In, Secondary, or Color FX corrections if you don’t want to turn on Broadcast Safe for the entire program.

The Ceiling parameters can also be used to perform RGB limiting for hard-to-legalize clips.
*Note:* If Enable Clipping and Broadcast Safe are both on, the lowest of the two standards is applied.

These controls are used to adjust color channel ceiling settings:

- *Enable Clipping:* Enables the Ceiling Red/Green/Blue controls.
- *Ceiling Red:* Sets the maximum allowable chroma in the red channel. All values above this level will be set to this level.
- *Ceiling Green:* Sets the maximum allowable chroma in the green channel. All values above this level will be set to this level.
- *Ceiling Blue:* Sets the maximum allowable chroma in the blue channel. All values above this level will be set to this level.
Color provides many tools for managing the corrections and grades that you've applied. You can work even faster by saving, copying, and applying corrections and grades you've already created to multiple shots at once.

There are three areas of the Color interface where you can save, organize, copy, apply, and otherwise manage corrections and grades: the corrections bin inside each room, the Grades bin and the Shots browser in the Setup room, and the grades track in the Timeline. This chapter describes the use of all these areas of the interface in more detail.

This chapter covers the following:
• The Difference Between Corrections and Grades (p. 317)
• Saving and Using Corrections and Grades (p. 318)
• Managing Grades in the Timeline (p. 325)
• Using the Copy To Buttons in the Primary Rooms (p. 332)
• Using the Copy Grade and Paste Grade Memory Banks (p. 334)
• Setting a Beauty Grade in the Timeline (p. 334)
• Disabling All Grades (p. 335)
• Managing Grades in the Shots Browser (p. 336)
• Managing a Shot’s Corrections Using Multiple Rooms (p. 343)

The Difference Between Corrections and Grades
There is a distinct difference between corrections and grades in Color. Understanding the difference is key to managing each set of adjustments correctly.
Corrections are adjustments that are made within a single room. You have the option to save individual corrections into the bins available in the Primary In and Out, Secondaries, and Color FX rooms. Once saved, corrections can be applied to one or more shots in your project without changing the settings of any other rooms. For example, if there are five shots in a scene to which you want to apply a previously saved secondary correction, you can do so without affecting the primary corrections that have already been made to those shots. Each room has its own corrections bin for saving and applying individual corrections, although the Primary In and Primary Out rooms share the same saved corrections.

A grade, on the other hand, encompasses multiple corrections across several rooms, saving every primary, secondary, and Color FX correction together as a single unit. When you save a group of corrections as a grade, you can apply them all together as a single preset. Applying a saved grade overwrites any corrections that have already been made to the shot or shots you’re applying it to. Saved grades are managed using the Grades bin, located in the Setup room.

Saving and Using Corrections and Grades
You can save any correction and grade, in order to apply one shot’s settings to others at a later time. Examples of the use of saved corrections and grades include:

• Saving the finished grade of a shot in your program in order to apply it to other shots that are also from the same angle of coverage

• Saving a correction to a shot from a specific problem reel of tape (for example, a reel with a uniformly incorrect white balance) that you’ll want to apply to every other shot from the same reel

• Saving a stylistic “look” correction in the Primary, Secondaries, or Color FX room that you want to apply to other scenes or programs

For more information, see:

• Saving Corrections into Corrections Bins

• Saving Grades into the Grades Bin

• Deleting Saved Corrections and Grades

• Organizing Saved Corrections and Grades with Folders

• Applying Saved Corrections and Grades to Shots

Saving Corrections into Corrections Bins
The Primary In, Secondaries, Color FX, and Primary Out rooms all have corrections bins where you can save corrections that are specific to those rooms for future use. When you save corrections in any room, they’re available to every project you open in Color.
To save a correction from the current shot into the current room’s bin
1 Move the playhead to the shot with a correction you want to save.
2 Click in the File field underneath the corrections bin, enter a name for the saved correction, and press Return. (This step is optional.)
3 Click Save.

The correction is saved into the current room’s bin with a thumbnail of the shot it was saved from.

To save any shot’s correction into the current room’s bin
1 Click in the File field underneath the corrections bin, enter a name for the saved correction, and press Return. (This step is optional.)
2 Drag the correction bar (in the grades track of the Timeline) of the shot you want to save to the corrections bin.

![Image of correction bar]

**Tip:** To overwrite a previously saved correction with a new one using the same name, select the correction you want to overwrite before saving the new grade, then click Replace when a warning appears. This is useful when you’ve updated a grade that you previously saved.

Entering a custom name for your saved correction is optional, but recommended, to help you keep track of all your corrections during extensive grading sessions. If you don’t enter a name, saved corrections (and grades) are automatically named using the following method:

```
CorrectionType.Day Month Year Hour.Minute.Second TimeZone.extension
```

The date and time used correspond to the exact second the correction is saved. For example, a saved secondary correction might have the following automatic name:

```
Secondary.01 May 2007 10.31.47EST.scc
```

Corrections from each room are saved into corresponding directories in the `/Users/username/Library/Application Support/Color` directory. For more information, see How Are Grades and Corrections Saved and Organized?

### Saving Grades into the Grades Bin

Saved grades store the corrections that are applied in the Primary In, Secondaries, Color FX, and Primary Out rooms all at once, so there’s one more step.

**To save a grade from the current shot**

1 Click the Grades tab in the Setup room.
2 Move the playhead to the shot with a grade you want to save.

3 Select the grade that you want to save by clicking it in the Timeline.

4 Click in the File field underneath the corrections bin, enter a name for the saved correction, and press Return. (This step is optional.)

5 Click the Save button (in the bottom-right corner of the Grades bin).

The grade is saved to the Grades bin.

The grade is saved with a thumbnail from the shot it was saved from. Once you've saved a grade, deleting, organizing, and applying grades is identical to deleting, organizing, and applying saved corrections.

Grades are saved to the /Users/username/Library/Application Support/Color/Grades directory.
To save any shot’s grade
1 Click in the File field underneath the corrections bin, enter a name for the saved correction, and press Return. (This step is optional.)

2 Drag the grade bar of any shot you want to save into the Grades bin.

Tip: To overwrite a previously saved grade with a new one using the same name, select the grade you want to overwrite before saving the new grade, then click Replace when a warning appears. This is useful when you’ve updated a grade that you previously saved.

Deleting Saved Corrections and Grades
You can delete saved corrections and grades you no longer need.

To delete a saved correction or grade
1 Select a correction or grade in any bin.
2 Press Delete or Forward Delete.
3 When a warning appears, click Yes.
The selected correction or grade is deleted, both from Color and from disk. This operation cannot be undone.

**Organizing Saved Corrections and Grades with Folders**

Saved corrections and grades are available to every project you open. For this reason, you may find it useful to save your corrections and grades into folders within each room’s bin. There are a number of different ways you can use folders to organize your saved corrections and grades:

- You can create a folder for each new project you work on, saving all the corrections that are specific to a particular project within the corresponding folder.
- You can also create folders for grades that you have saved for use with any project. For example, you may create a library of your own stylistic "looks" that you can apply to instantly present your clients with different options.

**Note:** You can only save corrections and grades in a folder after that folder has been created.

**To create a new folder inside a bin**

1. Click New Folder.

2. Enter a name for the new folder in the New Folder dialog, then click Create.

A new folder with the name you entered is created inside the corrections bin of that room.
Every time you create a folder in a bin, you also create a subdirectory within the saved correction directory for that room within the /Users/username/Library/Application Support/Color directory.

**To save a correction or grade into a folder**

1. Move the playhead to the shot with a correction or grade you want to save.
2. Double-click a folder in the corrections or Grades bin to open it.
   - The Directory pop-up menu updates to display the directory path in the Finder of the currently open folder.
3. Enter a name for the saved correction or grade in the File field underneath the corrections or Grades bin. (This step is optional.)
4. Click Save.
   - The correction or grade is saved within that folder.

**Important:** There is no way of moving a saved correction into a folder after it’s been saved using the Color interface.

---

**Reorganizing Saved Corrections and Grades in the Finder**

Since each corrections bin simply mirrors the contents of the corresponding subdirectories in the /Users/username/Library/Application Support/Color directory, you can also use the Finder to reorganize your saved corrections and grades. For more information, see Reorganizing Saved Corrections and Grades in the Finder.

---

**Applying Saved Corrections and Grades to Shots**

Once you’ve saved a correction or grade, applying it to one or more shots in your project is easy.

**To apply a saved correction or grade from a bin to a single shot**

1. Move the playhead to the shot you want to apply the correction or grade to.
2. Do one of the following:
   - Double-click the correction or grade you want to apply.
   - Select a correction or grade to apply, then click the Load button underneath the bin.
   - Drag the correction or grade onto the shot you want to apply it to.
   - The selected grade is applied to the shot at the position of the playhead.

**To apply a saved correction or grade from a bin to multiple shots**

1. In the Timeline, select all of the shots you want to apply the correction to.

**Important:** If the current shot at the position of the playhead is not selected, it will not be included in the selection when you apply a saved correction from a bin.
2  Do one of the following:

- In the Grades or corrections bin, double-click the correction or grade you want to apply.
- Select a saved correction or grade in the Grades or corrections bin, then click the Load button underneath the bin.
- Drag the saved correction or grade from the Grades or corrections bin, then drop it onto the selected shots in the Timeline.

The correction or grade is then applied to all selected shots in the Timeline.

**Managing Grades in the Timeline**

Each shot can have up to four alternate grades, shown with different colors in the grades tracks that are located underneath the video track. The currently selected grade for each shot is blue, while unselected grades are gray. The bars showing the individual corrections that contribute to the currently selected grade are shown in other colors, underneath each shot's grade bars.

You can use the grades and correction bars in the grades tracks to add, switch, and copy grades directly in the Timeline. For more information, see:

- Adding and Selecting Among Multiple Grades
- Resetting Grades in the Timeline
- Copying Corrections and Grades in the Timeline

**Adding and Selecting Among Multiple Grades**

Each shot in the Timeline can be set to use one of up to four alternate grades. Only the currently selected grade actually affects a shot. The other unused grades let you store alternate corrections and looks, so that you can experiment with different settings without losing the original.

By default, each shot in a project has a single primary grade applied to it, although you can add more at any time.
To add a new grade to a shot
Do one of the following:

- Control-click or right-click a grade, then choose Add New Grade from the shortcut menu.
- Move the playhead to the shot you want to add a new grade to, then press Control-1 through Control-4.

If a grade corresponding to the number of the grade you entered doesn’t already exist, one will be created. Whenever a new grade is added, the grades track expands, and the new grade becomes the selected grade. New grades are clean slates, letting you begin working from the original state of the uncorrected shot.

To change the selected grade
1. Move the playhead to the shot you want to change the grade of.
2. Do one of the following:
   - Click the grade you want to switch to.
   - Press Control-1 through Control-4.
   - Control-click or right-click a grade, then choose Select Grade [x] from the shortcut menu, where x is the number of the grade you’re selecting.

The shot is updated to use the newly selected grade.

Resetting Grades in the Timeline
If necessary, you can reset any of a shot’s four grades.

To reset a grade in the Timeline
1. Move the playhead to the shot whose grade you want to reset.
2. In the grades track of the Timeline, Control-click or right-click the grade you want to reset to and choose Reset Grade [x] from the shortcut menu, where x is the number of the grade.

Resetting a grade clears all settings from the Primary In, Secondaries, Color FX, and Primary Out rooms, bringing that shot to its original state. Pan & Scan settings in the Geometry room are left intact.

Copying Corrections and Grades in the Timeline
You can drag a correction or grade from one shot to another to copy it in the Timeline.
To copy a correction from one shot to another

- Drag a single correction bar in the grades track of the Timeline to the shot you want to copy it to.

The shot you drag the correction onto becomes highlighted, and after you drop the correction, the current grade for that shot appears with the same grade bar.

**Note:** When you copy individual corrections, secondary corrections overwrite other secondary corrections of the same number.

To copy a grade from one shot to another

- Drag a shot's grade bar in the grades track of the Timeline to a second shot you want to copy it to.

The shot you drag the grade onto becomes highlighted, and after you drop it, every correction in the current grade for that shot is overwritten with those of the grade you copied.

You can also copy a grade to another grade within the same shot. This is useful for duplicating a grade to use as a starting point for creating variations on that grade.
To copy a grade to another grade in the same shot

- Drag a grade bar in the grades track of the Timeline onto another grade bar for the same shot.

The copied grade overwrites all previous corrections.

**Tip:** This is a great way to save a shot's grade at a good state before continuing to experiment with it. If you don’t like your changes, you can easily switch back to the original grade.

You can also drag a corrections or grade bar to copy it to multiple selected shots.

To copy a correction or grade to multiple selected shots in the Timeline

1. Select the shots you want to copy a correction or grade to.

   **Tip:** You can select multiple clips directly in the Timeline, or you can select them in the Shots browser of the Setup room if that’s easier. Shots that you select in the Shots browser are also automatically selected in the Timeline.

2. Drag the correction or grade that you want to copy onto the grade bar of any of the selected shots, either from the Timeline, or from a bin.

   The grade bars of the shots you’re about to copy to should highlight in cyan.

   **Note:** When dragging corrections or grades from one shot to another in the Timeline, you should always drop them inside of the grades track of the Timeline. Dropping a correction or grade onto an item in a video track may only copy it to the shot you drop it onto.
3 Release the mouse button to copy the correction or grade to the selected shots.

Keep in mind the following rules when dragging corrections and grades onto multiple selected shots:

- Dragging onto one of several selected shots copies that correction or grade to the currently selected grade of each shot in the selection.
• Dragging onto an alternate grade of one of several selected shots copies that correction or grade into the alternate grade of the shot you dropped it onto, but it’s copied into the currently selected grade of every other shot in the selection.

Before

After
• Dragging onto a shot that’s not part of the current selection only copies that correction or grade to that shot.

Before

After
• The current shot at the position of the playhead is not included in a multishot Copy operation unless it’s specifically selected (with a cyan highlight).

Before

After

Using the Copy To Buttons in the Primary Rooms
The Copy To Selected and Copy To All buttons in the Primary In and Primary Out rooms are powerful tools for applying Primary In room or Primary Out room corrections to other shots in your project.

To copy a primary correction to all currently selected shots in the Timeline
1. Move the playhead to a shot with a grade you want to copy to other shots in your program.
2. Set the grade used by that shot to the one you want to copy.
3. Select all the shots in the Timeline you want to copy the current grade to, being careful not to move the playhead to another shot.
4 Click Copy To Selected.

The grade at the current position of the playhead is copied to all selected shots.

To copy a primary correction to every single shot in the Timeline
1 Move the playhead to a shot with a grade you want to copy to other shots in your program.
2 Set the grade used by that shot to the one you want to copy.
3 Click Copy To All.

The grade at the current position of the playhead is copied to every shot in your program.

**Note:** The Secondaries and Color FX rooms don’t have Copy To Selected or Copy To All buttons. However, you can accomplish the same task in one of two ways: select the shots you want to copy a correction to and then drag and drop within the Timeline (see Copying Corrections and Grades in the Timeline); or save a Secondaries or Color FX correction to that room’s bin, then select the shots you want to apply that correction to and drag it onto one of the selected shots. For more information, see Applying Saved Corrections and Grades to Shots.
Using the Copy Grade and Paste Grade Memory Banks
You can use the Copy Grade and Paste Grade commands to copy grades from one shot and paste them into others. Five memory banks are available for copying and pasting grades. This means that you can copy up to five different grades—with one in each memory bank—and then paste different grades into different shots as necessary.

To copy a grade into one of the five memory banks
1. Move the playhead to the shot you want to copy a grade from.
2. Make the grade you want to copy the currently selected grade.
3. Choose Grade > Copy Grade > Mem-Bank 1 through 5 (or press Shift–Option–Control–1 through 5).

To paste a grade from one of the five memory banks
1. Move the playhead to the shot you want to copy a grade to.
2. Set the currently selected grade to the grade you want to paste into.
3. Choose Grade > Paste Grade > Mem-Bank 1 through 5 (or press Shift–Option–1 through 5).

The grade is applied to the shot at the position of the playhead.

Note: You cannot paste a grade from one of the five memory banks to multiple selected shots at once.

You can also use the Copy and Paste memory banks feature via a supported control surface. For more information, see Setting Up a Control Surface.

Setting a Beauty Grade in the Timeline
When you’ve set up a project with multiple grades for each shot, it may become difficult to keep track of the grade you like best for any given shot. Marking a particular grade as the beauty grade lets you keep track of the currently preferred grade for each shot.

While the beauty grade setting is primarily intended as a visual marker for your reference, there is a command available from the Render Queue menu to add all beauty grades to the Render Queue. (For more information, see How to Render Shots in Your Project.) This means that you can use the beauty grade designation to control which shots are added to the Render Queue. For example, you might use the beauty grade to keep track of which clips you’ve changed during a revisions session, making it easy to render only the changed shots at the end of the day.

The beauty grade does not have to be the currently selected grade, although if you begin using the beauty grade designation, it’s best to keep it up-to-date for each shot in your project to avoid confusion.
To mark a grade as the beauty grade
1. Move the playhead to the shot on which you want to set a beauty grade.
2. Select the grade you want to set as the beauty grade.
3. Do one of the following:
   - Choose Grade > Set Beauty Grade.
   - Press Shift-Control-B.
   - Move the pointer into the Timeline area, then press B.
The currently selected grade turns rust red to show that it's the beauty grade.

You can change which grade is set as the beauty grade at any time, or you can clear beauty grade designations altogether.

To clear the beauty grade designation of one or more shots
1. Select one or more shots in the Timeline.
2. Choose Grade > Clear Selected Beauty Grades.
   The beauty grade color is removed from all selected shots.

To clear the beauty grade designation from all shots
- Choose Grade > Clear All Beauty Grades.
   The beauty grade color is removed from all shots in the Timeline.

Disabling All Grades
It's often valuable to disable every single correction you've applied to a shot, in order to see a before-and-after view of the current state of your grade.

To disable and reenable rendering for all grades
- Press Control-G.
All corrections made with the Primary In, Secondaries, Color FX, and Primary Out rooms are disabled, and the grades track of the Timeline turns red to indicate that all grades are currently disabled.

**Note:** Pan & Scan settings in the Geometry room remain enabled even when grades are disabled.

**Managing Grades in the Shots Browser**

The Shots browser provides a different way to navigate and organize the shots in your program, in a more nonlinear fashion than the Timeline allows. For example, you can use the Find field in list view to search for groups of shots with common names.

You can also use icon view as an organizational tool to rearrange the shots in your program into *groups* based not on their position in the program, but on the angle of coverage they’re from or the type of grade you’ll be applying, to give but two examples. For more information, see Using the Shots Browser.
Navigating and Arranging Shots in Icon View
When you're working on a project with many shots, it can help to scroll around and zoom in and out to find the shots you're looking for.

To scroll around the Shots browser when in icon view
- Middle-click anywhere within the Shots browser, then drag in the direction you want to scroll.

To zoom in to or out of the Shots browser when in icon view
Do one of the following:
- Press the Control key and drag with the left mouse button.
- Right-click and drag up to zoom out, or down to zoom in.

You can also rearrange shots freely when the Shots browser is in icon view. Rearranging the order of shots in icon view does nothing to change the shot order in the Timeline, but it can help you to organize shots visually so they're faster to find, select, and work with later.

To move a shot in icon view
- Drag the name bar of a shot to another location in the Shots browser.

Choosing Grades in Icon View
You can show all the alternate grades that are available to a shot and select the grade that is currently in use.

To show all of a shot's available grades
- Double-click the name bar underneath a shot’s icon.

All the grades available to that shot appear as bars underneath, connected to the shot with blue connection lines. Once the grades are revealed, you can change which one is selected.
To select the grade used by a shot
- Double-click the grade you want to select.

The selected grade turns blue, while the unselected grades remain dark gray.

**Note:** Grades that have been rendered are colored green.

**Selecting Shots in the Shots Browser in Icon View**
When in icon view, you can select one or more shots in the Timeline just as you can when in list view. Additionally, you can select which grade a shot uses by expanding a shot to reveal all its grades.

**To change the current shot in icon view**
- Click the arrow to the right of a shot’s name bar.

The current shot’s name bar appears gray, and the playhead moves to that shot’s first frame in the Timeline.
To select a shot
- Click the shot’s name bar, underneath its icon.

Selected shots appear with a cyan highlight over their name bars, and are simultaneously selected in the Timeline.

To select multiple shots
- Command-click the name bars of all the shots you want to select.

Grouping and Ungrouping Shots
A *group* is an organizational construct that’s available in the Shots browser only when it’s in icon view. The purpose of groups is very simple: they provide targets with which you can copy a grade to multiple shots at once.

Some examples of ways you might use groups include:
- You can organize all shots in a particular scene in a single group to facilitate applying and updating stylized corrections to every shot in that scene at the same time.
- You could also organize only those shots within a scene that are from the same angle of coverage (and so may be able to share the same corrections), so that you can apply and update the same grade to every shot at once.
- Every shot of a certain type (for example, all head shots of a specific speaker) can be grouped together to similarly let you apply corrections or grades to all those shots simultaneously.

The uses of groups are endless. In short, any time you find yourself wanting to apply a single correction or grade to an entire series of shots, you should consider using groups.

*Note:* Shots can only belong to one group at a time.

There are several different ways you can select shots you want to group together.

**To select shots in the Timeline or Shots browser (in list view) and create a group**

1. Select the shots you want to include in the group by doing one of the following:
   - Shift-click or Command-click to select a range of contiguous or noncontiguous shots in the Timeline.
• Set the Shots browser to list view, then Shift-click or Command-click to select a range of contiguous or noncontiguous shots.
• Use the Find field, or click a column header to sort the list view, to help you identify the shots you want to group together.

2 Set the Shots browser to icon view.

3 Press G.

A group is created, and a group node appears with blue connection lines showing all the shots that belong to that group. Once created, you can rearrange the shot icons as necessary to clean up the browser.

To create a group in icon view
1 Open the Shots browser in the Setup room.
2 Set the Shots browser to icon view.
3 Rearrange the shots you want to group within the Shots browser area (optional).

Even though this step is not strictly necessary, it can be helpful visually for you to see which shots you’re grouping together as a spatially arranged set of icons.

4 Select all the shots you want to group by Command-clicking their name bars.

5 Press G.
A group is created, and a group node appears with blue connection lines showing all the shots that belong to that group.

To add a shot to an already existing group
- Right-click anywhere on a shot’s name bar, then drag a connection line to the node of the group you want to add it to.

To ungroup a collection of grouped clips
- Select the group node you want to delete, then press Delete or Forward Delete.
  The node and its connection lines disappear, leaving the shots ungrouped.

To remove a single shot from a group
- Right-click anywhere on a shot’s name bar, then drag a connection line to an empty area of the Shots browser.
When you release the mouse button, that shot will no longer be connected to the group.

For more information on working with groups once you’ve created them, see Working with Groups.

**Working with Groups**

Once you’ve created one or more groups of shots, you can use the group node to show and hide the shots that are connected to the group, and to copy grades and corrections to every shot that’s connected to that group.

When a group is collapsed, the shots that are connected to that group are hidden.

Double-clicking a collapsed group makes all the hidden shots visible again.

To collapse or expand a group

- Double-click any group’s node.

Once you’ve created a group, copying a correction or grade to the group is easy.

**To copy a correction to a group**

- Drag the correction bar you want to copy from the Timeline onto any group node.

The correction you dragged overwrites the settings in the same room of every shot in that group.
Important: You can only copy corrections and grades from the Timeline to groups in the Shots browser.

To copy a grade to a group
- Drag a grade bar from the Timeline onto any group node.

The grade you dragged overwrites the currently selected grade of every shot in that group. Unselected grades are not affected.

Managing a Shot’s Corrections Using Multiple Rooms
Color’s interface for correcting and manipulating the color of your shots is extremely flexible. While each room has individual controls that are tailored to specific kinds of operations, some functions do overlap, and the Primary In, Secondaries, Color FX, and Primary Out rooms collectively contribute to the final appearance of your piece. How you use these rooms is entirely up to you.

At minimum, the grading of every project involves the following steps:

Stage 1: Optimizing the Exposure and Color of Each Shot
See Stage 1: Correcting Errors in Color Balance and Exposure for more information.

Stage 2: Balancing Every Shot in a Scene to Have Similar Contrast and Color Balance
See Stage 3: Balancing All the Shots in a Scene to Match for more information.

Stage 3: Applying a Creative Look to the Scene
See Stage 5: Achieving a “Look for more information.

Stage 4: Making Modifications in Response to Client Feedback
See Stage 8: Making Digital Lighting Adjustments for more information.

These steps can all be performed within a single room, or they can be broken up among several rooms.

Doing Everything in One Room
- Excluding special operations such as secondary color corrections and Color FX, each of these steps in the grading process can be performed via a single set of adjustments within the Primary In room. In fact, for simple programs that don’t require extensive corrections, this may be the only room you use.
This is especially true for projects where the director of photography and the crew worked to achieve the desired look during the shoot, leaving you with the tasks of balancing the shots in each scene and making whatever adjustments are necessary to simply expand and perfect the contrast and color that you’ve been provided.

**Grading Across Multiple Rooms**
- You can also distribute the different color correction steps outlined above among multiple rooms. This technique lets you focus your efforts during each stage of the color correction process and also provides a way of discretely organizing the adjustments you make, making each change easier to adjust later. For more detailed information, see [Grading a Shot Using Multiple Rooms](#).

**Grading a Shot Using Multiple Rooms**
One common color correction strategy is to break up the various stages of correction you apply to a shot among several rooms in Color, instead of trying to do everything within the Primary In room. This can focus your efforts during each step of the color correction process, and it also provides a way of discretely organizing the adjustments you make, making them easier to adjust later once the client has notes.

This section suggests but one out of countless ways in which the different rooms in Color can be used to perform the steps necessary to grade your projects.

**Stage 1: Optimizing the Exposure and Color of Each Shot**
You might start by optimizing each shot’s exposure and color in the Primary In room. As a way of prepping the project in advance of working with the client in a supervised session, you might restrict your adjustments to simply making each shot look as good as possible on its own by optimizing its exposure and balancing the color, regardless of the later steps you’ll perform.

**Stage 2: Balancing Every Shot in a Scene to Have Similar Contrast and Color Balance**
After optimizing each clip, you can balance the contrast and color of each shot to match the others in that scene using the first tab in the Secondaries room. If you select the Enable button of the Secondaries room without restricting the default settings of the HSL qualifiers, the adjustments you make are identical to those made in one of the Primary rooms.

*Important*: If you’re using a secondary tab to affect the entire image, make sure the Previews tab is not the selected tab while you work. If the Previews tab is selected, the monitored image is modified by the selected Matte Preview Mode and may exhibit a subtle color shift as a result while the Secondaries tab is selected. Clicking the Hue, Sat, or Lum Curve tabs, even though you’re not using them, lets you monitor the image correctly.
Stage 3: Applying a Creative Look to the Scene
Now that the shots have been optimized and the scenes balanced, you can focus on specific creative issues using tabs 2 through 8 in the Secondaries room. You might use these tabs to apply a creative look, or you could go further and make specific digital relighting adjustments. At this point in the process, you can also use the Color FX room to further extend your creative possibilities.

Stage 4: Making Modifications in Response to Client Feedback
Once your client has had the opportunity to screen the nearly finished grade of the program, you'll no doubt be given additional notes and feedback on your work. You can use the Primary Out room, which up until now has remained unused, to easily apply these final touches.

Moreover, because each step of the color grading process was performed in a specific room of the Color interface, it will hopefully be easier to identify which client notes correspond to the adjustments needing correction.

The steps outlined above are simply suggestions. With time, you'll undoubtedly develop your own way of managing the different processes that go into grading programs in Color.
You can create animated grades and other effects using keyframes in the Timeline.

The keyframing mechanism in Color is simple, but effective. It’s designed to let you quickly animate color corrections, vignettes, Color FX nodes, Pan & Scan effects, and user shapes with a minimum number of steps.

This chapter covers the following:
- Why Keyframe an Effect? (p. 347)
- Keyframing Limitations (p. 347)
- How Keyframing Works in Different Rooms (p. 349)
- Working with Keyframes in the Timeline (p. 351)
- Keyframe Interpolation (p. 353)

Why Keyframe an Effect?
In many cases, you may work on entire projects where there’s no need to keyframe any of your corrections. However, keyframed primary corrections will often let you compensate for dynamic changes in exposure or color in shots that might otherwise be unusable. You can also use keyframes to create animated lighting and color effects to further extend a scene’s original lighting.

Here are some common examples of ways you can use animated keyframes:
- Correct an accidental exposure change in the middle of a shot.
- Create an animated lighting effect, such as a light being turned off or on.
- Correct an accidental white balance adjustment in the middle of a shot.
- Move a vignette to follow the movement of a subject.
- Animate a user shape to rotoscope a subject for an intensive correction.

Keyframing Limitations
There are three major limitations to the use of keyframes in Color.
You Can't Keyframe Clips That Use Speed Effects
While color correcting projects that were sent from Final Cut Pro, there's a limitation to shots with speed effects applied to them. While they can be adjusted in any of the rooms in Color like any other shot, speed-effected shots cannot be keyframed in Color.

If you're prepping a project in Final Cut Pro that you want to send to Color, you can avoid this limitation by exporting all clips with speed effects as self-contained QuickTime files and reedit them into the Timeline of your Final Cut Pro sequence to replace the original effects before you send the sequence to Color.

Tip: If you're exporting clips with speed effects in order to make them self-contained QuickTime files, you may want to try sending slow motion clips to Motion, where you can set the clip’s Frame Blending parameter to Optical Flow for smoother effects processing. After you’ve processed your slow motion clips in Motion, it’s best to export self-contained QuickTime files from Motion, which you can then reedit into your Final Cut Pro sequence to replace the original effects.

You Can't Keyframe Curves in the Primary or Secondaries Room
Curves in the Primary In and Out rooms, or in the Secondaries room, can't be animated with keyframes. The other parameters in the room will be animated, but curves remain static throughout the shot.

Pan & Scan Room Keyframes Can’t Be Sent Back to Final Cut Pro
Pan & Scan keyframes that are created in Color cannot be translated into corresponding motion effect keyframes in Final Cut Pro. All Color keyframes are removed when you send your project back to Final Cut Pro, with the settings at the first frame of each clip being used for translation.

Note: Keyframed Scale, Rotation, Center, and Aspect Ratio Motion tab parameters in Final Cut Pro do not appear and are not editable in Color, but these keyframes are preserved and reappear when you send your project back to Final Cut Pro. If a clip has Motion tab keyframes from Final Cut Pro, it appears in Color with the geometry of the last keyframe that's applied to the clip. If necessary, you can Reset the geometry room to see the entire clip, since this will have no effect on the keyframes being internally preserved and returned to Final Cut Pro.
How Keyframing Works in Different Rooms

You can keyframe effects in the Primary In, Secondaries, Color FX, Primary Out and Geometry rooms. Each room has its own separate set of keyframes, stored in individual tracks of the keyframe graph of the Timeline. These tracks are hidden until you start adding keyframes within a particular room, which makes that room’s keyframe track visible.

Keyframes created in each room are visible in the Timeline all at once, but you can edit and delete only the keyframes of the room that’s currently open. All other keyframes are locked until you open their associated rooms.

Although the ways you create, edit, and remove keyframes are identical for every room, keyframes have different effects in each room. For more information, see:

- Keyframing Corrections in the Primary In and Out Rooms
- Keyframing Secondary Corrections
- Keyframing Color FX
- Keyframing Pan & Scan Effects
- Keyframing User Shapes

Keyframing Corrections in the Primary In and Out Rooms

You can keyframe every control and parameter in the Primary In and Out rooms. This lets you correct inappropriately shifting lighting and color caused by automatic camera settings, as well as create animated effects of your own. There are two caveats to keyframing corrections in the Primary In and Out rooms:

- Keyframes in the Primary rooms record the state of all controls and parameters at once. It’s not possible to independently keyframe individual parameters.
- Curves cannot be animated with keyframes, although every other parameter in the Primary In and Primary Out rooms can be.
Note: How color adjustments are animated depends on the Radial HSL Interpolation setting in the User Prefs tab of the Setup room. In nearly all cases, you’ll get the best results by leaving this option turned off. For more information, see The User Preferences Tab.

Keyframing Secondary Corrections
Like parameters and controls in the Primary In and Out rooms, most of the color correction parameters and controls in the Secondaries room can be animated. Each of the eight secondary tabs has its own keyframe track. Furthermore, each secondary tab’s Inside and Outside settings are individually keyframed.

In addition to the color and contrast controls, the following secondary controls can also be animated using keyframes:
- The Enable button that turns each secondary correction off and on
- The qualifiers for the secondary keyer
- The Vignette button that turns vignetting off and on
- All vignette shape parameters

Note: Secondary curves cannot be animated with keyframes.

The ability to keyframe all these controls means you can automate secondary color correction operations in extremely powerful ways. For example, you can adjust the qualifiers of the secondary keyer to compensate for a change of exposure in the original shot that’s causing an unwanted change in the area of isolation.

Keyframing the vignette shape parameters lets you animate vignettes to follow a moving subject, or to create other animated spotlight effects.

Keyframing Color FX
You can keyframe node parameters in the Color FX room to create all sorts of effects. Even though the Color FX room only has a single keyframe track, each node in your node tree has its own keyframes. You can record the state of every parameter within a node using a single set of keyframes; however, a node’s parameters cannot be individually keyframed.

The only keyframes that are displayed in the Color FX room’s keyframe track are those of the node that’s currently selected for editing. All other node keyframes are hidden. This can be a bit confusing at first, as keyframes appear and disappear in the Timeline depending on which node is currently being edited.

Keyframing Pan & Scan Effects
You can keyframe all the adjustments you make using the Pan & Scan parameters and onscreen controls in the Geometry room, creating animated Pan & Scan effects and geometric transformations. All parameters are keyframed together.
Keyframing User Shapes
You can keyframe user shapes created in the Shapes tab of the Geometry room to rotoscope (isolate by tracing frame by frame) moving subjects and areas of the frame for detailed correction in the Secondaries room.

Note: You can only keyframe shapes after they have been assigned to a tab in the Secondaries room.

Working with Keyframes in the Timeline
It takes a minimum of two keyframes to animate an effect of any kind. Each keyframe you create stores the state of the room you're in at that frame. When you've added two keyframes with two different corrections to a room, Color automatically animates the correction that's applied to the image from the correction at the first keyframe to the correction at the last.

Once you add a keyframe to a shot in a particular room, you can edit the controls and parameters in that room only when the playhead is directly over a keyframe. If you want to make further adjustments to a keyframed shot, you need to move the playhead to the frame at which you want to make an adjustment and add another keyframe. Then you can make the necessary adjustments while the playhead is over the new keyframe.

To add a keyframe for the currently open room
- Choose Timeline > Add Keyframe (or press Control-9).

Once you've added one or more keyframes, you can use a pair of commands to quickly move the playhead to the next keyframe to the right or left.
To move the playhead from one keyframe to the next in the currently open room
Do one of the following:

- Press Option–Left Arrow to move to the next keyframe to the left.
- Press Option–Right Arrow to move to the next keyframe to the right.
- Control-click in the keyframe graph of the Timeline, then choose Next Keyframe or Previous Keyframe from the shortcut menu.

Keyframes at the current position of the playhead are highlighted.

You can delete keyframes you don’t need.

To delete a single keyframe
1. Move the playhead to the frame with the keyframe you want to delete.
2. Choose Timeline > Remove Keyframe (or press Control-0).

You can also delete every keyframe applied to a shot in a particular room all at once. When you remove all the keyframes from a particular effect, the entire effect is changed to match the values of the frame at the current position of the playhead.

To delete every keyframe in a single room
1. Click the tab of the room with the keyframes you want to remove.
2. Move the playhead to a frame where the effect is at a state you want applied to the entire shot.
3. Control-click the keyframe you want to delete in the Timeline, then choose Remove All Keyframes from the shortcut menu.

Every keyframe applied to that room or secondary tab is deleted, and the keyframe graph for that room disappears from the Timeline. When you delete all a shot's keyframes at once, the correction or effects settings of the frame at the position of the playhead become the settings for the entire shot.

**Important:** The Remove All Keyframes command removes all the keyframes in the currently selected room, regardless of which area in the Timeline's keyframe graph you Control-click.

You can easily adjust the timing of keyframes that you're already created.

To move a keyframe and change its timing
- Drag it to the left or right.

You can also adjust the timing of a keyframe while previewing the frame you’re moving it to.
To move a keyframe while updating the previewed image

- Press Option while dragging a keyframe to the left or right.

If you need to, you can also make the keyframe graph in the Timeline taller, to make it easier to see what you're doing. For more information, see Customizing the Timeline Interface.

You can also use the keyframe graph to navigate to a room with keyframed effects.

To open the room corresponding to a keyframe track

- Double-click any keyframe track in the Timeline.

### Keyframe Interpolation

The interpolation method that a keyframe is set to determines how settings are animated from one keyframe to the next. There are three possible types of interpolation:

- **Smooth**: Smooth keyframes begin the transition to the next keyframed state slowly, reaching full speed in the middle of the transition and then slowing down to a stop at the next keyframe. This "easing" from one keyframe to the next creates transitions between color corrections, animated Color FX node parameters, Pan & Scan settings, and animated user shapes that look and move smoothly and naturally. However, if you have more than two keyframes, your effect will seem to pause for one frame as the playhead passes over each keyframe, which may or may not be desirable.

- **Linear**: Linear keyframes make a steady transition from one keyframed state to the next, with no acceleration and no slowing down. If you use linear keyframes to animate an effect that happens somewhere in the middle of a shot, the animated effect may appear to begin and end somewhat abruptly. On the other hand, if you are keyframing an animated effect that begins at the first frame and ends at the last frame of the shot, the appearance will be of a consistent rate of change.
• **Constant**: Constant keyframes perform no interpolation whatsoever. All effects change abruptly to the next keyframed state when the playhead reaches the next constant keyframe. Constant keyframes are useful when you want an effect to change immediately to another state, such as increasing the contrast to simulate a sudden lightning strike flashing through a window.

By default, all new keyframes that you create are smooth, although you can change a keyframe's interpolation at any time. Changing a keyframe's interpolation affects only the way values are animated between it and the next keyframe to the right.

**To change a keyframe's interpolation**

1. Move the playhead to the keyframe you want to change.
2. Choose Timeline > Change Keyframe (or press Control-8).
The Geometry room provides a way to zoom in to shots, create pan and scan effects, draw custom mattes for vignetted secondary operations, and track moving subjects to automate the animation of vignettes and shapes.

The Geometry room is divided into an image preview (which contains the onscreen controls for all of the functions in this room) and three tabs to the right. Each tab has different tools to perform specific functions. The Pan & Scan tab lets you resize, rotate, flip, and flop shots as necessary. The Shapes tab lets you create custom masks to use with secondary corrections. Finally, the Tracking tab provides an interface for creating and applying motion tracking, to use with vignettes and custom shapes in your project.

This chapter covers the following:
• Navigating Within the Image Preview (p. 355)
• The Pan & Scan Tab (p. 356)
• The Shapes Tab (p. 361)
• The Tracking Tab (p. 370)

Navigating Within the Image Preview
Each of the tabs in the Geometry room relies upon onscreen controls in the image preview area to the left of the controls tabs. You can zoom in or out and scroll around this area to get a better look at your image while you work, and you can even zoom and pan around while you're in the middle of drawing a shape.

To zoom in to or out of the image preview
• Right-click and drag up to zoom out, and down to zoom in to the image preview.

To pan around the image preview
• Middle-click to drag the image preview in any direction.

To reframe the image preview to fit to the current size of the screen
• Press F.
**The Pan & Scan Tab**

The Pan & Scan tab lets you apply basic transformations to the shots in your projects. You can use these transformations to blow images up, reposition them to crop out unwanted areas of the frame, and rotate shots to create canted angles. You can also use pan and scan effects to reframe each shot when you’re downconverting a high-resolution widescreen project to a standard definition 4:3 frame. For more information, see:

- Exchanging Geometry Settings with Final Cut Pro
- Working with the Pan & Scan Tab
- Animating Pan & Scan Settings with Keyframes and Trackers
- Copying and Resetting Pan & Scan Settings

**Exchanging Geometry Settings with Final Cut Pro**

When you send a sequence from Final Cut Pro to Color, the following Motion tab parameters are translated into their equivalent Color parameters.

<table>
<thead>
<tr>
<th>Motion tab parameters in Final Cut Pro</th>
<th>Pan &amp; Scan parameters in Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Scale</td>
</tr>
<tr>
<td>Rotation</td>
<td>Rotation</td>
</tr>
<tr>
<td>Center</td>
<td>Position X, Position Y</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>Aspect Ratio</td>
</tr>
</tbody>
</table>

While you grade your program, you can preview the effect these transformations have on each shot and make further adjustments as necessary.

Once you finish working on your project in Color, whether or not Color processes Pan & Scan adjustments when you render each shot from the Render Queue depends on what kind of source media you’re using, and how you’re planning on rendering it:

- When projects are sent to Color from Final Cut Pro or imported via XML files, all the Pan & Scan transformations that are applied to your shots in Color are translated back into their equivalent Final Cut Pro Motion tab settings. You then have the option to further customize those effects in Final Cut Pro prior to rendering and output.
- Keyframed Scale, Rotation, Center, and Aspect Ratio Motion tab parameters do not appear and are not editable in Color, but these keyframes are preserved and reappear when you send your project back to Final Cut Pro.
- Pan & Scan keyframes created in Color cannot be translated into corresponding Motion tab keyframes in Final Cut Pro. All Color keyframes are removed when you send your project back to Final Cut Pro, with the settings at the first frame of each clip being used for translation.
- When outputting 2K and 4K Cineon and DPX image sequences, Pan & Scan transformations are processed within Color along with your color corrections when rendering the output media.

- If your project uses 4K native RED QuickTime media, then Pan & Scan transformations are processed within Color, whether you’re rendering DPX/Cineon image sequences for film output, or QuickTime media to send back to Final Cut Pro. Projects using 2K native RED QuickTime media work similarly to other projects using QuickTime clips.

Motion Tab Keyframes Are Preserved In Roundtrips
If any clips are animated using Scale, Rotate, Center, or Aspect Ratio parameter keyframes in Final Cut Pro, these keyframes do not appear and are not editable in Color, but they are preserved and reappear when you send your project back to Final Cut Pro.

If a clip has Motion tab keyframes from Final Cut Pro, it appears in Color with the geometry of the last keyframe that is applied to the clip. If necessary, you can reset the geometry room to see the entire clip while you make corrections in Color, since this will have no effect on the keyframes being internally preserved and returned to Final Cut Pro.

Working with the Pan & Scan Tab
You can transform shots in your program using two sets of controls. To the left, onscreen controls appear within the image preview area, while to the right, numeric parameters mirror these adjustments.
Using the Onscreen Controls
The onscreen controls for the Pan & Scan tab consist of an outer bounding box that represents the scaled output with four handles at each corner and a pair of action safe and title safe indicators within. By default, the onscreen control is the same size as the resolution of your project.

The onscreen controls are designed to work in conjunction with the image that’s displayed by the preview and broadcast displays. In other words, you use the onscreen controls to isolate the portion of the image you want to output, and you view the actual transformation on the preview and broadcast displays.

To resize a shot
- Drag any of the four corners of the onscreen control to resize the shot relative to its center. The onscreen control shrinks or expands to include less or more of the image, and the preview and broadcast displays show the result. This also adjusts the Scale parameter.

To rotate a shot
- Drag just outside the four corner handles, right to rotate left, and left to rotate right.
Because the onscreen control works by selecting a portion of the static source image, the onscreen control rotates in the opposite direction of the effect, but the preview and broadcast displays show the correct result.

To reposition a shot

- Drag anywhere within the red bounding box.

  The onscreen control moves to select a different portion of the shot, and the preview and broadcast displays show the result.

*Note:* There are no onscreen controls for the Aspect Ratio, Flip, and Flop controls.
Using the Pan & Scan Parameters

Each of the adjustments you make using the onscreen controls is mirrored and recorded numerically by the parameters in the Pan & Scan tab to the right. If you want, you can directly manipulate these parameters by either entering new values into the fields or by holding down the middle mouse button and dragging within a field to adjust it using the virtual slider.

- **Position X and Y**: Controls the portion of the image that’s viewed when you reposition the onscreen control. These parameters translate to the two dimensions of the Center parameter in Final Cut Pro.
- **Scale**: Controls the size of the image.
- **Aspect Ratio**: Lets you change the width-to-height ratio of shots to either squeeze or stretch them. This parameter has no onscreen control.
- **Rotation**: Lets you spin the shot about the center of the onscreen control.
- **Flip Image**: Lets you reverse the image horizontally. Right and left are reversed.
- **Flop Image**: Lets you reverse the image vertically. Top and bottom are reversed.

*Important*: The Flip Image and Flop Image parameters are disabled when you’re working with an XML project from Final Cut Pro because there are no equivalent parameters in the Motion tab.

Animating Pan & Scan Settings with Keyframes and Trackers

Animation of the Pan & Scan parameters is primarily intended for projects which will be rendered out of Color as DPX or Cineon image sequences. Animating Pan & Scan parameters is not recommended for projects you’ll be sending back to Final Cut Pro, since neither keyframes nor tracker data can be sent back.
If necessary, you can animate Pan & Scan effects in one of two ways:

- **Using keyframes:** You can keyframe all the Pan & Scan transform controls. For more information on keyframing in Color, see [Keyframing](#).

- **Using a tracker:** You can also use motion tracking to automatically animate a Pan & Scan effect; for example, to move to follow a character who is walking across the screen. Once you create a tracker and analyze the shot (in the Tracking tab), you simply choose the number of the tracker you want to use from the Use Tracker pop-up menu, and the Position X and Y parameters are automatically animated. If Use Tracker is set to None, no trackers are applied. For more information, see [The Tracking Tab](#).

### Copying and Resetting Pan & Scan Settings

Three buttons at the bottom of the Pan & Scan tab let you copy and reset the adjustments you make with these controls.

- **Copy To Selected button:** Select one or more shots in the Timeline, then click this button to copy the current Pan & Scan settings to all the selected shots.

- **Copy To All button:** Copies the Pan & Scan settings to all the shots in the program. This is useful if you’re making a global adjustment when changing the format of a program.

- **Reset Geometry button:** Resets all the Pan & Scan parameters to the default scale for your project.

### The Shapes Tab

The Shapes tab lets you draw custom shapes to use as vignettes in the Secondaries room for feature isolation, vignetting, or digital relighting. The Shapes tab is not meant to be used by itself, nor are you meant to begin operations in the Shapes tab. Instead, shapes are initially created by choosing the User Shape option from the Shape pop-up menu of the Vignette controls in the Secondaries room.

When you choose this option, you are immediately taken to the Shapes tab of the Geometry room, which provides the controls for drawing and editing your own custom shapes. For a more thorough explanation of this workflow, see [Creating a User Shape for Vignetting](#).

**Note:** User Shapes can only be used with secondary operations in the Secondaries room. They cannot be used in the Color FX room.
Controls in the Shapes Tab

The Shapes tab has the following controls:

- **Current Secondary pop-up menu**: Lists which of the eight available tabs in the Secondaries room is the currently selected secondary operation, but you can choose any secondary tab from this pop-up menu prior to making an assignment. When you click the Attach button, this is the secondary tab that the currently selected shape will be attached to.

- **Attached Shape**: When you select a shape that has been attached to a shot’s secondary tab, this field shows the selected shape’s name and the grade to which it’s been attached using the following format: `shapeName.gradeNumber`.

- **Attach button**: Once you’ve drawn a shape you want to use to limit a secondary operation, click Attach to attach it to the currently open secondary tab in the Secondaries room (shown in the Current Secondary field).

- **Detach button**: Click Detach to break the relationship between a shape and the secondary tab to which it was previously assigned. Once detached, a shape no longer has a limiting effect on a secondary operation.
Shapes list: This list shows all the unattached shapes that are available in a project, as well as the shapes that have been assigned to the current shot. Clicking a shape in this list displays it in the image preview area and updates all the parameters in the Shapes tab with the selected shape's settings.

Name column: The name of the shape, editable in the Shape Name field.

ID column: An identification number for the shape. ID numbers start at 0 for the first shape and are incremented by one every time you create a new shape.

Grade column: When a shape is attached, this column shows the grade to which it’s been attached.

Sec column: When a shape is attached, this column shows which of the eight secondary tabs the shape has been attached to.

Hide Shape Handles: Click Hide Shape Handles to hide the control points of shapes in the image preview. The outline of the shape remains visible.

Reverse Normals: When a shape is feathered using the Softness parameter, this button reverses which shape defines the inner and outer edges of feathering.

Use Tracker pop-up menu: If you’ve analyzed one or more Motion Trackers in the current project, you can choose which tracker to use to automatically animate the position of the vignette from this pop-up menu. To disassociate a vignette from the tracker’s influence, choose None.

Softness: A global feathering operation for the entire shape. When set to 0, the shape has a hard (but anti-aliased) edge. When set to any value above 0, inner and outer softness shapes appear along with their own control points. The inner shape shows where the feathering begins, while the outer shape shows the very edge of the feathered shape. If necessary, each border can be independently adjusted.

Shape Name: This field defaults to “untitled”; however, you can enter your own name for the currently selected shape in order to better organize the shapes list.

New button: Click New to create a new, unassigned shape.

Remove button: Choose a shape and click Remove to delete a shape from the Shapes list.

Close Shape/Open Shape button: This button switches the currently selected shape between a closed and open state.

Save button: Saves the currently selected shape to the Shape Favorites directory.

Load button: Loads all shapes that are currently saved in the Shape Favorites directory into the Shapes list of the current shot.

B-spline/Polygon buttons: Switches the currently selected shape between B-Spline mode, which allows for curved shapes, and Polygon mode, in which shapes only have angled corners.
• **Main/Inner/Outer buttons**: These buttons let you choose which points you want to select when dragging a selection box in the image preview, without locking any of the other control points. You can always edit any control point, no matter what this control is set to.

**About the Shapes List**
The Shapes list contains an entry for every unattached shape in the current project, as well as for all of the attached shapes used by the shot at the current position of the playhead. Clicking a shape in this list displays it in the image preview area and updates all of the parameters in the Shapes tab with the selected shape’s settings.

• **Name column**: The name of the shape, editable in the Shape Name field.

• **ID column**: An identification number for the shape. ID numbers start at 0 for the first shape and are incremented by one every time you create a new shape.

• **Grade column**: When a shape is attached, this column shows the grade to which it’s been attached.

• **Sec column**: When a shape is attached, this column shows which of the eight secondary tabs the shape has been attached to.

**Saving and Loading Favorite Shapes**
You can create a collection of custom shapes to use in other projects by using the Save and Load buttons. When you select an unattached shape in the Shapes list and click Save, it’s saved to the following directory:

/Users/username/Library/Application Support/Color/BShapes/

Click Load to load all the shapes that are saved within this directory into the Shapes list of the current shot. Once you decide which shape you want to use, you can remove the others.

**Drawing Shapes**
Drawing and editing shapes works in much the same way as other compositing applications. Color uses B-Splines to draw curved shapes, which are fast to draw and edit. These splines work similarly to those used in the curves in the Primary and Secondaries rooms.
B-Splines use control points that aren’t actually attached to the shape’s surface to “pull” the shape into different directions, like a strong magnet pulling thin wire. For example, here’s a curve with three control points:

The control point hovering above the shape is pulling the entire shape toward itself, while the surrounding control points help to keep other parts of the shape in place.

The complexity of a shape is defined by how many control points are exerting influence on that shape. If two control points are added to either side, and moved down, the curve can be modified as seen below.

To make curves in a shape sharper, move their control points closer together. To make curves more gentle, move the control points farther away from one another.

The following procedures describe how to create, remove, and adjust the control points that edit curve controls.

**To draw a shape**

1. Click one of the eight tabs in the Secondaries room to use it to make a secondary correction, turn on the Enable and Vignette buttons, then choose User Shape from the Shape pop-up menu.

   The Shapes tab in the Geometry room opens, and you’re ready to draw a shape.

2. Click anywhere within the image preview area to add the first control point.

3. Continue clicking within the image preview area to add more points.

4. When you’re ready to finish, close the shape by clicking the first control point you created.
5  Enter a name into the Shape Name field, then press Return. (This step is optional.)
6  Click the Attach button to use the shape in the secondary tab.

A duplicate of the shape you just drew appears in the list, which shows the number of the grade and the secondary tab to which it’s attached. (The original shape you drew remains in the list above, ready to be recycled at a future time.) At this point, you’re ready to use that shape in the Secondaries tab to which it’s been attached.

**To adjust a shape**
- Drag any of its control points in any direction.

Unlike Bezier splines, B-Splines have no tangents to adjust. The only adjustments you can make require using the number and position of control points relative to one another.

![Diagram of B-Spline adjustments](image1)

**To reposition a shape**
- Drag its green center handle in any direction.

![Diagram of B-Spline center handle](image2)

The center handle is the point around which keyframing and motion tracking transformations are made.

**To resize a shape**
1  Make sure the Main button is selected in the Shapes tab.
2  Drag a selection box around every control point you want to resize.
Selected control points turn green.

You don’t have to select every control point in the shape; you can make a partial selection to resize only a portion of the overall shape. The center of all selected control points displays a small green crosshairs box that shows the position of the selected control points relative to the center handle.

3 Do one of the following:
   • Drag any of the four corners of the selection box to resize the shape relative to the opposite corner, which remains locked in position.
   • Option-drag the selection box to resize the shape relative to its center control (visible as green crosshairs).
   • Shift-drag the selection box to resize the shape while locking its aspect ratio, enlarging or reducing the shape without changing its width-to-height ratio.

To toggle a shape between a curved B-Spline and an angled polygon
   - Click either B-Spline or Polygon in the Shapes tab to change the shape to that type of rendering.

To feather the edge of a shape
1 Increase its Softness value.
The Softness parameter applies a uniform feathering around the entire shape. This also reveals a pair of inside and outside shapes that represent the inner and outer boundaries of the feathering effect that’s applied to the shape.

2 If necessary, adjust the shape’s inner and outer shape to create the most appropriate feathering outline around the perimeter of the shape. This lets you create irregularly feathered outlines when you’re isolating a feature where one edge should be hard, and another feathered.

To add control points to a previously existing shape
1 Select a shape to edit in the Shapes list.
2 Click Open Shape.
3 Click within the image preview area to add control points to the end of the selected shape.

4 Click the first control point of the shape when you finish adding more control points.

**Animating Shapes with Keyframes and Trackers**

If necessary, you can animate shapes in one of two ways:

- **Using keyframes:** You can keyframe shapes. For more information on keyframing in Color, see Keyframing.

- **Using a tracker:** You can also use motion tracking to automatically animate a shape; for example, to move to follow a feature that’s moving because the camera is panning.

Once you create a tracker and analyze the shot (in the Tracking tab), you simply select a shape from the Shapes list and choose the number of the tracker you want to use from the Use Tracker pop-up menu, and the shape is automatically animated. If the Use Tracker pop-up menu is set to None, no trackers are applied. For more information, see The Tracking Tab.
The Tracking Tab

Motion tracking is the process of analyzing a shot in order to follow the motion of a specific feature in the image to create a motion path. Once you’ve done this, you can use these motion-tracked camera paths to animate secondary vignettes, Pan & Scan operations, user shapes, and the Vignette node in the Color FX room to follow these motion paths. This way, the corrections you make appear to follow moving subjects or the motion of the camera.

There are actually two kinds of tracking:

• **Automatic Tracking**: Automatic tracking is ideal, as the computer analyzes part of the image that you specify to follow a moving subject. This method creates a motion path with a minimum of user input, but some shots may be difficult to track. When you create an Automatic Tracker, a single onscreen control appears that consists of a pair of boxes with crosshairs at the center.

![Automatic Tracker Example](image)

When you process a tracker, Color analyzes an area of pixels specified by the outer orange Search Region box of the onscreen control, over the range of frames specified by the Mark In and Mark Out buttons. The tracker attempts to “follow” the feature you’ve identified (using the inner red Reference Pattern box of the onscreen control) as it moves across the frame. Angular, high-contrast features are ideal reference patterns that will give you the best results.

• **Manual Tracking**: Manual tracking uses you as the computer, providing a streamlined interface for you to follow a moving subject by clicking it with your mouse, frame by frame from the In point to the Out point, until you’ve constructed a motion path by hand. This method can be tedious, but it can also yield the best results for shots that are difficult to track automatically.

You can use either one or both of these methods together to track a subject’s motion.

**Note**: Color can only use one-point motion tracking. Two- and four-point tracking are not supported.
Will Motion Tracking Solve All Your Problems?
With shots where there is a clearly defined target (something high-contrast and angular, preferably), automatic motion tracking can be the fastest way to quickly and accurately animate a vignette to follow the motion of the subject or camera in a shot, but not always.

If you’re working on a shot where automatic tracking is almost usable, but has a few errors, you might be able to use manual tracking on top of the automatic track to correct the most egregious mistakes, and then increase Tracking Curve Smoothness to get an acceptable result. For more information about manual tracking, see Using the Tracking Tab.

However, if actors or other subjects in the shot pass in front of the feature you’re tracking, or if the motion of a shot is so fast that it introduces motion blur, or if there’s excessive noise, or if there’s simply not a feature on the subject you need to track that’s well-enough defined, you may need to resort to manual tracking for the entire shot, which can be tedious if it’s a long shot. In many cases, manual keyframing may well be the most efficient solution. For more information on keyframing, see Keyframing.

Using Motion Tracking to Animate Vignettes and Shapes
After you’ve processed a tracker, you can use that tracker’s analysis to animate the following:

- A vignette in the Secondaries room
- A user shape in the Geometry room
- X and Y positions in the Pan & Scan tab of the Geometry room
- The Vignette node in the Color FX room

When applied to a vignette or a user shape, the animation of the Motion Tracker is added to the X and Y positioning of the shape. For this reason, it’s most efficient to track a subject and assign that tracker to the vignette, shape, or setting first, and adjust the positioning later.

For example, suppose you’ve used a tracker to follow the movement of someone’s eye, and you want to apply that motion to a vignette that highlights that person’s face. You should choose the tracker from the Use Tracker pop-up menu first. As soon as you choose a tracker, the vignette or shape you’re animating moves so that it’s centered on the tracked feature. At that point, you can position the center, angle, and softness of the shape to better fit the person’s face. This way, the vignette starts out in the correct position and goes on to follow the path created by the tracker. Because the tracker uses an additional transformation, you can still reposition the vignette using the X and Y center parameters or the onscreen control in the Previews tab.
If you track a limited range of a shot’s total duration by setting In and Out points for the tracker that are shorter than the length of the shot, the vignette stays at the initial position you drag it to until the playhead reaches the tracker’s In point, at which time the vignette begins to follow the tracker’s motion path. When the playhead reaches the Out point, the vignette stops and remains at the last tracked frame’s position until the end of the shot.

**Note:** If you apply a tracker to the Pan & Scan settings for any shot in a project that was sent from Final Cut Pro, the tracking data will be lost when the project is sent back to Final Cut Pro. However, if it’s for a project that’s being rendered as a DPX or Cineon image sequence, the animated Pan & Scan settings will be rendered into the final image.

**Controls in the Tracking Tab**

Motion tracking is accomplished by creating a tracker in the Tracker list in the Tracking tab of the Geometry room. You can create as many trackers for a shot as you like, but you can only use one at a time to animate a vignette or shape. The Tracker list shows every tracker you’ve created and analyzed for a given shot, and each tracker has an ID number (they’re numbered in the order in which they’re created). These ID numbers appear in the Use Tracker pop-up menu for any vignette or shape that can be animated using a tracker.
The Tracking tab has the following controls:

- **Tracker list**: A list of all the trackers that have been created for the shot at the current position of the playhead. This list has three columns:
  - **Name column**: The name of that tracker. All trackers are named in the following manner: `tracker.idNumber`
  - **ID number**: The ID number that corresponds to a particular tracker. This is the number you choose from any Use Tracker pop-up menu to pick a tracker to use to animate that adjustment.
  - **Status column**: A progress bar that shows whether or not a tracker has been processed. Red means that a tracker is unprocessed, while green means processed.
• **Manual Tracker**: Click to enter Manual Tracking mode, where you use the pointer to click on a feature in the preview area that you want to track. Each click positions the onscreen tracker control manually to create a tracking keyframe, and then advances the playhead one frame, until you reach the end of the shot. Using this feature, you can rapidly hand-track features in shots that automatic tracking can’t resolve.

• **Tracking Curve Smoothness**: Smooths the tracking data to eliminate uneven or irregular motion. Higher values smooth the tracked motion path more. You can smooth both automatic and manual tracking data.

  **Note**: The original Motion Tracker data is retained and never modified via the smoothing.

• **Process**: Once you’ve adjusted the onscreen controls to identify a reference pattern and search area, click Process to perform the analysis.

• **New**: Creates a new tracker in the Tracker list.

• **Remove**: Deletes the currently selected tracker in the Tracker list.

• **Mark In**: Marks an In point in the current shot at which to begin processing. When you create a new tracker, the In point is automatically created at the current position of the playhead.

• **Mark Out**: Marks an Out point in the current shot at which to end processing. When you create a new tracker, the Out point is automatically created at the end of the last frame of the shot.

### Using the Tracking Tab

This section describes how to use the Tracking tab to create motion paths with which to animate vignettes, shapes, and Pan & Scan settings.

**To automatically track a feature**

1. Move the playhead to the shot you want to track.

   Since a new In point will be created at the position of the playhead, make sure to move it to the first frame of the range you want to track.

2. Open the Tracker tab in the Geometry room, then click New.

   A new, unprocessed tracker appears in the Tracker list, and its onscreen controls appear in the image preview area. A green In point automatically appears at the playhead in a new track of the Timeline, and a green Out point appears at the end.
In many cases, the In and Out points will include the whole shot. However, if the feature you’re tracking is not visible or only moves for a small portion of the shot, you may want to set In and Out points only for that section of the clip. If the In point was incorrectly placed, you can always move the playhead to the correct frame and click Mark In.

3 Drag anywhere within the center box of the onscreen control to move it so that the crosshairs are centered on the feature you want to track.

In this example, the Reference Pattern box is being centered on the man’s eye.

4 Adjust the handles of the inner box (the Reference Pattern box) to fit snugly around this feature.

![Reference Pattern box centered on the man’s eye.

The bigger the box, the longer the track will take.

5 Next, adjust the outer box to include as much of the surrounding shot as you judge necessary to analyze the shot.

![Outer box adjusted to include more of the surrounding shot.

Tip: For a successful track, the feature you’ve identified using the Reference Pattern box should never move outside the search region you’ve defined as the shot proceeds from one frame to the next. If the motion in the shot is fast, you’ll want to make the outer box larger, even though this increases the length of time required for the analysis. If the motion in the shot is slow, you can shrink the Search Region box to a smaller size to decrease the time needed for analysis.

6 Move the playhead to the last frame of the range you want to track, then click Mark Out.
A green Out point appears in the Timeline.

In many cases, this will be the last frame of the shot. However, if the feature you’re tracking becomes obscured, you’ll want to set the Out point to the last frame where the feature is visible.

7 Click Process.

Color starts to analyze the shot, starting at the In point, and a green progress bar moves from the In point to the Out point to show how much of the clip has been analyzed.

When processing is complete, that tracker appears with a green bar in the Status column of the Tracker list, and that tracker is ready to be used in your project. That tracker’s motion path appears in the image preview area whenever that tracker is selected.

If necessary, the tracker is ready to be refined with smoothing, manual repositioning of individual control points in the motion path, or manual tracking. When you’re finished, the tracker is ready to be used to animate a vignette or shape.

If the resulting motion path from an Automatic Tracker has a few glitches, you can drag individual keyframes around to improve it.

To manually adjust a tracked motion path
1 If necessary, set the Tracking Curve Smoothness to 0 so you can more accurately see and position the tracked keyframes.
Drag the playhead in the Timeline through the tracked range of the shot, and identify keyframes that stick out incorrectly, or that drift from the proper direction of the subject's motion.

Drag the offending control point in the preview area so that it better fits the overall motion path.

You can drag any control point in the motion path to a new position, not just the keyframe at the position of the playhead.

If there’s a shot in which the motion is too difficult to track automatically, you might try manually tracking the feature. You can turn on the Manual Tracker option either to correct mistakes in an automatically tracked motion path, or you can use manual tracking on its own to create an entire motion path from scratch.

**To manually track a feature**

1. Move the playhead to the shot you want to track.
2. Open the Tracker tab in the Geometry room, and do one of the following:
   - Click an existing tracker in the Tracker list to modify it.
   - Click New to create a new motion path from scratch.
3. Click Manual Tracker to enter Manual Tracking mode.

When you turn on manual tracking, the onscreen tracker control disappears.

4. Move the playhead to the first frame of the range you want to track, then click Mark In.
5. Now that everything’s set up, simply click a feature in the preview area that you want to track.

For example, if you were tracking someone’s face for vignetting later on, you might click the nose. Whatever feature you choose, make sure it’s something that you can easily and clearly click on, in the same place, on every frame you need to track.

Each click creates a keyframe manually, and then advances the playhead one frame.

6. Click the same feature you clicked in the previous frame, as each frame advances, until you reach the Out point, or the end of the shot.
As you add more manual tracking points, a motion path slowly builds following the trail of the feature you’re tracking.

7 When you’ve finished manually tracking, stop clicking.
That tracker is ready to be assigned to a parameter elsewhere in your project.

*Note:* Turning off the Manual Tracker does not turn off your manually tracked keyframes.

Sometimes a motion track is successful, but the resulting motion path is too rough to use in its original state. Often, irregular motion will expose an animated effect that you’re trying to keep invisible. These may be seen as jagged motion paths.

In these cases, you can use the Tracking Curve Smoothness slider to smooth out the motion path that’s created by the tracker.

**To smooth a track**
1 Select a tracker in the Tracker list.
2 Adjust the Tracking Curve Smoothness slider, dragging it to the right until the motion tracking path is smooth enough for your needs.

The Tracking Curve Smoothness slider is nondestructive. This means that the original tracking data is preserved, and you can raise or lower the smoothing that's applied to the original data at any time if you need to make further adjustments. Lowering the Tracking Curve Smoothness to 0 restores the tracking data at its originally analyzed state.
The Still Store provides an interface with which to compare shots to one another while you do scene-to-scene color correction.

Using the Still Store interface, you can save images from different shots in a project to use as reference stills for comparison to shots you’re correcting to match. This is a common operation in scene-to-scene color correction, when you’re balancing all the shots in a scene to match the exposure and color of one another, so they all look as if they were shot at the same place, at the same time.

Using the Still Store, you can save reference stills from any shot in your project, for comparison to any other shot. This means if you’re working on a documentary where a particular style of headshot is interspersed throughout the program, you can save a reference still of the graded master headshot, and recall it for comparison to every other headshot in the program.

This chapter covers the following:
- Saving Images to the Still Store (p. 381)
- Saving Still Store Images in Subdirectories (p. 383)
-Removing Images from the Still Store (p. 383)
-Recalling Images from the Still Store (p. 384)
- Customizing the Still Store View (p. 384)

**Saving Images to the Still Store**
To use the Still Store, you must first save one or more images for later recall.

**To add an image to the Still Store**
1. Move the playhead to a frame you want to save to the Still Store.
   You should choose a graded image that contains the subjects you need to compare and that is representative of the lighting and color you’re trying to match.
2. If the Still Store is currently turned on, turn it off to make sure you don’t accidentally save a still of the currently displayed split screen.
Optionally, if you want to save the still with a custom name, you can click the Still Store tab and type a name in the File field below the Still Store bin.

If you don’t enter a custom name, each still image you save will be automatically named in the following manner:

`Still.Day_Month_Year_Hour_Minute_SecondTimezone.sri`

The date and time reflect exactly when the still image was saved.

**Note:** If you load a still image into the Still Store immediately prior to saving another one, the newly saved still image will use the name of the still you loaded, overwriting the previously saved still as a result.

To save the still, do one of the following:

- From any room, choose Still Store > Store (or press Control-I).
- Click the Still Store tab, then click Save.

A still image of the frame at the position of the playhead is saved as an uncompressed DPX file in the `/StillStore/` subdirectory within the project bundle itself. It also appears within Color as an item in the Still Store bin. When the Still Store is set to icon view, each saved still appears with a thumbnail for reference.

Still Store images are saved at the native resolution of the source media from which they’re derived, but they’re not saved with the currently applied LUT correction. That way, if your project were using a LUT when you saved the images in the Still Store, and you clear that LUT from your project, the saved still images will continue to match the shots they originated from.

**Important:** Still Store images aren’t updated if the shot they originated from is regraded. This means that if you save a Still Store image from a shot, and then later regrade that shot to have a different look, the saved Still Store image will no longer be representative of that shot and should be removed. If there is any question whether or not a still image correctly reflects a shot’s current grade, the date and time the still image was saved might provide a hint.
Why Is Your Project Getting So Big?
Because all still images are saved within the “StillStore” subdirectory inside your project bundle, you may notice that your project takes longer to back up than it used to if you save a lot of still images. If you need to reduce the size of the project file, you should delete as many unused Still Store images as you can.

Saving Still Store Images in Subdirectories
By default, whenever you save a still image, it’s saved in your project’s internal “StillStore” subdirectory and appears in the Still Store bin along with all the other stills you saved. All stills in the Still Store bin appear in the order in which they were created, with the newest stills appearing last.

You can also organize your saved stills into subdirectories. You might create individual subdirectories based on the date of work, the scene stills are saved from, or any other organizational means of your own devising.

To create a custom subdirectory in the Still Store bin
1. Click the Still Store tab.
2. Click New Folder.
3. When the New Folder dialog appears, enter a name in the “Name of new folder” field, then click Create.

A new subdirectory appears inside of the “StillStore” directory within your project bundle and becomes the currently open directory to which all new still images are saved.

Important: You cannot move still images into subdirectories once they’ve been created. To save new stills in a subdirectory, you need to navigate the Still Store bin to that directory before saving any new stills.

Removing Images from the Still Store
Saved images can stack up pretty quickly in the Still Store, so you want to make sure you regularly remove all unnecessary stills.

To remove an image from the Still Store
1. Click the Still Store tab.
2. Select the still image you want to remove.
3. Press the Delete or Forward Delete key.
4. Click Yes in the warning dialog that appears, to confirm that you really do want to delete the selected still image.

You cannot undo the deletion of a still from the Still Store.
Recalling Images from the Still Store
Once an image has been added to the Still Store, it can be recalled at any time. To display a saved still image, you need to load it into the Still Store and then enable the Still Store to view the image.

To load an image into the Still Store
1. Click the Still Store tab.
2. Do one of the following:
   - Select the still image you want to load, then click Load.
   - Double-click the still image you want to load.

Once a still is loaded, you still have to turn on Display Loaded Still to make the image visible.

To display an image that’s loaded into the Still Store
Do one of the following:
- Choose Still Store > Display Loaded Still (or press Control-U).
- Click the Still Store tab, then select Display Loaded Still.

The currently loaded still image appears both in the preview display and on your broadcast monitor. By default, still images appear as a left-to-right split-screen comparison, but this can be customized.

Customizing the Still Store View
Different colorists use the Still Store in different ways. Some prefer to flip between two full-screen images as they make their comparisons, while others like to create a split screen so they can compare the Still Store and the shot being graded side by side. Color lets you work either way. For more information, see:
- Still Store View Settings
- Controls in the Still Store Bin
Still Store View Settings
Each still image has its own settings for how that image will appear when it’s recalled. These settings can be found on the right side of the Still Store room.

- **Enable:** Makes the currently loaded Still Store image visible in the preview and video output monitors. Identical to the Still Store > Enable (Control-U) command.
- **Transition:** This parameter determines how much of the loaded still is visible onscreen. When set to 0, the loaded still is not visible at all. When set to 1, the loaded still fills the entire screen. Any value in between creates a split-screen view.
- **Angle:** Changes the angle along which the border of a split screen is oriented. The orientation buttons below automatically change the Angle parameter, but the only way to create a diagonal split screen is to customize this control yourself.
- **Left to Right:** Changes the Angle parameter to 180 degrees, to create a vertical split screen with the still to the left.
- **Right to Left:** Changes the Angle parameter to 0 degrees, to create a vertical split screen with the still to the right.
- **Top to Bottom:** Changes the Angle parameter to –90 degrees, to create a horizontal split screen with the still at the top.
- **Bottom to Top:** Changes the Angle parameter to 90 degrees, to create a horizontal split screen with the still at the bottom.
Controls in the Still Store Bin
The Still Store bin has the following controls:

- **Up Directory button:** Clicking this button takes you to the next directory up the current path. You cannot exit the project bundle. To keep your project organized you should make sure that you save all your stills within the “StillStore” directory of your project bundle.

- **Home Directory button:** Changes the directory path to the “StillStore” directory within your project bundle.

- **Icon View:** Changes the Still Store bin to icon view. Each saved still image is represented by a thumbnail, and all stills are organized according to the date and time they were saved, with the oldest stills appearing first (from left to right).

- **List View:** In list view, all still images and directories are represented by two columns; the still image file’s name appears to the left, and the date of its creation appears to the right. All stills are organized according to the date and time they were saved, with the oldest appearing at the top and the newest at the bottom.

- **Icon Size slider:** When the Still Store bin is in icon view, this slider lets you increase and decrease the size of the thumbnails that are displayed for each still.

- **File field:** This field does double duty. When you load a still image, this field displays the still image’s name. However, if you enter a custom name and then save another still, the new still will be created with the name you entered.

- **Directory pop-up menu:** This pop-up menu shows you the current directory path and lets you navigate farther up the current directory structure, if you wish.

- **New Folder button:** Creates a new subdirectory inside the StillStore directory of your project bundle.
• *Save button*: Saves the frame at the current position of the playhead as a still image, for later recall.

• *Load button*: Loads a still so that it’s available for comparison using the Enable button, or the Enable command in the Still Store menu (Control-U).
Once you’ve finished color correcting your program, the controls in the Render Queue let you render the appropriate set of media files for the final output of your program, either to Final Cut Pro or for delivery to other compatible systems.

This chapter covers the following:

• About Rendering in Color (p. 389)
• The Render Queue Interface (p. 395)
• How to Render Shots in Your Project (p. 396)
• Rendering Multiple Grades for Each Shot (p. 400)
• Managing Rendered Shots in the Timeline (p. 401)
• Examining the Color Render Log (p. 401)
• Choosing Printing Density When Rendering DPX Media (p. 402)
• Gather Rendered Media (p. 403)

About Rendering in Color

Rendering has a different purpose in Color than it does in an application like Final Cut Pro. In Color, all effects-processing for playback is done on the fly, either dropping frames or slowing down as necessary to display your color-corrected output at high quality for evaluation purposes. Playback in Color is not cached to RAM, and there is no way to “pre-render” your project for playback while you work.

In Color, rendering is treated as the final step in committing your corrections to disk by generating a new set of media files. The Render Queue lets you render some or all of the shots in your project once they’ve been corrected in Color.

You can use the Render Queue to render your project either incrementally or all at once. For example, if you’re working on a high-resolution project with a multi-day or multi-week schedule, you may choose to add each scene’s shots to the Render Queue as they’re approved, preparing them for an overnight render at the end of each day’s session. This distributes the workload over many days and eliminates the need for a single time-consuming render session to output the entire program at once.
The Graphics Card You’re Using Affects the Rendered Output

Color uses the GPU of the graphics card that’s installed in your computer to render the color correction and geometry adjustments that you’ve applied to the shots in your program. Different video cards have GPU processors with differing capabilities, so it’s entirely possible for the same Color project to look slightly different when rendered on computers with different graphics cards. To ensure color accuracy, it’s best to render your project on a computer using the same graphics card that was used when color correcting that program.

Which Effects Does Color Render?

Projects that are imported from XML and EDL project files may have many more effects than Color is capable of processing. These include transitions, geometric transformations, superimpositions, and speed effects. When rendering your finished program, your import/export workflow determines which effects Color renders.

In particular, if you render out 2K or 4K DPX or Cineon image sequences to be printed to film, Color renders the shots in your project very differently than if you’ve rendered QuickTime files to be sent in a return trip back to Final Cut Pro.

In all cases, the corrections you’ve made using the Primary In, Secondary, Color FX, and Primary Out rooms are always rendered.

Effects That Aren’t Rendered in a Color–to–Final Cut Pro Roundtrip

- When you shepherd a project through an XML-based Final Cut Pro–to–Color roundtrip, all transitions, filters, still images, generators, speed effects, Motion tab keyframes and superimposition settings, and other non-Color-compatible effects from the original Final Cut Pro project are preserved within your Color project, even if those effects aren’t visible.

- Color Corrector 3-way filters are the exception. The last Color Corrector 3-way filter applied to any clip is converted into a Primary In correction in Color. When you send the project back to Final Cut Pro, all Color Corrector 3-way filters will have been removed from your project.

- When you’ve finished grading your program in Color and you render that project as a series of QuickTime movies in preparation for returning to Final Cut Pro, any of the previously mentioned effects that have been invisibly preserved are not rendered. Instead, when you send the finished Color project back to Final Cut Pro, such effects reappear in the resulting Final Cut Pro sequence. At that point you have the option of making further adjustments and rendering the Final Cut Pro project prior to outputting it to tape or as a QuickTime master movie file.
Effects That Are Only Rendered for 2K and 4K Output

• When rendering out DPX or Cineon image sequences, all clips are rendered at the resolution specified by the Resolution Presets pop-up menu in the Project Settings tab of the Setup Room.

• When rendering out DPX or Cineon image sequences, all the transformations you made in the Geometry room’s Pan & Scan tab are rendered.

• When rendering out DPX or Cineon image sequences, all video transitions are rendered as linear dissolves when you use the Gather Rendered Media command to consolidate the finally rendered frames of your project in preparation for film output. This feature is only available for projects that use DPX and Cineon image sequence media or RED QuickTime media, and is intended only to support film out workflows. Only dissolves are rendered; any other type of transition (such as a wipe or iris) will be rendered as a dissolve instead.

• Effects that you need to manually create that aren’t rendered by Color include any video transitions that aren’t dissolves, speed effects, composites, and titles. These must be created in another application such as Shake.

Effects That Are Rendered When Projects Use 4K Native RED QuickTime Media

• When rendering projects using 4K native RED QuickTime media, the output is always rendered at the resolution specified by the Resolution Presets pop-up menu in the Project Settings tab of the Setup room. Additionally, all the transformations you’ve made in the Geometry room’s Pan & Scan tab are always rendered into the final media. This is not true of projects using 2K native RED QuickTime media.

• If you’re outputting to film and you’ve set the Render File Type pop-up menu in the Project Settings tab of the Setup room to DPX or Cineon, then all video transitions are rendered as linear dissolves when you use the Gather Rendered Media command to consolidate the finally rendered frames of your project in preparation for film output. This feature is only available for projects that use DPX and Cineon image sequence media or RED QuickTime media, and is intended only to support film out workflows. Only dissolves are rendered; any other type of transition (such as a wipe or iris) will be rendered as a dissolve instead.

• If you’re sending the project back to Final Cut Pro and the Render File Type pop-up menu in the Project Settings tab of the Setup room is set to QuickTime, effects such as transitions that have been invisibly preserved are not rendered. Instead, when you send the finished Color project back to Final Cut Pro, such effects reappear in the resulting Final Cut Pro sequence. At that point, you have the option of making further adjustments and rendering the Final Cut Pro project prior to outputting it to tape or as a QuickTime master movie file.
Motion Settings, Keyframes, and Pan & Scan Adjustments in Roundtrips
A subset of the static motion settings from Final Cut Pro is translated into the equivalent Pan & Scan settings in Color when you first import the project. These settings have a visible effect on your Color project and can be further adjusted as you fine-tune the program. However, if you’re rendering QuickTime output in preparation for sending your project back to Final Cut Pro, these effects are not rendered by Color unless your project uses 4K native RED QuickTime media; ordinarily, static Pan & Scan settings are passed from Color back to Final Cut Pro for rendering there. Keyframes are handled differently:

• Keyframed Scale, Rotation, Center, and Aspect Ratio Motion tab parameters from Final Cut Pro do not appear and are not editable in Color, but these keyframes are preserved and reappear when you send your project back to Final Cut Pro.

• Color Pan & Scan keyframes cannot be translated into corresponding motion effect keyframes in Final Cut Pro. All Color keyframes are removed when you send your project back to Final Cut Pro, with the settings at the first frame of each clip being used for translation.

For more information, see Exchanging Geometry Settings with Final Cut Pro.

Some Media Formats Require Rendering to a Different Format
There are many codecs that Color supports for media import, such as the XDCAM, MPEG IMX, and HDV families of codecs, that cannot be used as the export format when rendering out of Color. Most of these are formats which, because they’re so highly compressed, would be unsuitable for mastering. Additionally, many of these formats use “squeezed” anamorphic frame sizes, rather than the standard full-raster SD and HD frame sizes that programs are typically mastered to. For all of these codecs, two things happen when you render media for output:

• Media formats that are unsupported for output will be rendered using a different codec: If the media in your project uses a codec that’s not supported for output, then every shot in your project will be rendered using a different codec that is supported. In these cases, Color supports a specific group of codecs that are either lightly or completely uncompressed that are suitable for mastering. You can choose which of these codecs to render your media with by choosing from the Resolution and Codec Settings controls in the Project Settings tab of the Setup room.

• Media formats that are rendered using a different codec will be rendered full raster: If you’re rendering using a different codec, all anamorphic media in your project will be resized to the closest full-raster frame size. For example, media using the anamorphic 1280 x 1080 or 1440 x 1080 frame sizes will be rendered using the standard 1920 x 1080 frame size.
Whenever rendering your project changes the codec, frame size, or both, you are presented with a dialog when you send your project to Final Cut Pro that asks: “Change graded Final Cut Pro sequence to match the QuickTime export codec?”

- If you click Yes to change the sequence settings to match the graded media rendered by Color, then the codec used by the sequence sent to Final Cut Pro will be changed from the one that was originally sent to Color. Also, the frame size of the sequence will change to match the frame size of the rendered media.

- If you click No, the settings of the sequence that Color sends back to Final Cut Pro will be identical to those of the sequence that was originally sent from Final Cut Pro to Color, but the codec used by the clips won’t match that of the sequence, and the rendered clips will have their scale and aspect ratio altered to fit the original frame size.

For a complete list of which codecs are supported by Color, see Compatible QuickTime Codecs for Import.

For a list of the mastering codecs that Color supports for output, see Compatible QuickTime Codecs for Output.

Rendering Mixed Format Sequences

If you edit together a mixed format sequence in Final Cut Pro—for example, combining standard definition and high definition clips of differing formats—you can still send it to Color, as long as each clip of media throughout the sequence is in a format that’s compatible with Color.

When you render the finished project, how the final media is processed depends on the format you’re rendering to:

- **If you’re rendering QuickTime media to send back to Final Cut Pro:** Each shot is individually rendered with the same frame size, aspect ratio, and interlacing as the original media file it’s linked to. Regardless of the project’s resolution preset, standard definition shots are rendered as standard definition, high definition shots are rendered as high definition, progressive frame shots are rendered progressive, and interlaced shots are rendered interlaced. On the other hand, every shot in the project is rendered using the QuickTime export codec that’s specified in the Project Settings tab of the Setup room, and if the original frame size is a nonstandard high definition frame size, then it is changed to the nearest full-raster frame size when rendered.

When you send the project back to Final Cut Pro, the Position, Scale, Aspect Ratio, and Rotation parameters of each shot in the Pan & Scan tab of the Geometry room are passed back to each clip’s corresponding Motion tab settings in Final Cut Pro, so that all of the clips conform to the sequence settings as they did before. However, each rendered media file in the project that was sent back to Final Cut Pro should have the same frame size, aspect ratio, and interlacing as the original media files that were originally sent to Color.
If the original frame size of the sequence was a nonstandard high definition frame size, then you have the option of either changing the sequence frame size when you send the project back to Final Cut Pro to match that of the full-raster media rendered by Color, or leaving it alone. In either case, the Motion tab settings for each clip in Final Cut Pro are automatically adjusted so that all clips fit into the returned sequence in the same was as they did in in Color.

Ultimately, it’s up to Final Cut Pro to transform and render all clips that don’t match the current sequence settings as necessary to output the program to whichever format you require.

- **If you’re rendering 4K native RED QuickTime media, or DPX or Cineon image sequences to be output by a film printer:** In this case, all shots are rendered according to the Position, Scale, Aspect Ratio, and Rotation settings in the Pan & Scan tab settings, with the final frame size conforming to the currently specified resolution preset. The final result is a series of DPX or Cineon image sequences with uniform frame sizes.

**Mixing Frame Rates is Not Recommended**

Mixed format sequences are extremely convenient during the offline edit of a project that incorporates a wide variety of source material. For example, it’s extremely common to mix high definition and standard definition clips in documentary programs. In many cases, you can mix formats with different frame sizes and finish your program using the original media without problems.

However, it’s not recommended to send a sequence to Color that mixes clips with different frame rates, particularly when mixing 23.98 fps and 29.97 fps media. The resulting graded media rendered by Color may have incorrect timecode and in or out points that are off by a frame.

Furthermore, when outputting to tape, all sequences should consist of clips with matching frame rates and field handling (progressive or interlaced) for the highest quality results.

If you have one or more clips in your sequence with a frame rate or field handling standard that don’t match those of the sequence, you can use Compressor to do a standards conversion of the mismatched clips. For more information, see *Final Cut Studio Workflows*, available at http://documentation.apple.com/en/finalcutstudio/workflows.

**Rendering Projects That Use Multiclip**

If you’re working on a project that was edited using the multicamera editing features in Final Cut Pro, the multiclip in your sequence need no special preparation for use in Color. (They can be sent to Color either collapsed or uncollapsed.) However, no matter how many angles a multiclip may have had in Final Cut Pro, once a sequence is sent to Color, only the active angle for each multiclip is visible for grading and rendering. The resulting sequence of rendered media that is sent back to Final Cut Pro consists of ordinary clips.
The Render Queue Interface

You specify which shots in the program you want to render using the Render Queue list. Whenever you add shots to this list, they’re organized by shot number. The order in which shots appear in this column dictates the order in which they’re rendered—the topmost unrendered shot in the list is rendered first, and then rendering continues for the next unrendered shot on the list, and so on until the end of the list is reached.

- **Render Queue list**: Six columns of information appear in the Render Queue:
  - **Number column**: Identifies that shot’s numeric position in the Timeline. All shots in the Render Queue are listed in descending order based on their ID number.
  - **Shot Name column**: Shows a thumbnail and the name of the shot.
  - **In column**: The first frame of media that will be rendered for that shot. This timecode is equal to the Project In point plus the current Handles value specified in the Project Settings tab of the Setup room.
  - **Out column**: The last frame of media that will be rendered for that shot. This timecode is equal to the Project Out point plus the current Handles value specified in the Project Settings tab of the Setup room. If there is no extra media available on disk for handles at the beginning or end of shots, then handles will not be added.
  - **Grade ID column**: Shows the currently selected grade for that shot. You can queue up the same shot up to four times with different grades enabled, in order to render media for each grade associated with that shot.
  - **Progress column**: This is the column where a render bar appears to let you know how long that shot is taking to render. If the shot is not currently rendering, this column shows the render status of that shot (queued, rendering, or rendered).

Render Queue Controls

The following buttons beneath the Render Queue list let you add shots to the queue, remove them, and initiate rendering.

- **Add Unrendered**: Adds all currently unrendered shots to the Render Queue.
- **Add Selected**: Adds all currently selected shots to the Render Queue.
- **Add All**: Adds every shot in the Timeline to the Render Queue. Shots that have already been rendered are also placed in the queue and will be rerendered unless they’re first removed. Shots that are rerendered overwrite the previously rendered media.
- **Remove Selected**: Removes only shots that you’ve selected from the Render Queue.
- **Clear Queue**: Removes all shots from the Render Queue.
• **Start Render**: Initiates rendering for all the shots that have been placed into the Render Queue. This button has the same function as the Render > Start Render menu command.

  **Important**: Once you’ve initiated rendering, you can stop it by pressing either Escape or Control-Period. When you’ve stopped rendering, whichever shot was interrupted will need to be rerendered from its In point.

### How to Render Shots in Your Project
The Render Queue is designed to let you manage the rendering of your project any way you like. You can add every shot in the program to the Render Queue in order to render everything at once, or you can add only the shots that were completed that day as part of a process of rendering your project incrementally.

However you decide to render the media in your project, the process is pretty much the same: you check your project and shot settings, add shots to the Render Queue, and then use the Start Render command.

**To check your Project Settings and User Preferences before you add shots to the Render Queue**

1. Before you add any shots to the Render Queue, always double-check the Render Directory field in the Project Settings tab of the Setup room, to make sure that you’re using the correct render directory. Otherwise, your media may not be rendered where you expect it to be.

2. Next, check the following parameters in the Project Settings tab, since they affect how your media is rendered:
   - **Display LUT**: If you have a display LUT applied to your project, it will be rendered into the output. If you were using the LUT to simulate an output profile (for example, film printing), you don’t want this to happen. Choose File > Clear Display LUT to prevent the LUT from affecting the rendered output. For more information, see Using Display LUTs.
   - **Resolution Presets**: If you change the resolution preset to a different frame size than the one the project was originally set to, how that frame size affects the rendering of your final graded media depends on whether your project uses ordinary QuickTime media, native RED QuickTime media, or DPX/Cineon media. For more information, see Resolution and Codec Settings.
   - **Render File Type**: This setting determines whether you render QuickTime media (appropriate for sending back to Final Cut Pro), or DPX or Cineon image sequences (appropriate for printing to film). For more information, see Resolution and Codec Settings.
- **Printing Density**: If you’re rendering DPX media, make sure that Printing Density is set to the correct format. For more information, see Choosing Printing Density When Rendering DPX Media.

- **Deinterlace Renders**: This setting forces Color to deinterlace all media that’s rendered. Color does not have a sophisticated deinterlacing method, so this setting is inappropriate for high-quality output. For more information, see Resolution and Codec Settings.

- **QuickTime Export Codecs**: Choose the QuickTime codec you want to use for rendering your final output. The list of available codecs is limited to mastering-quality codecs including Apple ProRes and Uncompressed. For more information, see Compatible QuickTime Codecs for Output.

- **Broadcast Safe**: Turning Broadcast Safe on or off affects whether out-of-gamut values are clipped when the output media is rendered. For more information, see Broadcast Safe Settings.

Lastly, open the User Prefs tab and check the following settings:

- **Internal Pixel Format**: Make sure that the Internal Pixel Format is set to the correct bit depth. If you graded your program with Internal Pixel Format set to 8- through 16-bit, changing it to Floating Point may alter how certain Color FX operations work. If you intend to work at a lower bit depth but render at Floating Point, it’s a good idea to double-check all shots with Color FX corrections applied to them prior to rendering to make sure that they look the way you intended.

- **Render Proxy**: If you’re rendering Cineon or DPX image sequences, or RED QuickTime files, and you’re delivering full-quality files, make sure that the Render Proxy pop-up menu is set to Full Resolution.

**To render one or more shots in your program**

1. Go through the Timeline and, for each of the shots you’re planning on rendering, choose the grade you want to render.

   The grade you select for each shot determines which grade is rendered when you add a shot to the Render Queue.

2. Do one of the following to add shots to the Render Queue list:
   - Click Add All, or choose Render Queue > Add All (or press Option-Shift-A) to add the current grade for every shot in the project.
   - Click Add Unrendered, or choose Render Queue > Add Unrendered to add only the shots that haven’t yet been rendered.
   - Select one or more shots, then click Add Selected, or choose Render Queue > Add Selected (or press Option-A) to add only the selected shots.
   - Turn on the beauty grade designation for specific shots to indicate which grades are preferred or which shots you want to render, then choose Render > Add All Beauty Grades. (Shots without beauty grade designations aren’t added to the Render Queue.)
Once you add shots to the Render Queue list, the status of each of the shots that you add changes to Queued in the Shots browser. In the Timeline, each of the shots that you added appears with a yellow status bar over the currently used grade for each queued shot, to show you which of the available grades is being rendered.

**Note:** You can add a shot to the Render Queue with one grade enabled, then choose another grade for that shot and add it to the Render Queue again to render both grades for that shot.

3 Click Start Render, or choose Render Queue > Start Render (or press Command-P).

**Tip:** You may find that your program renders more quickly if you set the Video Output pop-up menu in the User Prefs tab of the Setup room to Disabled.

The shots in the Render Queue start rendering. A green progress bar appears in the Progress column of the first unrendered shot in the list, which shows how long that shot is taking to render.

At the same time, the render bar appearing above the Timeline ruler for the shot being rendered gradually turns green to mirror the progress of the render, while the grade bar that’s currently being rendered turns magenta.
Once the first shot in the Render Queue has finished rendering, the next one begins, and rendering continues from the top to the bottom of the list until the last shot is rendered. All rendered shots in the Timeline appear with a green render bar above the Timeline ruler and a green status bar over the grade that was rendered.

**Note:** To pause rendering, press Escape (whichever shot is interrupted will have to start rendering over again from its beginning). You can click Start Render again to resume rendering.

All rendered media is written to that project’s render directory, which is specified in the Project Settings tab of the Setup room. The render directory is organized into numbered subdirectories, with one subdirectory corresponding to each shot in your project’s Timeline. The number of each subdirectory corresponds to each shot’s number in the Number column of the Render Queue. Each of these subdirectories contains up to four rendered sets of media corresponding to each rendered grade.

**To save and export your program after rendering**

1. **After you’ve rendered all of the clips in your project, it’s important to save the project immediately.** The rendered status of each shot in the Timeline includes the path of each rendered media file, which is used to relink the media when your project is sent back to Final Cut Pro.

2. **Once your Color project is safely saved, you need to send the project to the environment in which it will be output.**
   - **In a Final Cut Pro roundtrip:** Send the project back to Final Cut Pro using the File > Send To > Final Cut Pro command. For more information, see [Sending Your Project Back to Final Cut Pro](#).
   - **If you’re rendering for film output:** The next step is to use the File > Gather Rendered Media command to prepare the final image sequence that will be output to film. For more information, see [Gather Rendered Media](#).

For more information about options in the Project Settings tab or User Prefs tab in the Setup room, see [The Project Settings Tab](#) or [The User Preferences Tab](#).
Rendering Multiple Grades for Each Shot

Each shot in your Color project uses one of up to four possible grades. As you work, you have the ability to freely change which grade is used by any shot, switching among different looks as necessary during the development of the program’s aesthetic.

You also have the ability to render each of a shot’s grades individually, or together. This way, whenever there’s a scene where the client might approve one of four different looks, you can hedge your bets by rendering all versions.

Color keeps track of which grade is currently selected when you send that project back to Final Cut Pro, or when you use the Gather Rendered Media command, and makes sure that the appropriate render file is used.

Each rendered grade is numbered. For example, if you rendered two different grades in a QuickTime-based project for shot number 1, the subdirectory for that shot would have two shots, named 1_g1.MOV and 1_g2.MOV, with the number coming immediately after the g indicating which grade that file corresponds to.

To render multiple grades for a single shot

1. Move the playhead to a shot you want to render, and choose the first grade you want to render out for that shot.
2. Select that shot, click the Render Queue tab, then click Add Selected to add that shot to the Render Queue.
3. Change the grade used by that shot to the next one you want to render.
4. Click Add Selected again to add that shot to the Render Queue a second time.

Every grade that’s queued for rendering appears with a yellow render bar over the grade bar in the Timeline.
The grade ID column in the Render Queue shows you what grades you’ve selected to render for each shot.

Managing Rendered Shots in the Timeline
Once you’ve rendered shots in the Timeline, they stay rendered unless you make a change to the grade. When you change the grade of a shot that’s already been rendered, its render bar will once again turn red, showing that its current state is unrendered. Rendering the new state of the grade for that shot overwrites the previous render file.

If you try to add a shot that’s currently shown as having been rendered to the Render Queue (for example, you’ve inadvertently included one or more shots that have already been rendered in a selection of shots you want to render), a dialog warns you which shots will be rerendered, with the option to leave them out of the queue.

Clicking Yes forces Color to add them to the Render Queue, where they will be rendered a second time.

Examining the Color Render Log
Every time you render shots in a project, information about what was rendered, when it was rendered, and how long it took to render is written to a color.log file. This information can be used to benchmark your system, troubleshoot rendering issues, and keep a record of how long different projects take to render. Every time you render anything in any Color project, information about that rendering session is appended to this one log.

Whenever you click Start Render, the date and time the render was started and number of clips queued up for rendering is written into the log, followed by information and statistics about each clip that is rendered. This information includes:

- Path the rendered file was written to
• Resolution of the rendered file
• QuickTime Codec or Format
• Number of Frames rendered in each rendered file
• Time to render
• Performance (in frames per second)

The date and time that rendering was completed appears after the end of each session’s individual clip entries.

The color.log file is stored in /Users/username/Library/Logs directory. However, you can view this log from within Color.

To see the Color render log
- Choose Render Queue > Show Render Log.

The render log appears in a Console window.

You have the option of clearing out the color.log file if it becomes too long.

To clear the Color render log
- With the Render Log window showing, click Clear Display.

Choosing Printing Density When Rendering DPX Media
When you’re rendering DPX image sequences in preparation for printing to film, it’s important that you choose the appropriate Printing Density from the Project Settings tab of the Setup room. Consult with the film printing facility you’re working with to determine the right setting for your program.

Note: Choosing Cineon as the Render File Type limits the Printing Density to Film (95 Black - 685 White : Logarithmic), while choosing QuickTime as the Render File Type limits it to Linear (0 Black - 1023 White).

The Printing Density pop-up menu lets you choose how to map 0 percent black and 100 percent white in each color-corrected shot to the minimum and maximum numeric ranges that each format supports. Additionally, the option you choose determines whether or not super-white values are preserved. There are three possible settings:

• Film (95 Black - 685 White : Logarithmic): The minimum and maximum values of 0 and 100 percent in Color’s scopes correspond to the digital values of 95 and 685 in rendered DPX files. Super-white values above 100, if present in Color, are preserved using this format.
• **Video (64 Black - 940 White : Linear):** The minimum and maximum values of 0 and 100 percent in Color’s scopes correspond to the digital values of 64 and 940 in rendered DPX files. Super-white values above 100, if present in Color, are preserved using this format.

• **Linear (0 Black - 1023 White):** The minimum and maximum values of 0 and 100 percent in Color’s scopes correspond to the digital values of 0 and 1023 in rendered DPX files. Super-white values, if present in Color, are clipped using this format when rendering DPX files.

This is also the default setting for QuickTime output. When rendering QuickTime files, super-white values above 100 are preserved if the QuickTime export codec is set to a Y’C_bC_r-compatible codec, such as Apple ProRes 422 (HQ) or 10-bit Uncompressed 4:2:2. If you’re rendering to an RGB-compatible codec, such as Apple ProRes 4444, super-white values are clipped.

### Gather Rendered Media

The Gather Rendered Media command can only be used if the shots of a project have been rendered as a series of DPX or Cineon image sequences. This command is used to reorganize all of a project’s rendered image sequence media in preparation for delivery to a film printer.

This operation organizes your rendered image sequences in three ways:

• Every rendered frame of media for your project is placed within a single directory.

• Every frame of media for your project is renamed to create a single, continuous range of frames from the first to the last image of the rendered project.

• All video transitions in your project are rendered as linear dissolves. Only dissolves are rendered; any other type of transition appearing in your project, such as a wipe or iris, will be rendered as a dissolve instead.

**Important:** You cannot gather media in an XML-based roundtrip.

**To gather rendered media**


2. Choose one of three options for gathering the rendered media for your project:

   • *Copy Files:* Makes duplicates of the image sequence files, but leaves the originally rendered files in the render directory.

   • *Move Files:* Copies the image sequence files, and then deletes the originally rendered files from the render directory.
• **Link Files**: Creates aliases of the originally rendered files in the render directory. This is useful if you want to process the frames using an application on your computer, and you don’t want to duplicate the media unnecessarily. This is not useful if you’re intending to transport the media to another facility, since the alias files only point to the original media in the render directory, and contain no actual image data.

3 Click Create New Directory if you want to place the gathered media inside of a new directory.

4 Click Gather.

   Every rendered frame of every shot in your project is renamed, renumbered, and placed in the directory you specified, ready for further processing or delivery.
When using analog devices, make sure they are calibrated for accurate brightness and color so you can color correct your video accurately.

This appendix covers the following:
• About Color Bars (p. 405)
• Calibrating Video Monitors with Color Bars (p. 405)

About Color Bars
Color bars are an electronically generated video signal that meet very strict specifications. Because the luma and chroma levels are standardized, you can use color bars passing through different components of a video system to see how each device is affecting the signal.

NTSC and PAL each have specific color bar standards, and even within NTSC and PAL there are several standards. When you evaluate color bars on a video scope, it is important to know which color bars standard you are measuring, or you may make improper adjustments. “SMPTE bars” is a commonly used standard.

When Should You Use Color Bars?
Analog devices always need to be calibrated and adjusted, even if only by minute degrees. This is because heat, age, noise, cable length, and many other factors subtly affect the voltage of an analog electronic video signal, which affects the brightness and color of the video image. Color bars provide a reference signal you can use to calibrate the output levels of an analog device.

Calibrating Video Monitors with Color Bars
Editors and broadcast designers shouldn’t rely on an uncalibrated monitor when making crucial adjustments to the color and brightness of their programs. Instead, it’s important to use a calibrated broadcast monitor to ensure that any adjustments made to exposure and color quality are accurate.
Monitors are calibrated using SMPTE standard color bars. Brightness and contrast are adjusted by eye, using the color bars onscreen. Adjusting chroma and phase involves using the “blue only” button found on professional video monitors. This calibration should be done to all monitors in use, whether they’re in the field or in the editing room.

**To calibrate your monitor**

1. Connect a color bars or test pattern generator to the monitor you’re using, or output one of the built-in color bars generators in Final Cut Pro.

   **Important:** Avoid using still image graphics of color bars. For more information, see Y’C_B'C_R Rendering and Color Bars.

2. Turn on the monitor and wait approximately 30 minutes for the monitor to “warm up” and reach a stable operating temperature.

3. Select the appropriate input on the video monitor so that the color bars are visible on the screen.

   Near the bottom-right corner of the color bars are three black bars of varying intensities. Each one corresponds to a different brightness value, measured in **IRE**. (IRE originally stood for **Institute of Radio Engineers**, which has since merged into the modern IEEE organization; the measurement is a video-specific unit of voltage.) These are the **PLUGE** (Picture Lineup Generation Equipment) bars, and they allow you to adjust the brightness and contrast of a video monitor by helping you establish what absolute black should be.

4. Turn the chroma level on the monitor all the way down.

   This is a temporary adjustment that allows you to make more accurate luma adjustments. The Chroma control may also be labeled **color or saturation**.

5. Adjust the brightness control of your monitor to the point where you can no longer distinguish between the two PLUGE bars on the left and the adjacent black square.

   At this point, the brightest of the bars (11.5 IRE) should just barely be visible, while the two PLUGE bars on the left (5 IRE and 7.5 IRE) appear to be the same level of black.

6. Now, turn the contrast all the way up so that this bar becomes bright, and then turn it back down.
The point where this bar is barely visible is the correct contrast setting for your monitor. (The example shown below is exaggerated to demonstrate.)

When adjusting the contrast, also watch the white square in the lower left. If the contrast is too high, the white square appears to “spill” into the surrounding squares. Adjust the contrast until the luma of the white square no longer spills into surrounding squares.

*Important:* Contrast should *only* be adjusted after brightness.

7 Once you have finished adjusting luma settings, turn up the Chroma control to the middle (detent) position.

*Note:* Some knobs stop subtly at a default position. This is known as the *detent* position of the knob. If you’re adjusting a PAL monitor, then you’re finished. The next few steps are color adjustments that only need to be made to NTSC monitors.

8 Press the “blue only” button on the front of your monitor to prepare for the adjustment of the Chroma and Phase controls.

*Note:* This button is usually only available on professional monitors.

9 Make the following adjustments based on the type of video signal you’re monitoring:

- If you’re monitoring an SDI or component Y’C₈C₉ signal, you only need to adjust the Chroma control so that the tops and bottoms of the alternating gray bars match. This is the only adjustment you need to make, because the Phase control has no effect with SDI or component signals.

- If you’re monitoring a Y/C (also called *S-Video*) signal, it’s being run through an RGB decoder that’s built into the monitor. In this case, adjust both the Chroma and Phase controls. The chroma affects the balance of the outer two gray bars; the phase affects the balance of the inner two gray bars. Adjustments made to one of these controls affects the other, so continue to adjust both until all of the gray bars are of uniform brightness at top and bottom.
**Note:** The step in the second bullet also applies to the monitoring of composite signals, but you really, really shouldn’t be monitoring a composite signal if you’re doing color correction.

Once your monitor is correctly calibrated, all the gray bars will be evenly gray and all the black bars evenly black.

When the phase (similar to hue) of the monitor is correctly adjusted, you should see alternating bars of gray and black, as shown.

**Y’C_BC_R Rendering and Color Bars**

Y’C_BC_R rendering must be supported by the codec used in a sequence in order for Final Cut Pro to render color bars with a PLUGE (Picture Lineup Generation Equipment) area that includes a super-black (4 IRE in NTSC, 2 IRE in PAL) signal for calibration. The PLUGE part of the test signal cannot be rendered using an RGB-based codec.
This chapter shows the various keyboard shortcuts that are available while working in Color.

This appendix covers the following:
- Project Shortcuts (p. 409)
- Switching Rooms and Windows (p. 410)
- Scopes Window Shortcuts (p. 411)
- Playback and Navigation (p. 411)
- Grade Shortcuts (p. 412)
- Timeline-Specific Shortcuts (p. 413)
- Editing Shortcuts (p. 413)
- Keyframing Shortcuts (p. 414)
- Shortcuts in the Shots Browser (p. 414)
- Shortcuts in the Geometry Room (p. 414)
- Still Store Shortcuts (p. 414)
- Render Queue Shortcuts (p. 415)

## Project Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>⌘ ⌘ + N</code></td>
<td>New project</td>
</tr>
<tr>
<td><code>⌘ ⌘ + O</code></td>
<td>Open project</td>
</tr>
<tr>
<td><code>⌘ ⌘ + R</code></td>
<td>Revert to last saved state of the current project</td>
</tr>
<tr>
<td><code>⌘ ⌘ + S</code></td>
<td>Save project</td>
</tr>
<tr>
<td><code>⌘ ⌘ + option + S</code></td>
<td>Save archive as; allows you to name an archive</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ ⌘ + option + A</td>
<td>Open archived version of project</td>
</tr>
<tr>
<td>⌘ ⌘ + I</td>
<td>Import clip (opens the File browser in the Setup room)</td>
</tr>
<tr>
<td>⌘ ⌘ + option + G</td>
<td>Gather Rendered Media (only for Cineon or DPX projects)</td>
</tr>
<tr>
<td>⌘ ⌘ + Z</td>
<td>Undo; press Command-Z a second time to restore the change</td>
</tr>
<tr>
<td>⌘ ⌘ + X</td>
<td>Cut</td>
</tr>
<tr>
<td>⌘ ⌘ + C</td>
<td>Copy</td>
</tr>
<tr>
<td>⌘ ⌘ + V</td>
<td>Paste</td>
</tr>
<tr>
<td>⌘ ⌘ + A</td>
<td>Select All</td>
</tr>
<tr>
<td>⌘ ⌘ + shift + A</td>
<td>Deselect All</td>
</tr>
<tr>
<td>⌘ ⌘ + shift + ?</td>
<td>Open Color Help</td>
</tr>
</tbody>
</table>

### Switching Rooms and Windows

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ ⌘ + 1</td>
<td>Open Setup room</td>
</tr>
<tr>
<td>⌘ ⌘ + 2</td>
<td>Open Primary In room</td>
</tr>
<tr>
<td>⌘ ⌘ + 3</td>
<td>Open Secondaries room</td>
</tr>
<tr>
<td>⌘ ⌘ + 4</td>
<td>Open Color FX room</td>
</tr>
<tr>
<td>⌘ ⌘ + 5</td>
<td>Open Primary Out room</td>
</tr>
<tr>
<td>⌘ ⌘ + 6</td>
<td>Open Geometry room</td>
</tr>
<tr>
<td>⌘ ⌘ + 7</td>
<td>Open Still Store</td>
</tr>
<tr>
<td>⌘ ⌘ + 8</td>
<td>Open Render Queue</td>
</tr>
<tr>
<td>⌘ ⌘ + 9</td>
<td>Open Project Settings tab in the Setup room</td>
</tr>
<tr>
<td>⌘ ⌘ + 0</td>
<td>Open Shots browser in the Setup room</td>
</tr>
<tr>
<td>Keyboard shortcut</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Shift + 1</td>
<td>Select Color window</td>
</tr>
<tr>
<td>Shift + 2</td>
<td>Select Scopes window</td>
</tr>
<tr>
<td>Shift + 0</td>
<td>Switches between single display and dual display modes the next time Color is opened</td>
</tr>
</tbody>
</table>

### Scopes Window Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Change scope to Waveform</td>
</tr>
<tr>
<td>V</td>
<td>Change scope to Vectorscope</td>
</tr>
<tr>
<td>H</td>
<td>Change scope to Histogram</td>
</tr>
<tr>
<td>C</td>
<td>Change scope to 3D Scope</td>
</tr>
</tbody>
</table>

### Playback and Navigation

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Switches between play and stop</td>
</tr>
<tr>
<td>J</td>
<td>Play backward</td>
</tr>
<tr>
<td>K</td>
<td>Stop</td>
</tr>
<tr>
<td>L</td>
<td>Play forward</td>
</tr>
<tr>
<td>↑</td>
<td>Move playhead to next shot</td>
</tr>
<tr>
<td>↑</td>
<td>Move playhead to previous shot</td>
</tr>
<tr>
<td>←</td>
<td>Move playhead back one frame</td>
</tr>
<tr>
<td>→</td>
<td>Move playhead forward one frame</td>
</tr>
<tr>
<td>Home</td>
<td>Go to beginning of Timeline</td>
</tr>
<tr>
<td>End</td>
<td>Go to end of Timeline</td>
</tr>
</tbody>
</table>
### Function Keyboard shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + control + M</td>
<td>Switch playback mode</td>
</tr>
<tr>
<td>I</td>
<td>Set In point in Timeline for playback</td>
</tr>
<tr>
<td>O</td>
<td>Set Out point in Timeline for playback</td>
</tr>
</tbody>
</table>

### Grade Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>control + 1</td>
<td>Create new grade-switch to grade 1</td>
</tr>
<tr>
<td>control + 2</td>
<td>Create new grade-switch to grade 2</td>
</tr>
<tr>
<td>control + 3</td>
<td>Create new grade-switch to grade 3</td>
</tr>
<tr>
<td>control + 4</td>
<td>Create new grade-switch to grade 4</td>
</tr>
<tr>
<td>control + G</td>
<td>Turns grade on/off</td>
</tr>
<tr>
<td>shift + control + B</td>
<td>Set current grade as the beauty grade</td>
</tr>
<tr>
<td>shift + option + control + 1</td>
<td>Copy current grade to memory bank 1</td>
</tr>
<tr>
<td>shift + option + control + 2</td>
<td>Copy current grade to memory bank 2</td>
</tr>
<tr>
<td>shift + option + control + 3</td>
<td>Copy current grade to memory bank 3</td>
</tr>
<tr>
<td>shift + option + control + 4</td>
<td>Copy current grade to memory bank 4</td>
</tr>
<tr>
<td>shift + option + control + 5</td>
<td>Copy current grade to memory bank 5</td>
</tr>
<tr>
<td>shift + option + 1</td>
<td>Paste grade from memory bank 1</td>
</tr>
<tr>
<td>shift + option + 2</td>
<td>Paste grade from memory bank 2</td>
</tr>
<tr>
<td>shift + option + 3</td>
<td>Paste grade from memory bank 3</td>
</tr>
<tr>
<td>shift + option + 4</td>
<td>Paste grade from memory bank 4</td>
</tr>
<tr>
<td>shift + option + 5</td>
<td>Paste grade from memory bank 5</td>
</tr>
</tbody>
</table>
# Timeline-Specific Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-</code></td>
<td>Zoom out</td>
</tr>
<tr>
<td><code>=</code></td>
<td>Zoom in</td>
</tr>
<tr>
<td><code>shift</code> + <code>Z</code></td>
<td>Zoom to fit every shot into the available width of the Timeline</td>
</tr>
<tr>
<td><code>F</code></td>
<td>Set Timeline ruler to frames</td>
</tr>
<tr>
<td><code>S</code></td>
<td>Set Timeline ruler to seconds</td>
</tr>
<tr>
<td><code>M</code></td>
<td>Set Timeline ruler to minutes</td>
</tr>
<tr>
<td><code>H</code></td>
<td>Set Timeline ruler to hours</td>
</tr>
<tr>
<td><code>tab</code></td>
<td>Switch Timeline ruler between frames/seconds/minutes/hours</td>
</tr>
<tr>
<td><code>control</code> + <code>A</code></td>
<td>Select all shots in timeline</td>
</tr>
<tr>
<td><code>control</code> + <code>shift</code> + <code>A</code></td>
<td>Deselect all shots in timeline</td>
</tr>
<tr>
<td>Shift-click</td>
<td>Select a contiguous region of clips in the timeline</td>
</tr>
<tr>
<td>Command-click</td>
<td>Select a noncontiguous region of clips in the timeline</td>
</tr>
</tbody>
</table>

# Editing Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>control</code> + <code>S</code></td>
<td>Choose Select tool</td>
</tr>
<tr>
<td><code>control</code> + <code>R</code></td>
<td>Choose Roll tool</td>
</tr>
<tr>
<td><code>control</code> + <code>T</code></td>
<td>Choose Ripple tool</td>
</tr>
<tr>
<td><code>control</code> + <code>Y</code></td>
<td>Choose Slip tool</td>
</tr>
<tr>
<td><code>control</code> + <code>X</code></td>
<td>Choose Split tool</td>
</tr>
<tr>
<td><code>control</code> + <code>Z</code></td>
<td>Choose Splice tool</td>
</tr>
<tr>
<td><code>control</code> + <code>V</code></td>
<td>Create an edit at the position of the playhead</td>
</tr>
<tr>
<td><code>control</code> + <code>B</code></td>
<td>Merge an edit at the position of the playhead</td>
</tr>
</tbody>
</table>
# Keyframing Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>control</code> + <code>8</code></td>
<td>Change keyframe interpolation type at position of playhead</td>
</tr>
<tr>
<td><code>8</code></td>
<td>Change keyframe interpolation type at position of playhead</td>
</tr>
<tr>
<td><code>control</code> + <code>8</code></td>
<td>Add keyframe at position of playhead</td>
</tr>
<tr>
<td><code>9</code></td>
<td>Add keyframe at position of playhead</td>
</tr>
<tr>
<td><code>control</code> + <code>0</code></td>
<td>Delete keyframe at position of playhead</td>
</tr>
<tr>
<td><code>0</code></td>
<td>Delete keyframe at position of playhead</td>
</tr>
<tr>
<td><code>option</code> + <code>←</code></td>
<td>Move playhead to previous keyframe of current shot in current room</td>
</tr>
<tr>
<td><code>option</code> + <code>→</code></td>
<td>Move playhead to next keyframe of current shot in current room</td>
</tr>
</tbody>
</table>

## Shortcuts in the Shots Browser

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>G</code></td>
<td>Assign selected shots into a group</td>
</tr>
<tr>
<td><code>F</code></td>
<td>Center the Shots browser</td>
</tr>
</tbody>
</table>

## Shortcuts in the Geometry Room

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>F</code></td>
<td>Frame the preview image in the Geometry room</td>
</tr>
</tbody>
</table>

## Still Store Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>control</code> + <code>U</code></td>
<td>Enable currently loaded still</td>
</tr>
<tr>
<td><code>control</code> + <code>I</code></td>
<td>Save frame at the current position of the playhead to the Still Store</td>
</tr>
</tbody>
</table>
## Render Queue Shortcuts

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option + A</code></td>
<td>Add selected shots to the Render Queue</td>
</tr>
<tr>
<td><code>shift + option + A</code></td>
<td>Add all shots in the Timeline to the Render Queue</td>
</tr>
<tr>
<td><code>blade + B</code></td>
<td>Start Render</td>
</tr>
</tbody>
</table>
The tables in this section show the various Multi-Touch controls that are available in Color. Multi-Touch controls require a Multi-Touch capable input device.

This appendix covers the following:

- Multi-Touch Control of the Timeline (p. 417)
- Multi-Touch Control in the Shots Browser (p. 417)
- Multi-Touch Control of the Scopes (p. 418)
- Multi-Touch Control in the Geometry Room (p. 418)
- Multi-Touch Control in the Image Preview of the Scopes Window (p. 419)

**Multi-Touch Control of the Timeline**
The following Multi-Touch controls let you modify the Timeline’s display.

<table>
<thead>
<tr>
<th>Multi-Touch Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pinch close</td>
<td>Zoom out</td>
</tr>
<tr>
<td>Pinch open</td>
<td>Zoom in</td>
</tr>
<tr>
<td>Two-finger scroll</td>
<td>Pan/scroll the Timeline</td>
</tr>
<tr>
<td>Three-finger swipe left</td>
<td>Select the previous shot</td>
</tr>
<tr>
<td>Three-finger swipe right</td>
<td>Select the next shot</td>
</tr>
<tr>
<td>Three-finger swipe up</td>
<td>Select the previous grade</td>
</tr>
<tr>
<td>Three-finger swipe down</td>
<td>Select the next grade</td>
</tr>
<tr>
<td>Rotate right</td>
<td>Scrub the playhead forward</td>
</tr>
<tr>
<td>Rotate left</td>
<td>Scrub the playhead back</td>
</tr>
</tbody>
</table>

**Multi-Touch Control in the Shots Browser**
The following Multi-Touch controls let you navigate the Shots browser when it’s in icon view.
<table>
<thead>
<tr>
<th>Multi-Touch Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pinch close</td>
<td>Shrink icons</td>
</tr>
<tr>
<td>Pinch open</td>
<td>Enlarge icons</td>
</tr>
<tr>
<td>Two-finger scroll</td>
<td>Pan around the image preview</td>
</tr>
</tbody>
</table>

**Multi-Touch Control of the Scopes**
The following Multi-Touch controls let you modify the display of the Video Scopes.

<table>
<thead>
<tr>
<th>Multi-Touch Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pinch close (Waveform, Vectorscope, 3D scope)</td>
<td>Zoom out</td>
</tr>
<tr>
<td>Pinch open (Waveform, Vectorscope, 3D scope)</td>
<td>Zoom in</td>
</tr>
<tr>
<td>Rotate left (3D scope)</td>
<td>Rotates the 3D scope to the left</td>
</tr>
<tr>
<td>Rotate right (3D scope)</td>
<td>Rotates the 3D scope to the right</td>
</tr>
</tbody>
</table>

**Multi-Touch Control in the Geometry Room**
The following Multi-Touch controls let you make adjustments to each shot’s onscreen controls (scroll, pinch, or rotate inside the onscreen control box), or to the preview display in the Geometry room (scroll or pinch outside the onscreen control box).

<table>
<thead>
<tr>
<th>Multi-Touch Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pinch close (inside the onscreen control box)</td>
<td>Shrink image</td>
</tr>
<tr>
<td>Pinch open (inside the onscreen control box)</td>
<td>Enlarge image</td>
</tr>
<tr>
<td>Two-finger scroll (inside the onscreen control box)</td>
<td>Pan/scan image</td>
</tr>
<tr>
<td>Rotate left (inside the onscreen control box)</td>
<td>Rotate image left</td>
</tr>
<tr>
<td>Rotate right (inside the onscreen control box)</td>
<td>Rotate image right</td>
</tr>
<tr>
<td>Two-finger scroll (outside the onscreen control box)</td>
<td>Pan/scroll preview image</td>
</tr>
<tr>
<td>Pinch close (outside the onscreen control box)</td>
<td>Zoom out of the image preview</td>
</tr>
<tr>
<td>Pinch open (outside the onscreen control box)</td>
<td>Zoom into the image preview</td>
</tr>
</tbody>
</table>
Multi-Touch Control in the Image Preview of the Scopes Window

The following Multi-Touch controls let you make adjustments to each shot’s Pan & Scan settings in the Geometry room, without having that room open.

<table>
<thead>
<tr>
<th>Multi-Touch Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pinch close</td>
<td>Shrink image</td>
</tr>
<tr>
<td>Pinch open</td>
<td>Enlarge image</td>
</tr>
<tr>
<td>Two-finger scroll</td>
<td>Pan/scan image</td>
</tr>
<tr>
<td>Rotate left</td>
<td>Rotate image left</td>
</tr>
<tr>
<td>Rotate right</td>
<td>Rotate image right</td>
</tr>
</tbody>
</table>

Appendix C Using Multi-Touch Controls in Color
Color is compatible with control surfaces from JLCooper and Tangent Devices.

A control surface lets you make simultaneous adjustments to multiple parameters while you work. Not only is this faster, but it allows you to interactively make complex color adjustments to different areas of the image at once. This appendix describes how to connect and configure compatible control surfaces to your computer for use with Color.

This appendix covers the following:

• JLCooper Control Surfaces (p. 421)
• Tangent Devices CP100 Control Surface (p. 426)
• Tangent Devices CP200 Series Control Surface (p. 429)
• Customizing Control Surface Sensitivity (p. 434)

**JLCooper Control Surfaces**

JLCooper makes a variety of control surfaces that are compatible with both Color and Final Cut Pro. The MCS family of control surfaces have both navigational and color correction–specific controls in a variety of configurations. The Eclipse CS is an improved version of the MCS-3000 and MCS-Spectrum that combines both units into a single control surface.

To use compatible JLCooper control surfaces with Color, you need the following:

• Eclipse CX, MCS-3000, MCS-3400, or MCS-3800 with an MCS-Spectrum
• Your Controller configured with an Ethernet board supplied in Slot #1
• Multiport hub, router, or switch
• Cat-5 Ethernet cables

The Eclipse CX has a single Ethernet connection. The Ethernet connection for the MCS-Spectrum is bridged to the MCS-3000 using an Expander Cable. The MCS-3000 then connects to your computer via Ethernet.

**Important:** The JLCooper control surfaces cannot be connected to the second Ethernet port of your Mac Pro; it must be connected to your computer’s primary Ethernet port, if necessary, through a hub or switch if you need to share the port with an Internet connection.

For more information, see:
• Configuring the MCS-3000 and MCS-Spectrum Control Surfaces
• Controls for the MCS-3000
• Controls for the MCS-Spectrum

**Configuring the MCS-3000 and MCS-Spectrum Control Surfaces**
The following procedures describe how to configure and use these control surfaces with Color.

**To set up the MCS-3000 and MCS-Spectrum for use with Color**

1. Turn on the MCS-3000 and wait for the unit to power up.
   The MCS-3000 works similarly to any other networked computer, so you must enter Ethernet IP settings into the device itself so that it can network with your computer.

2. Hold down the SHIFT and ASSIGN/UTILITY buttons simultaneously.
   The current IP address settings should appear in the display at the top of the unit.

3. Using the numeric keypad on the MCS-3000, type in the following values:
   a. Enter an IP Address, then press ENTER to accept and continue.
      For example, you might enter: 192.168.001.010
      **Note:** The first three period-delimited sets of numbers in the IP address must match the first three sets of numbers that are used on your particular network. If you’re not sure what values to use, you can check to see what IP address is used by your computer (look for your computer’s IP address in the Network settings of System Preferences), and base the MCS-3000 IP address on that, making sure you change the last three numbers so that this address isn’t used by any other device on your network.
   b. Enter a gateway address, then press ENTER to accept and continue.
      **Note:** The first three period-delimited sets of numbers in the gateway address must match the IP address you used.
c Enter a Subnet Mask number, then press ENTER to accept and continue.
   For example, you might enter: 255.255.255.000

d Enter a port number, then press ENTER to accept and continue.
   For example, you might enter: 49153

   Note: To be safe, use one of the range of values set aside as “dynamic and/or private
   ports” from 49152 through 65535.

4 Turn off both the MCS-3000 and the MCS-Spectrum.
   Now that your control surface is configured, you need to set it up within Color.

   To use the MCS-3000 and MCS-Spectrum with Color
   1 Turn on the MCS-Spectrum first, then turn on the MCS-3000.

   2 Open Color.

   If you're opening Color for the first time, you see the Control Surface Startup dialog. If
   you've already opened Color and have turned off the option for making this dialog appear,
   you need to click the Show Control Surface Dialog button in the User Prefs tab of the
   Setup room.

   3 When the Control Surface Startup dialog appears:
      a Choose “JLCooper - MCS3000/Spectrum” from the Control Surface pop-up menu.
      b Type the IP address you entered into the MCS-3000 into the IP Address field, then press
         Enter.
      c Type the Port number you entered into the MCS-3000 into the Port field, then press
         Enter.

   4 Click Yes.
   The MCS-3000 and MCS-Spectrum should now be ready for use with Color.
Controls for the MCS-3000

Many of the controls in the MCS-3000 are identified by the text displays running along the top of each panel.

The less obvious controls and functions are as follows:

- **Page 1-8:** Selects one of the eight main rooms in Color
- **F1:** Change keyframe interpolation
- **F2:** Add keyframe
- **F3:** Remove keyframe
- **F4** (*Secondaries room*): Toggle secondary between inside and outside
- **F5** (*Secondaries room*): Toggle vignette off and on
- **F6** (*Secondaries room*): Open previous secondary tab
- **F7** (*Secondaries room*): Open next secondary tab
- **Rewind (<<):** Jump to beginning of shot or previous shot
- **Forward (>>):** Jump to end of shot or next shot
- **Stop:** Stop playback
- **Play:** Start playback
- **Jog wheel:** Playhead control
- **Key pad:** Used for numerical navigation, by either timecode or shot ID
- **Locate:** Locate Timecode or Shot ID
- **Mode:** Toggle Locate between Timecode and Shot ID
- **Last:** Return to last location
- **Enter:** Cue navigation
- **M1:** Speed control
Using the Navigational Controls

There are two different ways to navigate in the Timeline using the keypad on the
MCS-3000.

To switch between timecode and shot number navigation

1. Press Mode Locate or Set Locate on the MCS-3000.
2. Hold down Shift (the blue button under the F-buttons), then press Mode Locate.
   The indicators on the MCS-3000 will switch between 00 00 00 00 (Timecode) and 0 (Shot
   ID) to let you know what mode you’re in.

To locate a position on the Timeline using timecode (in timecode mode)

1. Press Mode Locate or Set Locate on the MCS-3000.
2. Enter the Timecode you wish to locate, then press Enter.
   The playhead moves to that timecode location.

To locate a position on the Timeline using shot numbers (in shot number mode)

1. Press Mode Locate or Set Locate on the MCS-3000.
2. Enter the Shot ID you wish to locate, then press Enter.
   The playhead moves to the shot associated with that ID on the Timeline.
Controls for the MCS-Spectrum
Many of the controls in the MCS-3000 and MCS-Spectrum are identified by the text displays running along the top of each panel.

The less obvious controls and functions are as follows:

- **R1**: Reset Shadow contrast slider
- **B1**: Reset Shadow color control
- **Left joyball**: Shadow color control adjustment
- **Left wheel**: Shadow contrast slider adjustment (black point)
- **R2**: Reset Midtone contrast slider
- **B2**: Reset Midtone color control
- **Center joyball**: Midtone color control adjustment
- **Center wheel**: Midtone contrast slider adjustment (gamma)
- **R3**: Reset Highlight contrast slider
- **B3**: Reset Highlight color control
- **Right joyball**: Highlight color control adjustment
- **Right wheel**: Highlight contrast slider adjustment (white point)

Tangent Devices CP100 Control Surface
The Tangent Devices CP100 is a single, large control surface that combines all available functionality into a single device.

The following procedure describes how to configure and use this control surface with Color.

*Note*: You must be logged in as an administrator to set up the Tangent Devices CP100.
To set up and use the CP100 for use with Color

1 Connect the TDLan port of the CP100 to the primary Ethernet port of your computer using an Ethernet cable.

*Important*: The CP100 cannot be connected to the second Ethernet port of your Mac Pro; it must be connected to your computer’s primary Ethernet port, if necessary through a router or switch if you need to share the port with an Internet connection.

2 Turn on the CP100 and wait for the unit to power up.

3 Open Color.

If you're opening Color for the first time, you see the Control Surface Startup dialog. If you've already opened Color and have turned off the option for making this dialog appear, you need to click the Show Control Surface Dialog button in the User Prefs tab of the Setup room.

4 When the Control Surface Startup dialog appears:
   a Choose “Tangent Devices - CP100” from the Control Surface pop-up menu.
   b When you're prompted for your Administrator password, enter it into the field and click OK.

The CP100 should now be ready for use with Color.

Controls in the CP100

The CP100 features the following controls:

- **Do**: Copy grade (Mem-Bank 1)
- **Undo**: Paste grade (Mem-Bank 1)
- **Redo**: Copy grade from previous edit on Timeline
- **Cue**: Cue up the navigation (modes are Timecode or Shot ID)
- **Mark**: Create still
- **In**: Set play marker In
- **Out**: Set play marker out
- Select: Toggle playback mode
- Mix: Toggle show still
- Grade: Toggle show grade
- Delete: Return grade to identity or base-mem
- |<: Previous event
- >|: Next event
- <: Play reverse
- ][: Stop playback
- >: Play forward
- Button next to jog/shuttle: Toggle x10 speed control
- /< (while holding down Left Alt): Previous keyframe
- >/ (while holding down Left Alt): Next keyframe
- < (while holding down Left Alt): Step backward one frame
- > (while holding down Left Alt): Step forward one frame
- F1: Toggle keyframe interpolation
- F2: Create keyframe
- F3: Delete keyframe
- F4 (Primary In and Out rooms): Alternate panel encoders
- F5 (Primary In and Out rooms): Set scope resolution to 100%
- F6 (Primary In and Out rooms): Set scope resolution to 25%
- F7 (Primary In and Out rooms): Open Parade waveform
- F8 (Primary In and Out rooms): Open Histogram

In the Secondaries room, F5-F9 serve different functions.
- F5 (Secondaries room): Toggle secondary off and on
- F6 (Secondaries room): Toggle secondary between inside and outside
- F7 (Secondaries room): Toggle vignette off and on
- F8 (Secondaries room): Open previous secondary tab
- F9 (Secondaries room): Open next secondary tab
Tangent Devices CP200 Series Control Surface
The Tangent Devices CP200 is a modular series of controllers all designed to work together.

To use the CP200 series of control surfaces with Color, you need the following:

- A CP200-BK Trackerball/Knob panel, CP200-TS Transport/Selection Panel, CP200-K Knob Panel, and/or CP200-S Selection Panel
- Multiport hub or switch
- Cat-5 Ethernet cables

**Important:** The CP200 series control surfaces cannot be connected to the second Ethernet port of your Mac Pro; they must be connected to your computer’s primary Ethernet port, if necessary through a hub or switch if you need to share the port with an Internet connection.

For more information, see:
- Configuring the CP200 Series Control Surfaces
- Controls in the CP200-BK (Trackerball/Knob Panel)
- Controls in the CP200-TS (Transport/Selection Panel)
- Controls in the CP200-K (Knob/Button Panel)

### Configuring the CP200 Series Control Surfaces
The following procedures describe how to configure and use these control surfaces with Color.

**To set up the CP200 series controllers for use with Color**
1. Connect each of the CP200 devices to the router, hub, or switch that’s connected to your computer.
Important: The CP200 series control surfaces cannot be connected to the second Ethernet port of your Mac Pro; they must be connected to your computer’s primary Ethernet port, if necessary through a hub or switch if you need to share the port with an Internet connection.

2 Before you open Color, turn on each of the CP200 devices you have, and write down the two- to three-character ID numbers that appear on the display of each.

You use each device’s ID number to set up Color to communicate with these devices.

Note: The ID numbers that Color uses to connect to the CP200 control surfaces are not the serial numbers that appear on the back or bottom of your CP200 panels.

3 Open Color.

If you’re opening Color for the first time, you see the Control Surface Startup dialog. If you’ve already opened Color and have turned off the option for making this dialog appear, you need to click the Show Control Surface Dialog button in the User Prefs tab of the Setup room.

4 Choose “Tangent Devices - CP200” from the Control Surface pop-up menu.

Each CP200 device that Color is compatible with appears with an Enabled checkbox with two fields: one for the ID number that you wrote down previously, and one for the IP address.

5 For each CP200 device you own:
   a Select its checkbox.
   b Type its ID number into the corresponding field, then press Enter to continue.
   c Type an IP address into the corresponding field, then press Enter to continue.

   Note: The first three period–delimited sets of numbers in the IP address must match the first three sets of numbers that are used on your particular network. If you’re not sure what values to use, you can check to see what IP address is used by your computer, and base the CP200 IP address on that, making sure you change the last three numbers so that the address is unique.

6 Click Yes.
After you click Yes, Color connects with the control surfaces on the network. If this is successful, then each panel’s display should now go blank.

The CP200 series control surfaces are now ready for use with Color.

**Controls in the CP200-BK (Trackerball/Knob Panel)**

The CP200-BK has the following controls:

In the Primary In and Out rooms:

- *Left (Dot) button above wheels:* Reset contrast slider for that zone
- *Right (Circle) button above wheels:* Reset color control for that zone
- *Left joyball:* Shadow color control adjustment
- *Left wheel:* Shadow contrast slider adjustment (black point)
- *Center joyball:* Midtone color control adjustment
- *Center wheel:* Midtone contrast slider adjustment (gamma)
- *Right joyball:* Highlight color control adjustment
- *Right wheel:* Highlight contrast slider adjustment (white point)
- *F1:* Toggle keyframe interpolation
- *F2:* Add keyframe
- *F3:* Delete keyframe
- *F4:* Alternate panel encoders

In the Secondaries room:

- *F1:* Toggle keyframe interpolation
- *F2:* Add keyframe
- *F3:* Delete keyframe
- *F4:* Alternate panel encoders
• **F5:** Toggle secondary
• **F6:** Toggle secondary In/Out control
• **F7:** Toggle secondary vignette
• **F8:** Previous secondary
• **F9:** Next secondary

**Note:** In the Secondaries room, when switching to preview mode, the vignette controls will override these controls.

In the Geometry room:
• **F1:** Change keyframe
• **F2:** Add keyframe
• **F3:** Delete keyframe
• **F4:** Alternate panel encoders

**Controls in the CP200-TS (Transport/Selection Panel)**
The CP200-TS has the following controls:

- **Do:** Copy grade (mem-bank 1)
- **Undo:** Paste grade (mem-bank 1)
- **Redo:** Copy grade from previous edit on Timeline
- **Cue:** Cue up the navigation (modes are Timecode or Shot ID)
- **Mark:** Create still
- **In:** Set play marker In
- **Out:** Set play marker out
- **Mem:** Toggle show still
- **Grade:** Toggle show grade
• **Delete**: Return grade to Identity or base-mem
• `<`: Previous event
• `>`: Next event
• `<`: Play reverse
• `[]`: Stop playback
• `>`: Play forward
• **Button next to jog/shuttle**: Toggle x10 speed control

When Left Alt is held down:
• `<`: Previous keyframe
• `>`: Next keyframe
• `<`: Step backward one frame
• `>`: Step forward one frame

**Controls in the CP200-K (Knob/Button Panel)**
The CP200-K has the following controls:

- RGB channel controls

*Note*: When you open the Previews tab in the Secondaries room, the HSL qualifier controls override the RGB channel controls.
Customizing Control Surface Sensitivity

You can customize the sensitivity of the joyballs, knobs, contrast wheels, and the angle at which the joyballs adjust color, using settings located in the User Prefs tab of the Setup room.

![Table of default parameter values](image)

For more information, see Control Surface Settings.